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Table given below lists the Piping Codes that are built into CAEPIPE Version 12.20 or later for Code 
Compliance checks with their piping type and analysis type covered. 

Sl. 
No. 

Piping Code and Description 
Metallic / 

Nonmetallic 
Piping 

Above 
Ground 

Buried 
Piping 

1 ASME B31.1 (2022) - Power Piping Metallic Yes --- 

2 ASME B31.1 (1967) - Power Piping Metallic Yes --- 

3 ASME B31.1 (1973) - Power Piping Metallic Yes --- 

4 ASME B31.1 (1977) - Power Piping Metallic Yes --- 

5 ASME B31.1 (1980) - Power Piping Metallic Yes --- 

6 ASME B31.3 (2022) - Process Piping Metallic Yes --- 

7 
ASME B31.4 (2022) - Pipeline Transportation Systems 
for Liquids and Slurries 

Metallic Yes Yes 

8 
ASME B31.5 (2022) - Refrigeration Piping and Heat 
Transfer Components 

Metallic Yes --- 

9 
ASME B31.8 (2022) - Gas Transmission and Distribution 
Piping Systems 

Metallic Yes Yes 

10 ASME B31.9 (2020) - Building Services Piping Metallic Yes --- 

11 ASME B31.12 IP (2019) - Hydrogen Piping Metallic Yes --- 

12 ASME B31.12 PL (2019) - Hydrogen Pipelines Metallic Yes Yes 

13 ASME NM.1 (2022) - Thermoplastic Piping Systems Nonmetallic Yes --- 

14 
ASME NM.2 (2022) - Glass-Fiber-Reinforced 
Thermosetting-Resin Piping Systems (GRP/FRP) 

Nonmetallic Yes --- 

15 
ASME Class 2 (1980) - ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

16 
ASME Class 2 (1986) - ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

17 
ASME Class 2 (1992) - ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

18 
ASME Class 2 (2015) - ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

19 
ASME Class 2 (2017) ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

20 
ASME Class 2 (2021) - ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

21 
ASME Class 2 (2023) - ASME Section III, Subsection NC - 
Class 2 

Metallic Yes --- 

22 
ASME Class 3 (2017) - ASME Section III, Subsection ND - 
Class 3 

Metallic Yes --- 

23 
ASME Class 3 (2021) - ASME Section III, Subsection ND - 
Class 3 

Metallic Yes --- 

24 
ASME Class 3 (2023) - ASME Section III, Subsection ND - 
Class 3 

Metallic Yes --- 

25 
ISO 14692-3 (2017) - Petroleum and Natural Gas 
Industries - Glass Reinforced Plastics (GRP/FRP) Piping 

Nonmetallic Yes Yes 

26 EN 13480 (2020) - Metallic industrial piping Metallic Yes Yes 
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Sl. 
No. 

Piping Code and Description 
Metallic / 

Nonmetallic 
Piping 

Above 
Ground 

Buried 
Piping 

27 EN 13941 (2019) - District heating pipes Metallic No Yes 

28 

BS 806 (1986) - Construction of Ferrous Piping 
Installations for and in Connection with Land Boilers 
(British) 

Metallic Yes --- 

29 DNV-ST-F101 – Submarine pipeline systems Metallic Yes --- 

30 
IGEM (2012) - Institution of Gas Engineers and 
Managers (IGEM) IGE/TD/12 Edition 2 (UK) 

Metallic Yes --- 

31 Norwegian (1983) - Process design Metallic Yes --- 

32 Norwegian (1990) - Process design Metallic Yes --- 

33 

RCC-M (1985) - Design and Construction Rules for 
Mechanical Components of PWR Nuclear Islands 
(French) 

Metallic Yes --- 

34 

RCC-M (2018) - Design and Construction Rules for 
Mechanical Components of PWR Nuclear Islands 
(French) 

Metallic Yes --- 

35 

RCC-M (2020) - Design and Construction Rules for 
Mechanical Components of PWR Nuclear Islands 
(French) 

Metallic Yes --- 

36 

RCC-M (2022) - Design and Construction Rules for 
Mechanical Components of PWR Nuclear Islands 
(French) 

Metallic Yes --- 

37 
CODETI (2013) - CODE DE CONSTRUCTION DES 
TUYAUTERIES INDUSTRIELLES (French) 

Metallic Yes --- 

38 Stoomwezen (1989) - Dutch Power piping code Metallic Yes --- 

39 Swedish (1978) – Swedish piping code Metallic Yes --- 

40 Z183 (1990) - Oil Pipeline Systems (Canadian) Metallic Yes --- 

41 Z184 (1992) - Gas Pipeline Systems (Canadian) Metallic Yes --- 

42 Z662 (2019) - Oil & Gas Pipeline Systems (Canadian) Metallic Yes Yes 

43 
NONE (for AWWA M11 applications, and for 
applications in aircraft, aerospace & defence industries) 

Metallic Yes Yes 
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Allowable Pressure 

At this time, there is no provision in CAEPIPE to specify the type of pipe manufacturing 
process, i.e., whether the pipe is a seamless or longitudinal welded or spiral welded. 
Accordingly, irrespective of the type of pipe manufacturing process, for straight pipes and 
bends, CAEPIPE calculates allowable pressure using Eq. (9) of para.104.1.2 and Eqs. (3) & 
(5) of para. 102.4.5 (b). 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
. (
𝑊

𝐼
) 

where 

Pa= allowable pressure 

SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E 
(or casting quality factor F) at the design temperature (i.e., at Tdesign input into CAEPIPE). 
The values of SE and SF are given in Mandatory Appendix A of ASME B31.1 (2024) Code. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 

d = inside diameter of pipe 

I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline  

Values for coefficient Y are as per Table 104.1.2-1. Refer to the Table listed at the end of this 
section for details on coefficient ‘Y’ implemented in CAEPIPE. 

W = weld strength reduction factor as per Table 102.4.7-1. Refer to the Table listed at the 
end of this section for details on weld strength reduction factors implemented in CAEPIPE. 

ASME B31.1 Code does not provide any explicit equation to compute Allowable Pressure 
for closely spaced and widely spaced miter bends. Hence, for ASME B31.1 Code, CAEPIPE 
computes the allowable pressure for miter bends using the explicit equations given in ASME 
B31.3 (2022) [see para. 304.2.3], as listed below. 

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE as  

)2/(

)(

rRr

rRSEWt
P a

a



  

  



Power Piping 

ASME B31.1 (2024) 

4 
 

For widely spaced miter bends with  <= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE as 

)tan643.0(

2

aa

a
a

rttr

SEWt
P


  

For widely spaced miter bends with  > 22.5 deg, the allowable pressure is calculated in 
CAEPIPE as 

)tan25.1(

2

aa

a
a

rttr

SEWt
P


  

where 

r = mean radius of pipe = (Do - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Sustained Stress 

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads) 
is calculated from Eq. 15 of para.104.8.1 

𝑆𝐿 = √[𝐼𝑎 |𝑆𝑙𝑝 +
𝐹𝑎
𝐴𝑝
| +

√(𝐼𝑖𝑀𝑖𝐴)2 + (𝐼𝑜𝑀𝑜𝐴)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐴

𝑍
)
2

≤ 𝑆ℎ 

where 

P = internal design pressure that shall be not less than the maximum sustained operating 
pressure (MSOP) within the piping system, including the effects of static head = maximum 
of CAEPIPE pressures P1 through P10 

Slp = longitudinal pressure stress as defined in para. 102.3.2(a)(3) = 
𝑃𝐷𝑜

4𝑡𝑛
 𝑜𝑟 

𝑃𝑑𝑛
2

𝐷𝑜
2−𝑑𝑛

2 

tn= nominal wall thickness 

Do = nominal outside diameter 

dn = nominal inside diameter = Do – 2tn 

Fa= longitudinal force due to weight and other sustained mechanical loads (excluding 
pressure) 

Ia= sustained longitudinal force index = 1.00 
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Ii = sustained in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = sustained out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = sustained torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiA, MoA, MtA = in-plane, out-of-plane and torsional moment respectively due to weight and 
other sustained mechanical loads 

Z = nominal section modulus = un-corroded section modulus 

Ap= un-corroded nominal cross sectional area 

Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through 
T10)] 

SL = stress due to pressure, weight and other sustained mechanical loads 

Occasional Stress 

The stress (SO) due to sustained and occasional loads is calculated from Eq. 16 of para. 
104.8.2 as the combined stress due to (a) sustained loads such as pressure, weight and other 
sustained mechanical loads and (b) occasional loads such as earthquake or wind. Wind and 
earthquake are not considered to act concurrently as per para. 101.5.2 and para. 101.5.3. 

𝑆𝑂 = √[𝐼𝑎 |𝑆𝑙𝑝𝑜 +
𝐹𝑏
𝐴𝑝
| +

√(𝐼𝑖𝑀𝑖𝐵)2 + (𝐼𝑜𝑀𝑜𝐵)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐵

𝑍
)
2

≤ 𝑘𝑆ℎ 

where 

Fb = longitudinal force due to weight, other sustained mechanical loads (excluding pressure), 
and occasional loads such as thrusts from pressure/safety relief valve loads, from pressure 
and flow transients, earthquake, wind, etc. 

Slpo = longitudinal peak pressure stress = 
𝑃𝑜𝐷𝑜

4𝑡𝑛
 𝑜𝑟 

𝑃𝑜𝑑𝑛
2

𝐷𝑜
2−𝑑𝑛

2 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

tn= nominal wall thickness 

Do = nominal outside diameter 

dn = nominal inside diameter = Do – 2tn 

Ia= occasional longitudinal force index = 1.00 

Ii = occasional in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  
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Io = occasional out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = occasional torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiB, MoB, MtB = in-plane, out-of-plane and torsional moment respectively due to weight, 
other sustained mechanical loads (excluding pressure), and occasional loads such as thrusts 
from pressure/safety relief valve loads, from pressure and flow transients, earthquake, wind, 
etc. 

SO = stress due to pressure, weight, other sustained mechanical loads and occasional loads 
such as thrusts from relief / safety valve loads, from pressure and flow transients, 
earthquake, wind etc. 

k = 1.2 for occasional loads acting for no more than 1 hr at any one time and no more than 
80 hr/yr. 

All other terms such as P, Do, Z, etc. are as defined under Sustained Stress. 

For Unsigned occasional load cases such as Earthquake, etc. the forces and moments are 
combined as given below. 

𝐼𝑎 |𝑆𝑙𝑝𝑜 +
𝐹𝑏

𝐴𝑝
| =  𝑚𝑎𝑥 [𝐼𝑎 (|𝑆𝑙𝑝𝑜 +

𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| + |

𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|) , 𝐼𝑎 (|𝑆𝑙𝑝𝑜 +

𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| − |

𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|)]  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

For Signed occasional load cases such as Wind, etc. the forces and moments are combined as 
given below. 

𝐼𝑎 |𝑆𝑙𝑝𝑜 +
𝐹𝑏

𝐴𝑝
| =  𝐼𝑎 |𝑆𝑙𝑝𝑜 +

𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
+
𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

where 

MiB(sust), MoB(sust), MtB(sust) = in-plane, out-of-plane and torsional moment respectively due to 
weight and other sustained mechanical loads (excluding pressure). 

MiB(occa), MoB(occa), MtB(occa) = in-plane, out-of-plane and torsional moment respectively due to 
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and 
flow transients, earthquake, wind, etc. 
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Fb(sust) = longitudinal force due to weight, other sustained mechanical loads (excluding 
pressure) 

Fb(occa) = longitudinal force due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake, wind, etc. 

Expansion Stress Range (i.e., Stress due to Displacement Load Range) 

The stress range (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3. 

𝑆𝐸 = √[|
𝑖𝑎𝐹𝑐
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐶

𝑍
)
2

≤ 𝑆𝐴 

where 

Fc = axial force range due to reference displacement load range 

Ap= un-corroded nominal cross sectional area  

ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 

MiC, MoC, MtC = in-plane, out-of-plane and torsional moment range respectively due to the 
reference displacement load range 

ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 

Z = nominal section modulus = un-corroded section modulus 

)25.025.1( hCA SSfS  , from Eq. (1A) of para. 102.3.2 (b) 

f cyclic stress range reduction factor from Eq. (1C) of para. 102.3.2 (b),  

f 6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference 

displacement stress range cycles expected during the service life of the piping 

SC = basic allowable stress at minimum metal temperature expected during the displacement 
stress range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the displacement 
stress range under analysis 

When Sh is greater than SL, the allowable stress range may be calculated as  

])(25.1[ LhCA SSSfS  , from Eq. (1B) of para. 102.3.2 (b).  

This equation can be re-written as  

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 2 below) 
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This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options-
>Analysis on the Code tab of CAEPIPE.  

Note: 

1. Refer to the end of this appendix for the details of “Thickness and Section Modulus 
used for weight, pressure and stress calculations”. 

2. As per Note 2 of para. 102.3.2 (b) (1) of ASME B31.1 (2024), “For materials with a 
minimum tensile strength of over 70 ksi (480 MPa), eqs. (1A) and (1B) shall be 
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise 
justified.”  

Compliance to this criterion is checked using the value entered under Tensile 
Strength field of CAEPIPE Material property input. If this field is NOT entered or 
left BLANK, then CAEPIPE will compute the Tensile Strength of the material by 
multiplying the Allowable Stress at the minimum temperature (at which the material 
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is 
because, the allowable stress for material below creep is generally 1/3.5 of Tensile 
Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II, 
Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the 
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 
= 77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and 
Sh as 20,000 psi as Tensile Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through 
Layout Window > Options > Analysis > Code, then if the left over Sustained stress 
(= Sh - SL) is positive, CAEPIPE will multiply this positive left over Sustained stress 
by the Stress range reduction factor (f) and add that resulting value to the Expansion 
allowable stress computed using the above equation (1A) of para. 102.3.2. 

Settlement Stress 

The stress range (𝑆𝑆) due to single, noncyclic displacement stress range (e.g., predicted 
settlement or uplift or movement of pipe support structures such as buildings, pipe racks, 
anchors, etc.) is calculated from Eq. 17 of Figure 104.8-1 as given below in accordance with 
para. 102.3.2 (b)(2). 

𝑆𝑆 = √[|
𝑖𝑎𝐹𝐷
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐷)

2 + (𝑖𝑜𝑀𝑜𝐷)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐷
𝑍

)
2

≤ 3𝑆𝐶 

where 
ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 

ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 
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FD = axial force range due to any single noncyclic anchor movement (e.g., predicted building 
settlement) 

Ap= un-corroded nominal cross sectional area 

MiD, MoD, MtD = in-plane, out-of-plane and torsional moment range respectively due to any 
single noncyclic anchor movement (e.g., predicted building settlement) 

Z = nominal section modulus = un-corroded section modulus 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 
 
Hydrotest Stress 

The sum of longitudinal stress (SL) due to test pressure, live and dead loads at the time of 
hydrotest shall not exceed 90% of yield strength at test temperature as per para. 102.3.3 (b). 

𝑆𝐿𝑇 = √[𝐼𝑎 |
𝑃𝐷𝑜
4𝑡𝑛

+
𝐹𝑎
𝐴𝑝
| +

√(𝐼𝑖𝑀𝑖𝐻)2 + (𝐼𝑜𝑀𝑜𝐻)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐻

𝑍
)
2

≤ 0.9𝑆𝑦 

where 

P = The hydrostatic test pressure at any point in the piping system shall not be less than 1.5 
times the design pressure as per para. 137.4.5. 
Do = nominal outside diameter 

tn= nominal wall thickness 

Fa= longitudinal force due to hydrotest loads (excluding pressure) 

Ia= longitudinal force index = 1.00 

Ii = in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken from ASME 
B31J, Table 1-1.  

Io = out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is taken from 
ASME B31J, Table 1-1.  

It = torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken from 
ASME B31J, Table 1-1.  

MiH, MoH, MtH = in-plane, out-of-plane and torsional moment respectively due to hydrotest 

Z = nominal section modulus = un-corroded section modulus 

Ap= un-corroded nominal cross sectional area 

Sy = yield strength at test temperature [i.e., at Tref in CAEPIPE)] 

SLT = stress due to hydrotest loads 
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ASME B31.1 (2024) – Nonmetallic piping as per Chapter N-II 

The Piping Code ASME NM.1 (2020) titled “Thermoplastic Piping Systems” provides 
methods to evaluate Nonmetallic piping such as PVC, CPVC, HDPE, etc. Code Compliance 
as per ASME NM.1 is built into CAEPIPE Version 12.00 or later. Hence, for Nonmetallic 
Piping Analysis, ASME NM.1 can be selected in CAEPIPE for Code Compliance checks. 
 
Material Properties for PVC, CPVC, etc. are provided in “Chapter N-II” titled “Design” of 
ASME B31.1 (2024). These properties are already included in the material library for Plastics 
(B311-2024_N-II.mat) in CAEPIPE. In addition, Allowable Pressure calculation for Non-
metallic pipe and pipe fittings as per Chapter N-II is already included into CAEPIPE as 
given below. 
 
So, if you still wish to perform Nonmetallic piping analysis as per ASME B31.1 (2024), then 
the material properties for Nonmetallic piping can be selected from the material library 
(B311-2024_N-II.mat) supplied with CAEPIPE. 
 
Allowable Pressure 

From ASME B31.1 (2024) Chapter N-II, Allowable Pressure for Nonmetallic (thermoplastics) pipe 
and pipe fittings are computed using Eq. (2) of para. N-104.1.2(a)(1). 

𝑃𝑎 =
2𝑆𝑎

(
𝐷𝑜

𝑡𝑎
− 1)

 

where 

Pa= allowable pressure 

Sa = hydrostatic design stress from Table N-102.2.1-1 of ASME B31.1 (2024) code (input 
into CAEPIPE material property for thermoplastics) 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE as per para. N-104.1.1) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 
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Coefficient ‘Y’ used in CAEPIPE to compute components Allowable Design Pressure 
(extracted from Table 104.1.2-1 of ASME B31.1 – 2024) 

S. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloy UNS No. 
N06690 (NA) 

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

4. Other Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

5. Cast Iron 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

6. Material Types other 
than those stated from 
Sl. Nos. 1 to 5. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 

1. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF 
(480oC) and below, CAEPIPE calculates Y as 

oDd

d
Y
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Weld Strength Reduction Factors (W) used in CAEPIPE to calculate components 
Allowable Design Pressure (extracted from Table 102.4.7-1 of ASME B31.1-2024) 

Sl. 
No. 

Material 
Type/Material 
Description 

Weld Strength Reduction Factor for Temperature, Deg F (Deg C) 

700 750 800 850 900 950 1000 1050 1100 1150 1200 

(371) (399) (427) (454) (482) (510) (538) (566) (593) (621) (649) 

1 Carbon Steel 
(CS)  
[see Note (a)] 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Ferritic Steels 
(FS) 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

3 Austenitic 
Steel (AS)  

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

4 Material 
Description 
that contains a 
string “CrMo” 

1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 

5 Material Types 
other than 
those stated in 
Sl. Nos. 1 to 3 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 
Notes: 
(a) Based on Note 7 of Table 102.4.7-1 of ASME B31.1 (2024) code, W = 1.0 for Carbon 

Steel (CS). 
(b) For Austenitic Steels (including 800H and 800 HT), values up to 1500 deg F are as 

follows: 
Temperature, deg F Temperature, deg C Weld Strength Reduction Factor 
1250    677    0.73 
1300    704    0.68 
1350    732    0.64 
1400    760    0.59 
1450    788    0.55 
1500    816    0.50 
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Allowable Pressure 

At this time, there is no provision in CAEPIPE to specify the type of pipe manufacturing 
process, i.e., whether the pipe is a seamless or longitudinal welded or spiral welded. 
Accordingly, irrespective of the type of pipe manufacturing process, for straight pipes and 
bends, CAEPIPE calculates allowable pressure using Eq. (9) of para.104.1.2 and Eqs. (3) & 
(5) of para. 102.4.5 (b). 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
. (
𝑊

𝐼
) 

where 

Pa= allowable pressure 

SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E 
(or casting quality factor F) at the design temperature (i.e., at Tdesign input into CAEPIPE). 
The values of SE and SF are given in Mandatory Appendix A of ASME B31.1 (2022) Code. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 

d = inside diameter of pipe 

I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline  

Values for coefficient Y are as per Table 104.1.2-1. Refer to the Table listed at the end of this 
section for details on coefficient ‘Y’ implemented in CAEPIPE. 

W = weld strength reduction factor as per Table 102.4.7-1. Refer to the Table listed at the 
end of this section for details on weld strength reduction factors implemented in CAEPIPE. 

ASME B31.1 Code does not provide any explicit equation to compute Allowable Pressure 
for closely spaced and widely spaced miter bends. Hence, for ASME B31.1 Code, CAEPIPE 
computes the allowable pressure for miter bends using the explicit equations given in ASME 
B31.3 (2020) [see para. 304.2.3], as listed below. 

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE as  

)2/(

)(

rRr

rRSEWt
P a

a



  

For widely spaced miter bends with  <= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE as 

)tan643.0(

2

aa

a
a

rttr

SEWt
P
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For widely spaced miter bends with  > 22.5 deg, the allowable pressure is calculated in 
CAEPIPE as 

)tan25.1(

2

aa

a
a

rttr

SEWt
P


  

where 

r = mean radius of pipe = (Do - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Sustained Stress 

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads) 
is calculated from Eq. 15 of para.104.8.1 

𝑆𝐿 = √[𝐼𝑎 |
𝑃𝐷𝑜
4𝑡𝑛

+
𝐹𝑎
𝐴𝑝
| +

√(𝐼𝑖𝑀𝑖𝐴)2 + (𝐼𝑜𝑀𝑜𝐴)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐴

𝑍
)
2

≤ 𝑆ℎ 

where 

P = internal design pressure that shall be not less than the maximum sustained operating 
pressure (MSOP) within the piping system, including the effects of static head = maximum 
of CAEPIPE pressures P1 through P10 

Do = nominal outside diameter 

tn= nominal wall thickness 

Fa= longitudinal force due to weight and other sustained mechanical loads (excluding 
pressure) 

Ia= sustained longitudinal force index = 1.00 

Ii = sustained in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = sustained out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = sustained torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiA, MoA, MtA = in-plane, out-of-plane and torsional moment respectively due to weight and 
other sustained mechanical loads 
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Z = nominal section modulus = un-corroded section modulus 

Ap= un-corroded nominal cross sectional area 

Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through 
T10)] 

SL = stress due to pressure, weight and other sustained mechanical loads 

Occasional Stress 

The stress (SO) due to sustained and occasional loads is calculated from Eq. 16 of para. 
104.8.2 as the combined stress due to (a) sustained loads such as pressure, weight and other 
sustained mechanical loads and (b) occasional loads such as earthquake or wind. Wind and 
earthquake are not considered to act concurrently as per para. 101.5.2 and para. 101.5.3. 

𝑆𝑂 = √[𝐼𝑎 |
𝑃𝑜𝐷𝑜
4𝑡𝑛

+
𝐹𝑏
𝐴𝑝
| +

√(𝐼𝑖𝑀𝑖𝐵)2 + (𝐼𝑜𝑀𝑜𝐵)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐵

𝑍
)
2

≤ 𝑘𝑆ℎ 

where 

Fb = longitudinal force due to weight, other sustained mechanical loads (excluding pressure), 
and occasional loads such as thrusts from pressure/safety relief valve loads, from pressure 
and flow transients, earthquake, wind, etc. 
Ia= occasional longitudinal force index = 1.00 

Ii = occasional in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = occasional out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = occasional torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiB, MoB, MtB = in-plane, out-of-plane and torsional moment respectively due to weight, 
other sustained mechanical loads (excluding pressure), and occasional loads such as thrusts 
from pressure/safety relief valve loads, from pressure and flow transients, earthquake, wind, 
etc. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

SO = stress due to pressure, weight, other sustained mechanical loads and occasional loads 
such as thrusts from relief / safety valve loads, from pressure and flow transients, 
earthquake, wind etc. 

k = 1.2 for occasional loads acting for no more than 1 hr at any one time and no more than 
80 hr/yr. 

All other terms such as P, Ap, Z, etc. are as defined under Sustained Stress. 
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For Unsigned occasional load cases such as Earthquake, etc. the forces and moments are 
combined as given below. 

𝐼𝑎 |
𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐹𝑏

𝐴𝑝
| =  𝑚𝑎𝑥 [𝐼𝑎 (|

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| + |

𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|) , 𝐼𝑎 (|

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| − |

𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|)]  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

For Signed occasional load cases such as Wind, etc. the forces and moments are combined as 
given below. 

𝐼𝑎 |
𝑃𝑜𝐷𝑜

4𝑡𝑛
+

𝐹𝑏

𝐴𝑝
| =  𝐼𝑎 |

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
+
𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

where 

MiB(sust), MoB(sust), MtB(sust) = in-plane, out-of-plane and torsional moment respectively due to 
weight and other sustained mechanical loads (excluding pressure). 

MiB(occa), MoB(occa), MtB(occa) = in-plane, out-of-plane and torsional moment respectively due to 
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and 
flow transients, earthquake, wind, etc. 

Fb(sust) = longitudinal force due to weight, other sustained mechanical loads (excluding 
pressure) 

Fb(occa) = longitudinal force due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake, wind, etc. 
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Expansion Stress Range (i.e., Stress due to Displacement Load Range) 

The stress range (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3. 

𝑆𝐸 = √[|
𝑖𝑎𝐹𝑐
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐶

𝑍
)
2

≤ 𝑆𝐴 

where 

Fc = axial force range due to reference displacement load range 

Ap= un-corroded nominal cross sectional area  

ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 

MiC, MoC, MtC = in-plane, out-of-plane and torsional moment range respectively due to the 
reference displacement load range 

ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 

Z = nominal section modulus = un-corroded section modulus 

)25.025.1( hCA SSfS  , from Eq. (1A) of para. 102.3.2 (b) 

f cyclic stress range reduction factor from Eq. (1C) of para. 102.3.2 (b),  

f 6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference 

displacement stress range cycles expected during the service life of the piping 

SC = basic allowable stress at minimum metal temperature expected during the displacement 
stress range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the displacement 
stress range under analysis 

When Sh is greater than SL, the allowable stress range may be calculated as  

])(25.1[ LhCA SSSfS  , from Eq. (1B) of para. 102.3.2 (b).  

This equation can be re-written as  

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 2 below) 

This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options-
>Analysis on the Code tab of CAEPIPE.  

  



Power Piping 
ASME B31.1 (2022) 

[Superseded by ASME B31.1 (2024)] 

18 
 

Note: 

3. Refer to the end of this appendix for the details of “Thickness and Section Modulus 
used for weight, pressure and stress calculations”. 

4. As per Note 2 of para. 102.3.2 (b) (1) of ASME B31.1 (2022), “For materials with a 
minimum tensile strength of over 70 ksi (480 MPa), eqs. (1A) and (1B) shall be 
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise 
justified.”  

Compliance to this criterion is checked using the value entered under Tensile 
Strength field of CAEPIPE Material property input. If this field is NOT entered or 
left BLANK, then CAEPIPE will compute the Tensile Strength of the material by 
multiplying the Allowable Stress at the minimum temperature (at which the material 
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is 
because, the allowable stress for material below creep is generally 1/3.5 of Tensile 
Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II, 
Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the 
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 
= 77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and 
Sh as 20,000 psi as Tensile Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through 
Layout Window > Options > Analysis > Code, then if the left over Sustained stress 
(= Sh - SL) is positive, CAEPIPE will multiply this positive left over Sustained stress 
by the Stress range reduction factor (f) and add that resulting value to the Expansion 
allowable stress computed using the above equation (1A) of para. 102.3.2. 

Settlement Stress 

The stress range (𝑆𝑆) due to single, noncyclic displacement stress range (e.g., predicted 
settlement or uplift or movement of pipe support structures such as buildings, pipe racks, 
anchors, etc.) is calculated from Eq. 17 of Figure 104.8-1 as given below in accordance with 
para. 102.3.2 (b)(2). 

𝑆𝑆 = √[|
𝑖𝑎𝐹𝐷
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐷)

2 + (𝑖𝑜𝑀𝑜𝐷)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐷
𝑍

)
2

≤ 3𝑆𝐶 

where 
ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 

ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 

FD = axial force range due to any single noncyclic anchor movement (e.g., predicted building 
settlement) 
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Ap= un-corroded nominal cross sectional area 

MiD, MoD, MtD = in-plane, out-of-plane and torsional moment range respectively due to any 
single noncyclic anchor movement (e.g., predicted building settlement) 

Z = nominal section modulus = un-corroded section modulus 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 
 
Hydrotest Stress 

The sum of longitudinal stress (SL) due to test pressure, live and dead loads at the time of 
hydrotest shall not exceed 90% of yield strength at test temperature as per para. 102.3.3 (b). 

𝑆𝐿𝑇 = √[𝐼𝑎 |
𝑃𝐷𝑜
4𝑡𝑛

+
𝐹𝑎
𝐴𝑝
| +

√(𝐼𝑖𝑀𝑖𝐻)2 + (𝐼𝑜𝑀𝑜𝐻)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐻

𝑍
)
2

≤ 0.9𝑆𝑦 

where 

P = The hydrostatic test pressure at any point in the piping system shall not be less than 1.5 
times the design pressure as per para. 137.4.5. 
Do = nominal outside diameter 

tn= nominal wall thickness 

Fa= longitudinal force due to hydrotest loads (excluding pressure) 

Ia= longitudinal force index = 1.00 

Ii = in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken from ASME 
B31J, Table 1-1.  

Io = out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is taken from 
ASME B31J, Table 1-1.  

It = torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken from 
ASME B31J, Table 1-1.  

MiH, MoH, MtH = in-plane, out-of-plane and torsional moment respectively due to hydrotest 

Z = nominal section modulus = un-corroded section modulus 

Ap= un-corroded nominal cross sectional area 

Sy = yield strength at test temperature [i.e., at Tref in CAEPIPE)] 

SLT = stress due to hydrotest loads 
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ASME B31.1 (2022) – Nonmetallic piping as per Chapter N-II 

The Piping Code ASME NM.1 (2020) titled “Thermoplastic Piping Systems” provides 
methods to evaluate Nonmetallic piping such as PVC, CPVC, HDPE, etc. Code Compliance 
as per ASME NM.1 is built into CAEPIPE Version 12.00 or later. Hence, for Nonmetallic 
Piping Analysis, ASME NM.1 can be selected in CAEPIPE for Code Compliance checks. 
 
Material Properties for PVC, CPVC, etc. are provided in “Chapter N-II” titled “Design” of 
ASME B31.1 (2022). These properties are already included in the material library for Plastics 
(B311-2022_N-II.mat) in CAEPIPE. In addition, Allowable Pressure calculation for Non-
metallic pipe and pipe fittings as per Chapter N-II is already included into CAEPIPE as 
given below. 
 
So, if you still wish to perform Nonmetallic piping analysis as per ASME B31.1 (2022), then 
the material properties for Nonmetallic piping can be selected from the material library 
(B311-2022_N-II.mat) supplied with CAEPIPE. 
 
Allowable Pressure 

From ASME B31.1 (2022) Chapter N-II, Allowable Pressure for Nonmetallic 
(thermoplastics) pipe and pipe fittings are computed using Eq. (2) of para. N-104.1.2(a)(1). 

 

𝑃𝑎 =
2𝑆𝑎

(
𝐷𝑜

𝑡𝑎
− 1)

 

where 

Pa= allowable pressure 

Sa = hydrostatic design stress from Table N-102.2.1-1 of ASME B31.1 (2022) code (input 
into CAEPIPE material property for thermoplastics) 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE as per para. N-104.1.1) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of 
components (extracted from Table 104.1.2-1 of ASME B31.1 – 2022) 

S. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloy UNS No. 
N06690 (NA) 

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

4. Other Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

5. Cast Iron 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

6. Material Types other 
than those stated from 
Sl. Nos. 1 to 5. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 

2. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF 
(480oC) and below, CAEPIPE calculates Y as 

oDd

d
Y
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Weld Strength Reduction Factors (W) used in CAEPIPE to calculate the 
Allowable Design Pressure of components (extracted from Table 102.4.7-1 of ASME 

B31.1-2022) 

Sl. 
No. 

Material 
Type/Material 
Description 

Weld Strength Reduction Factor for Temperature, Deg F (Deg C) 

700 750 800 850 900 950 1000 1050 1100 1150 1200 

(371) (399) (427) (454) (482) (510) (538) (566) (593) (621) (649) 

1 Carbon Steel 
(CS)  
[see Note (a)] 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Ferritic Steels 
(FS) 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

3 Austenitic 
Steel (AS)  

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

4 Material 
Description 
that contains a 
string “CrMo” 

1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 

5 Material Types 
other than 
those stated in 
Sl. Nos. 1 to 3 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 
Notes: 
(c) Based on Note 7 of Table 102.4.7-1 of ASME B31.1 (2022) code, W = 1.0 for Carbon 

Steel (CS). 
(d) For Austenitic Steels (including 800H and 800 HT), values up to 1500 deg F are as 

follows: 
Temperature, deg F Temperature, deg C Weld Strength Reduction Factor 
1250    677    0.73 
1300    704    0.68 
1350    732    0.64 
1400    760    0.59 
1450    788    0.55 
1500    816    0.50 
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Allowable Pressure 

At this time, there is no provision in CAEPIPE to specify the type of pipe manufacturing 
process, i.e., whether the pipe is a seamless or longitudinal welded or spiral welded. 
Accordingly, irrespective of the type of pipe manufacturing process, for straight pipes and 
bends, CAEPIPE calculates allowable pressure using Eq. (9) of para.104.1.2 and Eqs. (3) & 
(5) of para. 102.4.5 (b). 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
. (
𝑊

𝐼
) 

where 

Pa= allowable pressure 

SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E 
(or casting quality factor F) at the design temperature (i.e., at Tdesign input into CAEPIPE). 
The values of SE/SF are given in Mandatory Appendix A of B31.1 (2020) Code. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 

d = inside diameter of pipe 

I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline  

Values for coefficient Y are as per Table 104.1.2-1. Refer to the Table listed at the end of this 
section for details on coefficient ‘Y’ implemented in CAEPIPE. 

W = weld strength reduction factor as per Table 102.4.7-1. Refer to the Table listed at the 
end of this section for details on weld strength reduction factors implemented in CAEPIPE. 

ASME B31.1 Code does not provide any explicit equation to compute Allowable Pressure 
for closely spaced and widely spaced miter bends. Hence, for ASME B31.1 Code, CAEPIPE 
computes the allowable pressure for miter bends using the explicit equations given in ASME 
B31.3 (2018) [see para. 304.2.3], as listed below. 

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE as  

)2/(

)(

rRr

rRSEWt
P a

a



  

For widely spaced miter bends with  <= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE as 
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)tan643.0(

2

aa

a
a

rttr

SEWt
P


  

For widely spaced miter bends with  > 22.5 deg, the allowable pressure is calculated in 
CAEPIPE as 

)tan25.1(

2

aa

a
a

rttr

SEWt
P


  

where 

r = mean radius of pipe = (Do - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Sustained Stress 

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads) 
is calculated from Eq. 15 of para.104.8.1 

𝑆𝐿 = √[|
𝑃𝐷𝑜
4𝑡𝑛

+
𝐼𝑎𝐹𝑎
𝐴𝑝

| +
√(𝐼𝑖𝑀𝑖𝐴)2 + (𝐼𝑜𝑀𝑜𝐴)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐴

𝑍
)
2

≤ 𝑆ℎ 

where 

P = internal design pressure that shall be not less than the maximum sustained operating 
pressure (MSOP) within the piping system, including the effects of static head = maximum 
of CAEPIPE pressures P1 through P10 

Do = nominal outside diameter 

tn= nominal wall thickness 

Fa= longitudinal force due to weight and other sustained mechanical loads (excluding 
pressure) 

Ia= sustained longitudinal force index = 1.00 

Ii = sustained in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = sustained out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  
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It = sustained torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiA, MoA, MtA = in-plane, out-of-plane and torsional moment respectively due to weight and 
other sustained mechanical loads 

Z = nominal section modulus = un-corroded section modulus 

Ap= un-corroded nominal cross sectional area 

Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through 
T10)] 

SL = stress due to pressure, weight and other sustained mechanical loads 

Note: 

When the option “Pressure stress” is selected as “Pd^2/(D^2-d^2)” through CAEPIPE 
Layout Window > Options > Analysis > Pressure; then CAEPIPE will replace the term 
“PD/4t” with the term “Pd^2/(D^2 – d^2)”, where, d = nominal inside diameter 

Occasional Stress 

The stress (SO) due to sustained and occasional loads is calculated from Eq. 16 of para. 
104.8.2 as the combined stress due to (a) sustained loads such as pressure, weight and other 
sustained mechanical loads and (b) occasional loads such as earthquake or wind. Wind and 
earthquake are not considered to act concurrently as per para. 101.5.2 and para. 101.5.3. 

𝑆𝑂 = √[|
𝑃𝑜𝐷𝑜
4𝑡𝑛

+
𝐼𝑎𝐹𝑏
𝐴𝑝

| +
√(𝐼𝑖𝑀𝑖𝐵)2 + (𝐼𝑜𝑀𝑜𝐵)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐵

𝑍
)
2

≤ 𝑘𝑆ℎ 

where 

Fb = longitudinal force due to weight, other sustained mechanical loads (excluding pressure), 
and occasional loads such as thrusts from pressure/safety relief valve loads, from pressure 
and flow transients, earthquake, wind, etc. 
Ia= occasional longitudinal force index = 1.00 

Ii = occasional in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = occasional out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = occasional torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiB, MoB, MtB = in-plane, out-of-plane and torsional moment respectively due to weight, 
other sustained mechanical loads (excluding pressure), and occasional loads such as thrusts 
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from pressure/safety relief valve loads, from pressure and flow transients, earthquake, wind, 
etc. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

SO = stress due to pressure, weight, other sustained mechanical loads and occasional loads 
such as thrusts from relief / safety valve loads, from pressure and flow transients, 
earthquake, wind etc. 

k = 1.2 for occasional loads acting for no more than 1 hr at any one time and no more than 
80 hr/yr. 

All other terms such as P, Ap, Z, etc. are as defined under Sustained Stress. 

For Unsigned occasional load cases such as Earthquake, etc. the forces and moments are 
combined as given below. 

|
𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏

𝐴𝑝
| =  𝑚𝑎𝑥 [|

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| + |

𝐼𝑎𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
| , |

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| − |

𝐼𝑎𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|]  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

For Signed occasional load cases such as Wind, etc. the forces and moments are combined as 
given below. 

|
𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏

𝐴𝑝
| =  |

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
+
𝐼𝑎𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

where 

MiB(sust), MoB(sust), MtB(sust) = in-plane, out-of-plane and torsional moment respectively due to 
weight and other sustained mechanical loads (excluding pressure). 

MiB(occa), MoB(occa), MtB(occa) = in-plane, out-of-plane and torsional moment respectively due to 
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and 
flow transients, earthquake, wind, etc. 

Fb(sust) = longitudinal force due to weight, other sustained mechanical loads (excluding 
pressure) 
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Fb(occa) = longitudinal force due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake, wind, etc. 
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Note: 

When the option “Pressure stress” is selected as “Pd^2/(D^2-d^2)” through CAEPIPE 
Layout Window > Options > Analysis > Pressure; then CAEPIPE will replace the term 
“PoD/4t” with the term “Pod^2/(D^2 – d^2)”, where, d = nominal inside diameter 

Expansion Stress Range (i.e., Stress due to Displacement Load Range) 

The stress range (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3. 

𝑆𝐸 = √[|
𝑖𝑎𝐹𝑐
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐶

𝑍
)
2

≤ 𝑆𝐴 

where 

Fc = axial force range due to reference displacement load range 

Ap= un-corroded nominal cross sectional area  

ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 

MiC, MoC, MtC = in-plane, out-of-plane and torsional moment range respectively due to the 
reference displacement load range 

ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 

Z = nominal section modulus = un-corroded section modulus 

)25.025.1( hCA SSfS  , from Eq. (1A) of para. 102.3.2 (b) 

f cyclic stress range reduction factor from Eq. (1C) of para. 102.3.2 (b),  

f 6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference 

displacement stress range cycles expected during the service life of the piping 

SC = basic allowable stress at minimum metal temperature expected during the displacement 
stress range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the displacement 
stress range under analysis 

When Sh is greater than SL, the allowable stress range may be calculated as  

])(25.1[ LhCA SSSfS  , from Eq. (1B) of para. 102.3.2 (b).  

This equation can be re-written as  
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𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 2 below) 

This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options-
>Analysis on the Code tab of CAEPIPE.  

Note: 

1. Refer end of this appendix for the details of “Thickness and Section Modulus used 
for weight, pressure and stress calculations”. 

2. As per Note 2 of para. 102.3.2 (b) (1) of ASME B31.1 (2020), “For materials with a 
minimum tensile strength of over 70 ksi (480 MPa), eqs. (1A) and (1B) shall be 
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise 
justified.”  

Compliance to this criterion is checked using the value entered under Tensile 
Strength field of CAEPIPE Material property input. If this field is NOT entered or 
left BLANK, then CAEPIPE will compute the Tensile Strength of the material by 
multiplying the Allowable Stress at the minimum temperature (at which the material 
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is 
because, the allowable stress for material below creep is generally 1/3.5 of Tensile 
Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II, 
Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the 
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 
= 77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and 
Sh as 20,000 psi as Tensile Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through 
Layout Window > Options > Analysis > Code, then if the left over Sustained stress 
(= Sh - SL) is positive, CAEPIPE will multiply this positive left over Sustained stress 
by the Stress range reduction factor (f) and add that resulting value to the Expansion 
allowable stress computed using the above equation (1A). 

Settlement Stress 

The stress range (𝑆𝑆) due to single, noncyclic displacement stress range (e.g., predicted 
settlement or uplift or movement of pipe support structures such as buildings, pipe racks, 
anchors, etc.) is calculated from Eq. 17 of Figure 104.8-1 as given below in accordance with 
para. 102.3.2 (b)(2). 

𝑆𝑆 = √[|
𝑖𝑎𝐹𝐷
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐷)

2 + (𝑖𝑜𝑀𝑜𝐷)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐷
𝑍

)
2

≤ 3𝑆𝐶 

where 
ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 
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ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 

FD = axial force range due to any single noncyclic anchor movement (e.g., predicted building 
settlement) 

Ap= un-corroded nominal cross sectional area 

MiD, MoD, MtD = in-plane, out-of-plane and torsional moment range respectively due to any 
single noncyclic anchor movement (e.g., predicted building settlement) 

Z = nominal section modulus = un-corroded section modulus 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 
 
ASME B31.1 (2020) – Non-metallic piping as per Chapter N-II 

The Chapter N-II titled “Design” of ASME B31.1 (2020) provides methods to evaluate 
Non-metallic piping such as PVC, CPVC etc. This Chapter presents equations and 
references for 
 
1. Pressure Design (Allowable Pressure calculation) of Non-metallic Pipe and Pipe Fittings, 
and  
2. Code Compliance checks (such as Sustained Stress, Expansion Stress and Occasional 
Stress) for Non-Metallic piping . 
 
From ASME B31.1 (2020) Chapter N-II, it was observed that the equations for Allowable 
Pressure for Non-metallic piping and pipe fittings are different from those provided for 
Metallic piping and pipe fittings. On the other hand, equations provided for Code 
Compliance checks for Metallic piping are also applicable for Non-metallic piping.  Refer to  
Code Compliance equations for Metallic piping as per ASME B31.1 (2020) given above.  
 
In view of the above, CAEPIPE can be used for analyzing Plastic Piping (such as PVC, 
CPVC etc.) using ASME B31.1 (2020) code to obtain results for displacements, element 
forces and moments, stresses, support loads and support load summary; however, the 
Allowable Pressure results given in Column 2 of Code Compliance Results should be 
ignored. Allowable pressures for Plastic Pipe and Pipe Fittings have to be computed 
manually as per Chapter N-II of ASME B31.1 (2020) outside of CAEPIPE.  
 
Material Properties for PVC, CPVC, etc. are provided in “Chapter N-II” titled “Design” of 
ASME B31.1 (2020). These properties are already included in the material library for Plastics 
starting CAEPIPE Version 11.00.  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of 
components (extracted from Table 104.1.2-1 of ASME B31.1 – 2020) 

S. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloy UNS No. 
N06690 (NA) 

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

4. Other Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

5. Cast Iron 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

6. Material Types other 
than those stated from 
Sl. Nos. 1 to 5. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 

3. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF 
(480oC) and below, CAEPIPE calculates Y as 

oDd

d
Y
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Weld Strength Reduction Factors (W) used in CAEPIPE to calculate the 
Allowable Design Pressure of components (extracted from Table 102.4.7-1 of ASME 

B31.1-2020) 

Sl. 
No. 

Material 
Type/Material 
Description 

Weld Strength Reduction Factor for Temperature, Deg F (Deg C) 

700 750 800 850 900 950 1000 1050 1100 1150 1200 

(371) (399) (427) (454) (482) (510) (538) (566) (593) (621) (649) 

1 Carbon Steel 
(CS)  
[see Note (a)] 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Ferritic Steels 
(FS) 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

3 Austenitic 
Steel (AS)  

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

4 Material 
Description 
that contains a 
string “CrMo” 

1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 

5 Material Types 
other than 
those stated in 
Sl. Nos. 1 to 3 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 
Notes: 
(e) Based on Note 7 of Table 102.4.7-1 of ASME B31.1 (2020) code, W = 1.0 for Carbon 

Steel (CS). 
(f) For Austenitic Steels (including 800H and 800 HT), values up to 1500 deg F are as 

follows: 
Temperature, deg F Temperature, deg C Weld Strength Reduction Factor 
1250    677    0.73 
1300    704    0.68 
1350    732    0.64 
1400    760    0.59 
1450    788    0.55 
1500    816    0.50 
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Allowable Pressure 

At this time, there is no provision in CAEPIPE to specify the type of pipe construction, i.e., 
whether the pipe is a seamless or longitudinal welded or spiral welded. Accordingly, 
irrespective of the type of pipe construction, CAEPIPE calculates allowable pressure as 
follows. 

For straight pipes and bends with seamless construction or designed for sustained operation 
below the creep range, Eq. (9) of para.104.1.2 is used as given below to compute allowable 
pressure. 

ao

a
a

YtD

SEWt
P

2

2


  

where 

Pa= allowable pressure 

SE = maximum allowable stress in material due to internal pressure and joint efficiency (or 
casting quality factor) at the design temperature. The values of SE are given in Mandatory 
Appendix A of B31.1 (2018) Code 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 

d = inside diameter of pipe 

The coefficient Y is implemented as per Table 104.1.2-1. Refer to the Table listed at the end 
of this section for details on ‘Y’ factor implemented in CAEPIPE. 

W = weld strength reduction factor as per Table 102.4.7-1. Refer to the Table listed at the 
end of this section for details on Weld strength reduction factor implemented in CAEPIPE. 

ASME B31.1 Code does not provide any explicit equation to compute Allowable Pressure 
for closely spaced and widely spaced miter bends. Hence, for ASME B31.1 Code, CAEPIPE 
computes the allowable pressure for miter bends using the explicit equations given in ASME 
B31.3 (2018) [see para. 304.2.3] as listed below. 

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE as  

)2/(

)(

rRr

rRSEWt
P a

a
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For widely spaced miter bends with  <= 22.5 deg, the allowable pressure is calculated in 

CAEPIPE as 

)tan643.0(

2

aa

a
a

rttr

SEWt
P


  

For widely spaced miter bends with  > 22.5 deg, the allowable pressure is calculated in 

CAEPIPE as 

)tan25.1(

2

aa

a
a

rttr

SEWt
P


  

where 

r = mean radius of pipe = (Do - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Sustained Stress 

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads) 
is calculated from Eq. 15 of para.104.8.1 

h
A

n

o

L S
Z

iM

t

PD
S 

75.0

4
 

where 

P = maximum of CAEPIPE pressures P1 through P10 

Do = outside diameter 

tn= nominal wall thickness 

i = stress intensification factor. The product 0.75i shall not be less than 1.0. 

MA = resultant bending moment due to weight and other sustained loads 

Z = un-corroded section modulus; for reduced outlets, effective section modulus as per para. 
104.8.4 

Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through 
T10)] 
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Occasional Stress 

The stress (SLO) due to occasional loads is calculated from Eq. 16 of para.104.8.2 as the sum 
of stress due to sustained loads (SL) and stress due to occasional loads (So) such as earthquake 
or wind. Wind and earthquake are not considered concurrently. 

h
BA

n

opeak

Lo S
Z

iM

Z

iM

t

DP
S 2.1

75.075.0

4


 

where 

MB = resultant bending moment on the cross-section due to occasional loads such as thrusts 
from relief / safety valve loads, from pressure and flow transients, earthquake, wind etc. 

Ppeak = peak pressure = (peak pressure factor in CAEPIPE) x P 

Expansion Stress Range (i.e., Stress due to Displacement Load Range) 

The stress (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3. 

A

C

E S
Z

iM
S 

 

where 

MC = resultant moment due to thermal expansion 

)25.025.1( hCA SSfS  , from Eq. (1A) of para. 102.3.2 (b) 

f cyclic stress range reduction factor from Eq.(1C) of para. 102.3.2(b),  

f 6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference 

displacement stress range cycles expected during the service life of the piping 

SC = basic allowable stress at minimum metal temperature expected during the displacement 
cycle under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the displacement 
cycle under analysis 

When Sh is greater than SL, the allowable stress range may be calculated as  

])(25.1[ LhCA SSSfS  , from Eq. (1B) of para. 102.3.2 (b) 

This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options-
>Analysis on the Code tab of CAEPIPE.  

Note: 

Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”.  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of 
components (extracted from Table 104.1.2-1 of ASME B31.1 – 2018) 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel 
(AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloy UNS 
No. N06690 (NA) 

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

4. Other Nickel 
Alloys (NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

5. Cast Iron 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

6. Material Types 
other than those 
stated from Sl. 
Nos. 1 to 5. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 

4. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF 
(480oC) and below, CAEPIPE calculates Y as 

oDd

d
Y




 

Weld Strength Reduction Factors used in CAEPIPE to calculate the Allowable 
Design Pressure of components (extracted from Table 102.4.7-1 of ASME B31.1-2018) 

Sl. 
No. 

Material 
Type/Material 
Description 

Weld Strength Reduction Factor for Temperature, Deg F (Deg C) 

700 750 800 850 900 950 1000 1050 1100 1150 1200 

(371) (399) (427) (454) (482) (510) (538) (566) (593) (621) (649) 

1 Carbon Steel 
(CS) 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Ferritic Steels 
(FS) 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

3 Austenitic 
Steel (AS)  

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

4 Material 
Description 
that contains a 
string “CrMo” 

1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 

5 Material Types 
other than 
those stated in 
Sl. Nos. 1 to 3 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 
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Notes: 
For Austenitic Steels (including 800H and 800 HT) the values upto 1500 deg F are as 
follows: 
Temperature, deg F  Temperature, deg C Weld Strength Reduction Factor 
1250    677    0.73 
1300    704    0.68 
1350    732    0.64 
1400    760    0.59 
1450    788    0.55 
1500    816    0.50
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Allowable Pressure 

At this time, there is no provision in CAEPIPE to specify the type of pipe construction, i.e., 
whether the pipe is a seamless or longitudinal welded or spiral welded. Accordingly, 
irrespective of the type of pipe construction, CAEPIPE calculates allowable pressure as 
follows. 

For straight pipes and bends with seamless construction or designed for sustained operation 
below the creep range, Eq. (9) of para.104.1.2 is used as given below to compute allowable 
pressure. 

ao

a

a
YtD

SEt
P

2

2




 

For straight pipes and bends designed for sustained operation within the creep range, Eq. 
(11) of para.104.1.4 is used as given below to calculate allowable pressure. 

ao

a

a
YtD

SEWt
P

2

2




 

where 

Pa= allowable pressure 

SE = allowable stress as given in Appendix A of B31.1 (2016) Code, where 

E = weld joint efficiency factor or casting quality factor as given in Table 102.4.3 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= outside diameter of pipe 

d = inside diameter of pipe 

The Pressure coefficient Y is implemented as per Table 104.1.2 (A). Refer to the Table listed 
at the end of this section for details on ‘Y’ factor implemented in CAEPIPE  

W = weld strength reduction factor as per Table 102.4.7. Refer to the Table listed at the end 
of this section for details on Weld strength reduction factor implemented in CAEPIPE. 
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For closely spaced miter bends, the allowable pressure is calculated from Eq. (C.3.1) of 
para.104.3.3. 

)2/(

)(

rRr

rRSEt
P a

a





 

where 

r = mean radius of pipe = (Do - tn)/2 

R = equivalent bend radius of the miter 

For widely spaced miter bends, the allowable pressure is calculated from Eq. (C.3.2) of para. 
104.3.3. 

)tan25.1(

2

aa

a

a
rttr

SEt
P




 

Where,  = miter half angle 

Sustained Stress 

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Eq. 15 of para.104.8.1 

h
A

n

o

L S
Z

iM

t

PD
S 

75.0

4
 

where 

P = maximum of CAEPIPE pressures P1 through P10 

Do = outside diameter 

tn= nominal wall thickness 

i = stress intensification factor. The product 0.75i shall not be less than 1.0. 

MA = resultant bending moment due to weight and other sustained loads 

Z = un-corroded section modulus; for reduced outlets, effective section modulus as per para. 
104.8.4 

Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through 
T10)] 
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Occasional Stress 

The stress (SLo) due to occasional loads is calculated from Eq. 16 of para.104.8.2 as the sum 
of stress due to sustained loads (SL) and stress due to occasional loads (So) such as 
earthquake or wind. Wind and earthquake are not considered concurrently. 

h
BA

n

opeak

Lo S
Z

iM

Z

iM

t

DP
S 2.1

75.075.0

4


 

where 

MB = resultant bending moment on the cross-section due to occasional loads such as thrusts 
from relief / safety valve loads, from pressure and flow transients, earthquake, wind etc. 

Ppeak = peak pressure = (peak pressure factor in CAEPIPE) x P 

Expansion Stress Range (i.e., Stress due to Displacement Load Range) 

The stress (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3. 

A

C

E S
Z

iM
S 

 

where 

MC = resultant moment due to thermal expansion 

)25.025.1( hCA SSfS 
, from Eq. (1A) of para. 102.3.2 (B) 

f
cyclicstress range reduction factor from Eq.(1C) of para. 102.3.2(B),  

f
6/N0.2 <= 1.0 and f >= 0.15 with N being the total number of equivalent reference 

displacement stress range cycles expected during the service life of the piping 

SC = basic allowable stress as minimum metal temperature expected during the displacement 
cycle under analysis 

Sh = basic allowable stress as maximum metal temperature expected during the displacement 
cycle under analysis 

When Sh is greater than SL, the allowable stress range may be calculated as  

])(25.1[ LhCA SSSfS 
, from Eq. (1B) of para. 102.3.2 (B) 

This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options-
>Analysis on the Code tab of CAEPIPE.  

Note: 

Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”.  
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Pressure coefficient ‘Y’ used in Allowable Design Pressure of components 
(extracted from Table 104.1.2(A) of ASME B31.1 – 2016). 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel 
(AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloy UNS 
No. N06690 (NA) 

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

4. Other Nickel 
Alloys (NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

5. Cast Iron 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

6. Material Types 
other than those 
stated from Sl. 
Nos. 1 to 5. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 

5. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF 
(480oC) and below then 

oDd

d
Y
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Weld Strength Reduction Factors applied for calculating the Allowable Design 
Pressure of components (extracted from Table 102.4.7 of ASME B31.1-2016). 

Sl. 
No. Material Type 

Weld Strength Reduction Factor for Temperature, Deg F (Deg C) 

700 750 800 850 900 950 1000 1050 1100 1150 1200 

(371) (399) (427) (454) (482) (510) (538) (566) (593) (621) (649) 

1 Carbon Steel 
(CS) 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Ferritic Steels 
(FS) 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

3 Austenitic 
Steel (AS)  

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

4 Material Types 
other than 
those stated in 
Sl. Nos. 1 to 3 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

 
Notes: 
For Austenitic Steels (including 800H and 800 HT) the values upto 1500 deg F are as 
follows: 
Temperature, deg F  Temperature, deg C Weld Strength Reduction Factor 
1250    677    0.73 
1300    704    0.68 
1350    732    0.64 
1400    760    0.59 
1450    788    0.55 
1500    816    0.50
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from 104.1.2. 

𝑃 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃 = allowable pressure 

𝑆 = allowable stress 

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical, corrosion, and erosion 
 allowances 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter 

𝑑 = nominal inside diameter 

𝑌 = pressure coefficient from Table 104.1.2(a)2 

Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) 
is calculated from 102.3.2(d) 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑚
+
𝐹𝐴
𝐴
| +

√(𝑖𝑖𝑀𝑖𝐴)
2 + (𝑖𝑜𝑀𝑜𝐴)

2

𝑍
≤ 𝑆ℎ 

where 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 

𝑡𝑚 = minimum wall thickness as given above 

𝑖𝑖 = in-plane stress intensification factor 

𝑖𝑜 = out-of-plane stress intensification factor 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 
A = nominal metal area 

𝑀𝑖𝐴 = in-plane bending moment due to weight and other sustained loads 

𝑀𝑜𝐴 = out-of-plane bending moment due to weight and other sustained loads 

𝑍 = nominal section modulus = un-corroded section modulus 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 
through T10)] 

Note: 
1. When the option “Include axial force in stress calculations” is tuned OFF, then 

CAEPIPE will exclude the term 
𝐹𝐴
𝐴

 in the equation above. 

2. When the option “Pressure stress” is selected as “Pd^2/(D^2-d^2)”; then CAEPIPE 

will replace the term 
𝑃𝐷

4𝑡𝑚
 with 

𝑃𝑑2

𝐷2−𝑑2
, where, d = nominal inside diameter 
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Occasional Stress 

The stress 𝑆𝐿𝑂 is calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind. Wind and earthquake are not considered 
concurrently (102.3.1). 

𝑆𝐿𝑂 = 𝑆𝐿 + |
(𝑃𝑜 − 𝑃)𝐷

4𝑡𝑚
+
𝐹𝐵
𝐴
| +

√(𝑖𝑖𝑀𝑖𝐵)2 + (𝑖𝑜𝑀𝑜𝐵)2

𝑍
≤ 1.2𝑆ℎ 

where 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 

𝑖𝑖 = in-plane stress intensification factor 

𝑖𝑜= out-of-plane stress intensification factor 

𝐹𝐵 = axial force due to occasional loads 
A = nominal metal area 

𝑀𝑖𝐵 = in-plane bending moment only due to occasional loads 

𝑀𝑜𝐵 = out-of-plane bending moment only due to occasional loads 

𝑍 = nominal section modulus = un-corroded section modulus 

𝑆ℎ= hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 
1. When the option “Include axial force in stress calculations” is tuned OFF, then 

CAEPIPE will exclude the term 
𝐹𝐵
𝐴

 in the equation above. 

2. When the option “Pressure stress” is selected as “Pd^2/(D^2-d^2)” then CAEPIPE 

will replace the term 
(𝑃𝑜−𝑃)𝐷

4𝑡𝑚
 with 

(𝑃𝑂−𝑃)𝑑
2

𝐷2−𝑑2
, where, d = nominal inside diameter 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from (119.6.4). 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴 

where 

𝑆𝑏 = resultant bending stress = √(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2/𝑍 

𝑆𝑡 = torsional stress = 𝑀𝑡𝐶/2Z 

𝑍 = un-corroded section modulus; for a branch, effective section modulus 

𝑀𝑖𝐶 = in-plane bending moment only due to thermal loads 

𝑀𝑜𝐶 = out-of-plane bending moment only due to thermal loads 

𝑀𝑡𝐶  = torsional moment only due to thermal loads 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per eq. (1) in para. 102.3.2 (c). 

SC = basic allowable stress at minimum metal temperature expected during the displacement 
stress range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the displacement 
stress range under analysis 
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f = stress range reduction factor from Table 102.3.2(c). 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as 

𝑆𝐴 = 𝑓[1.25(𝑆𝑐 + 𝑆ℎ) − 𝑆𝐿] 

This is specified as an option (Use liberal allowable stresses) in the menu Options > Analysis 
on the Code tab. 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| + √𝑆𝑏

2 + 4𝑆𝑡
2 ≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force due to thermal loads only. 

A = nominal metal area 

Pressure Correction for Bends (Pressure stiffening effect) 

In large diameter thin-wall bends, pressure can significantly affect their flexibility and SIF. If pressure correction 
for bends is turned ON then the Flexibility of the bend is divided by 

 

1 + 6 × (
𝑃

𝐸
) (
𝑟

𝑡
)
7/3

(
𝑅

𝑟
)
1/3

 

and the SIF for the bend is divided by 

1 + 3.25 × (
𝑃

𝐸
) (
𝑟

𝑡
)
5/2

(
𝑅

𝑟
)
2/3

 

where 

P = pressure, E = elastic modulus, r = mean radius of matching pipe, t = nominal wall thickness and R = bend 
radius 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated using eq. (4) in para. 
104.1.2A. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E 
(or casting quality factor F) at the design temperature (i.e., at Tdesign input into CAEPIPE). 
The values of SE/SF are given in Appendix A of B31.1 (1973) Code. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

𝑑 = nominal inside diameter 

𝑌 = coefficient from Table 104.1.2, A 

S. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 

3. Nonferrous Steels 0.4 0.4 0.4 0.4 0.4 0.4 

4. Cast Iron 0.4 0.4 0.4 0.4 0.4 0.4 

5. Material Types other 
than those stated from 
Sl. Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 

1. If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF 
(480oC) and below, CAEPIPE calculates Y using eq. (5) in para. 104.1.2. 

oDd

d
Y
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Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from para. 102.3.2 D. 

𝑆𝐿 = |
𝑃𝑑2

𝐷2 − 𝑑2
| +

√(𝑖𝑖𝑀𝑖𝐴)
2 + (𝑖𝑜𝑀𝑜𝐴)

2

𝑍
≤ 𝑆ℎ 

where 

𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure 
(MSOP) within the piping system, including the effects of static head = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖𝑖 = in-plane stress intensification factor from Appendix D 

𝑖𝑜 = out-of-plane stress intensification factor from Appendix D 

𝑀𝑖𝐴 = in-plane bending moment due to weight and other sustained mechanical loads (excluding 
pressure) 

𝑀𝑜𝐴 = out-of-plane bending moment due to weight and other sustained mechanical loads 
(excluding pressure) 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 119.7.3. 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |
𝑃𝑑2

𝐷2−𝑑2
| with |

𝑃𝑑2

𝐷2−𝑑2
+
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal metal area 

Occasional Stress 

The stress 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind, shall meet the following conditions as per para. 
102.3.3A. Wind and earthquake are not considered concurrently as per para. 101.5.3. 

𝑆𝐿𝑂 = 𝑆𝐿 + |
(𝑃

𝑜
− 𝑃)𝑑2

𝐷2 − 𝑑2
| +

√(𝑖𝑖𝑀𝑖𝐵)2 + (𝑖𝑜𝑀𝑜𝐵)2

𝑍
≤ 𝑘. 𝑆ℎ 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 119.7.3. 

𝑀𝑖𝐵 = in-plane bending moment due to occasional loads such as thrusts from pressure/safety 
relief valve loads, from pressure and flow transients, earthquake/wind, etc. 
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𝑀𝑜𝐵 = out-of-plane bending moment due to occasional loads such as thrusts from pressure/safety 
relief valve loads, from pressure and flow transients, earthquake/wind, etc. 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 
k = 1.2 for Level B 

k = 1.8 for Level C 

k = 2.40 for Level D 

𝑖𝑖 = in-plane stress intensification factor from Appendix D 

𝑖𝑜 = out-of-plane stress intensification factor from Appendix D 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
| with |

(𝑃𝑜−𝑃)𝑑
2

𝐷2−𝑑2
+
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, 
from pressure and flow transients, earthquake/wind, etc. 

A = nominal metal Area 

Expansion Stress Range 

The stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (8) in para. 119.6.4A. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴 

where 

𝑆𝑏 = resultant bending stress = √(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2/𝑍 

𝑆𝑡 = torsional stress = 𝑀𝑡𝐶/2Z 

𝑖𝑖 = in-plane stress intensification factor from Appendix D 

𝑖𝑜 = out-of-plane stress intensification factor from Appendix D 

𝑀𝑖𝐶 = in-plane bending moment due to the reference thermal load range 

𝑀𝑜𝐶 = out of plane bending moment due to the reference thermal load range 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 119.7.3. 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per eq. (1) in para. 102.3.2 (c). 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table 102.3.2, C 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as follows, in 
accordance with para. 102.3.2 D. 

𝑆𝐴 = 𝑓[1.25(𝑆𝑐 + 𝑆ℎ) − 𝑆𝐿] 
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This is specified as an option (Use liberal allowable stresses) in the menu Options > Analysis 
on the Code tab. 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| + √𝑆𝑏

2 + 4𝑆𝑡
2 ≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force due to reference displacement load range. 

A = nominal metal area 

Pressure Correction for Bends (Pressure stiffening effect) 

In large diameter thin-wall bends, pressure can significantly affect their flexibility and SIF. If pressure correction 
for bends is turned ON then the Flexibility of the bend is divided by 

 

1 + 6 × (
𝑃

𝐸
) (
𝑟

𝑡
)
7/3

(
𝑅

𝑟
)
1/3

 

and the SIF for the bend is divided by 

1 + 3.25 × (
𝑃

𝐸
) (
𝑟

𝑡
)
5/2

(
𝑅

𝑟
)
2/3

 

where 

P = pressure, E = elastic modulus, r = mean radius of matching pipe, t = nominal wall thickness and R = bend 
radius 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated using eq. (4) in para. 
104.1.2A. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E 
(or casting quality factor F) at the design temperature (i.e., at Tdesign input into CAEPIPE). 
The values of SE or SF are given in Appendix A of B31.1 (1977) Code. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

𝑌 = coefficient from Table 104.1.2A 

S. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 

3. Nonferrous Steels 0.4 0.4 0.4 0.4 0.4 0.4 

4. Cast Iron 0.4 0.4 0.4 0.4 0.4 0.4 

5. Material Types other 
than those stated from 
Sl. Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 
If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF (480oC) and 
below, CAEPIPE calculates Y using eq. (5) in para. 104.1.2. 

𝑌 =
𝑑

(𝑑 + 𝐷𝑜)
 

where, d = nominal inside diameter 
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Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from para. 102.3.2 D and eq. (11) of para. 104.8.1. 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure stress option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure 
(MSOP) within the piping system, including the effects of static head = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from Appendix D and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal metal area 

Occasional Stress 

The stress 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind, shall meet the following conditions as per para. 
102.3.3 (A) and eq. (12) of para. 104.8.2. Wind and earthquake are not considered concurrently as 
per para. 101.5.3. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress =|
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
| This pressure stress option can be selected in 

CAEPIPE through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 
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𝑖 = stress intensification factor from Appendix D and 0.75i shall not be less than 1.0 

k = 1.2 for Level B 

k = 1.8 for Level C 

k = 2.40 for Level D 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake/wind, etc. = 

√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, 
from pressure and flow transients, earthquake/wind, etc. 

A = nominal metal Area 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (13) in para. 104.8.3 (A). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Appendix D 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per eq. (1) in para. 102.3.2 (C). 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table 102.3.2 (C) 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 
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where 

𝐹𝐶 = axial force due to displacement load range under analysis. 

A = nominal metal area 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
using eq. (14) of para. 104.8.3 (B). 

𝑆𝑇𝐸 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
+ 
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐴 + 𝑆ℎ 

Where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure stress option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure 
(MSOP) within the piping system, including the effects of static head = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from Appendix D and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| and term 

𝑖𝑀𝐶

𝑍
 with |

𝐹𝐶

𝐴
| +

𝑖𝑀𝐶

𝑍
 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

𝐹𝐶 = axial force due to displacement load range under analysis 

A = nominal metal area 
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SIFs are computed in CAEPIPE as given below for the items listed. 

Sl. No. Component Type SIF (i) 

1. Flange - Weld neck 1.0 

2. Flange - Double welded 1.2 

3. Flange - Single/Fillet/Socket welded 1.3 

4. Flange – Lap Joint 1.6 

Pressure Correction for Bends (Pressure stiffening effect) 

In large diameter thin-wall bends, pressure can significantly affect their flexibility and SIF. If pressure correction for 
bends is turned ON then the Flexibility of the bend is divided by 

 

1 + 6 × (
𝑃

𝐸
) (
𝑟

𝑡
)
7/3

(
𝑅

𝑟
)
1/3

 

and the SIF for the bend is divided by 

1 + 3.25 × (
𝑃

𝐸
) (
𝑟

𝑡
)
5/2

(
𝑅

𝑟
)
2/3

 

where 

P = pressure, E = elastic modulus, r = mean radius of matching pipe, t = nominal wall thickness and R = bend radius 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated using eq. (4) in para. 
104.1.2A. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
SE = maximum allowable stress for the material inclusive of weld joint efficiency factor E 
(or casting quality factor F) at the design temperature (i.e., at Tdesign input into CAEPIPE). 
The values of SE or SF are given in Appendix A of B31.1 (1980) Code. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

𝑌 = coefficient from Table 104.1.2A 

S. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 

3. Nonferrous Steels 0.4 0.4 0.4 0.4 0.4 0.4 

4. Cast Iron 0.4 0.4 0.4 0.4 0.4 0.4 

5. Material Types other 
than those stated from 
Sl. Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 

 
Notes: 
If Do/ta< 6, for ferritic and austenitic steels designed for temperatures of 900oF (480oC) and 
below, CAEPIPE calculates Y using eq. (5) in para. 104.1.2. 

𝑌 =
𝑑

(𝑑 + 𝐷𝑜)
 

where, d = nominal inside diameter 
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Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from para. 102.3.2 D and eq. (11) of para. 104.8.1. 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure 
(MSOP) within the piping system, including the effects of static head = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from Appendix D and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal metal area 

Occasional Stress 

The stress 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind, shall meet the following conditions as per para. 
102.3.3 (A) and eq. (12) of para. 104.8.2. Wind and earthquake are not considered concurrently as 
per para. 101.5.3. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress = |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
| This pressure option can be selected in 

CAEPIPE through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 
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𝑖 = stress intensification factor from Appendix D and 0.75i shall not be less than 1.0 

k = 1.2 for Level B 

k = 1.8 for Level C 

k = 2.40 for Level D 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake/wind, etc. = 

√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, 
from pressure and flow transients, earthquake/wind, etc. 

A = nominal metal Area 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (13) in para. 104.8.3 (A). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Appendix D 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per eq. (1) in para. 102.3.2 (C). 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table 102.3.2 (C) 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 
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where 

𝐹𝐶 = axial force due to reference displacement load range. 

A = nominal metal area 

Sustained + Expansion Stress 

Stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
using eq. (14) of para. 104.8.3 (B). 

𝑆𝑇𝐸 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
+ 
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐴 + 𝑆ℎ 

Where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure 
(MSOP) within the piping system, including the effects of static head = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from Appendix D and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 104.8.4. 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| and term 

𝑖𝑀𝐶

𝑍
 with |

𝐹𝐶

𝐴
| +

𝑖𝑀𝐶

𝑍
 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

𝐹𝐶 = axial force due to displacement load range under analysis 

A = nominal metal area 
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SIFs are computed in CAEPIPE as given below for the items listed. 

Sl. No. Component Type SIF (i) 

1. Flange - Weld neck 1.0 

2. Flange - Double welded 1.2 

3. Flange - Single/Fillet/Socket welded 1.3 

4. Flange – Lap Joint 1.6 

Pressure Correction for Bends (Pressure stiffening effect) 

In large diameter thin-wall bends, pressure can significantly affect their flexibility and SIF. If pressure correction for 
bends is turned ON then the Flexibility of the bend is divided by 

 

1 + 6 × (
𝑃

𝐸
) (
𝑟

𝑡
)
7/3

(
𝑅

𝑟
)
1/3

 

and the SIF for the bend is divided by 

1 + 3.25 × (
𝑃

𝐸
) (
𝑟

𝑡
)
5/2

(
𝑅

𝑟
)
2/3

 

where 

P = pressure, E = elastic modulus, r = mean radius of matching pipe, t = nominal wall thickness and R = bend radius
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight pipes 
and Eq. (3c) for bends from paras. 304.1.2. and 304.2.1 respectively. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷 − 2𝑌𝑡𝑎)
. (
𝑊

𝐼
) 

where 

Pa= allowable internal pressure 

S = allowable stress at Design Temperature (i.e., at Tdesign input into CAEPIPE) as provided in para. 
302.3.1 (a) and as per Table A-1 

E = joint factor (input as material property) from Table A-1A as per para. 302.3.3 (b) or Table A-1B 
as per para. 302.3.4 (a). 

W = Weld Joint Strength Reduction Factor at Design Temperature (i.e., at Tdesign input into 
CAEPIPE) from para. 302.3.5 (e) and as per Table 302.3.5. Refer to the Table listed at the end of 
this section for details on Weld Strength Reduction Factor implemented in CAEPIPE. 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance “c” in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑌 = coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the end of this 
Section for details on ‘Y’ used in CAEPIPE.  

I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline  

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. (4a) and 
Eq. (4b) from para. 304.2.3 (a) as 

𝑃𝑎 = 𝑚𝑖𝑛 [
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
,
𝑆𝐸𝑊𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
] 

For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in CAEPIPE 
using Eq. (4a) from para. 304.2.3 (b) (1) as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃√𝑟𝑡𝑎)
 

 

For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in CAEPIPE 
using Eq. (4c) from para. 304.2.3 (b) (2) as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
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where 

𝑟 = mean radius of pipe using nominal wall thickness = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. 304.2.3 (d) of code for definition) [an input in 
CAEPIPE for miters] 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Note: 

As per para. 304.1.2 (a), Eq. 3(a) used above to compute allowable internal pressure is valid only 
when ta < D/6. Hence, CAEPIPE will issue a warning message and will leave the Allowable 
Pressure row BLANK for elements where ta >= D/6 in Code Compliance Results.  

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 320.2 and para. 302.3.5 (c). 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= 𝐼𝑎 [
𝑃𝜋𝑑2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆 = wall thickness used for sustained stress calculation after deducting corrosion allowance from 
the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝑑 = corroded inside diameter = 𝐷 − 2𝑡𝑆 

𝐴𝑝 = sustained corroded cross-sectional area of the pipe computed using ts as per para. 320.2. 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight) 

𝑅 = axial force due to weight alone, where weight is computed using nominal thickness. 

𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.  

𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater. 

𝐼𝑡 = sustained torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads, e.g., pressure and weight 
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𝑍𝑚 = corroded section modulus as per para. 320.1 

𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10) 

ii and io = in-plane and out-of-plane index from ASME B31J (2017) respectively. 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) due to 

sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads such as 
earthquake or wind. Wind and earthquake are not considered as acting concurrently. See para. 
302.3.6 (a). 

For temp ≤ 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ as per para. 302.3.6 (a)(1) 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ min (0.9𝑊𝑆𝑦, 4𝑆ℎ)as per para. 302.3.6 (a)(2) [only 302.3.6 (a)(2)(-a) and 302.3.6 (a)(2)(-b) 

considered] 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b), (23c) 
and (23d) with applicable loads as per para. 302.3.6 (a). 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= 𝐼𝑎 [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝜋𝑑

2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊 = 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. 302.3.6(a)(2) 

𝑍𝑚 = corroded section modulus as per para. 320.1 
 
Note: When the field Yield strength is left BLANK or NOT input, then CAEPIPE will compute 
the Yield Strength of the material by multiplying the Allowable Stress at the minimum temperature 
(at which the material properties are entered in CAEPIPE stress model) with a factor of 1.5 (=3/2). 
This is because; the allowable stress for material below creep is generally 2/3 of Yield Strength. 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 and shall not 
exceed (SA) as per para.302.3.5 (d). 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆𝐴  

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal thickness 𝑡𝑛 and 
outer diameter D, as per para. 319.3.5. 

𝑖𝑎= axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 𝑖𝑎 = 𝑖𝑜 for 
other components as per ASME B31J (2017) 

𝐹𝑎 = range of axial force between any two thermal conditions being evaluated 

𝑖𝑖 = in-plane stress intensification factor (SIF) as per ASME B31J (2017); shall not be < 1.0 

𝑖𝑜 = out-of-plane SIF as per ASME B31J (2017); shall not be < 1.0 
𝑖𝑡 = torsional SIF as per ASME B31J (2017); shall not be < 1.0 
𝑀𝑖 = in-plane bending moment range between any two conditions being evaluated 
𝑀𝑜 = out-of-plane bending moment range between any two conditions being evaluated 
𝑀𝑡 = torsional moment range between any two conditions being evaluated 

𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a) 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 20(N)-0.333 <= fm & f >= 0.15 
𝑓𝑚 = maximum value of stress range factor; 1.2 for ferrous materials with specified minimum tensile 
strengths <= 75 ksi) and at metal temperatures <=700° F; otherwise 𝑓𝑚 = 1.0 
𝑁= equivalent number of full displacement cycles during expected service of piping (= Number of 

Thermal Cycles input into CAEPIPE through Options > Analysis > Temperature) 
𝑆𝐶= basic allowable stress at minimum metal temperature expected during the displacement cycle 

under analysis 
𝑆ℎ= basic allowable stress at maximum metal temperature expected during the displacement cycle 

under analysis 
when 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. 302.3.5(d). This equation can be re-written as  

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 3 below) 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 
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Notes: 

1. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to form the 
stiffness matrix in accordance with para. 319.4.4 (a). 

2. Refer to the end of this appendix for the details of “Thickness and Section Modulus used for 
weight, allowable pressure and stress calculations”. 

3. Para. 302.3.5 provides maximum value of Sc and Sh as 138 MPa (20 ksi). The reason for this 
criterion is explicitly stated in Note 2 of para. 102.3.5 (b) (1) of ASME B31.1 (2022) as “For 
materials with a minimum tensile strength of over 70 ksi (480 MPa), eqs. (1a) and (1b) shall be 
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise justified.”  

Compliance to this criterion is checked using the value entered under Tensile Strength field of 
CAEPIPE Material property input. If this field is NOT entered or left BLANK, then CAEPIPE 
will compute the Tensile Strength of the material by multiplying the Allowable Stress at the 
minimum temperature (at which the material properties are entered in CAEPIPE stress model) 
with a factor of 3.5. This is because, the allowable stress for material below creep is generally 
1/3.5 of Tensile Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section 
II, Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the minimum 
temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 = 77,000 psi. So, in 
this case, CAEPIPE will internally set the values of both Sc and Sh as 20,000 psi as Tensile 
Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through Layout Window 
> Options > Analysis > Code, then if the left over Sustained stress (= Sh - SL) is positive, 
CAEPIPE will multiply this positive left over Sustained stress by the Stress range reduction 
factor (f) and add that resulting value to the Expansion allowable stress computed using the 
above equation (1a). 

4. Para. 319.2.1(c), implies that wind sway at a piping support (e.g., piping supported from a tall 
slender tower) could be considered as an imposed thermal displacement at that support. Since 
CAEPIPE allows up to 10 thermal loads, the question arises “under which thermal load should 
this wind sway to be included”. Hence, we recommend that wind sway is to be input as a part of 
“wind displacement under occasional stress condition”.  

Operating Stress for Impact Test Exemption 

The combined stress (𝑆𝑜𝑝𝑟) due to pressure, dead loads, live loads and displacement strain for 

Operating Load Case 1 condition is calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 
320.2 as per para. 323.2.2 (b)(3). The combined stress thus computed is then divided by the basic 
allowable stress at the Operating 1 Temperature (T1) and reported under “Operating Stress for 
Impact Test Exemption”. 

This can be seen by turning ON the option “Show Opr. Stress – Impact Test Exemption” by using 
the Mouse Right Click while in “Sorted Stresses” results of CAEPIPE. See the Section titled 
“Operating Stress for NDE/Impact Test/Impact Test Exemption” in this manual for further 
details. 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ 
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where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔 1

= 𝐼𝑎 [
𝑃𝜋𝑑2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔 1

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔 1

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔 1 

𝑃 = CAEPIPE input pressure P1  

𝐷 = outside diameter 

𝑡𝑆 = wall thickness after deducting corrosion allowance from the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝑑 = corroded inside diameter = 𝐷 − 2𝑡𝑆 

𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 323.2.2 (b)(3) 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to Operating load case 1 

𝑅 = axial force due to Operating load case 1 

𝐼𝑖 = in-plane moment index = 1.0 

𝐼𝑜 = out-of-plane moment index = 1.0 

𝐼𝑡 = torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to Operating load case 1 

𝑀𝑜 = out-of-plane bending moment due to Operating load case 1 

𝑀𝑡 = torsional moment due to Operating load case 1 

𝑍𝑚 = corroded section modulus computed using ts as per para. 323.2.2 (b)(3) 

𝑆ℎ = basic allowable stress at temperature T1 input in CAEPIPE 

 

Notes on Material Library for B313-2022.mat supplied with CAEPIPE: 

Material library for ASME B31.3 (2022) [B313-2022.mat] supplied with CAEPIPE has been created 
by referring to the values provided in Appendix A and Appendix C of ASME B31.3 (2022).  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of components 
(extracted from Table 304.1.1 of ASME B31.3 – 2022) 

Sl. No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic 
Steel (AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / 
Cast Iron (CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material 
Types other 
than those 
stated from 
Sl. Nos. 1 to 
4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 
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Weld Joint Strength Reduction Factors used in CAEPIPE to calculate the Allowable Internal Pressure of components (extracted from 
Table 302.3.5 of ASME B31.3-2022) 

Sl. 
No. 

Material 
Type/Material 
Description 

Weld Joint Strength Reduction Factor W for Temperature, Deg F (Deg C) 

<=800 850 900 950 1000 1050 1100 1150 1200 1250 1300 1350 1400 1450 1500 

(427) (454) (482) (510) (538) (566) (593) (621) (649) (677) (704) (732) (760) (788) (816) 

1 Carbon Steel (CS) 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Material 
Description that 
contains a string 
“CrMo” 

1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.64 0.64 0.64 0.64 0.64 0.64 

3 Ferritic Steels 
(FS) [CSEF & CSEF 
(N+T)]  

1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.77 0.77 0.77 0.77 0.77 0.77 

4 Austenitic Steel 
(AS)  

1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.59 0.55 0.5 

5 Nickel Alloy (NA) 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.59 0.55 0.5 

6 Stainless Steel 
(SS) 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

7 Material Types 
other than those 
stated in Sl. Nos. 
1 to 6 

1.00 W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 800 deg. F (or 427 deg. C) and <= 1500 deg. F (or 816 deg. C),  
where, Tcr is taken as 800 deg. F 
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight pipes 
and Eq. (3c) for bends from paras. 304.1.2. and 304.2.1 respectively. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
. (
𝑊

𝐼
) 

where 

Pa= allowable internal pressure 

S = allowable stress at Design Temperature (i.e., at Tdesign input into CAEPIPE) as provided in para. 
302.3.1 (a) and as per Table A-1 

E = joint factor (input as material property) from Table A-1A as per para. 302.3.3 (b) or Table A-1B 
as per para. 302.3.4 9 (a). 

W = Weld Joint Strength Reduction Factor at Design Temperature (i.e., at Tdesign input into 
CAEPIPE) from para. 302.3.5 (e) and as per Table 302.3.5. Refer to the Table listed at the end of 
this section for details on Weld Strength Reduction Factor implemented in CAEPIPE. 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance “c” in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑌 = coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the end of this 
Section for details on ‘Y’ used in CAEPIPE.  

I = 1.0 for straight pipes and at the side wall on the bend / elbow centerline  

For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. (4a) and 
Eq. (4b) from para. 304.2.3 (a) as 

𝑃𝑎 = 𝑚𝑖𝑛 [
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
,
𝑆𝐸𝑊𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
] 

For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in CAEPIPE 
using Eq. (4a) from para. 304.2.3 (b) (1) as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃√𝑟𝑡𝑎)
 

 

For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in CAEPIPE 
using Eq. (4c) from para. 304.2.3 (b) (2) as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
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where 

𝑟 = mean radius of pipe using nominal wall thickness = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. 304.2.3 (d) of code for definition) [an input in 
CAEPIPE for miters] 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Note: 

As per para. 304.1.2 (a), Eq. 3(a) used above to compute allowable internal pressure is valid only 
when ta < D/6. Hence, CAEPIPE will issue a warning message and will leave the Allowable 
Pressure row BLANK for elements where ta >= D/6 in Code Compliance Results.  

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 320.2 and para. 302.3.5 (c). 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= 𝐼𝑎 [
𝑃𝜋𝑑2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆 = wall thickness used for sustained stress calculation after deducting corrosion allowance from 
the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝐴𝑝 = sustained corroded cross-sectional area of the pipe computed using ts as per para. 320.2. 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight) 

𝑅 = axial force due to weight alone, where weight is computed using nominal thickness. 

𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.  

𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater. 

𝐼𝑡 = sustained torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads, e.g., pressure and weight 

𝑍𝑚 = corroded section modulus as per para. 320.1 
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𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10) 

ii and io = in-plane and out-of-plane index from ASME B31J (2017) respectively. 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) due to 

sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads such as 
earthquake or wind. Wind and earthquake are not considered as acting concurrently. See para. 
302.3.6 (a). 

For temp ≤ 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ as per para. 302.3.6 (a)(1) 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ min (0.9𝑊𝑆𝑦, 4𝑆ℎ)as per para. 302.3.6 (a)(2) [only 302.3.6 (a)(2)(-a) and 302.3.6 (a)(2)(-b) 

considered] 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b), (23c) 
and (23d) with applicable loads as per para. 302.3.6 (a). 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= 𝐼𝑎 [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝜋𝑑

2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊 = 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. 302.3.6(a)(2) 

𝑍𝑚 = corroded section modulus as per para. 320.1 
 
Note: When the field Yield strength is left BLANK or NOT input, then CAEPIPE will compute 
the Yield Strength of the material by multiplying the Allowable Stress at the minimum temperature 
(at which the material properties are entered in CAEPIPE stress model) with a factor of 1.5 (=3/2). 
This is because; the allowable stress for material below creep is generally 2/3 of Yield Strength. 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 and shall not 
exceed (SA) as per para.302.3.5 (d). 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆𝐴  

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal thickness 𝑡𝑛 and 
outer diameter D, as per para. 319.3.5. 

𝑖𝑎= axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 𝑖𝑎 = 𝑖𝑜 for 
other components as per ASME B31J (2017) 

𝐹𝑎 = range of axial force between any two thermal conditions being evaluated 

𝑖𝑖 = in-plane stress intensification factor (SIF) as per ASME B31J (2017); shall not be < 1.0 

𝑖𝑜 = out-of-plane SIF as per ASME B31J (2017); shall not be < 1.0 
𝑖𝑡 = torsional SIF as per ASME B31J (2017); shall not be < 1.0 
𝑀𝑖 = in-plane bending moment range between any two conditions being evaluated 
𝑀𝑜 = out-of-plane bending moment range between any two conditions being evaluated 
𝑀𝑡 = torsional moment range between any two conditions being evaluated 

𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a) 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N-0.2 where f ≥ 0.15 and f ≤ 
1.0 (see Note 1 below) 

𝑁= equivalent number of full displacement cycles during expected service of piping (= Number of 
Thermal Cycles input into CAEPIPE through Options > Analysis > Temperature) 

𝑆𝐶= basic allowable stress at minimum metal temperature expected during the displacement cycle 
under analysis 

𝑆ℎ= basic allowable stress at maximum metal temperature expected during the displacement cycle 
under analysis 

when 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. 302.3.5(d). This equation can be re-written as  

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 3 below) 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 
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Notes: 

5. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to form the 
stiffness matrix in accordance with para. 319.4.4 (a). 

6. Refer to the end of this appendix for the details of “Thickness and Section Modulus used for 
weight, allowable pressure and stress calculations”. 

7. Para. 302.3.5 provides maximum value of Sc and Sh as 138 MPa (20 ksi). The reason for this 
criterion is explicitly stated in Note 2 of para. 102.3.5 (b) (1) of ASME B31.1 (2020) as “For 
materials with a minimum tensile strength of over 70 ksi (480 MPa), eqs. (1a) and (1b) shall be 
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise justified.”  

Compliance to this criterion is checked using the value entered under Tensile Strength field of 
CAEPIPE Material property input. If this field is NOT entered or left BLANK, then CAEPIPE 
will compute the Tensile Strength of the material by multiplying the Allowable Stress at the 
minimum temperature (at which the material properties are entered in CAEPIPE stress model) 
with a factor of 3.5. This is because, the allowable stress for material below creep is generally 
1/3.5 of Tensile Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section 
II, Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the minimum 
temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 = 77,000 psi. So, in 
this case, CAEPIPE will internally set the values of both Sc and Sh as 20,000 psi as Tensile 
Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through Layout Window 
> Options > Analysis > Code, then if the left over Sustained stress (= Sh - SL) is positive, 
CAEPIPE will multiply this positive left over Sustained stress by the Stress range reduction 
factor (f) and add that resulting value to the Expansion allowable stress computed using the 
above equation (1a). 

8. As per para. 319.2.1 (c), wind sway should be input into appropriate thermal load displacement. 

Notes on Material Library for B313-2020.mat supplied with CAEPIPE: 

Material library for ASME B31.3 (2020) [B313-2020.mat] supplied with CAEPIPE has been created 
by referring to the values provided in Appendix A and Appendix C of ASME B31.3 (2020).  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of components 

(extracted from Table 304.1.1 of ASME B31.3 – 2020) 

Sl. No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic 
Steel (AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / 
Cast Iron (CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material 
Types other 
than those 
stated from 
Sl. Nos. 1 to 
4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 
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Weld Joint Strength Reduction Factors used in CAEPIPE to calculate the Allowable Internal Pressure of components (extracted from 
Table 302.3.5 of ASME B31.3-2020) 

Sl. 
No. 

Material 
Type/Material 
Description 

Weld Joint Strength Reduction Factor W for Temperature, Deg F (Deg C) 

<=800 850 900 950 1000 1050 1100 1150 1200 1250 1300 1350 1400 1450 1500 

(427) (454) (482) (510) (538) (566) (593) (621) (649) (677) (704) (732) (760) (788) (816) 

1 Carbon Steel (CS) 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Material 
Description that 
contains a string 
“CrMo” 

1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.64 0.64 0.64 0.64 0.64 0.64 

3 Ferritic Steels 
(FS) [CSEF & CSEF 
(N+T)]  

1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.77 0.77 0.77 0.77 0.77 0.77 

4 Austenitic Steel 
(AS)  

1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.59 0.55 0.5 

5 Nickel Alloy (NA) 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.59 0.55 0.5 

6 Stainless Steel 
(SS) 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

7 Material Types 
other than those 
stated in Sl. Nos. 
1 to 6 

1.00 W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 800 deg. F (or 427 deg. C) and <= 1500 deg. F (or 816 deg. C),  
where, Tcr is taken as 800 deg. F 

 



Process Piping 
ASME B31.3 (2018) 

[Superseded by ASME B31.3 (2020)] 

 

92 
 

 

Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively. 

a

a
a

YtD

SEWt
P

2

2


  

where 

Pa= allowable pressure 

S = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1 

E = joint factor (input as material property) from Table A-1A as per para. 302.3.3. or Table 
A-1B as per para. 302.3.4. 

W = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table 
302.3.5.Refer to the Table listed at the end of this section for details on Weld strength 
reduction factor implemented in CAEPIPE. 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance “c” in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑑= inside diameter 

𝑌 = coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the end 
of this Section for details on ‘Y’ used in CAEPIPE.  

𝑌 = 
𝑑+2𝑐

𝐷+𝑑+2𝑐
 , valid for 𝑡𝑎 ≥ 𝐷/6 for all material types. 

 
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. 
(4b) from para. 304.2.3. 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
 

For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4a) from para. 304.2.3 as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
 

 
  



Process Piping 
ASME B31.3 (2018) 

[Superseded by ASME B31.3 (2020)] 

 

93 
 

 

For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4c) from para. 304.2.3 as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
 

where 

𝑟 = mean radius of pipe = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition) [an input 
in CAEPIPE for miters] 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eqs. (23a), (23b1), (23b2), (23c) and (23d) from para. 320.2 and 
para. 302.3.5 (c). 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= [
𝑃𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

For branch (Leg 3 in Fig. 319.4.4B), 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)

2 + (𝐼𝑜𝑀𝑜)
2

𝑍3
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆 = wall thickness used for sustained stress calculation after deducting corrosion 
 allowance from the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.1. 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight) 

𝑅 = axial force due to weight alone, where weight is computed using nominal thickness. 
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𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.  

𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater. 

𝐼𝑡 = torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to sustained loads e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads e.g., pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads e.g., pressure and weight 

𝑍𝑚 = corroded section modulus as per para. 320.1 

𝑍3= effective corroded section modulus (Ze) when Appendix D of B31.3 is used to 

compute ii  and io(or) corroded section modulus (Zm) when B31J is used to compute 

ii  and io 

𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10) 
 

Note: 
ii andio are taken from Appendix D of B31.3 (2018) or ASME B31J (2017), when the 
Analysis option “Use B31J for SIFs and Flexibility Factors” is Turned ON in CAEPIPE. 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) 
due to sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads 
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently 
(see para. 302.3.6(a)). 

For temp ≤ 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎas per para. 302.3.6 (a)(1) 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ min (0.9𝑊𝑆𝑦, 4𝑆ℎ)as per para. 302.3.6 (a)(2) [only 302.3.6 (a)(2)(-a) and 302.3.6 

(a)(2)(-b) considered] 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b1), 
(23b2), (23c) and (23d) with applicable loads as per para. 302.3.6 (a). 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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For branch (Leg 3 in Fig. 319.4.4B) 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍3
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊 = 1.0 for Austenetic stainless steel and 0.8 for all other materials as per para. 
302.3.6(a) 

𝑍𝑚 = corroded section modulus as per para. 320.1 

𝑍3= effective corroded section modulus (Ze) when Appendix D of B31.3 is used to 

compute ii  and io(or) corroded section modulus (Zm) when B31J is used to compute 

ii  and io 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

For branch (Leg 3 in Fig. 319.4.4B) 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍3
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal 
 thickness 𝑡𝑛 and outer diameter D, as per para. 319.3.5. 
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𝑖𝑎=  axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 or as per B31J 

𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions 
 being evaluated 

𝑖𝑖 = in-plane stress intensification factor; shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; shall not be less than 1.0 
𝑖𝑡    =   torsional stress intensification factor as listed in Appendix D of B31.3or as per B31J 
𝑀𝑖 = in-plane bending moment  
𝑀𝑜 = out-of-plane bending moment  
𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a) 

𝑍3 = effective un-corrodedsection modulus (Ze) when Appendix D of B31.3 is used to 

compute ii  and io(or) un-corrodedsection modulus (Z) when B31J is used to 

compute ii  and io 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N-0.2 
  where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below) 
𝑁= equivalent number of full displacement cycles during expected service of piping (= 

Number of Thermal Cycles input into CAEPIPE through Options > Analysis > 
Temperature) 

𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the 
 displacement cycle under analysis 

𝑆ℎ = basic allowable stress at maximum metal temperature expected during the 
 displacement cycle under analysis 

When 𝑆ℎ is greater than𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. 302.3.5(d).
 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 

Notes: 

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal 
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not available 
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 319.4.4 (a). 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

4. 𝑖𝑖and𝑖𝑜 are taken from Appendix D of B31.3 (2018) or ASME B31J (2017), when the 
Analysis option “Use B31J for SIFs and Flexibility Factors” is Turned ON in CAEPIPE. 
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Notes on Material Library for B313-2018.mat supplied with CAEPIPE: 

Material library for ASME B31.3 (2018) [B313-2018.mat] supplied with CAEPIPE has been 
created by referring to the values provided in Appendix A and Appendix C of ASME B31.3 
(2018).  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of 
components (extracted from Table 304.1.1 of ASME B31.3 – 2018) 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel 
(AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / Cast 
Iron (CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material Types 
other than those 
stated from Sl. 
Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 
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Weld Strength Reduction Factors used in CAEPIPE to calculate the Allowable Design Pressure of components (extracted from Table 302.3.5 

of ASME B31.3-2018) 

Sl. 
No. 

Material Type/Material 
Description 

Weld Strength Reduction Factor for Temperature, Deg F (Deg C) 

<=80
0 

850 900 950 1000 1050 1100 1150 1200 1250 1300 1350 1400 1450 1500 

(427) (454) (482) (510) (538) (566) (593) (621) (649) (677) (704) (732) (760) (788) (816) 

1 Carbon Steel (CS) 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

2 Material Description 
that contains a string 
“CrMo” 

1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.64 0.64 0.64 0.64 0.64 0.64 

3 Ferritic Steels (FS) 
[CSEF & CSEF (N+T)]  

1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.77 0.77 0.77 0.77 0.77 0.77 

4 Austenitic Steel (AS)  1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.59 0.55 0.5 

5 Nickel Alloy (NA) 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 0.59 0.55 0.5 

6 Stainless Steel (SS) 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

7 Material Types other 
than those stated in Sl. 
Nos. 1 to 6 

1.00 W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 800 deg. F (or 427 deg. C) and <= 1500 deg. F (or 816 deg. C),  
where, Tcr is taken as 800 deg. F 
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively. 

a

a
a

YtD

SEWt
P

2

2


  

where 

Pa= allowable pressure 

S = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1 

E = joint factor (input as material property) from Table A-1A as per para. 302.3.3. or Table 
A-1B as per para. 302.3.4. 

W = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table 302.3.5 is 
implemented in CAEPIPE as follows.  

Tmax below denotes maximum operating temperature (i.e., max of T1 through T10 and Tref 
in CAEPIPE). 

With Material Type in CAEPIPE = CS [CrMo] 

W = 1.0 with Tmax<= 8000 F (or 4270 C) 

W = 0.64 with Tmax> 12000 F (or 6490 C) and  

For Tmax> 8000 F (or 4270 C) and <= 12000 F (or 6490 C), the values of W are taken from 
Table 302.3.5.  

W for intermediate temperatures is linearly interpolated. 

With Material Type in CAEPIPE = FS [CSEF (Subcritical)] 

W = 1.0 with Tmax<= 9000 F (or 4820 C) 

W = 0.5 with Tmax> 9000 F (or 4820C) 

With Material Type in CAEPIPE = AS or NA 

W = 1.0 with Tmax<= 9500 F (or 5100 C) 

For Tmax> 9500 F (or 5100 C), the values of W are taken as per Table 302.3.5.  

W for intermediate temperatures is linearly interpolated. 

With Material Type in CAEPIPE = SS 

W = 1.0 with Tmax<= 15000 F (or 8160 C) 

For Other Material Types in CAEPIPE 

W = 1.0 with Tmax<= 8000 F (or 4270 C) 
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W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 8000 F (or 4270 C) and<= 15000F (or 8100C) 

where, Tcr is taken as 8000 F 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑑 = inside diameter 

𝑌 = coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6. Refer to the Table listed at the 
end of this Section for details on ‘Y’ used in CAEPIPE.  

𝑌 = 
𝑑+2𝑐

𝐷+𝑑+2𝑐
 , valid for 𝑡𝑎 ≥ 𝐷/6 for all material types. 

 
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. 
(4b) from para. 304.2.3. 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
 

For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4a) from para. 304.2.3 as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
 

 

For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4c) from para. 304.2.3 as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
 

where 

𝑟 = mean radius of pipe = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition) [an input 
in CAEPIPE for miters] 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
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Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eqs. (23a), (23b1), (23b2), (23c) and (23d) from para. 320.2 and 
para. 302.3.5 (c). 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= [
𝑃𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

For branch (Leg 3 in Fig. 319.4.4B), 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑒
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆 = wall thickness used for sustained stress calculation after deducting corrosion 
 allowance from the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.1. 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight) 

𝑅 = axial force due to weight alone, where weight is computed using nominal thickness. 

𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.  

𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater. 

  where𝑖𝑖  and 𝑖𝑜 are taken from Appendix D of B31.3 (2016). 

𝐼𝑡 = torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to sustained loads e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads e.g., pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads e.g., pressure and weight 

𝑍𝑚 = corroded section modulus as per para. 320.1 

𝑍𝑒 = effective corroded section modulus for branch as per para. 320.2 
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Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) 
due to sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads 
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently 
(see para. 302.3.6(a)). 

For temp ≤ 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦
 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b1), 
(23b2), (23c) and (23d) with applicable loads. 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

For branch (Leg 3 in Fig. 319.4.4B) 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑒
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊 = 1.0 for Austenetic stainless steel and 0.8 for all other materials as per para. 
302.3.6(a) 

𝑍𝑚 = corroded section modulus as per para. 320.1 

𝑍𝑒 = effective corroded section modulus for branch as per para. 320.2 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

For branch (Leg 3 in Fig. 319.4.4B) 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑒
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal 
 thickness 𝑡𝑛 and outer diameter D, as per para. 319.3.5. 

𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
 𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 (2016) 

𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions 
 being evaluated 

𝑖𝑖 = in-plane stress intensification factor; shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; shall not be less than 1.0 
𝑖𝑡 = torsional stress intensification factor = 1.0 
𝑀𝑖 = in-plane bending moment  
𝑀𝑜 = out-of-plane bending moment  
𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a) 

𝑍𝑒 = un-corroded effective section modulus as per para. 319.3.5 and para. 319.4.4 (c) 
 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N-0.2 
  where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below) 
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the 

 displacement cycle under analysis 
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the 

 displacement cycle under analysis 
When 𝑆ℎ is greater than𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. 302.3.5(d).
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This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 

Notes: 

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal 
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not available 
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 319.4.4 (a). 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

Notes on Material Library for B313-2016.mat supplied with CAEPIPE: 

Material library for ASME B31.3 (2016) [B313-2016.mat]supplied with CAEPIPE has been 
created by referring to the values provided in Appendix A and Appendix C of ASME B31.3 
(2016).  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure of 
components (extracted from Table 304.1.1 of ASME B31.3 – 2016) 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel 
(AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / Cast 
Iron (CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material Types 
other than those 
stated from Sl. 
Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively. 

a

a

a
YtD

SEWt
P

2

2




 

where 

Pa= allowable pressure 

S = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1 

E = joint factor (input as material property) from Table A-1A or A-1B from para. 302.3.3. 
and para. 302.3.4. 

W = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table 302.3.5 is 
implemented in CAEPIPE as follows. Tmax below denotes maximum operating temperature 
(i.e., max of T1 through T10 and Tref in CAEPIPE). 

With Material Type in CAEPIPE = CS [CrMo] 

W = 1.0 with Tmax<= 8000 F (or 4270 C) 

W = 0.64 with Tmax> 12000 F (or 6490 C) and  

For Tmax> 8000 F (or 4270 C) and <= 12000 F (or 6490 C), the values of W are taken from 
Table 302.3.5.  

W for intermediate temperatures is linearly interpolated. 

With Material Type in CAEPIPE = FS [CSEF (Subcritical)] 

W = 1.0 with Tmax<= 9000 F (or 4820 C) 

W = 0.5 with Tmax> 9000 F (or 4820C) 

With Material Type in CAEPIPE = AS or NA 

W = 1.0 with Tmax<= 9500 F (or 5100 C) 

For Tmax> 9500 F (or 5100 C), the values of W are taken as per Table 302.3.5.  

W for intermediate temperatures is linearly interpolated. 

With Material Type in CAEPIPE = SS 

W = 1.0 with Tmax<= 15000 F (or 8160 C) 

For Other Material Types in CAEPIPE 

W = 1.0 with Tmax<= 8000 F (or 4270 C) 

W = 1 – 0.000909 (Tmax – Tcr) for Tmax> 8000 F (or 4270 C) and<= 15000F (or 8100C)
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where, Tcr is taken as 8000 F 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑑 = inside diameter 

𝑌 = Pressure coefficient from Table 304.1.1, valid for 𝑡𝑎 < 𝐷/6, and  

𝑌 = 
𝑑+2𝑐

𝐷+𝑑+2𝑐
 , valid for 𝑡𝑎 ≥ 𝐷/6 

 
For closely spaced miter bends, the allowable pressure is calculated using Eq. (4b) from para. 
304.2.3. 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
 

where 

𝑟 = mean radius of pipe = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition) 
For widely spaced miter bends, the allowable pressure is calculated using Eq. (4c) from para. 
304.2.3 as 

𝑃𝑎 =
𝑆𝐸𝑊𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
 

where 

𝜃 = miter half angle 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eq. (23a) and (23b) from para. 320.2 and para. 302.3.5 (c). 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= [
𝑃𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 
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𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆 = wall thickness used for sustained stress calculation after deducting corrosion 
 allowance from the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.1. 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight) 

𝑅 = axial force due to weight 

𝐼𝑖 = in-plane stress intensification factor; the product of0.75𝑖𝑖shall not be less than 1.0 

𝐼𝑜 = out-of-plane stress intensification factor; the product of 0.75𝑖𝑜shall not be less than 
 1.0 

𝐼𝑡 = torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to sustained loads e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads e.g., pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads e.g., pressure and weight 

𝑍𝑚 = corroded section modulus as per para. 320.1; for reduced outlets / branch 
 connections, effective section modulus 

𝑍𝑚 = hot allowable stress at maximum temperature [i.e., at Max(Tref, T1 through T10)] 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress due 

to sustained loads such as due to pressure and weight (𝑆𝐿) and stress due to occasional loads 

(𝑆𝑜) such as due to earthquake or wind. Wind and earthquake are not considered 
concurrently (see para. 302.3.6(a)). 

For temp ≤ 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦
 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max(Tref, T1 through T10) 

𝑊 = 1.0 for Austeniticstainless steel and 0.8 for all other materials as per para.302.3.6(a) 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal 
 thickness 𝑡𝑛 and outer diameter D, as per para. 319.3.5. 

𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
 𝑖𝑎 = 𝑖𝑜for other components as listed in Appendix D of B31.3 (2014) 

𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions 
 being evaluated 

𝑖𝑖 = in-plane stress intensification factor; shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; shall not be less than 1.0 
𝑖𝑡 = torsional stress intensification factor = 1.0 
𝑀𝑖 = in-plane bending moment  
𝑀𝑜 = out-of-plane bending moment  
𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus as per para. 319.3.5; for reduced outlets/branch
 connections, effective section modulus as per para. 319.4.4 (a) 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N-0.2 
  where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below) 
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the 

 displacement cycle under analysis 
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𝑆ℎ = basic allowable stress at maximum metal temperature expected during the 
 displacement cycle under analysis 

When 𝑆ℎ is greater than𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. 302.3.5(d).
 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout 
>Options>Analysis >Code tab. 

Notes: 

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal 
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not available 
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”.



Process Piping 
ASME B31.3 (2014) 

 

119 
 

 



Process Piping 
ASME B31.3 (2014) 

 

120 
 

 



Process Piping 
ASME B31.3 (2014) 

 

121 
 

 



Process Piping 
ASME B31.3 (2014) 

 

122 
 

 



Pipeline Transportation Systems for  
Liquids and Slurries 
ASME B31.4 (2022) 

 

123 
 

 

Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 403.2.1. 

𝑃𝑖 =
2𝑆𝑡𝑎
𝐷

 

where 

𝑃𝑖 = allowable pressure 

𝑆 =  allowable stress = F x E x Sy 

𝐹 =  Design Factor = 0.72 as specified in para 403.2.1 

𝑆𝑦 = specified minimum yield strength of pipe at Design Temperature input in CAEPIPE 

𝐸 = weld joint factor as defined in Table 403.2.1-1 

𝑡𝑎 =  available thickness for pressure design 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for 
 corrosion, threading, grooving and erosion. 

𝐷 = outside diameter 

Stress due to Sustained Loads [Unrestrained (above ground) Piping] 

The sum of longitudinal stress due to pressure and due to axial loading (other than thermal 
expansion and pressure) and the bending stress due to external loads, such as weight of the 
pipe and contents, etc. is calculated as follows. 

For Pipes (as per para. 402.6.2) 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1

 where 

𝑖𝑖 = in-plane stress intensification factor; for straight pipes, 𝑖𝑖 = 1.0 (See Note 5) 

𝑖𝑜 = out-of-plane stress intensification factor; for straight pipes, 𝑖𝑜 = 1.0 (See Note 5) 

For Fittings & Components.(as per para. 402.6.2) 

𝑆𝐿(𝑓𝑐) = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃 = maximum operating pressure = max. of CAEPIPE input pressures P1 through P10 Due 
considerations shall be given as per para. 401.2.2.2 while inputting pressure values in 
CAEPIPE. 

𝐷 = nominal outside diameter 
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𝑡𝑛 = nominal thickness as per para. 402.1 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖shall not be less than 1.0 (See 
Note 5) 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75𝑖𝑜shall not be less than 1.0 
(See Note 5) 

𝑀𝑖 = in-plane bending moment due to weight and other external loads 

𝑀𝑜 = out-of-plane bending moment due to weight and other external loads 

𝑀𝑡 = torsional moment due to weight and other external loads 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝐹𝑎 = axial force component for external loads 

𝐴 = nominal metal cross-section area 

𝑆𝑦 = specified minimum yield strength of pipe at maximum CAEPIPE temperature [i.e., at 

max (Tref, T1 through T10)] 

Stress due to Sustained Loads + Occasional Loads [Unrestrained (above ground) 
Piping] 

The sum of longitudinal pressure stress due to axial loading (other than thermal expansion 
and pressure) and the bending stress due to external loads, such as weight of the pipe and 
contents, seismic or wind, etc. is calculated as follows. Wind and Seismic is not considered to 
act concurrently. 

For Pipes (as per para. 402.6.2) 

𝑆𝐿𝑂 = SL + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦

 

as per Table 403.3.1-1 

For Fittings & Components (as per para. 402.6.2) 

𝑆𝐿𝑂(𝑓𝑐) = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating 

 pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para. 
 403.3.4 
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Expansion Stress [Unrestrained (above ground) Piping] 

The stress range (𝑆𝐸) due to thermal expansion is calculated from para.402.5.2 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴as per Table 403.3.1-1 and para. 403.3.2 

where 

𝑆𝑏 = resultant bending stress =
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

Z
 

𝑆𝑡 = torsional stress =
Mt

2Z
 

𝑀𝑖 = in-plane bending moment due to thermal expansion 

𝑀𝑜 = out-of-plane bending moment due to thermal expansion 

𝑀𝑡 = torsional moment due to thermal expansion 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 

𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range  

  Cycles, where 𝑓 ≤ 1.2 (from para. 403.3.2). See Note below. 
 

𝑆𝑐= 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature <= 

20,000 psi 

𝑆ℎ= 0.67𝑆𝑦 at the higher of the installed temperature or maximum operating temperature 

<= 20,000 psi 

𝑆𝑦= specified minimum yield strength of pipe at maximum operating temperature [i.e., at 

max (Tref, T1 through T10)] 

Note: 

As per para. 403.3.2, f cannot exceed 1.2 for ferrous materials with specified minimum 
tensile strengths ≤ 517 MPa (75 ksi) and at Metal temperatures ≤ 371°C (700°F). This 
criterion is not implemented in CAEPIPE as the provision for entering the minimum tensile 
strength in material property is not available at this time. Hence f ≤ 1.0 for all materials 
including Ferrous materials. 

Stress due to Sustained, Thermal and Occasional Loads [Restrained (buried) 
Piping] 

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for 
restrained piping is calculated from para. 402.6.1 

𝑆𝐿𝑝 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝐹𝑎

𝐴
+
𝑀

𝑍
 

𝑆𝐿𝑛 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝐹𝑎

𝐴
−
𝑀

𝑍
 

As per para. 402.6.1, both positive and negative values of M/Z shall be considered for 
analysis. 
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Where 

𝑆𝐸 = Thermal expansion stress = 𝐸𝛼𝑚(𝑇𝑚 − 𝑇𝑖), which can either be positive or negative 

𝑆𝐻 = circumferential (hoop) stress = 
𝑃𝐷

2𝑡𝑛
, which can either be positive or negative as per para. 

402.6.1. 

𝜐 = Poission’s ratio = 0.3 as per para. 402.2.3 

𝐹𝑎 = axial force from weight and other sustained and occasional loads. As per para. 402.6.1, 𝐹𝑎 can 
be positive or negative. 

M = bending moment from Weight and other Sustained and Occasional loads 

For Pipes  

M = √(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2 

For Fittings & Components 

𝑀 = √(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 

 

where 

𝑃 = PFO x max. pressure (P1 through P10) entered in CAEPIPE. 

𝑃𝐹𝑂 = Peak Pressure Factor input. PFO = 1.0, if occasional loads are not present. 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment from Weight and other Sustained and Occasional loads 

𝑀𝑜 = out-of-plane bending moment from Weight and other Sustained and Occasional loads 

𝐴 = nominal metal cross-section area 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝑦 = specified minimum yield strength of pipe at maximum operating temperature [i.e., at 

max (Tref, T1 through T10)] 

𝑇𝑖= installation temperature = Tref in CAEPIPE (see Note below) 

𝑇𝑚= warmest or coldest operating temperature (see Note below) 

𝛼𝑚 = coefficient of thermal expansion at Tm defined above (see Note below) 

𝐸 = young’s modulus at ambient (reference) temperature 

Note: 

If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates 

longitudinal stress 𝑆𝑇 due to thermal expansion as follows. 

For a change in temperature from Tref to T1, 𝑆𝑇1 = −𝐸𝛼1(𝑇1 − 𝑇𝑟𝑒𝑓) 
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For a change in temperature from Tref to T2, 𝑆𝑇2 = −𝐸𝛼2(𝑇2 − 𝑇𝑟𝑒𝑓) 

For a change in temperature from T1 to T2, 𝑆𝑇1−.>𝑇2 = 𝑆𝑇2 − 𝑆𝑇1 

Please note, that negative (-) sign is added in the above equations as the soil is restraining the 
thermal expansion / contraction of the buried pipe due to friction at the soil-to-pipe 
interface. 

Combining of Stresses [Restrained (buried) Piping] 

The longitudinal and circumferential stresses are combined in accordance with the maximum 
shear stress theory as follows (by default in CAEPIPE) as per para. 402.7. 

S𝑒𝑞1 = 2√[(𝑆𝐿𝑝 − 𝑆𝐻)/2]
2
+ (𝑆𝑡)2  S𝑒𝑞2 = 2√[(𝑆𝐿𝑛 − 𝑆𝐻)/2]2 + (𝑆𝑡)2 

where, SLp and SLn are calculated as given above. 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 4 below): 

S𝑒𝑞1 =√(𝑆𝐻)
2 − 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐿𝑝)

2
+ 3(𝑆𝑡)

2 S𝑒𝑞2= √(𝑆𝐻)
2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐿𝑛)

2 + 3(𝑆𝑡)
2 

S𝑒𝑞 = 𝑚𝑎𝑥{𝑆𝑒𝑞1, 𝑆𝑒𝑞2} ≤ 0.9𝑆𝑦 as per Table 403.3.1-1 

where 

S𝑒𝑞 = equivalent combined stress 

S𝑡 = torsional stress =
Mt

2Z
 

𝑀𝑡 = torsional moment from Weight and other Sustained and Occasional loads 

Notes: 

1. Para. 402.6.2 of B31.4 (2022) states that “Longitudinal stress from pressure in an 
unrestrained line should include consideration of bending stress or axial stress that may 
be caused by elongation of the pipe due to internal pressure and result in stress at bends 
and at connections and produce additional loads on equipment and on supports”. 

The above statement implies that “elongation due to Bourdon effect” is to be included in 
the Sustained load case (and hence in Operating case and Sustained plus Occasional load 
case).  

In view of the above, Bourdon effect is turned ON always and disabled for editing by the 
user for ASME B31.4. This can be seen through CAEPIPE Layout Window > Options 
> Analysis > Pressure. 

Please note, since the deformation due to Bourdon effect is being constrained by piping 
supports, CAEPIPE includes the Bourdon effect, by default as part of Thermal 
Expansion (when “Solve Thermal Case” is opted) or as part of Operating Case (when 
“Thermal = Operating – Sustained is opted). 
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2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 402.2.2. 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

4. By default, CAEPIPE combines the stresses for restrained piping using the maximum 
shear stress theory as stated above. To combine stresses in accordance with the 
maximum distortion energy theory as stated above, turn ON the analysis option 
“Combine stresses as per Max. Distortion Energy Theory” through Layout Window > 
Options > Analysis > Code. 

5. Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) are computed using 
ASME B31J (2017) by default.  

Notes on Material Library for B314-2022.mat supplied with CAEPIPE: 

Material library for ASME B31.4 (2022) [B314-2022.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

1. Coefficient of Thermal Expansion: As stated in para. 402.2.1 of B31.4 (2022), 
Coefficient of Thermal Expansion for Carbon and low alloy high tensile steel are entered 
as 6.5E-6 in./in./0F for temperatures up to 250 0F. 

2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy high tensile steel 
for temperatures up to 250 0F are entered by referring to the values provided in Table 
832.5-1 of ASME B31.8 (2022). 

3. Yield Strength: Yield Strength for Carbon and low alloy high tensile steel for 
temperatures up to 250 0F are entered by referring to the values specified in Mandatory 
Appendix D titled “Specified Minimum Yield Strength for Steel Pipe Commonly Used in 
Piping Systems” of ASME B31.8 (2022). 

4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 403.2.1. 

𝑃𝑖 =
2𝑆𝑡𝑎
𝐷

 

where 

𝑃𝑖 = allowable pressure 

𝑆 =  allowable stress = F x E x Sy 

𝐹 =  Design Factor = 0.72 as specified in para 403.2.1 

𝑆𝑦 = specified minimum yield strength of pipe at Design Temperature input in CAEPIPE 

𝐸 = weld joint factor as defined in Table 403.2.1-1 

𝑡𝑎 =  available thickness for pressure design 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for 
 corrosion, threading, grooving and erosion. 

𝐷 = outside diameter 

Stress due to Sustained Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1

 where 

𝑖𝑖 = in-plane stress intensification factor; for straight pipes, 𝑖𝑖 = 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; for straight pipes, 𝑖𝑜 = 1.0 

For Fittings & Components.(as per para. 402.6.2) 

𝑆𝐿(𝑓𝑐) = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃 = maximum operating pressure = max. of CAEPIPE input pressures P1 through P10 
Due considerations shall be given as per para. 401.2.2.2 while inputting pressure 
values in CAEPIPE. 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness as per para. 402.1 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75𝑖𝑜shall not be less than 1.0
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𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝐹𝑎 = axial force component for external loads 

𝐴= nominal cross-section area 

𝑆𝑦=specified minimum yield strength of pipe at maximum CAEPIPE temperature [i.e., at 

max (Tref, T1 through T10)] 

Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝐿𝑂 = SL + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦

 

as per Table 403.3.1-1 

For Fittings & Components (as per para. 402.6.2) 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating 

 pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para. 
 403.3.4 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.402.5.2 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴as per Table 403.3.1-1 and para. 403.3.2 

where 

𝑆𝑏 = resultant bending stress =
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

Z
 

𝑆𝑡 = torsional stress =
Mt

2Z
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

Please note, “Liberal allowable” option is always turned ON for ANSI B31.4 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 

𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range  
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  Cycles, where𝑓 ≤ 1.2 (from para. 403.3.2). 

𝑆𝑐= 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature  

𝑆ℎ= 0.67𝑆𝑦 at the higher of the installed temperature or maximum operating temperature 

𝑆𝑦= specified minimum yield strength of pipe at maximum operating temperature [i.e., at 

max (Tref, T1 through T10)] 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for 
restrained piping is calculated from para. 402.6.1 

𝑆𝐿𝑝 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝐹𝑎

𝐴
+
𝑀

𝑍
 

𝑆𝐿𝑛 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝐹𝑎

𝐴
−
𝑀

𝑍
 

As per para. 402.6.1, both positive and negative values of M/Z shall be considered for 
analysis. 

Where 

𝑆𝐸 = Thermal expansion stress = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜), which can either be positive or negative 

𝑆𝐻 = circumferential (hoop) stress = 
𝑃𝐷

2𝑡𝑛
 

𝜐 = Poission’s ratio = 0.3 as per para. 402.2.3 

As per para. 402.6.1, 𝑆𝐻 can be either positive or negative. 

𝐹𝑎 = axial force, such as weight on a riser. As per para. 402.6.1, 𝐹𝑎can be positive or negative. 

M = bending moment from Weight and other Sustained and Occasional loads 

For Pipes  

M = √(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2 

For Fittings & Components 

𝑀 = √(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 

 

where 

𝑃 = PFO x max. pressure (P1 through P10) entered in CAEPIPE. 

𝑃𝐹𝑂 = Peak Pressure Factor input. PFO = 1.0, if occasional loads are not present. 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 
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𝑀𝑖 = in-plane bending moment from Weight and other Sustained and Occasional loads 

𝑀𝑜= out-of-plane bending moment from Weight and other Sustained and Occasional loads 

𝐹𝑎= axial force component for Weight and other Sustained and Occasional loads 

𝐴= nominal cross-section area 

𝑍= un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝑦= specified minimum yield strength of pipe at maximum operating temperature [i.e., at 

max (Tref, T1 through T10)] 

𝑇𝑖= installation temperature = Tref in CAEPIPE 

𝑇𝑜= warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at To defined above 

𝐸= young’s modulus at ambient (reference) temperature 

Combining of Stresses (Restrained Piping) 

The longitudinal and circumferential stresses are combined in accordance with the maximum 
shear stress theory as follows (by default in CAEPIPE). 

S𝑒𝑞1 = 2√[(𝑆𝐿𝑝 − 𝑆𝐻)/2]
2
+ (𝑆𝑡)2  S𝑒𝑞2 = 2√[(𝑆𝐿𝑛 − 𝑆𝐻)/2]2 + (𝑆𝑡)2 

whereSLp and SLn are calculated as given above. 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 4 below): 

S𝑒𝑞1 =√(𝑆𝐻)2 − 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐿𝑝)
2
+ 3(𝑆𝑡)2 S𝑒𝑞2= √(𝑆𝐻)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐿𝑛)2 + 3(𝑆𝑡)2 

S𝑒𝑞 = 𝑚𝑎𝑥{𝑆𝑒𝑞1, 𝑆𝑒𝑞2} ≤ 0.9𝑆𝑦 

where 

S𝑒𝑞 = equivalent combined stress 

S𝑡 = torsional stress =
Mt

2Z
 

𝑀𝑡 = torsional moment from Weight and other Sustained and Occasional loads 

Notes: 

1. Para. 402.6.2 of B31.4 (2019) states that “Longitudinal stress from pressure in an 
unrestrained line should include consideration of bending stress or axial stress that may 
be caused by elongation of the pipe due to internal pressure and result in stress at bends 
and at connections and produce additional loads on equipment and on supports”. 
The above statement seems to imply that “elongation due to Bourdon effect” is to be 
included in the Sustained load case (and hence in Operating case and Sustained plus 
Occasional load case). 
On the other hand, since the deformation due to Bourdon effect is being constrained by 
piping supports, CAEPIPE includes the Bourdon effect as part of the results for 
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating 
Case (when “Thermal = Operating – Sustained is opted). 
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2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 402.2.2. 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

4. By default, CAEPIPE combines the stresses for restrained piping using the maximum 
shear stress theory as stated above. To combine stresses in accordance with the 
maximum distortion energy theory as stated above, set an environmental variable with 
name “DET_314” with its value as “YES”. 

5. Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) are computed using 
ASME B31.4 (2019) by default. When the option “Use B31J for SIFs and Flexibility 
Factors” is Turned ON, then CAEPIPE computes SIFs and FFs as per B31J (2017). 

Notes on Material Library for B314-2019.mat supplied with CAEPIPE: 

Material library for ASME B31.4 (2019) [B314-2019.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

1. Coefficient of Thermal Expansion: As stated in para. 402.2.1 of B31.4 (2019), 
Coefficient of Thermal Expansion for Carbon and low alloy high tensile steel are entered 
as 6.5E-6 in./in./0F for temperatures up to 250 0F. 

2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy high tensile steel 
for temperatures up to 250 0F are entered by referring to the values provided in Table 
832.5-1 of ASME B31.8 (2018). 

3. Yield Strength: Yield Strength for Carbon and low alloy high tensile steel for 
temperatures up to 250 0F are entered by referring to the values specified in Mandatory 
Appendix D titled “Specified Minimum Yield Strength for Steel Pipe Commonly Used in 
Piping Systems” of ASME B31.8 (2018). 

4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 403.2.1. 

𝑃𝑖 =
2𝑆𝐸𝑡𝑎
𝐷

 

where 

𝑃𝑖 = allowable pressure 

𝑆 =  allowable stress = 0.72 Sy, where 𝑆𝑦 is specified minimum yield strength of pipe 

𝐸 = weld joint factor as defined in Table 403.2.1-1 

𝑡𝑎 =  available thickness for pressure design 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for 
 corrosion, threading, grooving and erosion. 

𝐷 = outside diameter 

Stress due to Sustained Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1

 where 

𝑖𝑖 = in-plane stress intensification factor = 1.0 for pipes 

𝑖𝑜 = out-of-plane stress intensification factor = 1.0 for pipes 

For Fittings & Components.(as per para. 402.6.2) 

𝑆𝐿(𝑓𝑐) = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃 = maximum operating pressure = max of CAEPIPE input pressures (P1 through P10). 
 Due considerations shall be given as per para. 401.2.2.2 while inputting pressure 
 values in CAEPIPE. 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness as per para. 402.1 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75𝑖𝑜shall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 
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𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝐹𝑎 = axial force component for external loads 

𝐴 = nominal cross-section area 

𝑆𝑦 = specified minimum yield strength of pipe 

Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝐿𝑂 = SL + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦

 

as per Table 403.3.1-1 

For Fittings & Components (as per para. 402.6.2) 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating 

 pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para. 
 403.3.4 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.402.5.2 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴as per Table 403.3.1-1 and para. 403.3.2 

where 

𝑆𝑏 = resultant bending stress =
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)
2

Z
 

𝑆𝑡 = torsional stress =
Mt

2Z
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

Please note, “Liberal allowable” option is always turned ON for ANSI B31.4 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range  
  cycles 

where𝑓 ≤ 1.2 (from para. 403.3.2). 

𝑆𝑐 = 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature  
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𝑆ℎ = 0.67𝑆𝑦 at the higher of the installed temperature or maximum operating temperature 

where 

𝑆𝑦 = specified minimum yield strength of pipe 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for 
restrained piping is calculated from para. 402.6.1 

𝑆𝐿𝑝 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝐹𝑎

𝐴
+
𝑀

𝑍
 

𝑆𝐿𝑛 = 𝑆𝐸 + 𝜐𝑆𝐻 +
𝐹𝑎

𝐴
−
𝑀

𝑍
 

As per para. 402.6.1, both positive and negative values of M/Z shall be considered for 
analysis. 

where 

𝑆𝐻 = circumferential (hoop) stress = 
𝑃𝐷

2𝑡𝑛
 

𝜐 = Poission’s ratio = 0.3 as per para. 402.2.3 

As per para. 402.6.1, 𝑆𝐻 can be either positive or negative. 

𝐹𝑎 = axial force, such as weight on a riser. As per para. 402.6.1, 𝐹𝑎can be positive or negative. 

M = bending moment from Weight and other External loads 

For Pipes  

M = √(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2 

For Fittings & Components 

𝑀 = √(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 

 

𝑆𝐸 = Thermal expansion stress = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜), which can either be positive or negative 

where 

𝑃 = PFO x maximum pressure (P1 through P10) entered in CAEPIPE. 

𝑃𝐹𝑂 = Peak Pressure Factor input. PFO = 1.0, if occasional loads are not present. 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment from Weight and other External loads 

𝑀𝑜 = out-of-plane bending moment from Weight and other External loads 
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𝐹𝑎 = axial force component for Weight and other External loads 

𝐴 = nominal cross-section area 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝑦 = specified minimum yield strength of pipe 

𝑇𝑖 = installation temperature = Tref in CAEPIPE 

𝑇𝑜 = warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at To defined above 

𝐸 = young’s modulus at ambient (reference) temperature 

Combining of Stresses 

In restrained pipe, the longitudinal and circumferential stresses are combined in accordance 
with the maximum shear stress theory as follows (by default in CAEPIPE). 

S𝑒𝑞1 = 2√[(𝑆𝐿𝑝 − 𝑆𝐻)/2]
2
+ (𝑆𝑡)2  S𝑒𝑞2 = 2√[(𝑆𝐿𝑛 − 𝑆𝐻)/2]2 + (𝑆𝑡)2 

Where SLp and SLn are calculated as given above. 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 4 below): 

S𝑒𝑞1 =√(𝑆𝐻)2 − 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐿𝑝)
2
+ 3(𝑆𝑡)2 S𝑒𝑞2= √(𝑆𝐻)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐿𝑛)2 + 3(𝑆𝑡)2 

S𝑒𝑞 = 𝑚𝑎𝑥{𝑆𝑒𝑞1, 𝑆𝑒𝑞2} ≤ 0.9𝑆𝑦 

where 

S𝑒𝑞 = equivalent combined stress 

S𝑡 = torsional stress  

Notes: 

5. Para. 402.6.2 of B31.4 (2016) states that “Longitudinal stress from pressure in an 
unrestrained line should include consideration of bending stress or axial stress that may 
be caused by elongation of the pipe due to internal pressure and result in stress at bends 
and at connections and produce additional loads on equipment and on supports”. 
The above statement seems to imply that “elongation due to Bourdon effect” is to be 
included in the Sustained load case (and hence in Operating case and Sustained plus 
Occasional load case). 
On the other hand, since the deformation due to Bourdon effect is being constrained by 
piping supports, CAEPIPE includes the Bourdon effect as part of the results for 
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating 
Case (when “Thermal = Operating – Sustained is opted). 

6. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 402.2.2. 

7. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 
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8. By default, CAEPIPE combines the stresses for restrained piping using the maximum 
shear stress theory as stated above. To combine stresses in accordance with the 
maximum distortion energy theory as stated above, set an environmental variable with 
name “DET_314” with its value as “YES”. 

Notes on Material Library for B314-2016.mat supplied with CAEPIPE: 

Material library for ASME B31.4 (2016) [B314-2016.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

9. Coefficient of Thermal Expansion: As stated in para. 402.2.1 of B31.4 (2016), 
Coefficient of Thermal Expansion for Carbon and low alloy high tensile steel are entered 
as 6.5E-6 in./in./0F for temperatures up to 250 0F. 

10. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy high tensile steel 
for temperatures up to 250 0F are entered by referring to the values provided in Table 
832.5-1 of ASME B31.8 (2016). 

11. Yield Strength: Yield Strength for Carbon and low alloy high tensile steel for 
temperatures up to 250 0F are entered by referring to the values specified in Mandatory 
Appendix D titled “Specified Minimum Yield Strength for Steel Pipe Commonly Used in 
Piping Systems” of ASME B31.8 (2016). 

12. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 

13. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy high 
tensile steel are entered by referring to the values specified in Table 841.1.7-1 of ASME 
B31.8 (2016). 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 403.2.1. 

𝑃𝑖 =
2𝑆𝐸𝑡𝑎
𝐷

 

where 

𝑃𝑖 = allowable pressure 

𝑆 =  allowable stress = 0.72 Sy 

𝑆𝑦 =  specified minimum yield strength of pipe 

𝐸 = weld joint factor as defined in Table 403.2.1-1 

𝑡𝑎 =  available thickness for pressure design 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for 
 corrosion, threading, grooving and erosion. 

𝐷 = outside diameter 

Stress due to Sustained Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1

 where 

𝑖𝑖 = in-plane stress intensification factor = 1.0 for pipes 

𝑖𝑜 = out-of-plane stress intensification factor = 1.0 for pipes 

For Fittings & Components.(as per para. 402.6.2) 

𝑆𝐿(𝑓𝑐) = |
𝑃𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃 = maximum operating pressure = max of CAEPIPE input pressures (P1 through P10). 
 Due considerations shall be given as per para. 401.2.2.2 while inputting pressure 
 values in CAEPIPE. 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness as per para. 402.1 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75𝑖𝑖shall not be less than 1.0 
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𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75𝑖𝑜shall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝐹𝑎 = axial force component for external loads 

𝐴 = nominal cross-section area 

𝑆𝑦 = specified minimum yield strength of pipe 

Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝐿𝑂 = SL + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦

 

as per Table 403.3.1-1 

For Fittings & Components (as per para. 402.6.2) 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝐹𝑎
𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.8𝑆𝑦 

as per Table 403.3.1-1 

where 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor x P) where P = maximum operating 

 pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para. 
 403.3.4 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.402.5.2 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴as per Table 403.3.1-1 and para. 403.3.2 

where 

𝑆𝑏 = resultant bending stress =
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)
2

Z
 

𝑆𝑡 = torsional stress =
Mt

2Z
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

Please note, “Liberal allowable” option is always turned ON for ANSI B31.4 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range  
  cycles 
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where𝑓 ≤ 1.2 (from para. 403.3.2). 

𝑆𝑐 = 0.67𝑆𝑦 at the lower of the installed temperature or minimum operating temperature 

 = 0.67𝑆𝑦at the higher of the installed temperature or maximum operating temperature 

where 

𝑆𝑐 = specified minimum yield strength of pipe 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for 
restrained piping is calculated from para. 402.6.1 

𝑆𝐿 = max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵|, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵|)𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 + 

  max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵|, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵|)𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙 + 

  max(|𝑆𝑇|𝑤𝑎𝑟𝑚𝑒𝑠𝑡, |𝑆𝑇|𝑐𝑜𝑙𝑑𝑒𝑠𝑡) ≤ 0.9𝑆𝑦 

where 

Pressure stress = 𝑆𝑝 = 𝜐
𝑃𝐷

2𝑡𝑛
= where 𝜐 = 0.3 as per para. 402.2.3 and can be either positive or 

negative 

Stress due to axial loading (other than temperature and pressure)= 𝑆𝑥 =
𝐹𝑎

𝐴
 

and can be positive or negative. 

Nominal bending stress SB from Weight and / or other External loads for  

For Pipes  

𝑆𝐵 = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2+(𝑀𝑡)2

Z
 

For Fittings & Components 

𝑆𝐵 = 
√(0.75𝑖𝑖𝑀𝑖)

2+(0.75𝑖𝑜𝑀𝑜)2+(𝑀𝑡)2

𝑍
 

Thermal expansionstress 𝑆𝑇 = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜), which can either be positive or negative 

where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product ii75.0  shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product oi75.0 shall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 
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𝐹𝑎 = axial force component for external loads 

𝐴 = nominal cross-section area 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝑦 = specified minimum yield strength of pipe 

𝑇𝑖 = installation temperature = Tref in CAEPIPE 

𝑇𝑜 = warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at To defined above 

𝐸 = young’s modulus at ambient (reference) temperature 

Note: 

1. Para. 402.6.2 of B31.4 (2012) states that “Longitudinal stress from pressure in an 
unrestrained line should include consideration of bending stress or axial stress that may 
be caused by elongation of the pipe due to internal pressure and result in stress at bends 
and at connections and produce additional loads on equipment and on supports”. 
The above statement seems to imply that “elongation of pipe and opening of bends due 
to Bourdon effect” are to be included in the Sustained load case (and hence in Operating 
case and Sustained plus Occasional load case). 
On the other hand, since the deformation due to Bourdon effect is being constrained by 
piping supports, CAEPIPE includes the Bourdon effect as part of the results for 
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating 
Case (when “Thermal = Operating – Sustained is opted). 

2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 402.2.2. 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 
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Allowable Pressure  

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 504.1.2. 

𝑃 =
2𝑆𝐸𝑡𝑎
𝐷 − 2𝑌𝑡𝑎

 

where 

𝑃 = allowable pressure 

𝑆 = basic allowable stress at Design Temperature (i.e., at Tdesign input into CAEPIPE)  

𝐸 = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and 
Table 502.3.1-1 

Table 502.3.1-1 provides maximum allowable hoop stress values (𝑆𝐸) as a function of 

metal temperature and includes Longitudinal or Spiral Joint Factor (𝐸) for various 

materials. Divide 𝑆𝐸 value by 𝐸 value provided in Table 502.3.1-1 to obtain basic 

allowable stress 𝑆. For materials where 𝐸 is not given explicitly in Table 502.3.1-1, use 

𝐸 = 1.0. 

𝑆𝐸 in the above formula for allowable pressure 𝑃 is the allowable hoop stress per para. 
502.3.1 and Table 502.3.1-1. 

𝑡𝑎 = available thickness for pressure design (as per para. 504.1.1) 

 = 𝑡𝑛× (1 - mill tolerance/100) - corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 
For ductile non-ferrous materials and ferritic and austenitic steels from para. 504.1.1, 

𝑌 = 0.4 and 𝑌 =
𝑑

𝑑+𝐷
, for 4 ≤ 𝐷/𝑡𝑎 < 6 

Y = 0.0 for Cast Iron 

Sustained Stress (in corroded condition) 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from para. 502.3.2(d). Also, refer to Note 1 below. 

𝑆𝐿 = |
𝑃𝑑2

(𝐷2 − 𝑑2)
| +

√(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2

𝑍𝑐
≤ 𝑆ℎ

 

where 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑐 = nominal thickness – corrosion allowance, as per para. 502.3.2 (d) 

𝑑 = inside diameter = 𝐷 − 2. 𝑡𝑐 
𝑖𝑖 =  in-plane stress intensification factor from Table 519.3.6-1 
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𝑖𝑜 = out-of-plane stress intensification factor from Table 519.3.6-1 

𝑀𝑖 =  in-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑍𝑐 = corroded section modulus as per para. 502.3.2 (d) 

𝑆ℎ = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

Occasional Stress (in corroded condition) 

The stress (𝑆𝐿𝑜) due to occasional loads is calculated as the sum of stress due to sustained 

loads such as pressure, weight and other sustained mechanical loads (𝑆𝐿) and stress due to 

occasional loads (𝑆𝑜) such as earthquake or wind. Wind and earthquake are not considered 
concurrently (see para. 502.3.3 (a)). Also, refer to Note 1 and Note 3 below. 

𝑆𝐿𝑂 = 𝑆𝐿𝑂 + [|
(𝑃

𝑝𝑒𝑎𝑘
−𝑃)𝑑2

(𝐷2 − 𝑑2)
|+

√(𝑖𝑖𝑀𝑖)
2 + (𝑖𝑜𝑀𝑜)

2

𝑍𝑐
] ≤ 1.33. (𝑆ℎ𝐸)

 
where 
𝑃𝑝𝑒𝑎𝑘=  peak pressure = (peak pressure factor) x P, where P is defined above 

𝑀𝑖 =  in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑍𝑐 = corroded section modulus as per para. 502.3.2 (d) 

𝐷 = outside diameter 

𝑡𝑐 = nominal thickness – corrosion allowance, as per para. 502.3.2 (d) 

𝑑 = inside diameter = 𝐷 − 2. 𝑡𝑐 
𝑖𝑖 =  in-plane stress intensification factor from Table 519.3.6-1 

𝑖𝑜 = out-of-plane stress intensification factor from Table 519.3.6-1 

𝑆ℎ = basic allowable stress (input as material property) at maximum of CAEPIPE input 
temperatures T1 through T10 

𝐸  = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and 
Table 502.3.1-1 

Expansion Stress (in un-corroded condition) 

The stress range (𝑆𝐸) due to thermal expansion is calculated from para. 519.4.5 and para. 
519.3. See Note 3 below. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress =
𝑀𝑡

2𝑍
 

Mi   =  in-plane bending moment range between any two conditions being evaluated 
𝑀𝑜   = out-of-plane bending moment range between any two conditions being evaluated 
𝑀𝑡   = torsional moment range between any two conditions being evaluated 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 
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𝑖𝑖  = in-plane stress intensification factor from Table 519.3.6-1 

𝑖𝑜  = out-of-plane stress intensification factor from Table 519.3.6-1 

𝑆𝐴 = 𝑓(1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡) (see para. 502.3.2 (c)) 
 

𝑓 = stress range reduction factor from Figure 502.3.2-1. f >= 0.5 and f <= 1.0 

𝑆𝑐𝑜𝑙𝑑 = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ𝑜𝑡 = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as 

𝑆𝐴 = 𝑆𝐴 + 𝑓(𝑆ℎ − 𝑆𝐿) 

where, 𝑆ℎ= basic allowable stress at maximum of CAEPIPE input temperatures T1 through 
T10 

This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE 
menu Options->Analysis on the Code tab. 

Notes: 

1. As per para. 502.3.2 (d), the pressure stress should be calculated using the formula 

𝑃𝑑2/(𝐷2 − 𝑑2), where d is the internal diameter = 𝐷 − 2𝑡𝑐 . Hence, "𝑃𝑑2/(𝐷2 − 𝑑2)" 
(available through CAEPIPE Layout > Options > Analysis > Pressure) is set as "default" 
and is disabled for user to modify. 

2. As per para. 519.4.5(a), Bending and torsional stress shall be computed using the as-
installed modulus of elasticity, i.e., Ec at installation temperature. Hence, "Use modulus 
at reference temperature" (available through CAEPIPE Layout > Options > Analysis > 
Temperature) is set as "default" and is disabled for user to modify. 

3. Para. 519.2.2 requires wind sway (displacement at support due to wind) to be included as 
a part of Thermal Load Displacement. Since CAEPIPE allows up to 10 thermal loads, 
the question arises “under which thermal load should this wind sway to be included”. 
Hence, we recommend that wind sway is to be input as a part of “wind displacement 
under occasional stress condition”. 

4. Table 502.3.1-1 provides maximum allowable hoop stress values (𝑆𝐸) as a function of 

metal temperature and includes Longitudinal or Spiral Joint Factor (𝐸) for various 
materials. Hence, while entering Allowable Stress (S) into CAEPIPE Material Properties 

or in Material Library, divide 𝑆𝐸 value by 𝐸 value provided in Table 502.3.1-1 to obtain 

basic allowable stress 𝑆. For materials where 𝐸 is not given explicitly in Table 502.3.1-1, 

use 𝐸 = 1.0.  
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Operating Stress for Impact Test 

Allowable stress for Impact Test is specified for the materials given in Table 502.3.1 of 
ASME B31.5 (2022) Code. Accordingly, “Sall” is computed and shown above.  

The equation used to calculate the operating stresses is modeled along the lines of a piping 
code specified stress equation. The three components of the equation are: 

1. Axial stress combined with the longitudinal pressure stress, 
2. Bending stress from in-plane and out-of-plane bending moments, and 
3. A torsional stress from the torsion term. 

The allowable stress for this case is simply a combination of the sustained and the thermal 
allowable stresses. 

Note that the Operating Stress is calculated and shown only for the first Operating case (W+P1+T1). 
Details follow. 

The stress (Sopr) due to operating loads (pressure, weight and thermal load T1) is calculated as 
 

𝑆𝑜𝑝𝑟 = 𝑆𝑎 +√(𝑆𝑎)2 + (2𝑆𝑡)2 ≤ 𝑆𝑎𝑙𝑙 
where 

𝑆𝑎 = ⌊
𝑃𝐷

4𝑡
+
𝐹

𝐴
⌋
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔1

 

𝑆𝑏 = ⌊
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
⌋
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔1

 

𝑆𝑡 = ⌊
𝑀𝑡

2𝑍
⌋
𝑂𝑝𝑒𝑟𝑎𝑡𝑖𝑛𝑔1

 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡 = nominal wall thickness 

𝐴 = un-corroded cross-sectional area of the pipe 

𝐹 = longitudinal force  

𝑖𝑖 = in-plane stress intensification factor according to analysis code selected in 
 CAEPIPE 

𝑖𝑜 = out-of-plane stress intensification factor according to analysis code selected in 
 CAEPIPE 

Note: If the analysis code selected provides only the stress intensification i, then 𝑖𝑖 = 𝑖𝑜 = 𝑖. 
𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = factor for loose type flanges (from Fig. 2-7.5) 

𝑀𝑡 = factor for loose type flanges (from Fig. 2-7.4) 

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective
 section modulus 

𝑆𝑎𝑙𝑙 = 𝑓(1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡) + 𝑆ℎ𝑜𝑡 for all codes excepting ASME B31.5. For ASME  
 B31.5, it is calculated as 0.35 Shot.  
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𝑓 =  stress range reduction factor = 6/N0.2 

𝑁 =  Number of equivalent full-range thermal cycles 
𝑆𝑐𝑜𝑙𝑑 = basic allowable stress at Tref 

𝑆ℎ𝑜𝑡 = basic allowable stress at CAEPIPE input temperature T1 

Refer to Section titled “Operating Stress for NDE/Impact Test/Impact Test Exemption” in 
this manual for details regarding the requirements and implementation of Impact Test in 
CAEPIPE for this code. 
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Allowable Pressure  

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 504.1.2. 

𝑃 =
2𝑆𝐸𝑡𝑎
𝐷 − 2𝑌𝑡𝑎

 

where 

𝑃 = allowable pressure 

𝑆 = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

𝐸 = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and 
Table 502.3.1-1 

Table 502.3.1-1 provides maximum allowable hoop stress values (𝑆𝐸) as a function of 

metal temperature and includes Longitudinal or Spiral Joint Factor (𝐸) for various 

materials. Divide 𝑆𝐸 value by 𝐸 value provided in Table 502.3.1-1 to obtain basic 

allowable stress 𝑆. For materials where 𝐸 is not given explicitly in Table 502.3.1-1, use 

𝐸 = 1.0. 

𝑆𝐸 in the above formula for allowable pressure 𝑃 is the allowable hoop stress per para. 
502.3.1 and Table 502.3.1-1. 

𝑡𝑎 = available thickness for pressure design (as per para. 504.1.1) 

 = 𝑡𝑛× (1 - mill tolerance/100) - corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 
For ductile non-ferrous materials and ferritic and austenitic steels from para. 504.1.1, 

𝑌 = 0.4 and 𝑌 =
𝑑

𝑑+𝐷
, for 4 ≤ 𝐷/𝑡𝑎 < 6 

Y = 0.0 for Cast Iron 

Sustained Stress (in corroded condition) 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from para. 502.3.2(d). Also, refer to Note 1 below. 

𝑆𝐿 =
𝑃𝐷

4𝑡𝑐
+
√(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2

𝑍𝑐
≤ 𝑆ℎ

 

where 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑐 = nominal thickness – corrosion allowance, as per para. 502.3.2 (d) 

𝑖𝑖 =  in-plane stress intensification factor from Table 519.3.6-1 
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𝑖𝑜 = out-of-plane stress intensification factor from Table 519.3.6-1 

𝑀𝑖 =  in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑍𝑐 = corroded section modulus as per para. 502.3.2 (d) 

𝑆ℎ = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

Occasional Stress (in corroded condition) 

The stress (𝑆𝐿𝑜) due to occasional loads is calculated as the sum of stress due to sustained 

loads (𝑆𝐿) and stress due to occasional loads (𝑆𝑜) such as earthquake or wind. Wind and 
earthquake are not considered concurrently (see para. 502.3.3 (a)). Also, refer to Note 1 
below. 

𝑆𝐿𝑂 =
𝑃𝑝𝑒𝑎𝑘𝐷

4𝑡𝑐
+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑐
]

𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑐
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 1.33𝑆ℎ

 where 
𝑃𝑝𝑒𝑎𝑘=  peak pressure = (peak pressure factor) x P, where P is defined above 

Expansion Stress (in un-corroded condition) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para. 519.4.5 and para. 519.3. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress =
𝑀𝑡

2𝑍
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑖𝑖  = in-plane stress intensification factor from Table 519.3.6-1 

𝑖𝑜  = out-of-plane stress intensification factor from Table 519.3.6-1 

𝑆𝐴 = 𝑓(1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡)(see para. 502.3.2 (c)) 
 

𝑓 = stress range reduction factor from Figure 502.3.2-1. f >= 0.5 and f <= 1.0 

𝑆𝑐𝑜𝑙𝑑 = basic allowable stress at minimum metal temperature expected during the 
 displacement cycle under analysis 

𝑆ℎ𝑜𝑡 = basic allowable stress at maximum metal temperature expected during the 
 displacement cycle under analysis 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as 

𝑆𝐴 = 𝑆𝐴 + 𝑓(𝑆ℎ − 𝑆𝐿) 

where, 𝑆ℎ= basic allowable stress at maximum of CAEPIPE input temperatures T1 through 
T10 
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This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE 
menu Options->Analysis on the Code tab. 

Notes: 

1. As per para. 502.3.2 (d), the pressure stress should be calculated using the formula 

𝑃𝑑2/(𝐷2 − 𝑑2), where d is the internal diameter = 𝐷 − 2𝑡𝑐 . Hence, "𝑃𝑑2/(𝐷2 − 𝑑2)" 
(available through CAEPIPE Layout > Options > Analysis > Pressure) is set as "default" 
and is disabled for user to modify. 

2. As per para. 519.4.5(a), Bending and torsional stress shall be computed using the as-
installed modulus of elasticity, i.e., Ec at installation temperature. Hence, "Use modulus at 
reference temperature" (available through CAEPIPE Layout > Options > Analysis > 
Temperature) is set as "default" and is disabled for user to modify. 

3. As per para. 519.2.2, wind sway should be input into the appropriate Thermal Load 
Displacement. 

4. Refer to Section titled “Operating Stress for NDE/Impact Test” in this manual for 
details regarding the requirements and implementation of Impact Test in CAEPIPE for 
this code. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 504.1.2. 

𝑃 =
2𝑆𝐸𝑡𝑎
𝐷 − 2𝑌𝑡𝑎

 

where 

𝑃 = allowable pressure 

𝑆 = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

𝐸 = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and 
  Table 502.3.1 

Table 502.3.1 provides maximum allowable hoop stress values (𝑆𝐸) as a function of metal 

temperature and includes Longitudinal or Spiral Joint Factor (𝐸) for various materials. 

Divide 𝑆𝐸 value by 𝐸 value provided in Table 502.3.1 to obtain basic allowable stress 𝑆. For 

materials where 𝐸 is not given explicitly in Table 502.3.1, use 𝐸 = 1.0. 

Hence, 𝑆𝐸 in the above formula for allowable pressure 𝑃 is the allowable hoop stress per 
para. 502.3.1 and Table 502.3.1. 

𝑡𝑎 = available thickness for pressure design (as per para. 504.1.1) 

 = 𝑡𝑛× (1 - mill tolerance/100) - corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 
For ductile non-ferrous materials and ferritic and austenitic steels,  

𝑌 = 0.4for𝐷/𝑡𝑎 ≥ 6 and 𝑌 =
𝑑

𝑑+𝐷
, for 4 ≤ 𝐷/𝑡𝑎 < 6 

Y = 0.0 for Cast Iron 

Sustained Stress (in corroded condition) 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from para. 502.3.2(d). Also, refer to Note 1 below. 

𝑆𝐿 =
𝑃𝐷

4𝑡𝑐
+
√(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2

𝑍𝑐
≤ 𝑆ℎ

 

where 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑐 = nominal thickness – corrosion allowance, as per para. 502.3.2 (d) 

𝑖𝑖 =  in-plane stress intensification factor 

𝑖𝑜 = out-of-plane stress intensification factor 

𝑀𝑖 =  in-plane bending moment 
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𝑀𝑜 = out-of-plane bending moment 

𝑍𝑐 = corroded section modulus as per para. 502.3.2 (d) 

𝑆ℎ = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

Occasional Stress (in corroded condition) 

The stress (𝑆𝐿𝑜) due to occasional loads is calculated as the sum of stress due to sustained 

loads (𝑆𝐿) and stress due to occasional loads (𝑆𝑜) such as earthquake or wind. Wind and 
earthquake are not considered concurrently (see para. 502.3.3 (a)). Also, refer to Note 1 
below. 

𝑆𝐿𝑂 =
𝑃𝑝𝑒𝑎𝑘𝐷

4𝑡𝑐
+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑐
]

𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑐
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 1.33𝑆ℎ

 where 
𝑃𝑝𝑒𝑎𝑘=  peak pressure = (peak pressure factor) x P, where P is defined above 

Expansion Stress (in un-corroded condition) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para. 519.4.5 and para. 519.3.5. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress =
𝑀𝑡

2𝑍
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝐴 = 𝑓(1.25𝑆𝑐𝑜𝑙𝑑 + 0.25𝑆ℎ𝑜𝑡)(see para. 502.3.2 (c)) 
 

𝑓 = stress range reduction factor from Figure 502.3.2  

𝑆𝑐𝑜𝑙𝑑 = basic allowable stress as minimum metal temperature expected during the 
 displacement cycle under analysis 

𝑆ℎ𝑜𝑡 = basic allowable stress as maximum metal temperature expected during the 
 displacement cycle under analysis 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as 

𝑆𝐴 = 𝑆𝐴 + 𝑓(𝑆ℎ − 𝑆𝐿) 

where, 𝑆ℎ= basic allowable stress at maximum of CAEPIPE input temperatures T1 through 
T10 

This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE 
menu Options->Analysis on the Code tab. 
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Notes: 

1. As per para. 502.3.2 (d), the pressure stress should be calculated using the formula 

𝑃𝑑2/(𝐷2 − 𝑑2), where d is the internal diameter = 𝐷 − 2𝑡𝑐 . This can be selected 
through Options > Analysis > Pressure. 

2. As per para. 519.4.5(a), Bending and torsional stress shall be computed using the as-
installed modulus of elasticity, i.e., Ec at installation temperature. Hence, "Use modulus at 
reference temperature" (available through CAEPIPE Layout > Options > Analysis > 
Temperature) is set as "default" and is disabled for user to modify. 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 



Refrigeration Piping and Heat Transfer Components 
ASME B31.5 (2016) 

 

168 
 

 



Refrigeration Piping and Heat Transfer Components 
ASME B31.5 (2016) 

 

169 
 

 



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2022) 

 

170 
 

 

Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends) of 
Steel gas piping systems, the allowable pressure is calculated from para. 841.1.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷  
When D/tn< 30, then 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷 − 𝑡𝑛  
 
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. 841.1.1 (a), as input in CAEPIPE material 
properties 

𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1 and 
para. 817.1.3 (d) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter 

𝐹 = construction location design factor, obtained from Table 841.1.6-1 

𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8 

Note: 

Allowable pressure calculation for Ductile Iron and Plastic piping systems as per this code 
are not included in CAEPIPE. 

Stress due to Sustained & Occasional Loads [Unrestrained (above ground) Piping] 

The sum of longitudinal stress due to internal pressure and due to axial loading (other than 
thermal expansion and pressure) and the bending stress due to external loads, such as weight 
of the pipe and contents, occasional loads such as seismic or wind, etc. is calculated 
according to paras. 833.6 (a) and 833.6 (b) along with paras. 805.2.3, 833.2 (b), 833.2 (d), 
833.2 (e) and 833.2 (f). Wind and seismic are not considered to act concurrently. 

Please note, the “include axial force in stress calculations” option is turned ON by default for 
ASME B31.8 in CAEPIPE. 

Sustained Stress𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑀𝑖)

2 + (𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75ST

 
For other Fittings and Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained

≤ 0.75ST
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Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝑴𝒊)

𝟐 + (𝑴𝒐)
𝟐+(𝑴𝒕)

𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓 

 
For other Fittings and Components 

𝑆𝐿𝑂(𝑓𝑐) = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇

 
where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜= out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment due to weight and other external loads 

𝑀𝑜= out-of-plane bending moment due to weight and other external loads 

𝑀𝑡= torsional moment due to weight and other external loads 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force due to external loads (other than due to thermal expansion and pressure) 

𝐴 = un-corroded pipe metal cross-section area 

𝑆 = specified minimum yield strength from para. 841.1.1(a) 

𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1  

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations in accordance with para. 832.3(g). 

Expansion Stress [Unrestrained (above ground) Piping] 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.833.8. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
 

𝑀𝑖 = in-plane bending moment due to thermal expansion 

𝑀𝑜= out-of-plane bending moment to thermal expansion 

𝑀𝑡= torsional moment due to thermal expansion 
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𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

 cycles 

where 𝑓 ≤ 1.0 (from para. 833.8 (b)). 

𝑆𝐿 = sustained stress computed as per equation given above 

𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature  

𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
 
where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 

𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a) 

𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [= min(T1 
through T10, Tref)] is used to form the stiffness matrix for Expansion load calculations in 
accordance with para. 832.3 (g). 

Sustained, Thermal & Occasional Stress [Restrained (buried) Piping] 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3, 
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f) 

𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵 

𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵 

As per 833.4 (d), both the tensile and compressive values of SB shall be considered in 
analysis. 
where 

𝑆𝑝 = 0.3𝑆𝐻 = 0.3
𝑃𝐷

2𝑡𝑛
 = longitudinal stress due to internal pressure in restrained pipeline 

𝑆𝐻 = hoop stress = 
𝑃𝐷

2𝑡𝑛
 as per para. 805.2.3 

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼𝑚(𝑇𝑖 − 𝑇𝑚) 
(see Note 1 below) 

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) =
𝑅

𝐴
 

𝑆𝐵 = nominal bending stress due to weight and other external loads (other than thermal 
expansion) 
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For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑀𝑖)2 + (𝑀𝑜)2 + (𝑀𝑡)2

𝑍  

For other Fittings and Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍  
As per para 833.3(a), note that 𝑆𝐵,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative 
where 

𝑃 = maximum operating pressure = max(P1 through P10) 

𝐷 = outside diameter 

𝑡𝑛=nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖  = in-plane bending moment due to weight and other external loads (other than thermal 
expansion) 

𝑀𝑜 = out-of-plane bending moment due to weight and other external loads (other than 
thermal expansion) 

𝑀𝑡 = torsional moment due to weight and other external loads (other than thermal 
expansion) 

𝑅 = axial force due to weight and other external loads (other than thermal expansion and 
pressure) 

𝐴 = un-corroded pipe metal cross-sectional area (i.e., before deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a) 

𝑇 = Temperature derating factor from para. 841.1.8 and Table 841.1.8-1 

𝐸 = Young’s modulus at ambient temperature from para. 833.2 (c), i.e., at Tref in CAEPIPE 

𝑇𝑖 = installation temperature = Tref in CAEPIPE (see Note 1 below) 

𝑇𝑚 = warmest or coldest operating temperature (see Note 1 below) 

𝛼𝑚 = coefficient of thermal expansion at Tm in CAEPIPE (see Note 1 below) 

Note 1: 

If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates 

longitudinal stress 𝑆𝑇 due to thermal expansion as follows. 

For a change in temperature from Tref to T1, 𝑆𝑇1 = −𝐸𝛼1(𝑇1 − 𝑇𝑟𝑒𝑓) 

For a change in temperature from Tref to T2, 𝑆𝑇2 = −𝐸𝛼2(𝑇2 − 𝑇𝑟𝑒𝑓) 

For a change in temperature from T1 to T2, 𝑆𝑇1−.>𝑇2 = 𝑆𝑇2 − 𝑆𝑇1 

Please note, that negative (-) sign is added in the above equations as the soil is restraining the 
thermal expansion / contraction of the buried pipe due to friction at the soil-to-pipe 
interface. 
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Combined Stress for Restrained Pipe 

The combined biaxial stress state of the pipeline in the operating mode is evaluated using 
maximum shear stress theory as per the calculation given below by default in CAEPIPE as 
per para. 833.4. 

S𝑒𝑞 = max {𝑆𝑒𝑞1,𝑆𝑒𝑞2} ≤ 0.9𝑆𝑇 

where 

S𝑒𝑞 = equivalent combined stress  

 

S𝑒𝑞1 = max {|𝑆𝐻 − 𝑆𝐿𝑝|, |𝑆𝐻|, |𝑆𝐿𝑝|} 

S𝑒𝑞2 = max {|𝑆𝐻 − 𝑆𝐿𝑛|, |𝑆𝐻|, |𝑆𝐿𝑛|} 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 3 below): 

S𝑒𝑞1 = √(𝑆𝐿𝑝)
2
− 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐻)2 

S𝑒𝑞2 = √(𝑆𝐿𝑛)
2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐻)

2 

Notes: 

1. Young’s modulus of elasticity corresponding to the lowest operating temperature 
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para. 
832.3 (g). 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

3. By default, CAEPIPE combines the stresses for restrained piping using the maximum 
shear stress theory as stated above. To combine stresses in accordance with the 
maximum distortion energy theory as stated above, turn ON the analysis option 
“Combine stresses as per Max. Distortion Energy Theory” through Layout Window > 
Options > Analysis > Code. 
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Notes on Material Library for B318-2022.mat supplied with CAEPIPE: 

Material library for ASME B31.8 (2022) [B318-2022.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

1. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2022), 
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring 
to the values given in Table 832.2-1 of ASME B31.8 (2022). 

2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered 
by referring to the values given in Table 832.5-1 of ASME B31.8 (2022). 

3. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to 
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength 
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2022). 

4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 

5. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are 
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2022). 

  



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2022) 

 

176 
 

 

 
  



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2022) 

 

177 
 

 

 
  



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2022) 

 

178 
 

 

 
  



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2022) 

 

179 
 

 

 
  



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2022) 

 

180 
 

 

 



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2020) 

[Superseded by ASME B31.8 (2022)] 

 

181 
 

 

Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 841.1.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷  
When D/tn< 30, then 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷 − 𝑡𝑛  
 
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. 841.1.1 (a) 

𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1 
 and para. 817.1.3 (d) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter 

𝐹 = construction location design factor selected (obtained from Table 841.1.6-1) 

𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8 

Note: 

Allowable Pressure calculation for Ductile Iron and Plastic piping systems as per this code 
are not included in CAEPIPE. 

Stress due to Sustained & Occasional Loads [Unrestrained (above ground) Piping] 

The sum of longitudinal stress due to internal pressure and due to axial loading (other than 
thermal expansion and pressure) and the bending stress due to external loads, such as weight 
of the pipe and contents, seismic or wind, etc. is calculated according to paras. 833.6 (a) and 
833.6 (b) along with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f). 

Please note, the “include axial force in stress calculations” option is turned ON by default for 
ANSI B31.8 in CAEPIPE. 

Sustained Stress𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑀𝑖)

2 + (𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75ST

 
For other Fittings and Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained

≤ 0.75ST

   



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2020) 

[Superseded by ASME B31.8 (2022)] 

 

182 
 

 

Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝑴𝒊)

𝟐 + (𝑴𝒐)
𝟐+(𝑴𝒕)

𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓
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For Fittings and Components 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇

 
where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜= out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜= out-of-plane bending moment 

𝑀𝑡= torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force component for external loads (other than thermal expansion and pressure) 

𝐴 = un-corroded pipe metal cross-section area 

𝑆 = specified minimum yield strength from para. 841.1.1(a) 

𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1  

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations in accordance with para. 832.3(g). 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.833.8. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8. 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

 cycles 

where𝑓 ≤ 1.0 (from para. 833.8 (b)). 

𝑆𝐿 = sustained stress computed as per equation given above 

𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature  

𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
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where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 

𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a) 

𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T1 
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations in 
accordance with para. 832.4 (g). 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3, 
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f) 

𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵 

𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵 

As per 833.4 (d), both the tensile and compressive values of SB shall be considered in 
analysis. 
where 

𝑆𝑝 = 0.3𝑆𝐻 = 0.3
𝑃𝐷

2𝑡𝑛
 = longitudinal stress due to internal pressure in restrained pipeline 

𝑆𝐻 = hoop stress = 
𝑃𝐷

2𝑡𝑛
 as per para. 805.2.3 

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜) (see 
Note 1 below) 

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) =
𝑅

𝐴
 

𝑆𝐵 = nominal bending stress due to weight and other external loads (other than thermal 
expansion) 

For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑀𝑖)2 + (𝑀𝑜)2 + (𝑀𝑡)2

𝑍  

For other Fittings and Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍  
As per para 833.3(a), note that 𝑆𝐵,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative 
where 

𝑃 = maximum operating pressure = max(P1 through P10) 

𝐷 = outside diameter 
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𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑅 = axial force component for external loads (other than thermal expansion and pressure) 

𝐴 = un-corroded pipe metal cross-sectional area (i.e., before deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a) 

𝑇 = Temperature derating factor from para. 841.1.8 and Table 841.1.8-1 

𝐸 = Young’s modulus at ambient temperature from para. 833.2 (c) = Tref in CAEPIPE 

𝑇𝑖 = installation temperature = Tref in CAEPIPE 

𝑇𝑜 = warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at T0 in CAEPIPE 

Note 1: 

If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates 
longitudinal stress due to thermal expansion as follows. 

𝐸𝛼1(𝑇1 − 𝑇𝑟𝑒𝑓) for T1, 𝐸𝛼2(𝑇2 − 𝑇𝑟𝑒𝑓) for T2 and for  

(𝑇2 − 𝑇1) = 𝐸𝛼𝑛(𝑇𝑛 − 𝑇𝑟𝑒𝑓) −  𝐸𝛼𝑚(𝑇𝑚 − 𝑇𝑟𝑒𝑓), where n = 1 and m = 2 

Combined Stress for Restrained Pipe 

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the 
calculation given below by default in CAEPIPE as per para. 833.4. 

S𝑒𝑞 = max {𝑆𝑒𝑞1,𝑆𝑒𝑞2} ≤ 0.9𝑆𝑇 

where 

S𝑒𝑞 = equivalent combined stress  

 

S𝑒𝑞1 = max {|𝑆𝐻 − 𝑆𝐿𝑝|, |𝑆𝐻|, |𝑆𝐿𝑝|} 

S𝑒𝑞2 = max {|𝑆𝐻 − 𝑆𝐿𝑛|, |𝑆𝐻|, |𝑆𝐿𝑛|} 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 3 below): 

S𝑒𝑞1 = √(𝑆𝐿𝑝)
2
− 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐻)2 

S𝑒𝑞2 = √(𝑆𝐿𝑛)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐻)2 

Notes: 
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1. Young’s modulus of elasticity corresponding to the lowest operating temperature 
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para. 
832.3 (g). 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

3. To combine stresses in accordance with the maximum distortion energy theory as stated 
above, set an environmental variable with name “DET_318” with its value as “YES”. 

Notes on Material Library for B318-2020.mat supplied with CAEPIPE: 

Material library for ASME B31.8 (2020) [B318-2020.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

1. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2020), 
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring 
to the values given in Table 832.2-1 of ASME B31.8 (2020). 

2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered 
by referring to the values given in Table 832.5-1 of ASME B31.8 (2020). 

3. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to 
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength 
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2020). 

4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 

5. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are 
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2020). 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 841.1.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷  
When D/tn< 30, then 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷 − 𝑡𝑛  
 
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. 841.1.1 (a) and para. 817.1.3 (h) 

𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1 
 and para. 817.1.3 (d) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = outside diameter 

𝐹 = construction type design factor, obtained from Table 841.1.6-1 

𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8 

Stress due to Sustained and Occasional Loads (Unrestrained Piping) 

The sum of longitudinal pressure stress due to axial loading (other than thermal expansion 
and pressure) and the bending stress due to external loads, such as weight of the pipe and 
contents, seismic or wind, etc. is calculated according to paras. 833.6 (a) and 833.6 (b) along 
with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f). 

Please note, the “include axial force in stress calculations” option is turned ON by default for 
ANSI B31.8 in CAEPIPE. 

Sustained Stress𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑀𝑖)

2 + (𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75ST

 
For other Fittings and Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained

≤ 0.75ST

 
Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝑴𝒊)

𝟐 + (𝑴𝒐)
𝟐+(𝑴𝒕)

𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓
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For Fittings and Components 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇

 
where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜= out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜= out-of-plane bending moment 

𝑀𝑡= torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force component for external loads (other than thermal expansion and pressure) 

𝐴 = un-corroded cross-section area 

𝑆 = specified minimum yield strength from para. 841.1.1(a) 

𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1  

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations in accordance with para. 832.3(g). 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.833.8. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8. 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

 cycles 

where𝑓 ≤ 1.0 (from para. 833.8 (b)). 

𝑆𝐿 = sustained stress computed as per equation given above 

𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature  
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𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 

𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a) 

𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T1 
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations in 
accordance with para. 832.4(b). 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3, 
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f) 

𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵 

𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵 

As per 833.4 (d), both the tensile and compressive values of SB shall be considered in 
analysis. 
where 

𝑆𝑝 = 0.3𝑆𝐻 = 0.3
𝑃𝐷

2𝑡𝑛
 = longitudinal stress due to internal pressure in restrained pipeline 

𝑆𝐻 = hoop stress 

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜) (see 
Note 1 below) 

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) =
𝑅

𝐴
 

𝑆𝐵 = nominal bending stress due to weight and other external loads(other than thermal 
expansion) 

For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑀𝑖)2 + (𝑀𝑜)2 + (𝑀𝑡)2

𝑍  

For other Fittings and Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍  
As per para 833.3(a), note that 𝑆𝐵,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative 
where 

𝑃 = maximum operating pressure = max(P1 through P10) 



Gas Transmission and Distribution Piping Systems 
ASME B31.8 (2018) 

[Superseded by ASME B31.8 (2020)] 

 

195 
 

 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑅 = axial force component for external loads (other than thermal expansion and pressure) 

𝐴 = un-corroded cross-sectional area (i.e., before deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a) 

𝑇 = Temperature derating factor from para. 841.1.8 and Table 841.1.8-1 

𝐸 = Young’s modulus at ambient temperature= Tref in CAEPIPE 

𝑇𝑖 = installation temperature = Tref in CAEPIPE 

𝑇𝑜 = warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at T0 in CAEPIPE 

Note 1: 

If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates 
longitudinal stress due to thermal expansion from T1 to T2 in restrained pipeline as follows. 

𝐸𝛼(𝑇𝑛 − 𝑇𝑚) =  𝐸𝛼𝑛(𝑇𝑛 − 𝑇𝑟𝑒𝑓) −  𝐸𝛼𝑚(𝑇𝑚 − 𝑇𝑟𝑒𝑓), where n = 1 and m = 2 

Combined Stress for Restrained Pipe 

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the 
calculation given below by default in CAEPIPE. 

S𝑒𝑞1 = max {|𝑆𝐻 − 𝑆𝐿𝑝|, |𝑆𝐻|, |𝑆𝐿𝑝|} 

S𝑒𝑞2 = max {|𝑆𝐻 − 𝑆𝐿𝑛|, |𝑆𝐻|, |𝑆𝐿𝑛|} 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 3 below): 

S𝑒𝑞1 = √(𝑆𝐿𝑝)
2
− 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐻)2 

S𝑒𝑞2 = √(𝑆𝐿𝑛)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐻)2 

S𝑒𝑞 = max {𝑆𝑒𝑞1,𝑆𝑒𝑞2} ≤ 0.9𝑆𝑇 

where 

S𝑒𝑞 = equivalent combined stress  
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Notes: 

6. Young’s modulus of elasticity corresponding to the lowest operating temperature 
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para. 
832.4(b). 

7. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

8. To combine stresses in accordance with the maximum distortion energy theory as stated 
above, set an environmental variable with name “DET_318” with its value as “YES”. 

Notes on Material Library for B318-2018.mat supplied with CAEPIPE: 

Material library for ASME B31.8 (2018) [B318-2018.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

9. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2018), 
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring 
to the values given in Table 832.2-1 of ASME B31.8 (2018). 

10. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered 
by referring to the values given in Table 832.5-1 of ASME B31.8 (2018). 

11. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to 
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength 
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2018). 

12. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 

13. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are 
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2018). 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 841.1.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷  
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. 817.1.3 (h) and para. 841.1.4 (a) 

𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1 
 and para. 817.1.3 (d) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = outside diameter 

𝐹 = construction type design factor, obtained from Table 841.1.6-2 

𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8 

Stress due to Sustained and Occasional Loads (Unrestrained Piping) 

The sum of longitudinal pressure stress due to axial loading (other than thermal expansion 
and pressure) and the bending stress due to external loads, such as weight of the pipe and 
contents, seismic or wind, etc. is calculated according to paras. 833.6 (a) and 833.6 (b) along 
with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f). 

Please note, the “include axial force in stress calculations” option is turned ON by default for 
ANSI B31.8 in CAEPIPE. 

Sustained Stress 𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑀𝑖)

2 + (𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75ST

 
For other Fittings or Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained

≤ 0.75ST

 
Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝑴𝒊)

𝟐 + (𝑴𝒐)
𝟐+(𝑴𝒕)

𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓

 For Fittings or Components 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇
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where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜= out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜= out-of-plane bending moment 

𝑀𝑡= torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force component for external loads (other than thermal expansion and pressure) 

𝐴 = un-corroded cross-section area 

𝑆 = specified minimum yield strength from para. 841.1.1(a) 

𝑇= temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1  

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations in accordance with para. 832.4(b). 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.833.8. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8. 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

 cycles 

where𝑓 ≤ 1.0 (from para. 833.8 (b)). 

𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature  

𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 

𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a) 

𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1 
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Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T1 
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations in 
accordance with para. 832.4(b). 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3, 
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f) 

𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵 

𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵 

As per 833.4 (d), both the tensile and compressive values of SB shall be considered in 
analysis. 
where 

𝑆𝑝 = 0.3𝑆𝐻 = 0.3
𝑃𝐷

2𝑡𝑛
 = longitudinal stress due to internal pressure in restrained pipeline 

𝑆𝐻 = hoop stress 

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜) 

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) =
𝑅

𝐴
 

𝑆𝐵 = nominal bending stress due to weight and other external loads(other than thermal 
expansion) 

For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑀𝑖)2 + (𝑀𝑜)2 + (𝑀𝑡)2

𝑍  

For other Fittings or Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍  
As per para 833.3(a), note that 𝑆𝐵,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can have negative values. 
where 

𝑃 = maximum operating pressure = max(P1 through P10) 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 
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𝑅 = axial force component for external loads (other than thermal expansion and pressure) 

𝐴 = un-corroded cross-sectional area (i.e., after deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a) 

𝑇 = Temperature derating factor from para. 841.1.8 and Table 841.1.8-1 

𝐸 = Young’s modulus at ambient (reference) temperature 

𝑇𝑖 = installation temperature = Tref in CAEPIPE 

𝑇𝑜 = warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at To defined above 

Combined Stress for Restrained Pipe 

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the 
calculation given below by default in CAEPIPE. 

S𝑒𝑞1 = max {|𝑆𝐻 − 𝑆𝐿𝑝|, |𝑆𝐻|, |𝑆𝐿𝑝|} 

S𝑒𝑞2 = max {|𝑆𝐻 − 𝑆𝐿𝑛|, |𝑆𝐻|, |𝑆𝐿𝑛|} 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 3 below): 

S𝑒𝑞1 = √(𝑆𝐿𝑝)
2
− 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐻)2 

S𝑒𝑞2 = √(𝑆𝐿𝑛)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐻)2 

S𝑒𝑞 = max {𝑆𝑒𝑞1,𝑆𝑒𝑞2} ≤ 0.9𝑆𝑇 

where 

S𝑒𝑞 = equivalent combined stress  

Notes: 

1. Young’s modulus of elasticity corresponding to the lowest operating temperature 
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with para. 
832.4(b). 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

3. To combine stresses in accordance with the maximum distortion energy theory as stated 
above, set an environmental variable with name “DET_318” with its value as “YES”. 
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Notes on Material Library for B318-2016.mat supplied with CAEPIPE: 

Material library for ASME B31.8 (2016) [B318-2016.mat] has been created and supplied with 
CAEPIPE as mentioned below. 

1. Coefficient of Thermal Expansion: As stated in para. 832.2 of B31.8 (2016), 
Coefficient of Thermal Expansion for Carbon and low alloy steel are entered by referring 
to the values given in Table 832.2-1 of ASME B31.8 (2016). 

2. Modulus of Elasticity: Modulus of Elasticity for Carbon and low alloy steel are entered 
by referring to the values given in Table 832.5-1 of ASME B31.8 (2016). 

3. Yield Strength: Yield Strength for Carbon and low alloy steel are entered by referring to 
the values specified in Mandatory Appendix D titled “Specified Minimum Yield Strength 
for Steel Pipe Commonly Used in Piping Systems” of ASME B31.8 (2016). 

4. Density and Poisson’s ratio: Density and Poisson’s ratio for Carbon and low alloy high 
tensile steel are entered as 0.283 lb/in3 and 0.3 respectively. 

5. Longitudinal Joint Factor: Longitudinal Joint Factor for Carbon and low alloy steel are 
entered by referring to the values specified in Table 841.1.7-1 of ASME B31.8 (2016). 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 841.1.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇

𝐷  
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. 817.1.3 (h) and para. 841.1.4 (a) 

𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1 
 and para. 817.1.3 (d) 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter 

𝐹 = construction type design factor, obtained from Table 841.1.6-1 

𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8 

Stress due to Sustained and Occasional Loads (Unrestrained Piping) 

The sum of longitudinal pressure stress and the bending stress due to external loads, such as 
weight of the pipe and contents, seismic or wind, etc. is calculated according to paras. 833.6 
(a) and 833.6 (b) along with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f). 

Please note, the “include axial force in stress calculations” option is turned ON by default for 
ANSI B31.8. 

Sustained Stress 𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 
For other Fittings or Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained
 

Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝐢𝐢𝐌𝐢)

𝟐 + (𝐢𝐨𝐌𝐨)
𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓

 For Fittings or Components 

𝑆𝐿𝑂 = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇
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where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = nominal outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 
 1.0 

𝑀𝑖 =  in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force component for external loads (other than thermal expansion and 
 pressure) 

𝐴 = corroded cross-section area (i.e., after deducting for corrosion) 

𝑆 = specified minimum yield strength from para. 841.1.1(a) 

𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1  

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations. 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.833.8. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
 

𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8. 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 
𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

 cycles 

where𝑓 ≤ 1.0 (from para. 833.8 (b)). 

𝑓 = 0.33SuT at the minimum installed or operating temperature  

𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 
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𝑆𝑦 = specified minimum yield strength as per para. 841.1.1(a) 

𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T1 
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations. 

Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3, 
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f) 

𝑆𝐿 = max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵|, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵|)𝑠𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 + 

  max(|𝑆𝑝 + 𝑆𝑥 + 𝑆𝐵|, |𝑆𝑝 + 𝑆𝑥 − 𝑆𝐵|)𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙 + 

  max(|𝑆𝑇|𝑤𝑎𝑟𝑚𝑒𝑠𝑡, |𝑆𝑇|𝑐𝑜𝑙𝑑𝑒𝑠𝑡) ≤ 0.9𝑆𝑇 

where 

Internal pressure stress =𝑆𝑝 = 0.3
𝑃𝐷

2𝑡𝑛
 

Stress due to axial loading (other than thermal expansion and pressure) =𝑆𝑥 =
𝑅

𝐴
, and may be 

positive or negative 

Nominal bending stress SB from Weight and / or other External loads for  

For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑖𝑖𝑀𝑖)2 + (𝑖𝑜𝑀𝑜)2

𝑍  

For other Fittings or Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍  
Thermal expansion stress = 𝑆𝑇 = 𝐸𝛼(𝑇𝑖 − 𝑇𝑜) , and may be positive or negative 

Where 

𝑃 = maximum operating pressure = max(P1 through P10) 

𝐷 = nominal outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torsional moment 

𝑅 = axial force component for external loads (other than thermal expansion and pressure) 
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𝐴 = corroded cross-sectional area (i.e., after deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a) 

𝑇 = Temperature derating factor from para. 841.1.8 and Table 841.1.8-1 

𝐸 = Young’s modulus at ambient (reference) temperature 

𝑇𝑖 = installation temperature = Tref in CAEPIPE 

𝑇𝑜 = warmest or coldest operating temperature 

𝛼 = coefficient of thermal expansion at To defined above 
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Allowable Pressure 

For straight pipes and bends, the calculation of allowable pressure is based on Eq. (2) of 
para. 904.1 and 904.2.1. 

𝑃 =
2𝑆𝐸(𝑡𝑚 − 𝐴)

𝐷
 

where 

𝑃 = allowable pressure 

𝑆𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2020) Code, where 

𝐸= longitudinal or spiral weld joint efficiency factor as per Table I-1 of Appendix I of 
ASME B31.9 (2020). For casting materials, factor E is replaced with Casting Qualify 
Factor F from Table I-1 of Appendix I of ASME B31.9 (2020) 

𝑡𝑚=minimum required pipe thickness as per para. 904.1.1(a) =𝑡𝑛 × (1 – mill tolerance/100) 

𝑡𝑛=nominal pipe thickness 

𝐴= corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in “corrosion allowance” in CAEPIPE) 

𝐷=outside diameter 

For closely and widely spaced miter bends, the allowable pressure shall be the lower positive 
value calculated from Eqs.(3A) and (3B) of para. 904.2.2(a) 

𝑃 =
𝑆𝐸𝑇

𝑟
(

𝑇

𝑇+0.64 tan𝜃√𝑟𝑇
) Eq. (3A) 

𝑃 =
𝑆𝐸𝑇

𝑟
(
𝑅−𝑟

𝑅−𝑟/2
) Eq. (3B) 

where 

𝑟 = mean radius of pipe = (𝐷 − 𝑡𝑛)/2 

𝑇 = 𝑡𝑚 − 𝐴, where 𝑡𝑚 and 𝐴 are defined above 

𝑅 = effective bend radius of the miter 

𝜃 = miter half angle, with 𝜃 ≤ 22.5 deg. 

Note: 

Equations (3A) and (3B) given above is applicable when R entered in CAEPIPE is at least as 
great as the value calculated by eq. (4) of ASME B31.9 (2020). 

Sustained Stress (in un-corroded condition) 

The longitudinal sustained stress (𝑆𝐿) due to sustained loads (pressure, weight and other 
sustained mechanical loads) is calculated as mentioned in para. 902.3.2(d) 

𝑆𝐿 = √[|
𝑃𝐷𝑜
4𝑡𝑛

+
𝐼𝑎𝐹𝑎
𝐴𝑝

| +
√(𝐼𝑖𝑀𝑖𝐴)2 + (𝐼𝑜𝑀𝑜𝐴)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐴

𝑍
)
2

≤ 𝑆ℎ 

where 
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P = internal design pressure that shall be not less than the maximum sustained operating 
pressure (MSOP) within the piping system, including the effects of static head = maximum 
of CAEPIPE pressures P1 through P10 

Do = nominal outside diameter 

tn= nominal wall thickness 

Fa= longitudinal force due to weight and other sustained mechanical loads (excluding 
pressure) 

Ia= sustained longitudinal force index = 1.00 

Ii = sustained in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = sustained out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = sustained torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiA, MoA, MtA = in-plane, out-of-plane and torsional moment respectively due to weight and 
other sustained mechanical loads 

Z = nominal section modulus = un-corroded section modulus 

Ap= un-corroded nominal cross sectional area 

Sh = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through 
T10)] 

SL = stress due to pressure, weight and other sustained mechanical loads 

Occasional Stress (in un-corroded condition) 

The stress (SO) due to sustained and occasional loads as mentioned in para.902.3.3 as the 
combined stress due to (a) sustained loads such as pressure, weight and other sustained 
mechanical loads and (b) occasional loads such as earthquake or wind. Wind and earthquake 
are not considered to act concurrently. 

𝑆𝑂 = √[|
𝑃𝑜𝐷𝑜
4𝑡𝑛

+
𝐼𝑎𝐹𝑏
𝐴𝑝

| +
√(𝐼𝑖𝑀𝑖𝐵)2 + (𝐼𝑜𝑀𝑜𝐵)2

𝑍
]

2

+ (
𝐼𝑡𝑀𝑡𝐵

𝑍
)
2

≤ 𝑘𝑆ℎ 

where 

Fb = longitudinal force due to weight, other sustained mechanical loads (excluding pressure), 
and occasional loads such as thrusts from pressure/safety relief valve loads, from pressure 
and flow transients, earthquake / wind, etc. 
Ia= occasional longitudinal force index = 1.00 
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Ii = occasional in-plane moment index. Ii is taken as the greater of 0.75ii and 1.00. ii is taken 
from ASME B31J, Table 1-1.  

Io = occasional out-of-plane moment index. Io is taken as the greater of 0.75io and 1.00. io is 
taken from ASME B31J, Table 1-1.  

It = occasional torsional moment index. It is taken as the greater of 0.75it and 1.00. it is taken 
from ASME B31J, Table 1-1.  

MiB, MoB, MtB = in-plane, out-of-plane and torsional moment respectively due to weight, 
other sustained mechanical loads (excluding pressure), and occasional loads such as thrusts 
from pressure/safety relief valve loads, from pressure and flow transients, earthquake / 
wind, etc. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

SO = stress due to pressure, weight, other sustained mechanical loads and occasional loads 
such as thrusts from relief / safety valve loads, from pressure and flow transients, earthquake 
/ wind etc. 

k = 1.33 for occasional loads as per para. 902.3.3 (a)  

All other terms such as P, Ap, Z, etc. are as defined under Sustained Stress. 

For Unsigned occasional load cases such as Earthquake, etc. the forces and moments are 
combined as given below. 

|
𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏

𝐴𝑝
| =  𝑚𝑎𝑥 [|

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| + |

𝐼𝑎𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
| , |

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
| − |

𝐼𝑎𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|]  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡)| + |𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
 

For Signed occasional load cases such as Wind, etc. the forces and moments are combined as 
given below. 

|
𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏

𝐴𝑝
| =  |

𝑃𝑜𝐷𝑜

4𝑡𝑛
+
𝐼𝑎𝐹𝑏(𝑠𝑢𝑠𝑡)

𝐴𝑝
+
𝐼𝑎𝐹𝑏(𝑜𝑐𝑐𝑎)

𝐴𝑝
|  

(𝐼𝑖𝑀𝑖𝐵)
2 = (𝐼𝑖)

2. [|𝑀𝑖𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑖𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑜𝑀𝑜𝐵)
2 = (𝐼𝑜)

2. [|𝑀𝑜𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑜𝐵(𝑜𝑐𝑐𝑎)|]
2
 

(𝐼𝑡𝑀𝑡𝐵)
2 = (𝐼𝑡)

2. [|𝑀𝑡𝐵(𝑠𝑢𝑠𝑡) +𝑀𝑡𝐵(𝑜𝑐𝑐𝑎)|]
2
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where 

MiB(sust), MoB(sust), MtB(sust) = in-plane, out-of-plane and torsional moment respectively due to 
weight and other sustained mechanical loads (excluding pressure). 

MiB(occa), MoB(occa), MtB(occa) = in-plane, out-of-plane and torsional moment respectively due to 
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and 
flow transients, earthquake / wind, etc. 

Fb(sust) = longitudinal force due to weight, other sustained mechanical loads (excluding 
pressure) 

Fb(occa) = longitudinal force due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake / wind, etc. 

Expansion Stress Range (in un-corroded condition) 

The stress range (𝑆𝐸) due to thermal expansion is calculated from para. 902.3.2(c), para. 
919.2.1 and para. 919.4.1(b) 

𝑆𝐸 = √[|
𝑖𝑎𝐹𝑐
𝐴𝑝

| +
√(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐶

𝑍
)
2

≤ 𝑆𝐴 

where 

Fc = axial force range due to reference displacement load range 

Ap= un-corroded nominal cross sectional area  

ia= axial force stress intensification factor = 1.0 for elbows, pipe bends and miter bends 
(single, closely spaced and widely spaced), and ia = io(or i when listed) in ASME B31J for 
other components 

MiC, MoC, MtC = in-plane, out-of-plane and torsional moment range respectively due to the 
reference displacement load range 

ii, io, it = in-plane, out-of-plane and torsional stress intensification factors respectively as 
defined in ASME B31J, Table 1-1 

Z = nominal section modulus = un-corroded section modulus 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) (See Note 2 below) 

𝑓 = stress range reduction factor 6/𝑁0.2, where 𝑁 being the total number of equivalent  
 reference displacement stress range cycles expected during the service life of the 

piping.  Also 0.15 ≤ 𝑓 ≤ 1.0 
SC = basic allowable stress at minimum metal temperature expected during the displacement 
stress range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the displacement 
stress range under analysis 
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When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as per para. 902.3.2 
(d). 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿]. This equation can be re-written as  

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 2 below) 

This is specified as an analysis option:  “Use liberal allowable stresses”, in the CAEPIPE 
menu Options>Analysis on the “Code” tab is Turned ON. 

Notes: 

1. Refer end of this appendix for the details of “Thickness and Section Modulus used 
for weight, pressure and stress calculations” as per ASME B31.9 (2020). 

2. Para. 902.3.2 (c) and (d) refers to para. 102.3.2 (b) of ASME B31.1 (2020) for Allowable Stress. As 
per Note 2 of para. 102.3.2 (b) (1) of ASME B31.1 (2020), “For materials with a 
minimum tensile strength of over 70 ksi (480 MPa), eqs. (1A) and (1B) shall be 
calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise 
justified.”  

Compliance to this criterion is checked using the value entered under Tensile 
Strength field of CAEPIPE Material property input. If this field is NOT entered or 
left BLANK, then CAEPIPE will compute the Tensile Strength of the material by 
multiplying the Allowable Stress at the minimum temperature (at which the material 
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is 
because, the allowable stress for material below creep is generally 1/3.5 of Tensile 
Strength as stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II, 
Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the 
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 
= 77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and 
Sh as 20,000 psi as Tensile Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through 
Layout Window > Options > Analysis > Code, then if the left over Sustained stress 
(= Sh - SL) is positive, CAEPIPE will multiply this positive left over Sustained stress 
by the Stress range reduction factor (f) and add that resulting value to the Expansion 
allowable stress computed using the above equation (1A) to arrive at “Liberal 
Thermal Allowable Stress”. 
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Allowable Pressure 

For straight pipes and bends, the calculation of allowable pressure is based on Eq. 2 of para. 
904.1 and 904.2.1. 

𝑃 =
2𝑆𝐸(𝑡𝑚 − 𝐴)

𝐷
 

where 

𝑃 = allowable pressure 

𝑆𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2017) Code, where 

𝐸= longitudinal or spiral weld joint efficiency factor as per Table I-1 of Appendix I of 
ASME B31.9 (2017). For casting materials, factor E is replaced with Casting Qualify 
Factor from Table I-1 of Appendix I of ASME B31.9 (2017) 

𝑡𝑚=minimum required pipe thickness as per para. 904.1.1(a) 

=𝑡𝑛 × (1 – mill tolerance/100) 

𝑡𝑛=nominal pipe thickness 

𝐴= corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in “corrosion allowance” in CAEPIPE) 

𝐷=outside diameter 

For closely and widely spaced miter bends, the allowable pressure shall be the lower positive 
value calculated from Eqs.(3A) and (3B) of para. 904.2.2(a) 

𝑃 =
𝑆𝐸𝑇

𝑟
(

𝑇

𝑇+0.64 tan𝜃√𝑟𝑇
) Eq. (3A) 

𝑃 =
𝑆𝐸𝑇

𝑟
(
𝑅−𝑟

𝑅−𝑟/2
) Eq. (3B) 

where 

𝑟 = mean radius of pipe = (𝐷 − 𝑡𝑛)/2 

𝑇 = 𝑡𝑚 − 𝐴, where 𝑡𝑚 and 𝐴 are defined above 

𝑅 = effective bend radius of the miter 

𝜃 = miter half angle 

Sustained Stress (in un-corroded condition) 

The longitudinal stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated as mentioned in para. 902.3.2(d) 

𝑆𝐿 =
𝑃𝐷𝑜
4𝑡𝑛

+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑃= maximum of CAEPIPE input pressures P1 through P10 

𝐷𝑜= outside diameter 

𝑡𝑛=nominal wall thickness 
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𝑖=stress intensification factor.  The product 0.75𝑖 shall not be less than 1.0. See Note 1 
below. 

𝑀𝐴 = resultant bending moment due to weight and other sustained loads 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆ℎ = hot allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

 

Occasional Stress (in un-corroded condition) 

The longitudinal stress (𝑆𝐿𝑂)due to occasional loads is calculated as mentioned in 
para.902.3.3 (a) as the sum of stresses due to pressure, live and dead loads and stress due to 

occasional loads(𝑆𝑂) such as earthquake or wind.  Wind and earthquake are not considered 
to occur concurrently. 

𝑆𝐿𝑂 =
𝑃𝑝𝑒𝑎𝑘𝐷𝑜

4𝑡𝑛
+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐵

𝑍
≤ 1.33𝑆ℎ 

where 

𝑀𝐵 = resultant bending moment due to occasional loads 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor) x P 

Expansion Stress (in un-corroded condition) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para. 902.3.2(c), para. 919.2.1 
and para. 919.4.1(b) 

𝑆𝐸 =
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐴 

where 

𝑀𝐶 = resultant moment due to thermal expansion 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) 
𝑓 = stress range reduction factor 6/𝑁0.2, where 𝑁 being the total number of equivalent  

 reference displacement stress range cycles expected during the service life of the 

piping.  Also 0.15 ≤ 𝑓 ≤ 1.0 

𝑆𝐶 = allowable stress at cold temperature, i.e. at minimum of CAEPIPE input  
  temperatures T1 through T10 and Tref 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as per para. 902.3.2 
(d). 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 

This is specified as an analysis option:  “Use liberal allowable stresses”, in the CAEPIPE 
menu Options>Analysis on the “Code” tab is Turned ON. 

Notes: 
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1. Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) are computed using 
ASME B31.1 (2016) by default as given below. When the option “Use B31J for SIFs 
and Flexibility Factors” is Turned ON, then CAEPIPE computes SIFs and FFs as 
per B31J (2017). 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used 
for weight, pressure and stress calculations”. 
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Allowable Pressure 

For straight pipes and bends, the calculation of allowable pressure is based on Eq. 2 of para. 
904.1 and 904.2.1. 

𝑃 =
2𝑆𝐸(𝑡𝑚 − 𝐴)

𝐷
 

where 

𝑃 = allowable pressure 

𝑆𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2014) Code, where 

𝐸 = longitudinal or spiral weld joint efficiency factor or casting quality factor 

𝑡𝑚 = minimum required pipe thickness as per para. 904.1.1(a) 

 = 𝑡𝑛 × (1 – mill tolerance/100) 

𝑡𝑛 = nominal pipe thickness 

𝐴 = corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in “corrosion allowance” in CAEPIPE) 

𝐷 = outside diameter 

For closely and widely spaced miter bends, the allowable pressure shall be the lower positive 
value calculated from Eqs.(3A) and (3B) of para. 904.2.2(a) 

𝑃 =
𝑆𝐸𝑇

𝑟
(

𝑇

𝑇+0.64 tan𝜃√𝑟𝑇
) Eq. (3A) 

𝑃 =
𝑆𝐸𝑇

𝑟
(
𝑅−𝑟

𝑅−𝑟/2
) Eq. (3B) 

where 

𝑟 = mean radius of pipe = (𝐷 − 𝑡𝑛)/2 

𝑇 = 𝑡𝑚 − 𝐴, where 𝑡𝑚 and 𝐴 are defined above 

𝑅 = effective bend radius of the miter 

𝜃 = miter half angle 

Sustained Stress (in un-corroded condition) 

The longitudinal stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated as mentioned in para. 902.3.2(d) 

𝑆𝐿 =
𝑃𝐷𝑜
4𝑡𝑛

+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑃 = maximum of CAEPIPE pressures P1 through P10 

𝐷𝑜 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑖 = stress intensification factor.  The product 0.75𝑖 shall not be less than 1.0.  

𝑀𝐴 = resultant bending moment due to weight and other sustained loads 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 
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𝑆ℎ = hot allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

 

Occasional Stress (in un-corroded condition) 

The longitudinal stress (𝑆𝐿𝑂)due to occasional loads is calculated as mentioned in 
para.902.3.3 (a) as the sum of stresses due to pressure, live and dead loads and stress due to 

occasional loads(𝑆𝑂) such as earthquake or wind.  Wind and earthquake are not considered 
to occur concurrently. 

𝑆𝐿𝑂 =
𝑃𝑝𝑒𝑎𝑘𝐷𝑜

4𝑡𝑛
+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐵

𝑍
≤ 1.33𝑆ℎ 

where 

𝑀𝐵 = resultant bending moment due to occasional loads 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor) x P 

Expansion Stress (in un-corroded condition) 

The stress (𝑆𝐸) due to thermal expansion is calculated from para. 902.3.2(c), para. 919.2.1 
and para. 919.4.1(b) 

𝑆𝐸 =
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐴 

where 

𝑀𝐶 = resultant moment due to thermal expansion 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) 
𝑓 = stress range reduction factor 6/𝑁0.2, where 𝑁 being the total number of equivalent  

 reference displacement stress range cycles expected during the service life of the 

piping.  Also 0.15 ≤ 𝑓 ≤ 1.0 

𝑆𝐶 = allowable stress at cold temperature, i.e. at minimum of CAEPIPE input  
  temperaturesT1 through T10 and Tref 

When 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as per para. 902.3.2 
(d). 

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿] 

This is specified as an analysis option:  “Use liberal allowable stresses”, in the CAEPIPE 
menu Options>Analysis on the “Code” tab. 

Note: 

Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 
 
Stress Intensification Factor (SIF) values for B31.9 (2014) are referred from Appendix D of 
B31.1 (2012). The same is provided below for details. 
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. IP-3.2.1 and IP-3.3.1 respectively. 

a

af

a
YtD

tSEM
P

2

2


  

where 

Pa = allowable pressure 

S = stress value for material from Table IX-1A in Appendix IX 

E = quality factor from Table IX-2 or Table IX-3A in Appendix IX 

Mf = material performance factor that addresses loss of material properties associated with 
hydrogen gas service from Tables IX-5B and IX-5C in Appendix IX. 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑑 = inside diameter 

𝑌 = coefficient from Table IP-3.2.1, valid for 𝑡𝑎 < 𝐷/6 for Ferritic and Austenitic steels. 
Refer to the Table listed at the end of this Section for details on ‘Y’ used in CAEPIPE 
for all available materials.  

𝑌 = 
𝑑+2𝑐

𝐷+𝑑+2𝑐
 , valid for 𝑡𝑎 ≥ 𝐷/6 for all material types. 

 
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. 
(4a) and Eq. (4b) from para. IP-3.3.3. 

𝑃𝑎 = 𝑚𝑖𝑛𝑖𝑚𝑢𝑚 [
𝑆𝐸𝑀𝑓𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
,

𝑆𝐸𝑀𝑓𝑡𝑎
2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
] 

For widely spaced miter bends with 𝜃 <= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4a) from para. IP-3.3.3 as 

𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
 

For widely spaced miter bends with 𝜃 > 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4c) from para. IP-3.3.3 as 

𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
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where 

𝑟 = mean radius of pipe = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. IP-3.3.3 (d) of code for definition) [an input 
in CAEPIPE for miters] 

 = angle of miter cut (see para. IP-3.3.3 of code for definition) 

Sustained Stress 

As per para. IP-6.2, the stress (𝑆𝐿) due to sustained loads (pressure, weight and other 
sustained mechanical loads) is calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 
320.2 of ASME B31.3 (2022) and compared against the allowable as stated in para. IP-
2.2.10(c).  

All paragraph numbers cited below are from the ASME B31.3 (2022) code, unless otherwise specified. 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ𝑀𝑓 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= 𝐼𝑎 [
𝑃𝜋𝑑2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)

2 + (𝐼𝑜𝑀𝑜)
2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆 = wall thickness used for sustained stress calculation after deducting corrosion 
allowance from the nominal thickness  

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 

𝑑 = corroded inside diameter = 𝐷 − 2𝑡𝑆 

𝐴𝑝 = corroded cross-sectional area of the pipe computed using ts as per para. 320.2 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎 = longitudinal force due to sustained loads (pressure and weight) 

𝑅 = axial force due to weight alone, where weight is computed using nominal thickness. 

𝐼𝑖 = sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater 

𝐼𝑜 = sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater 

𝐼𝑡 = sustained torsional moment index = 1.0 

𝑀𝑖 = in-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads, e.g., pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads, e.g., pressure and weight 

𝑍𝑚 = corroded section modulus as per para. 320.1 

𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10) from 
Table IX-1A in Appendix IX 

ii and io = in-plane and out-of-plane index from ASME B31J (2017) respectively 
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𝑀𝑓 = material performance factor that addresses loss of material properties associated with 

hydrogen gas service from Tables IX-5B and IX-5C in Appendix IX. 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) 
due to sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads 
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently 
(see para. IP-2.2.11).  

All paragraph numbers cited below are from the ASME B31.3 (2022) code, unless otherwise specified. 

For temp ≤ 4270 C or 8000 F  

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ𝑀𝑓 as per para. IP-2.2.11(a) 

For temp > 4270 C or 8000 F (see Note 2 below) 

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦𝑀𝑓 as per IP-2.2.11(a) 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b), 
(23c) and (23d) with applicable loads as per para. 302.3.6 (a). 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= 𝐼𝑎 [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝜋𝑑

2/4

𝐴𝑝
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑃  = maximum of CAEPIPE input pressures P1 through P10 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊 = 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. IP-
2.2.11(a)  

𝑍𝑚  = corroded section modulus as per para. 320.1 

𝑀𝑓   = material performance factor from Tables IX-5B and IX-5C in Appendix IX. 

Ii and Io = in-plane and out-of-plane index from ASME B31J (2017) respectively. 
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Notes:  
1. When the field Yield strength is left BLANK or NOT input, then CAEPIPE will 

compute the Yield Strength of the material by multiplying the Allowable Stress at the 
minimum temperature (at which the material properties are entered in CAEPIPE 
stress model) with a factor of 1.5 (=3/2). This is because; the allowable stress for 
material below creep is generally 2/3 of Yield Strength. 

2. The allowable stress equations for (𝑆𝐿𝑂) are taken from para. IP-2.2.11, ignoring the 
“wrongly-worded” last statement given in that paragraph namely “At temperatures 
warmer than 427 deg. C (800 deg.F), use 1.33.Sh.Mf”  

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated according to Equation 17 of 
Paragraph 319.4.4 of the ASME B31.3 (2022) code, as referenced in Paragraphs IP-6.1 and 
IP-2.2.10(d). All paragraph numbers cited below are from the ASME B31.3 (2022) code, 
unless otherwise specified.  

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆𝐴  

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal thickness 
𝑡𝑛 and outer diameter D, as per para. 319.3.5. 

𝑖𝑎= axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
𝑖𝑎 = 𝑖𝑜 for other components as per ASME B31J (2017) 

𝐹𝑎 = range of axial force between any two thermal conditions being evaluated 

𝑖𝑖 = in-plane stress intensification factor (SIF) as per ASME B31J (2017); shall not be < 1.0 

𝑖𝑜 = out-of-plane SIF as per ASME B31J (2017); shall not be < 1.0 
𝑖𝑡 = torsional SIF as per ASME B31J (2017); shall not be < 1.0 
𝑀𝑖 = in-plane bending moment range between any two conditions being evaluated 
𝑀𝑜 = out-of-plane bending moment range between any two conditions being evaluated 
𝑀𝑡 = torsional moment range between any two conditions being evaluated 

𝑍 = un-corroded section modulus as per para. 319.3.5 and para. 319.4.4 (a) 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 20(N)-0.333 <= fm & f 
>= 0.15 

𝑓𝑚 = maximum value of stress range factor; 1.2 for ferrous materials with specified minimum 
tensile strengths <= 75 ksi) and at metal temperatures <=700° F; otherwise 𝑓𝑚 = 1.0 
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𝑁 = equivalent number of full displacement cycles expected during service of piping. This 
full displacement cycles (N) shall be increased by a factor of 10 for carbon and low alloy 
steels and other materials that are susceptible to Hydrogen Embrittlement (HE) as per 
para. IP-2.2.10(d), irrespective of their design temperatures. 

𝑆𝐶  = basic allowable stress at minimum metal temperature expected during the displacement 
cycle under analysis 

𝑆ℎ = basic allowable stress at maximum metal temperature expected during the displacement 
cycle under analysis 

when 𝑆ℎ is greater than 𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. 302.3.5(d). This equation can be re-written as  

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ) + 𝑓(𝑆ℎ − 𝑆𝐿 ) (see Note 3 below) 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 

Notes: 

1. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 319.4.4 (a). 

2. Refer to the end of this appendix for the details of “Thickness and Section Modulus used 
for weight, allowable pressure and stress calculations”. 

3. Para. 302.3.5 provides maximum value of Sc and Sh as 138 MPa (20 ksi). The reason for 
this criterion is explicitly stated in Note 2 of para. 102.3.5 (b) (1) of ASME B31.1 (2022) 
as given here “For materials with a minimum tensile strength of over 70 ksi (480 MPa), eqs. (1a) 
and (1b) shall be calculated using Sc or Sh values no greater than 20 ksi (140 MPa), unless otherwise 
justified.”  

Compliance to this criterion is checked using the value entered under Tensile Strength 
field of CAEPIPE Material property input. If this Tensile Strength field is NOT entered 
or left BLANK, then CAEPIPE will compute the Tensile Strength of the material by 
multiplying the Allowable Stress at the minimum temperature (at which the material 
properties are entered in CAEPIPE stress model) with a factor of 3.5. This is because, 
the allowable stress for material below creep is generally 1/3.5 of Tensile Strength as 
stated in Section 1-100 of Mandatory Appendix 1 of ASME Section II, Part D.  

For example, if the allowable stress is 22,000 psi for a high strength material at the 
minimum temperature of -20 deg. F, then the Tensile Strength would be 22,000 x 3.5 = 
77,000 psi. So, in this case, CAEPIPE will internally set the values of both Sc and Sh as 
20,000 psi as Tensile Strength is greater than 70,000 psi. 

In addition, if the option “Use Liberal allowable stresses” is turned ON through Layout 
Window > Options > Analysis > Code, then if the left over Sustained stress (= Sh - SL) is 
positive, CAEPIPE will multiply this positive left over Sustained stress by the Stress 
range reduction factor (f) and add that resulting value to the Expansion allowable stress 
computed using the above equation (1a). 

4. Para. 319.2.1(c), implies that wind sway at a piping support (e.g., piping supported from a 
tall slender tower) could be considered as an imposed thermal displacement at that 
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support. Since CAEPIPE allows up to 10 thermal loads, the question arises “under 
which thermal load should this wind sway to be included”. Hence, we recommend that 
wind sway is to be input as a part of “wind displacement under occasional stress 
condition”.  

Notes on Material Library for B3112-2023.mat supplied with CAEPIPE: 

1. Material library for ASME B31.12 (2023) [B3112-2023.mat] supplied with CAEPIPE 
has been created by referring to the values provided in Appendix IX of ASME 
B31.12 (2023). 

2. Coefficient of Thermal Expansion: Coefficient of Thermal Expansion data are 
entered by referring to the values provided in Table C-1 of Appendix C of ASME 
B31.3 (2022). 

3. Modulus of Elasticity: Modulus of Elasticity data are entered by referring to the 
values provided in Table C-6 of Appendix C of ASME B31.3 (2022). 

4. Longitudinal Joint Factor: Longitudinal Joint Factors are entered by referring to 
the values specified in Table IX-3A of ASME B31.12 (2023). 

Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure  

[Sl. Nos. 1 & 2 below are from Table IP-3.2.1 and Sl. Nos. 3, 4 & 5 are from Table 304.1.1 of ASME 
B31.3 (2022)] 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels (FS) 0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel (AS)  0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys (NA) 0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / Cast Iron 
(CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material Types other 
than those stated 
from Sl. Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 

Carbon Steel Piping Materials Performance Factor (Mf) used in CAEPIPE for Material Type as 
“CS” (from Table IX-5B) 

Sl. 
No. 

Specified Min. Yield 
Strength (ksi) 

Materials Performance Factor (Mf) 

System Design Pressure, psig 

<=1000 2000 3000 4000 5000 6000 

1. <= 52 1.000 0.948 0.912 0.884 0.860 0.839 

2. <= 56 0.930 0.881 0.848 0.824 0.800 0.778 

3. <= 65 0.839 0.796 0.766 0.745 0.724 0.706 

4. <= 80 0.715 0.678 0.645 0.633 0.618 0.600 
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Low and Intermediate Alloy Steel Piping Materials Performance Factor (Mf) used in CAEPIPE 

for Material Type as “AS” (from Table IX-5C) 

Sl. 
No. 

Specified Min. Tensile 
Strength (ksi) 

Materials Performance Factor (Mf) 

System Design Pressure, psig 

0.000 1000 2000 3000 4000 5000 6000 

1. <= 35 1.000 0.918 0.881 0.875 0.836 0.815 0.800 

2. <= 45 0.791 0.724 0.696 0.675 0.660 0.642 0.630 

3. <= 60 0.655 0.601 0.577 0.561 0.547 0.533 0.524 

4. <= 65 0.580 0.532 0.511 0.497 0.485 0.472 0.464 

 
Note: 

For materials not covered by Tables given above, Material Performance Factor (Mf) is taken as 
1.00.
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. IP-3.2.1 and IP-3.3.1.respectively. 

a

af

a
YtD

tSEM
P

2

2


  

where 

Pa= allowable pressure 

S = stress value for material from Table IX-1A 

E = quality factor from Table IX-2 or Table IX-3A 

Mf= material performance factor that addresses loss of material properties associated with 
hydrogen gas service from Tables IX-5B and IX-5C from Appendix IX. 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑑= inside diameter 

𝑌= coefficient from Table IP-3.2.1, valid for 𝑡𝑎 < 𝐷/6 for Ferritic and Austenitic steels. 
Refer to the Table listed at the end of this Section for details on ‘Y’ used in CAEPIPE 
for all available materials.  

𝑌= 
𝑑+2𝑐

𝐷+𝑑+2𝑐
 , valid for 𝑡𝑎 ≥ 𝐷/6 for all material types. 

 
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. 
(4b) from para. IP-3.3.3. 

𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
 

For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4a) from para. IP-3.3.3 as 

𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
 

 

For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4c) from para. IP-3.3.3 as 
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𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
 

where 

𝑟 = mean radius of pipe = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. IP-3.3.3 (d) of code for definition) [an input 
in CAEPIPE for miters] 

 = angle of miter cut (see para. IP-3.3.3 of code for definition) 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eqs. (23a), (23b1), (23b2), (23c) and (23d) from para. 320.2 of 
ASME B31.3 (2018) and compared against the allowable provided in para. IP-2.2.10. 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ𝑀𝑓 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= [
𝑃𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

For branch (Leg 3 in Fig. 319.4.4B) of ASME B31.3 (2018), 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑒
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆= wall thickness used for sustained stress calculation obtained by deducting corrosion 
allowance from the nominal thickness  

𝑡𝑆 =  nominal thickness - corrosion allowance in CAEPIPE, as per para. 320.1 of ASME 
B31.3 (2018) 

𝐴𝑝= corroded cross-sectional area of the pipe computed using ts as per para. 320.1of ASME 

B31.3 (2018) 

𝐼𝑎 = longitudinal force index = 1.0 

𝐹𝑎= longitudinal force due to sustained loads such as pressure and weight 

𝑅= axial force due to weight alone, where weight is computed using nominal thickness. 

𝐼𝑖= sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.  

𝐼𝑜= sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater.  
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 where, 𝑖𝑖  and 𝑖𝑜 are taken from Appendix D of ASME B31.3 (2018) [reprinted at the 
end of this Section] or from B31J (2017) when the option “Use B31J for SIFs and 
Flexibility Factors” is Turned ON.  

𝐼𝑡 = torsional moment index = 1.0 

𝑀𝑖= in-plane bending moment due to sustained loads such as pressure and weight 

𝑀𝑜 = out-of-plane bending moment due to sustained loads such as pressure and weight 

𝑀𝑡 = torsional moment due to sustained loads such as pressure and weight 

𝑍𝑚 = corroded section modulus as per para. 320.1 of ASME B31.3 (2018) 

𝑍𝑒= effective corroded section modulus for branch as per para.320.2 of ASME B31.3 (2018) 
when Appendix D of ASME B31.3 is used to compute Stress Intensification Factors 
(SIFs) (or) corroded section modulus when B31J is used to compute to compute SIFs. 

𝑀𝑓= material performance factor that addresses loss of material properties associated 

withhydrogen gas service from Tables IX-5B and IX-5C from Appendix IX. 

𝑆ℎ = basic allowable stress at maximum temperature, i.e., max (Tref, T1 through T10) 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) 
due to sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads 
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently 
(see para. IP-2.2.11). 

For temp ≤ 4270 C or 8000 F(see Note 1 below) 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ𝑀𝑓 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦𝑀𝑓
 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b1), 
(23b2), (23c) and (23d) of ASME B31.3 (2018) with applicable loads. 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

For branch (Leg 3 in Fig. 319.4.4B) of ASME B31.3 (2018) 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑒
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙
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𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 
 

𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡 = torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦 = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊  = 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. IP-2.2.11(a) 

𝑍𝑚 = corroded section modulus as per para. 320.1 of ASME B31.3 (2018) 

𝑍𝑒= effective corroded section modulus for branch as per para.320.2 of ASME B31.3 (2018) 
when Appendix D of ASME B31.3 is used to compute Stress Intensification Factors 
(SIFs) (or) corroded section modulus when B31J is used to compute to compute SIFs. 

Note 1: 

The allowable stress equations for (𝑆𝐿𝑂)are taken from para. 302.3.6 of ASME B31.3 (2018), 
as the sentence “At temperatures warmer than 427 deg. C (800 deg.F), use 1.33.Sh.Mf” in 
para. IP-2.2.11 of ASME B31.12 (2019) code seems to be incorrectly worded.  

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. IP-6.1.5. The 

Axial Stress term (𝑆𝑎) is included in Expansion Stress calculation as per Eq. 17 of para. 
319.4.4 of ASME B31.3 (2018) code. 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

For branch (Leg 3 in Fig. IP-6.1.5-2) 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑒
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛
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𝐴 =un-corroded cross-sectional area of the pipe/fitting computed using nominal thickness 
𝑡𝑛 and outer diameter D as per IP-6.1.4 (e). 

𝑖𝑎=axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 (2018) 

𝐹𝑎=range of axial force due to displacement strains between any two thermal conditions 
being evaluated 

𝑖𝑖= in-plane stress intensification factor from Appendix D of ASME B31.3 (2018) or from 
B31J (2017) when the option “Use B31J for SIFs and Flexibility Factors” is Turned ON. 

𝑖𝑖shallnot be less than 1.0. 

𝑖𝑜=out-of-plane stress intensification factor Appendix D of ASME B31.3 (2018) or from 
B31J (2017) when the option “Use B31J for SIFs and Flexibility Factors” is Turned ON. 

𝑖𝑜shallnot be less than 1.0. 
𝑖𝑡=torsional stress intensification factor = 1.0 
𝑀𝑖=in-plane bending moment  
𝑀𝑜=out-of-plane bending moment  
𝑀𝑡=torsional moment 

𝑍=un-corroded section modulus as per IP-6.1.4 (e) 

𝑍𝑒=un-corroded effective section modulus as per IP-6.1.4 (e) 
 

𝑆𝐴=𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. IP-2.2.10 (d) 

𝑓=stress range reduction factor from Eq. (1c) of para. IP-2.2.10 (d) = 6N-0.2 
 where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below) 
𝑆𝐶=basic allowable stress at minimum metal temperature expected during the displacement 

cycle under analysis 
𝑆ℎ=basic allowable stress at maximum metal temperature expected during the displacement 

cycle under analysis 
When 𝑆ℎ is greater than Sustained Stress 𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. IP-2.2.10 (d).
 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 

Notes: 

1. As per para. IP-2.2.10 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at metal 
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not available 
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. IP-6.1.5 (d)(1). 

3. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 
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Notes on Material Library for B3112-2019.mat supplied with CAEPIPE: 

5. Material library for ASME B31.12 (2019) [B3112-2019.mat] supplied with CAEPIPE 
has been created by referring to the values provided in Appendix IX of ASME 
B31.12 (2019). 

6. Coefficient of Thermal Expansion: Coefficient of Thermal Expansion data are 
entered by referring to the values provided in Table C-1 of Appendix C of ASME 
B31.3 (2018). 

7. Modulus of Elasticity: Modulus of Elasticity data are entered by referring to the 
values provided in Table C-6 of Appendix C of ASME B31.3 (2018). 

8. Longitudinal Joint Factor: Longitudinal Joint Factor are entered by referring to the 
values specified in Table IX-3A of ASME B31.12 (2019). 
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Stress Intensification Factor (SIF) values for B31.12 (2019) are referred from Appendix D of 
B31.3 (2018). The same is provided below for details.  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure  

[Sl. Nos. 1 & 2 below are from Table IP-3.2.1 and Sl. Nos. 3, 4 & 5 are from Table 304.1.1 of ASME 

B31.3 (2018)] 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel 
(AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / Cast 
Iron (CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material Types 
other than those 
stated from Sl. 
Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 

Carbon Steel Piping Materials Performance Factor (Mf) used in CAEPIPE for Material Type as 
“CS” (from Table IX-5B) 

Sl. 
No. 

Specified Min. Yield 
Strength (ksi) 

System Design Pressure, psig 

<=1000 2000 3000 4000 5000 6000 

1. <= 52 1.000 0.948 0.912 0.884 0.860 0.839 

2. <= 56 0.930 0.881 0.848 0.824 0.800 0.778 

3. <= 65 0.839 0.796 0.766 0.745 0.724 0.706 

4. <= 80 0.715 0.678 0.645 0.633 0.618 0.600 

 
Low and Intermediate Alloy Steel Piping Materials Performance Factor (Mf) used in CAEPIPE 

for Material Type as “AS” (from Table IX-5C) 

Sl. 
No. 

Specified Min. Tensile 
Strength (ksi) 

System Design Pressure, psig 

0.000 1000 2000 3000 4000 5000 6000 

1. <= 35 1.000 0.918 0.881 0.875 0.836 0.815 0.800 

2. <= 45 0.791 0.724 0.696 0.675 0.660 0.642 0.630 

3. <= 60 0.655 0.601 0.577 0.561 0.547 0.533 0.524 

4. <= 65 0.580 0.532 0.511 0.497 0.485 0.472 0.464 

 
Note: 
For materials not covered by Tables given above, Material Performance Factor (Mf) is taken as 1.00.
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Allowable Pressure  

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. PL-3.7.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇𝐻𝑓

𝐷  
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. PL-3.7.1 (a) 

𝐸 = longitudinal joint factor (input as material property), obtained from Table IX-3B of 
Appendix IX 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter of pipe 

𝐹 = construction location design factor, obtained from Table PL-3.7.1-1 (for Option A) and  
Table PL-3.7.1-2 (for Option B) 

𝑇 = temperature derating factor, obtained from Table PL-3.7.1.3 

𝐻𝑓 = material performance factor from Mandatory Appendix IX, Table IX-5A. Hf given in 

Table IX-5A is applied only for Design Factors corresponding to Option A – 
Prescriptive Design Method. For Design Factors corresponding to Option B – 
Performance-based Design Method, Hf is set as 1.0 internally. Design Factor can be 
selected in CAEPIPE through Layout Window > Options > Analysis > Code. 

Stress due to Sustained & Occasional Loads [Unrestrained (above ground) Piping] 

The sum of longitudinal stress due to internal pressure and due to axial loading (other than 
thermal expansion and pressure) and the bending stress due to external loads, such as weight 
of the pipe and contents, occasional loads such as seismic or wind, etc. is calculated 
according to paras. PL-2.6.5 (a) and PL-2.6.5 (b) along with paras. PL-2.6.2 (b), PL-2.6.2 (d), 
PL-2.6.2 (e) and PL-2.6.2 (f). Wind and Seismic is not considered to act concurrently. 

Note: 

The “include axial force in stress calculations” option is turned ON by default for ASME 
B31.12 PL in CAEPIPE. 

Sustained Stress 𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑀𝑖)

2 + (𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75ST

 
For other Fittings and Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained

≤ 0.75ST
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Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝑴𝒊)

𝟐 + (𝑴𝒐)
𝟐+(𝑴𝒕)

𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓 

 
For other Fittings and Components 

𝑆𝐿𝑂(𝑓𝑐) = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇

 
where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor from Appendix E of ASME B31.8 (2022); the 

product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor from Appendix E of ASME B31.8 (2022); the 

product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment due to weight and external loads  

𝑀𝑜= out-of-plane bending moment due to weight and external loads 

𝑀𝑡= torsional moment due to weight and external loads 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force component for external loads (other than due to thermal expansion and 
pressure) 

𝐴 = un-corroded pipe metal cross-section area 

𝑆 = specified minimum yield strength from para. PL-3.7.1 (a) 

𝑇= temperature derating factor, obtained from Table PL-3.7.1-3 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations in accordance with paras. PL-2.5.3 (g) and PL-2.5.4 (b). 

Expansion Stress [Unrestrained (above ground) Piping] 

The stress (𝑆𝐸) due to thermal expansion is calculated from para. PL-2.6.7, which in turn, 
refers to para. IP-2.2.10. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
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𝑀𝑖 = in-plane bending moment due to thermal expansion  

𝑀𝑜= out-of-plane bending moment due to thermal expansion 

𝑀𝑡= torsional moment due to thermal expansion 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) of ASME B31.3 (2022) = 
20(N)-0.333 <= fm & f >= 0.15 

𝑓𝑚 = maximum value of stress range factor; 1.2 for ferrous materials with specified minimum 
tensile strengths <= 75 ksi) and at metal temperatures <=700° F; otherwise 𝑓𝑚 = 1.0 

𝑁 = equivalent number of full displacement cycles expected during service of piping. This 
full displacement cycles (N) shall be increased by a factor of 10 for carbon and low alloy 
steels and other materials that are susceptible to Hydrogen Embrittlement (HE) as per 
para. IP-2.2.10(d), irrespective of their design temperatures. 

𝑆𝐿 = sustained stress computed as per equation given above 

𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature  

𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
 
where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 

𝑆𝑦 = specified minimum yield strength as per para. PL-3.7.1 (a) 

𝑇 = temperature derating factor from Table PL-3.7.1.3 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [= min(T1 
through T10, Tref)] is used to form the stiffness matrix for Expansion load calculations in 
accordance with paras. PL-2.5.3 (g) and PL-2.5.4 (b). 

Sustained, Thermal & Occasional Stress [Restrained (buried) Piping] 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. PL-2.6.3 (a), PL-2.6.3 (b) along with paras. PL-
2.6.2 (a), PL-2.6.2 (c), PL-2.6.2 (d), PL-2.6.2 (e) and PL-2.6.2 (f) 

𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵 

𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵 

As per PL-2.6.4 (d), both the tensile and compressive values of SB shall be considered in 
analysis. 
where 

𝑆𝑝 = 0.3𝑆𝐻 = 0.3
𝑃𝐷

2𝑡𝑛
 = longitudinal stress due to internal pressure in restrained pipeline 

𝑆𝐻 = hoop stress = 
𝑃𝐷

2𝑡𝑛
 as per para. PL-2.6.2 (a) 

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼𝑚(𝑇𝑚 − 𝑇𝑖) 
(see Note 1 below) 
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𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) =
𝑅

𝐴
 

𝑆𝐵 = nominal bending stress due to weight and other external loads (other than thermal 
expansion) 

For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑀𝑖)2 + (𝑀𝑜)2 + (𝑀𝑡)2

𝑍  

For other Fittings and Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍  
As per para PL-2.6.3 (a), note that 𝑆𝐵,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative 
 
where 

𝑃 = maximum operating pressure = max(P1 through P10) 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖  = in-plane bending moment due to weight and other external loads (other than thermal 
expansion) 

𝑀𝑜 = out-of-plane bending moment due to weight and other external loads (other than 
thermal expansion) 

𝑀𝑡 = torsional moment due to weight and other external loads (other than thermal 
expansion) 

𝑅 = axial force from weight and external loads (other than due to thermal expansion and 
pressure) 

𝐴 = un-corroded pipe metal cross-sectional area (i.e., before deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. PL-3.7.1 (a) 

𝑇 = Temperature derating factor from Table PL-3.7.1-3 

𝐸 = Young’s modulus at ambient temperature, i.e., at Tref in CAEPIPE 

𝑇𝑖 = installation temperature = Tref in CAEPIPE (see Note 1 below) 

𝑇𝑚 = warmest or coldest operating temperature (see Note 1 below) 

𝛼𝑚 = coefficient of thermal expansion at T0 in CAEPIPE (see Note 1 below) 

Note 1: 

If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates 

longitudinal stress 𝑆𝑇 due to thermal expansion as follows. 

For a change in temperature from Tref to T1, 𝑆𝑇1 = −𝐸𝛼1(𝑇1 − 𝑇𝑟𝑒𝑓) 

For a change in temperature from Tref to T2, 𝑆𝑇2 = −𝐸𝛼2(𝑇2 − 𝑇𝑟𝑒𝑓) 
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For a change in temperature from T1 to T2, 𝑆𝑇1−.>𝑇2 = 𝑆𝑇2 − 𝑆𝑇1 

Please note, that negative (-) sign is added in the above equations as the soil is restraining the 
thermal expansion / contraction of the buried pipe due to friction at the soil-to-pipe 
interface. 

Combined Stress for Restrained Pipe 

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the 
calculation given below by default in CAEPIPE as per para. PL-2.6.4. To be conservative, 
Seq1 and Seq2 given below are in line with para. 833.4 of ASME B31.8 (2022). 

S𝑒𝑞 = max {𝑆𝑒𝑞1,𝑆𝑒𝑞2} ≤ 0.9𝑆𝑇 

where 

S𝑒𝑞 = equivalent combined stress  

 

S𝑒𝑞1 = max {|𝑆𝐻 − 𝑆𝐿𝑝|, |𝑆𝐻|, |𝑆𝐿𝑝|} 

S𝑒𝑞2 = max {|𝑆𝐻 − 𝑆𝐿𝑛|, |𝑆𝐻|, |𝑆𝐿𝑛|} 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 3 below): 

S𝑒𝑞1 = √(𝑆𝐿𝑝)
2
− 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐻)2 

S𝑒𝑞2 = √(𝑆𝐿𝑛)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐻)2 

Notes: 

1. Young’s modulus of elasticity corresponding to the lowest operating temperature 
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with paras. 
PL-2.5.3 (g) and PL-2.5.4 (b). 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

3. By default, CAEPIPE combines the stresses for restrained piping using the maximum 
shear stress theory as stated above. To combine stresses in accordance with the 
maximum distortion energy theory as stated above, turn ON the analysis option 
“Combine stresses as per Max. Distortion Energy Theory” through Layout Window > 
Options > Analysis > Code. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. PL-3.7.1. 

𝑃 =
2𝑆𝐸𝑡𝑛𝐹𝑇𝐻𝑓

𝐷  
where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength from para. PL-3.7.1 (a) 

𝐸 = longitudinal joint factor (input as material property), obtained from Table IX-3B of 
Appendix IX 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter of pipe 

𝐹 = construction location design factor, obtained from Table PL-3.7.1-1 (for Option A) and  
Table PL-3.7.1-2 (for Option B) 

𝑇 = temperature derating factor, obtained from Table PL-3.7.1.3 

𝐻𝑓 = material performance factor from Mandatory Appendix IX, Table IX-5A. Hf given in 

Table IX-5A is applied only for Design Factors corresponding to Option A – 
Prescriptive Design Method. For Design Factors corresponding to Option B – 
Performance-based Design Method, Hf is set as 1.0 internally. Design Factor can be 
selected in CAEPIPE through Layout Window > Options > Analysis > Code. 

Stress due to Sustained & Occasional Loads [Unrestrained (above ground) Piping] 

The sum of longitudinal stress due to internal pressure and due to axial loading (other than 
thermal expansion and pressure) and the bending stress due to external loads, such as weight 
of the pipe and contents, occasional loads such as seismic or wind, etc. is calculated 
according to paras. PL-2.6.5 (a) and PL-2.6.5 (b) along with paras. PL-2.6.2 (b), PL-2.6.2 (d), 
PL-2.6.2 (e) and PL-2.6.2 (f). Wind and Seismic is not considered to act concurrently. 

Note: 

The “include axial force in stress calculations” option is turned ON by default for ASME 
B31.12 PL in CAEPIPE. 

Sustained Stress 𝑺𝑳: 

For Pipes and Long Radius Bends 

𝑆𝐿 = |
𝑃𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

+ [
√(𝑀𝑖)

2 + (𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

≤ 0.75ST

 
For other Fittings and Components. 

SL(fc) = |
PD

4tn
+
R

A
|
Sustained

+ [
√(0.75iiMi)

2 + (0.75ioMo)
2 + (Mt)

2

Z
]

Sustained

≤ 0.75ST
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Sustained + Occasional Stress 𝑺𝑳𝑶: 

For Pipes and Long Radius Bends 

𝐒𝐋𝐎 = 𝐒𝐋 + |
(𝐏𝐩𝐞𝐚𝐤 − 𝐏)𝐃

𝟒𝐭𝐧
+
𝐑

𝐀
|
𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

+ [
√(𝑴𝒊)

𝟐 + (𝑴𝒐)
𝟐+(𝑴𝒕)

𝟐

𝐙
]

𝐨𝐜𝐜𝐚𝐬𝐢𝐨𝐧𝐚𝐥

≤ 𝟎. 𝟕𝟓𝐒𝐓 

 
For other Fittings and Components 

𝑆𝐿𝑂(𝑓𝑐) = 𝑆𝐿(𝑓𝑐) + |
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑛
+
𝑅

𝐴
|
𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

+ [
√(0.75𝑖𝑖𝑀𝑖)

2 + (0.75𝑖𝑜𝑀𝑜)
2 + (𝑀𝑡)

2

𝑍
]

𝑜𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

≤ 0.75𝑆𝑇

 
where 

𝑃 = maximum operating pressure = max (P1 through P10) 

𝑃𝑝𝑒𝑎𝑘 = Peak pressure factor x P 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜= out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖 = in-plane bending moment due to weight and external loads  

𝑀𝑜= out-of-plane bending moment due to weight and external loads 

𝑀𝑡= torsional moment due to weight and external loads 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus  

𝑅 = axial force component for external loads (other than due to thermal expansion and 
pressure) 

𝐴 = un-corroded pipe metal cross-section area 

𝑆 = specified minimum yield strength from para. PL-3.7.1 (a) 

𝑇= temperature derating factor, obtained from Table PL-3.7.1-3 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations in accordance with paras. PL-2.5.3 (g) and PL-2.5.4 (b). 

Expansion Stress [Unrestrained (above ground) Piping] 

The stress (𝑆𝐸) due to thermal expansion is calculated from para.PL-2.6.7, which. In turn, 
refers to para. IP-2.2.10. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 𝑆𝐴
 

where 

𝑆𝑏 = resultant bending stress = 
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

𝑆𝑡 = torsional stress = 
𝑀𝑡

2𝑍
 

𝑀𝑖 = in-plane bending moment due to thermal expansion  
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𝑀𝑜= out-of-plane bending moment due to thermal expansion 

𝑀𝑡= torsional moment due to thermal expansion 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆𝐴= 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], which is eq. (1b) in para. IP-2.2.10 (d) 

𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

cycles, where 𝑓 ≤ 1.0 (eq. 1(c) from para. PL-2.2.10 (d)). See Note 2 below. 

𝑆𝐿 = sustained stress computed as per equation given above 

𝑆𝐶 = 0.33SuT at the minimum installed or operating temperature  

𝑆ℎ = 0.33SuT at the maximum installed or operating temperature 
where 

𝑆𝑢 = specified minimum ultimate tensile strength = 1.5 𝑆𝑦 (assumed), and 

𝑆𝑦 = specified minimum yield strength as per para. PL-3.7.1 (a) 

𝑇 = temperature derating factor from Table PL-3.7.1.3 

Note:  

1. Young’s modulus of elasticity corresponding to the lowest operating temperature [= 
min(T1 through T10, Tref)] is used to form the stiffness matrix for Expansion load 
calculations in accordance with paras. PL-2.5.3 (g) and PL-2.5.4 (b). 

2. As per para. IP-2.2.10 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal 
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not 
available at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

Sustained, Thermal & Occasional Stress [Restrained (buried) Piping] 

The Net longitudinal stress (𝑆𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. PL-2.6.3 (a), PL-2.6.3 (b) along with paras. PL-
2.6.2 (a), PL-2.6.2 (c), PL-2.6.2 (d), PL-2.6.2 (e) and PL-2.6.2 (f) 

𝑆𝐿𝑝 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 + 𝑆𝐵 

𝑆𝐿𝑛 = 𝑆𝑝 + 𝑆𝑇 + 𝑆𝑋 − 𝑆𝐵 

As per PL-2.6.4 (d), both the tensile and compressive values of SB shall be considered in 
analysis. 
where 

𝑆𝑝 = 0.3𝑆𝐻 = 0.3
𝑃𝐷

2𝑡𝑛
 = longitudinal stress due to internal pressure in restrained pipeline 

𝑆𝐻 = hoop stress = 
𝑃𝐷

2𝑡𝑛
 as per para. PL-2.6.2 (a) 

𝑆𝑇 = longitudinal stress due to thermal expansion in restrained pipeline = 𝐸𝛼𝑚(𝑇𝑚 − 𝑇𝑖) 
(see Note 1 below) 

𝑆𝑋 = stress due to axial loading (other than thermal expansion and pressure) =
𝑅

𝐴
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𝑆𝐵 = nominal bending stress due to weight and other external loads (other than thermal 
expansion) 

For Pipes and Long Radius Bends 

𝑆𝐵 =
√(𝑀𝑖)2 + (𝑀𝑜)2 + (𝑀𝑡)2

𝑍  

For other Fittings and Components. 

𝑆𝐵 =
√(0.75𝑖𝑖𝑀𝑖)2 + (0.75𝑖𝑜𝑀𝑜)2 + (𝑀𝑡)2

𝑍  
As per para PL-2.6.3 (a), note that 𝑆𝐵,𝑆𝐿 , 𝑆𝑇 𝑜𝑟 𝑆𝑋 can be positive or negative 
 
where 

𝑃 = maximum operating pressure = max(P1 through P10) 

𝐷 = outside diameter 

𝑡𝑛 = nominal thickness 

𝑖𝑖 = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 

𝑀𝑖  = in-plane bending moment due to weight and other external loads (other than thermal 
expansion) 

𝑀𝑜 = out-of-plane bending moment due to weight and other external loads (other than 
thermal expansion) 

𝑀𝑡 = torsional moment due to weight and other external loads (other than thermal 
expansion) 

𝑅 = axial force from weight and external loads (other than due to thermal expansion and 
pressure) 

𝐴 = un-corroded pipe metal cross-sectional area (i.e., before deducting for corrosion) 

𝑍 = un-corroded section modulus; for reduced outlets, effective section modulus 

𝑆 = Specified Minimum Yield Strength (SMYS) from para. PL-3.7.1 (a) 

𝑇 = Temperature derating factor from Table PL-3.7.1-3 

𝐸 = Young’s modulus at ambient temperature, i.e., at Tref in CAEPIPE 

𝑇𝑖 = installation temperature = Tref in CAEPIPE (see Note 1 below) 

𝑇𝑚 = warmest or coldest operating temperature (see Note 1 below) 

𝛼𝑚 = coefficient of thermal expansion at T0 in CAEPIPE (see Note 1 below) 

Note 1: 

If there are more than one thermal load, for example T1 and T2, then CAEPIPE calculates 

longitudinal stress 𝑆𝑇 due to thermal expansion as follows. 

For a change in temperature from Tref to T1, 𝑆𝑇1 = −𝐸𝛼1(𝑇1 − 𝑇𝑟𝑒𝑓) 

For a change in temperature from Tref to T2, 𝑆𝑇2 = −𝐸𝛼2(𝑇2 − 𝑇𝑟𝑒𝑓) 

For a change in temperature from T1 to T2, 𝑆𝑇1−.>𝑇2 = 𝑆𝑇2 − 𝑆𝑇1 
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Please note, that negative (-) sign is added in the above equations as the soil is restraining the 
thermal expansion / contraction of the buried pipe due to friction at the soil-to-pipe 
interface. 

Combined Stress for Restrained Pipe 

The combined biaxial stress state of the pipeline in the operating mode is evaluated using the 
calculation given below by default in CAEPIPE as per para. PL-2.6.4. To be conservative, 
Seq1 and Seq2 given below are in line with para. 833.4 of ASME B31.8. 

S𝑒𝑞 = max {𝑆𝑒𝑞1,𝑆𝑒𝑞2} ≤ 0.9𝑆𝑇 

where 

S𝑒𝑞 = equivalent combined stress  

 

S𝑒𝑞1 = max {|𝑆𝐻 − 𝑆𝐿𝑝|, |𝑆𝐻|, |𝑆𝐿𝑝|} 

S𝑒𝑞2 = max {|𝑆𝐻 − 𝑆𝐿𝑛|, |𝑆𝐻|, |𝑆𝐿𝑛|} 

Alternatively, the stresses may be combined in accordance with the maximum distortion 
energy theory as follows (see Note 3 below): 

S𝑒𝑞1 = √(𝑆𝐿𝑝)
2
− 𝑆𝐻𝑆𝐿𝑝 + (𝑆𝐻)2 

S𝑒𝑞2 = √(𝑆𝐿𝑛)2 − 𝑆𝐻𝑆𝐿𝑛 + (𝑆𝐻)2 

Notes: 

1. Young’s modulus of elasticity corresponding to the lowest operating temperature 
[=min(T1 through T10,Tref)] is used to form the stiffness matrix in accordance with paras. 
PL-2.5.3 (g) and PL-2.5.4 (b). 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

3. By default, CAEPIPE combines the stresses for restrained piping using the maximum 
shear stress theory as stated above. To combine stresses in accordance with the 
maximum distortion energy theory as stated above, turn ON the analysis option 
“Combine stresses as per Max. Distortion Energy Theory” through Layout Window > 
Options > Analysis > Code. 
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. IP-3.2.1 and IP-3.3.1.respectively. 

a

af

a
YtD

tSEM
P

2

2


  

where 

Pa= allowable pressure 

S = stress value for material from Table IX-1A 

E = quality factor from Table IX-2 or Table IX-3A 

Mf= material performance factor that addresses loss of material properties associated with 
hydrogen gas service from Tables IX-5B and IX-5C from Appendix IX. 

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

𝑑= inside diameter 

𝑌= coefficient from Table IP-3.2.1, valid for 𝑡𝑎 < 𝐷/6 for Ferritic and Austenitic steels. 
Refer to the Table listed at the end of this Section for details on ‘Y’ used in CAEPIPE 
for all available material.  

𝑌= 
𝑑+2𝑐

𝐷+𝑑+2𝑐
 , valid for 𝑡𝑎 ≥ 𝐷/6 for all material types. 

 
For closely spaced miter bends, the allowable pressure is calculated in CAEPIPE using Eq. 
(4b) from para. IP-3.3.3. 

𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 𝑟/2)
 

For widely spaced miter bends with 𝜃<= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4a) from para. IP-3.3.3 as 

𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643 tan 𝜃 √𝑟𝑡𝑎)
 

 

For widely spaced miter bends with 𝜃> 22.5 deg, the allowable pressure is calculated in 
CAEPIPE using Eq. (4c) from para. IP-3.3.3 as 
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𝑃𝑎 =
𝑆𝐸𝑀𝑓𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 tan 𝜃 √𝑟𝑡𝑎)
 

where 

𝑟= mean radius of pipe = (D- tn)/2 

𝑅 = effective bend radius of the miter (see para. IP-3.3.3 (d) of code for definition) [an input 
in CAEPIPE for miters] 

 = angle of miter cut 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eqs. (23a), (23b), (23c) and (23d) from para. 320.2 of ASME B31.3 
(2014) and compared against the allowable provided in para. IP-2.2.10. 

𝑆𝐿 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 ≤ 𝑆ℎ𝑀𝑓 

where 

𝑆𝑎 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

= [
𝑃𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

For branch (Leg 3 in Fig. 319.4.4B)of ASME B31.3 (2014), 

𝑆𝑏 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑒
]

𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑

 

 

𝑆𝑡 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑆𝑢𝑠𝑡𝑎𝑖𝑛𝑒𝑑 

𝑃= maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑆=wall thickness used for sustained stress calculation obtained by deducting corrosion 
allowance from the nominal thickness  

𝑡𝑆=  nominal thickness - corrosion allowance in CAEPIPE, as per para. 320.1ofASME B31.3 
(2014) 

𝐴𝑝=corroded cross-sectional area of the pipe computed using ts as per para. 320.1ofASME 

B31.3 (2014) 

𝐼𝑎= longitudinal force index = 1.0 

𝐹𝑎= longitudinal force due to sustained loads such as pressure and weight 

𝑅= axial force due to weight alone, where weight is computed using nominal thickness. 

𝐼𝑖= sustained in-plane moment index = 0.75𝑖𝑖 or 1.0, whichever is greater.  

𝐼𝑜= sustained out-of-plane moment index = 0.75𝑖𝑜 or 1.0, whichever is greater. 
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 where, 𝑖𝑖  and 𝑖𝑜 are taken from Appendix D of ASME B31.3 (2014) [reprinted at the 
end of this Section]. 

𝐼𝑡= torsional moment index = 1.0 

𝑀𝑖=in-plane bending moment due to sustained loads such as pressure and weight 

𝑀𝑜=out-of-plane bending moment due to sustained loads such as pressure and weight 

𝑀𝑡=torsional moment due to sustained loads such as pressure and weight 

𝑍𝑚=corroded section modulus as per para. 320.1ofASME B31.3 (2014) 

𝑍𝑒=effective corroded section modulus for branch as per para.320.2 of ASME B31.3 (2014) 

𝑀𝑓=material performance factor that addresses loss of material properties associated with 

hydrogen gas service from Tables IX-5B and IX-5C from Appendix IX. 

Sustained plus Occasional Stress 

The stress (𝑆𝐿𝑜) due to sustained and occasional loads is calculated as the sum of stress (𝑆𝐿) 
due to sustained loads such as pressure and weight and stress (𝑆𝑜) due to occasional loads 
such as earthquake or wind. Wind and earthquake are not considered as acting concurrently 
(see para. IP-2.2.11). 

For temp ≤ 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 1.33𝑆ℎ𝑀𝑓 

For temp > 4270 C or 8000 F 

𝑆𝐿𝑂 ≤ 0.9𝑊𝑆𝑦𝑀𝑓
 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above, and 𝑆𝑜 is calculated using Eqs. (23a), (23b), 
(23c) and (23d) of ASME B31.3 (2014) with applicable loads. 

𝑆𝑂 = √(|𝑆𝑎𝑜| + 𝑆𝑏𝑜)2 + (2𝑆𝑡𝑜)2 

𝑆𝑎𝑜 = [
𝐼𝑎𝐹𝑎
𝐴𝑝

]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

= [
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷

4𝑡𝑠
+
𝑅

𝐴𝑝
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑚
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

For branch (Leg 3 in Fig. 319.4.4B)of ASME B31.3 (2014) 

𝑆𝑏𝑜 = [
√(𝐼𝑖𝑀𝑖)2 + (𝐼𝑜𝑀𝑜)2

𝑍𝑒
]

𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑆𝑡𝑜 = [
𝐼𝑡𝑀𝑡

2𝑍𝑚
]
𝑂𝑐𝑐𝑎𝑠𝑖𝑜𝑛𝑎𝑙

 

𝑃𝑝𝑒𝑎𝑘 = peak pressure = (peak pressure factor in CAEPIPE) x P 
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𝑅 = axial force due to occasional loads such as earthquake or wind 

𝑀𝑖 = in-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑜 = out-of-plane bending moment due to occasional loads such as earthquake or wind 

𝑀𝑡= torsional moment due to occasional loads such as earthquake or wind 

𝑆𝑦= yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 

𝑊  = 1.0 for Austenetic stainless steel and 0.8 for other materials as per para. IP-2.2.11(a) 

𝑍𝑚 = corroded section modulus as per para. 320.1ofASME B31.3 (2014) 

𝑍𝑒 = effective corroded section modulus for branch as per para. 320.2ofASME B31.3 (2014) 

Note 1: 

The allowable stress equations for (𝑆𝐿𝑂)are taken from para. 302.3.6 of ASME B31.3 (2014), 
as the sentence “At temperatures warmer than 427 deg. C (800 deg.F), use 1.33.Sh.Mf” in 
para. IP-2.2.11 of ASME B31.12 (2014) code seems to be incorrectly worded.  

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated using Eq. 17 from para. IP-6.1.5 

𝑆𝐸 = √(|𝑆𝑎| + 𝑆𝑏)2 + (2𝑆𝑡)2 

where 

𝑆𝑎 = [
𝑖𝑎𝐹𝑎
𝐴
]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

For branch (Leg 3 in Fig. IP-6.1.5-2) 

𝑆𝑏 = [
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍𝑒
]

𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝑆𝑡 = [
𝑖𝑡𝑀𝑡
2𝑍

]
𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛

 

𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal 
 thickness 𝑡𝑛 and outer diameter D as per IP-6.1.4 (e). 

𝑖𝑎 = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
 𝑖𝑎 = 𝑖𝑜 𝑜𝑟 𝑖 for other components as listed in Appendix D of B31.3 (2014) 

𝐹𝑎 = range of axial force due to displacement strains between any two thermal conditions 
 being evaluated 

𝑖𝑖 = in-plane stress intensification factor from Appendix D of ASME B31.3 (2014) 
  shallnot be less than 1.0 

𝑖𝑜 = out-of-plane stress intensification factor Appendix D of ASME B31.3 (2014) 
  shall not be less than 1.0 
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𝑖𝑡 = torsional stress intensification factor = 1.0 
𝑀𝑖 = in-plane bending moment  
𝑀𝑜 = out-of-plane bending moment  
𝑀𝑡 = torsional moment 

𝑍 = un-corroded section modulus as per IP-6.1.4 (e) 

𝑍𝑒 = un-corroded effective section modulus as per IP-6.1.4 (e) 
 

𝑆𝐴 = 𝑓(1.25𝑆𝐶 + 0.25𝑆ℎ), Eq. (1a) of para. IP-2.2.10 (d) 

𝑓 = stress range reduction factor from Eq. (1c) of para. IP-2.2.10 (d) = 6N-0.2 
  where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below) 
𝑆𝐶 = basic allowable stress at minimum metal temperature expected during the 

 displacement cycle under analysis 
𝑆ℎ = basic allowable stress at maximum metal temperature expected during the 

 displacement cycle under analysis 
When 𝑆ℎ is greater than Sustained Stress 𝑆𝐿, the allowable stress range may be calculated as  

𝑆𝐴 = 𝑓[1.25(𝑆𝐶 + 𝑆ℎ) − 𝑆𝐿], Eq. (1b) of para. IP-2.2.10 (d).
 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 

Notes: 

4. As per para. IP-2.2.10 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at metal 
temperatures ≤ 371°C (700°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not available 
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

5. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. IP-6.1.5 (d)(1). 

6. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”. 

Notes on Material Library for B3112-2014.mat supplied with CAEPIPE: 

Material library for ASME B31.12 (2014) [B3112-2014.mat] supplied with CAEPIPE has 
been created by referring to the values provided in Appendix IX of ASME B31.12 (2014).  
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Coefficient ‘Y’ used in CAEPIPE to compute Allowable Design Pressure  

[Sl. Nos. 1 & 2 below are from Table IP-3.2.1 and Sl. Nos. 3, 4 & 5 are from Table 304.1.1 of ASME 

B31.3 (2014)] 

Sl. 
No. Material Type 

Values of ‘Y’ for Temperature, Deg F (Deg C) 

900 
(482) 
and 

below 

950 
(510) 

1000 
(538) 

1050 
(566) 

1100 
(593) 

1150 
(621) 

1200 
(649) 

1250 
(677) 
and 

above 

1. Ferritic Steels 
(FS) 

0.4 0.5 0.7 0.7 0.7 0.7 0.7 0.7 

2. Austenitic Steel 
(AS)  

0.4 0.4 0.4 0.4 0.5 0.7 0.7 0.7 

3. Nickel Alloys 
(NA) 

0.4 0.4 0.4 0.4 0.4 0.4 0.5 0.7 

4. Gray Iron / Cast 
Iron (CI) 

0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 

5. Material Types 
other than those 
stated from Sl. 
Nos. 1 to 4. 

0.4 0.4 0.4 0.4 0.4 0.4 0.4 0.4 

 

Carbon Steel Piping Materials Performance Factor (Mf) used in CAEPIPE for Material Type as 
“CS” (from Table IX-5B) 

Sl. 
No. 

Specified Min. Yield 
Strength (ksi) 

System Design Pressure, psig 

<=1000 2000 3000 4000 5000 6000 

1. <= 52 1.000 0.948 0.912 0.884 0.860 0.839 

2. <= 56 0.930 0.881 0.848 0.824 0.800 0.778 

3. <= 65 0.839 0.796 0.766 0.745 0.724 0.706 

4. <= 80 0.715 0.678 0.645 0.633 0.618 0.600 

 
Low and Intermediate Alloy Steel Piping Materials Performance Factor (Mf) used in CAEPIPE 

for Material Type as “AS” (from Table IX-5C) 

Sl. 
No. 

Specified Min. Tensile 
Strength (ksi) 

System Design Pressure, psig 

0.000 1000 2000 3000 4000 5000 6000 

1. <= 35 1.000 0.918 0.881 0.875 0.836 0.815 0.800 

2. <= 45 0.791 0.724 0.696 0.675 0.660 0.642 0.630 

3. <= 60 0.655 0.601 0.577 0.561 0.547 0.533 0.524 

4. <= 65 0.580 0.532 0.511 0.497 0.485 0.472 0.464 

 
Note: 
For materials not covered by Tables given above, Material Performance Factor (Mf) is taken as 1.00.
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 Implemented as an optional feature for B31.5 and B31.8 codes. This feature can 
be turned ON or OFF through Layout Frame > Options > Analysis.  

 When B31J is applied, it will allow users to select and specify among those 
Branch SIF types defined in B31J for the Piping Code selected for analysis. 

 When B31J is applied, CAEPIPE will calculate SIFs as per B31J and report 
Torsional, In-plane and Out-of-plane SIFs in Element Forces and Moments 
results irrespective of whether they are being used or not in Code Compliance as 
per the Piping Code selected for Analysis. For Example, CAEPIPE will not 
include Torsional Moment and Torsional SIF while calculating Sustained and 
Occasional Stresses as per ASME B31.5 (2022). 

 For Equal TEEs, the Run and Branch should be differentiated in CAEPIPE 
model by defining the Branch OD slightly less than the Run OD through 
CAEPIPE Sections input. Otherwise, CAEPIPE will use the equations 
corresponding to Run pipe even for Branch pipe. 

 ASME B31.3 (2022) includes the term Axial SIF in Stress Calculations. On the 
other hand, B31J is silent about the Axial SIF for various components. Hence, 
CAEPIPE will use the Axial SIF values as stated in the respective text portions of 
ASME B31.3 (2022) code while computing stresses. 

 As per para 402.6.1 of ASME B31.4 (2022), Torsion moment is not included in 
the equation for Sustained Stress for Restrained piping. In line with this ASME 
B31.4 (2022) code, CAEPIPE will not use Torsion Moment and Torsion SIF 
while calculating Sustained Stress for Restrained pipe. 

 For ASME B31.5 (2022), paras. 502.3.2(d), 502.3.3(a), 519.4.5 and 519.3.5 do not 
include Torsional moment in computing Stresses. Accordingly, CAEPIPE will 
not include Torsional Moment and Torsional SIF while calculating Stresses as per 
ASME B31.5 (2022) even when the option B31J is turned ON. 

 For ASME B31.8 (2022), para. 833.2 (e) states that the nominal Bending Stress 
for Fittings and Components as MR/Z, where MR is the resultant intensified 
moment across the fittings or components with Stress Intensification Factor 
(SIF) as 0.75i, where 0.75i cannot be less than 1.0. 

On the other hand, for Pipe and Long Radius Bends, para.833.2 (d) of the Code 
states that the nominal Bending Stress as M/Z, where M is the bending moment 
across the pipe cross section without SIF being considered. In other words, the 
moments are NOT intensified for Pipe and Long Radius Bends. 

 As ASME B31.8 (2022) does not include SIF for Pipe and Long Radius Bends in 
Sustained Stress equation, SIF calculated as per B31J will NOT be included in 
Sustained Stress calculation for Pipes and Long Radius bends at this time even 
when the option B31J is turned ON. However, the SIF calculated as per B31J will 
be displayed in the Element Forces and Moments results, but will not be used.  
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 When B31J is turned ON, In-plane and Out-of-plane Flexibility Factors for 
Bends, Miter bends and TEEs will be calculated as per B31J and included by 
CAEPIPE in the corresponding element stiffness matrices. Similarly, CAEPIPE 
will calculate the Torsion Flexibility Factors as per B31J and include them in the 
element stiffness matrices irrespective of whether the code includes or excludes 
Torsional Moment and Torsional SIF in Stress equations.  

 As it is not possible to identify the number of Flanges or Rigids at Run Pipe ends 
located within 0.1D^1.4/T^0.4 from Branch intersection node using CAEPIPE 
(required for applying the correction factor while computing Flexibility Factors as 
per B31J), a provision is made in the Branch SIF definition to manually input the 
no. of Flanges or Rigids that fall within the distance given by B31J. 

 When the bend angle is 90 degree and the thickness of the bend is equal to the 
thickness of the matching pipe, as per B31J (2023) the Ki and Ko should be 
calculated from 1.3/h. This is NOT implemented in CAEPIPE at this time. 

 Flexibility Factors computed for TEEs as per B31J are always applied to both 
ends of the first elements belonging to Leg 1, Leg 2 and Leg 3 that are connected 
at the Branch node as shown in Figure 1-1 of B31J.  

CAEPIPE includes a feature to automatically refine the elements connected to 
the Branch node as given detailed to compute and apply Flexibility Factors for 
Run (Leg 1 and Leg 2) and Branch Pipe (Leg 3). 

a. Two (2) nodes on Run Pipe (one on either side of the Branch SIF node) at a 
distance equal to Run Split Factor x Run Pipe OD, where the Run Split 
Factor can be input by the user.  

b. One (1) node on Branch Pipe at a distance equal to Branch Split Factor x Run 
Pipe OD from the Branch SIF node, where the Branch Split Factor can be 
input by the user. 
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Kb 

Kr 
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Changes between ASME B31J (2017) and ASME B31J (2023) are summarized 

below for easy reference. 

Item #1 

For Table 1-1, Sketch 1.1, Equations for SIF In-plane and 
Out-of-plane for Pipe Bend or Welding Elbow: The division 
sign, which was mistakenly omitted in B31J (2017), has now been 
included in B31J (2023). 

ASME B31J (2017) 
 

ASME B31J (2023) 
 

Remarks 

Although the division sign was omitted in B31J (2017), the 
CAEPIPE implementation was correct since Version 8.00, as it 
included the division. As a result, there will be no change in SIF 
values for Pipe Bend or Welding Elbows in a stress layout 
analyzed using both earlier and current versions of CAEPIPE. 

 

Item #2 

Run in-plane SIF for Sketch 2.2 (Reinforced Fabricated 
TEE). The exponent value for (d/D) has been updated from 
0.54 to 1.0, and the sign in front of 0.34 has been changed to 
negative, as shown below. 

ASME B31J (2017) 
 

ASME B31J (2023) 
 

Remarks 

Modifications shown above are implemented in CAEPIPE 
starting with Version 13.10. As a result, the calculated Run in-
plane SIF value for Reinforced Fabricated Tee may differ from 
those produced by earlier versions of CAEPIPE. 
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Item #3 
Branch in-plane SIF for Sketch 2.2 (Reinforced Fabricated 
TEE): The extra bracket that was mistakenly included in B31J 
(2017) has been removed in the B31J (2023) edition. 

ASME B31J (2017) 
 

ASME B31J (2023) 
 

Remarks 

Although an extra bracket was displayed in B31J (2017), the 
CAEPIPE implementation was correct since Version 8.00, as it 
was done without the additional bracket. Hence, there will be no 
change in Branch in-plane SIF values for Reinforced Fabricated 
Tee modeled in a stress layout analyzed using both earlier and 
current versions of CAEPIPE. 

 

Item #4 

Branch out-of-plane SIF for Sketch 2.2 (Reinforced 
Fabricated TEE): The extra bracket that was mistakenly 
included in B31J (2017) has been removed in the B31J (2023) 
edition. 

ASME B31J (2017) 

 

ASME B31J (2023) 

 

Remarks 

Although an extra bracket was displayed in B31J (2017), the 
CAEPIPE implementation was correct since Version 8.00, as it 
was done without the additional bracket. Hence, there will be no 
change in Branch out-of-plane SIF values for Reinforced 
Fabricated Tee modeled in a stress layout analyzed using both 
earlier and current versions of CAEPIPE. 
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Item #5 
Run in-plane SIF for Sketch 2.3 (Fabricated TEE). The 
exponent value for (d/D) has been updated from 0.5 to 1.0 as 
shown below. 

ASME B31J (2017) 

 

ASME B31J (2023) 

 

Remarks 

Modification shown above is implemented in CAEPIPE starting 
with Version 13.10. As a result, the calculated Run in-plane SIF 
value for Fabricated Tee may differ from those produced by 
earlier versions of CAEPIPE. 

 

Item #6 
Branch out-of-plane SIF for Sketch 2.3 (Fabricated TEE). 
When t/T < 0.85, use t/T = 0.85 has been updated to when t/T 
< 0.6, use t/T = 0.6 as shown below. 

ASME B31J (2017) 
 

ASME B31J (2023) 
 

Remarks 

Modification shown above is implemented in CAEPIPE starting 
with Version 13.10. As a result, the calculated Run in-plane SIF 
value for Fabricated Tee may differ from those produced by 
earlier versions of CAEPIPE. 

 

Item #7 
Run in-plane SIF for Sketch 2.4 (Extruded Outlet): Sign in 
front of 0.52 has been changed to negative, as shown below. 

ASME B31J (2017) 
 

ASME B31J (2023) 
 

Remarks 

Modification shown above is implemented in CAEPIPE starting 
with Version 13.10. As a result, the calculated Run in-plane SIF 
value for Extruded Outlet may differ from those produced by 
earlier versions of CAEPIPE. 
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 Implemented as an optional feature for B31.4, B31.5, B31.8 and B31.12 codes. This 
feature can be turned ON or OFF through Layout Frame > Options > Analysis.  

 Turning on the Option B31J will allow users to select and specify among those 
Branch SIF types defined in B31J for all the above codes. 

 When B31J is turned ON, CAEPIPE will calculate SIFs as per B31J and report 
Torsional, In-plane and Out-of-plane SIFs in Element Forces and Moments results 
irrespective of whether they are being used or not in Code Compliance as per the 
Piping Code selected for Analysis. For Example, CAEPIPE will not include 
Torsional Moment and Torsional SIF while calculating Sustained Stress as per ASME 
B31.5 (2016). 

 For Equal TEEs, the Run and Branch should be differentiated in CAEPIPE model 
by defining the Branch OD slightly less than the Run OD through CAEPIPE 
Sections input. Otherwise, CAEPIPE will use the equations corresponding to Run 
pipe even for Branch pipe. 

 ASME B31.3 (2020) includes the term Axial SIF in Stress Calculations. On the other 
hand, B31J is silent about the Axial SIF for various components. Hence, CAEPIPE 
will use the Axial SIF values as stated in the respective text portions of B31.3 (2016) 
while computing stresses irrespective of whether the option B31J is turned ON or 
OFF. 

 As per para 402.6.1 of ASME B31.4 (2019), Torsion moment is not included in the 
equation for Sustained Stress for Restrained piping. In line with the code, CAEPIPE 
will not use Torsion Moment and Torsion SIF while calculating Sustained Stress for 
Restrained pipe even with the option B31J turned ON. 

 For ASME B31.5 (2019), paras. 502.3.2(d), 502.3.3 (a), 519.4.5 and 519.3.5 do not 
include Torsional moment in computing Stresses. Accordingly, CAEPIPE will not 
include Torsional Moment and Torsional SIF while calculating Stresses as per ASME 
B31.5 (2016) even when the option B31J is turned ON. 

 For ASME B31.8 (2020), para. 833.2 (e) states that the nominal Bending Stress for 
Fittings and Components as MR/Z, where MR is the resultant intensified moment 
across the fittings or components with Stress Intensification Factor (SIF) as 0.75i. 

On the other hand, for Pipe and Long Radius Bends, para.833.2 (d) of the Code 
states that the nominal Bending Stress as M/Z, where M is the bending moment 
across the pipe cross section without SIF being considered. In other words, the 
moments are NOT intensified for Pipe and Long Radius Bends. 

 As ASME B31.8 (2020) does not include SIF for Pipe and Long Radius Bends in 
Sustained Stress equation, SIF calculated as per B31J will NOT be included in 
Sustained Stress calculation for Pipes and Long Radius bends at this time when the 
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option B31J is selected. On the other hand, the SIF calculated as per B31J will be 
displayed in the Element Forces and Moments results.  

 When B31J is turned ON, In-plane and Out-of-plane Flexibility Factors for Bends, 
Miter bends and TEEs will be calculated as per B31J and included by CAEPIPE in 
the corresponding element stiffness matrices. Similarly, CAEPIPE will calculate the 
Torsion Flexibility Factors as per B31J and include them in the element stiffness 
matrices irrespective of whether the code includes or excludes Torsional Moment 
and Torsional SIF in Stress equations.  

 As it is not possible to identify the number of Flanges or Rigids at Run Pipe ends 
located within 0.1D^1.4/T^0.4 from Branch intersection node using CAEPIPE 
(required for applying the correction factor while computing Flexibility Factors as per 
B31J), a provision is made in the Branch SIF definition to input the no. of Flanges or 
Rigids that fall within the distance given by B31J. 

 When the bend angle is 90 degree and the thickness of the bend is equal to the 
thickness of the matching pipe, the Ki and Ko should be calculated from 1.3/h. This 
is not implemented in CAEPIPE software at this time. 

 Flexibility Factors computed for TEEs as per B31J are always applied to both ends 
of the first elements belonging to Leg 1, Leg 2 and Leg 3 that are connected at the 
Branch nodeas shown in Figure 1-1 of B31J.  

CAEPIPE includes a feature “Layout Frame > Edit > Refine Branches for B31J” to 
refine the elements connected to the Branch node to compute and apply Flexibility 
Factors for Run (Leg 1 and Leg 2) and BranchPipe (Leg 3) as stated above. 

When the above command is used, CAEPIPE will add the following. 

c. Two (2) nodes on Run Pipe (one on either side of the Branch SIF node) at a 
distance equal to Run Split Factor x Run Pipe OD, where the Run Split Factor 
can be input by the user.  

d. One (1) node on Branch Pipe at a distance equal to Branch Split Factor x Run 
Pipe OD from the Branch SIF node, where the Branch Split Factor can be input 
by the user. 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃 = allowable pressure 

𝑆 = allowable stress 

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowances 

 = 𝑡 × (1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 9 of NC-3652. 

𝑆𝐿 =
𝑃𝐷

4𝑡
+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑃 = maximum pressure 

𝐷 = outside diameter 

𝑡 = nominal wall thickness 

𝑖 = stress intensification factor.  The product 0.75i, shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus, for reduced outlets, effective section modulus 

𝑆ℎ = hot allowable stress 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂) such as earthquake or wind from Equation 10 of NC-3652.2. Wind 
and earthquake are not considered concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 +
0.75𝑖𝑀𝐵

𝑍
≤ 1.2𝑆ℎ 

where 

𝑀𝐵 = resultant moment due to occasional loads  
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation 11 of NC-3652.3. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑀𝐶 = resultant moment due to thermal expansion 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) 
𝑆𝑐 = allowable stress at cold temperature 

𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 
The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 13 of NC-3652.2. 

𝑆𝑇𝐸 = 𝑆𝐿 + 𝑆𝐸 ≤ 𝑆ℎ + 𝑆𝐴 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃 = allowable pressure 

𝑆 = allowable stress 

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowance 

 = 𝑡 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NC-3652. 

𝑆𝐿 = 𝐵1
𝑃𝐷

2𝑡
+ 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from NB-3680 

𝑃 = maximum pressure 

𝐷 = outside diameter 

𝑡 = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus, for reduced outlets, effective section modulus 

𝑆ℎ = hot allowable stress 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂) such as earthquake or wind from Equation 9 of NC-3653.1. Wind 
and earthquake are not considered concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 +𝐵2
𝑀𝐵
𝑍
≤ 1.8𝑆ℎ 

where 

𝑀𝐵 = resultant moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation 10 of NC-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor 

𝑀𝐶 = resultant moment due to thermal expansion 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) 
𝑆𝑐 = allowable stress at cold temperature 

𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NC-3653.2(c). 

𝑆𝑇𝐸 =
𝑃𝐷

4𝑡
+
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆ℎ + 𝑆𝐴 

0.75i shall not be less than 1.0. 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃 = allowable pressure 

𝑆 = allowable stress 

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowance 

 = 𝑡 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NC-3652 (in case the option “Include Axial force 
in stress calculations” is turned OFF). 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) + 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from NB-3680 

𝑃 = internal Design Pressure = maximum of CAEPIPE Input pressures P1 through 
P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-
3653.3(d) 

𝑆ℎ = material allowable stress at Design Temperature = maximum of CAEPIPE Input 
Temperatures T1 through T10 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 8 of NC-3652 as follows. 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] + 𝐵2
𝑀𝐴
𝑍
≤ 1.5𝑆ℎ
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As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SL may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂) (such as earthquake or wind) from Equation 9 of NC-3653.1 (in 
case the option “Include Axial force in stress calculations” is turned OFF).Wind and 
earthquake are not considered concurrently. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑓𝑝𝑃𝐷

4𝑡𝑛
)+ 𝐵2 (

𝑀𝐴 +𝑀𝐵
𝑍

) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 9a as follows. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑓𝑝𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

+ (
𝐹

𝐴
)
𝑜𝑐𝑐𝑎

] + 𝐵2 (
𝑀𝐴 +𝑀𝐵

𝑍
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

where 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐵 = resultant moment due to occasional loads, inclusive of seismic anchor movements 

= √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑓𝑝 = peak pressure factor input into CAEPIPE 

𝑃 = internal Design Pressure defined above 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-
3653.3(d) 

𝑆𝐿𝑂(All)= minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NC-3653.1 

 =minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NC-3654.2 (a) 
 = minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NC-3655 (a)(2) 

𝑆ℎ = material allowable stress at Design Temperature defined above 

𝑆𝑦 = material yield strength at Design Temperature 

As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SLO may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation (10a) of NC-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from NB-3680 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NC-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

f    = stress range reduction factor from Table NC-3611.2(e)-1 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NC-3653.2(c) (in case the option “Include Axial force in stress 
calculations” is turned OFF).. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) +

0.75𝑖𝑀𝐴
𝑍

+
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐻 + 𝑆𝐴 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 11 as follows. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] +
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐻 + 𝑆𝐴 

0.75i shall not be less than 1.0. 

where 

𝑃    = internal Design Pressure = maximum of CAEPIPE Input pressures P1 through P10 

𝐷   = outside diameter 

𝑡𝑛  = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NC-
3611.2(e) 
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𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

𝑆𝐻   = material allowable stress at Design Temperature defined above 

𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 

Settlement Stress 

The stress (𝑆𝑆) due to single nonrepeated anchor movement (e.g., predicted building 
settlement) is calculated from Equation (10b) of NC-3653.2. 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from Table NC-3673.2(b)-1 

𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted 
building settlement) 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃𝑎 = allowable pressure 

𝑆 = allowable stress for the material at the Design Temperature  

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowance 

 = 𝑡 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NC-3652 (in case the option “Include Axial force 
in stress calculations” is turned OFF). 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) + 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from Table NC-3673.2(b)-1 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-
3653.3(d) 

𝑆ℎ= material allowable stress at maximum of CAEPIPE Inputtemperatures T1 through 
T10  

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 8 of NC-3652 as follows. 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] + 𝐵2
𝑀𝐴
𝑍
≤ 1.5𝑆ℎ



ASME Section III, Subsection NC - Class 2 (2015) 
 

348 
 

 

As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SL may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂) (such as thrusts from relief and safety valve loads from pressure and 
flow transients, and reversing and nonreversing dynamic loads, if the Design Specification 
requires calculation of moments due to reversing and non-reversing dynamic loads) from 
Equation 9a of NC-3653.1 (in case the option “Include Axial force in stress 
calculations” is turned OFF). 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑓𝑝𝑃𝐷

4𝑡𝑛
)+ 𝐵2 (

𝑀𝐴 +𝑀𝐵
𝑍

) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 9aof NC-3653.1as follows. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑓𝑝𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

+ (
𝐹

𝐴
)
𝑜𝑐𝑐𝑎

] + 𝐵2 (
𝑀𝐴 +𝑀𝐵

𝑍
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

where 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐵 = resultant moment due to occasional loads, inclusive of seismic anchor movements   
and movements due to reversing and nonreversing dynamic loads 

 = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑓𝑝 = peak pressure factor input into CAEPIPE 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-
3653.3(d) 

𝑆𝐿𝑂(All)= minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NC-3653.1 

 =minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NC-3654.2 (a) 
 = minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NC-3655 (a)(2) 

𝑆ℎ= material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10 

𝑆𝑦= material yield strength at maximum of CAEPIPE Input temperatures T1 through 

T10 

As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SLO may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 
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Note: 

Movements at anchors and nozzles due to seismic event and due to reversing and 
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they 
will be included as a part of the Occasional Stress evaluation given above. 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation (10a) of NC-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Table NC-3673.2(b)-1 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NC-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

f    = stress range reduction factor from Table NC-3611.2(e)-1 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NC-3653.2(c) (in case the option “Include Axial force in stress 
calculations” is turned OFF).. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) +

0.75𝑖𝑀𝐴
𝑍

+
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐻 + 𝑆𝐴 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 11of NC-3653.2(c)as follows. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] +
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐻 + 𝑆𝐴 

0.75i shall not be less than 1.0. 

where 

𝑃    = maximum of CAEPIPE Input pressures P1 through P10 

𝐷   = outside diameter 

𝑡𝑛  = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 
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𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NC-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

𝑆𝐻  = material allowable stress at maximum of CAEPIPE Input temperatures T1 through 
T10 

𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 

Settlement Stress 

The stress (𝑆𝑆) due to single nonrepeated anchor movement (e.g., predicted building 
settlement) is calculated from Equation (10b) of NC-3653.2. 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from Table NC-3673.2(b)-1 

𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted 
building settlement) 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 
  



ASME Section III, Subsection NC - Class 2 (2015) 
 

351 
 

 

 
Additional Note for Welding elbow or Pipe bend: 
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.  

 
Additional Note for Reinforced fabricated tee: 
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where 
r’m is the mean radius of the branch leg. 
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Additional Note for Circumferential fillet welded or socket welded joints: 

Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3 
respectively in CAEPIPE for the following reasons. 

1. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded 
flanges. 

2. The definition of Cx as per Note 11 of Table NC-3673.2(b)-1 contradicts with the definition 
of Cx as defined in Notes (3) and (4) of Figure NC-4427-1.  
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃𝑎 = allowable pressure 

𝑆 = allowable stress for the material at the Design Temperature  

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowance 

 = 𝑡 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NC-3652 (in case the option “Include Axial force 
in stress calculations” is turned OFF). 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) + 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from Table NC-3673.2(b)-1 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-
3653.3(d) 

𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10  

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 8 of NC-3652 as follows. 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] + 𝐵2
𝑀𝐴
𝑍
≤ 1.5𝑆ℎ
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As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SL may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂) (such as thrusts from relief and safety valve loads from pressure and 
flow transients, and reversing and nonreversing dynamic loads, if the Design Specification 
requires calculation of moments due to reversing and nonreversing dynamic loads) from 
Equation 9a of NC-3653.1 (in case the option “Include Axial force in stress 
calculations” is turned OFF). 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑓𝑝𝑃𝐷

4𝑡𝑛
)+ 𝐵2 (

𝑀𝐴 +𝑀𝐵
𝑍

) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 9aof NC-3653.1as follows. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑓𝑝𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

+ (
𝐹

𝐴
)
𝑜𝑐𝑐𝑎

] + 𝐵2 (
𝑀𝐴 +𝑀𝐵

𝑍
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

where 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐵 = resultant moment due to occasional loads, inclusive of seismic anchor movements   
and movements due to reversing and non-reversing dynamic loads 

 = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑓𝑝 = peak pressure factor input into CAEPIPE 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NC-
3653.3(d) 

𝑆𝐿𝑂(All)= minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NC-3653.1 

 =minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NC-3654.2 (a) 
 = minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NC-3655 (a)(2) 

𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10 

𝑆𝑦        = material yield strength at maximum of CAEPIPE Input temperatures T1 through 

T10 

As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SLO may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 
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Note: 

Movements at anchors and nozzles due to seismic event and due to reversing and 
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they 
will be included as a part of the Occasional Stress evaluation given above. 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation (10a) of NC-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Table NC-3673.2(b)-1 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NC-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

f    = stress range reduction factor from Table NC-3611.2(e)-1 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NC-3653.2(c) (in case the option “Include Axial force in stress 
calculations” is turned OFF).. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) +

0.75𝑖𝑀𝐴
𝑍

+
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐻 + 𝑆𝐴 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 11of NC-3653.2(c)as follows. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] +
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐻 + 𝑆𝐴 

0.75i shall not be less than 1.0. 

where 

𝑃    = maximum of CAEPIPE Input pressures P1 through P10 

𝐷   = outside diameter 

𝑡𝑛  = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 



ASME Section III, Subsection NC - Class 2 (2017) 
 

358 
 

 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NC-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

𝑆𝐻  = material allowable stress at maximum of CAEPIPE Input temperatures T1 through 
T10 

𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 

Settlement Stress 

The stress (𝑆𝑆) due to single nonrepeated anchor movement (e.g., predicted building 
settlement) is calculated from Equation (10b) of NC-3653.2. 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from Table NC-3673.2(b)-1 

𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted 
building settlement) 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NC-3653.3(d) 
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Additional Note for Welding elbow or Pipe bend: 
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.  

 
Additional Note for Reinforced fabricated tee: 
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where 
r’m is the mean radius of the branch leg. 
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Additional Note for Circumferential fillet welded or socket welded joints: 

Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3 
respectively in CAEPIPE for the following reasons. 

3. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded 
flanges. 

4. The definition of Cx as per Note 11 of Table NC-3673.2(b)-1 contradicts with the definition 
of Cx as defined in Notes (3) and (4) of Figure NC-4427-1.  
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of ND-
3641.1. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃𝑎 = allowable pressure 

𝑆 = allowable stress for the material at the Design Temperature 

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowance 

 = 𝑡 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of ND-3652 (in case the option “Include Axial force 
in stress calculations” is turned OFF). 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) + 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from Table ND-3673.2(b)-1 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus; for reduced outlets, effective section modulus as per ND-
3653.3(d) 

𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 8 of ND-3652 as follows. 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] + 𝐵2
𝑀𝐴
𝑍
≤ 1.5𝑆ℎ
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As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SL may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂) (such as thrusts from relief and safety valve loads from pressure and 
flow transients, and reversing and nonreversing dynamic loads, if the Design Specification 
requires calculation of moments due to reversing and non-reversing dynamic loads) from 
Equation 9a of ND-3653.1 (in case the option “Include Axial force in stress 
calculations” is turned OFF). 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑓𝑝𝑃𝐷

4𝑡𝑛
)+ 𝐵2 (

𝑀𝐴 +𝑀𝐵
𝑍

) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 9aof ND-3653.1as follows. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑓𝑝𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

+ (
𝐹

𝐴
)
𝑜𝑐𝑐𝑎

] + 𝐵2 (
𝑀𝐴 +𝑀𝐵

𝑍
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

where 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐵 = resultant moment due to occasional loads, inclusive of seismic anchor movements 
and movements due to reversing and non-reversing dynamic loads 

= √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑓𝑝 = peak pressure factor input into CAEPIPE 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑍 = section modulus; for reduced outlets, effective section modulus as per ND-
3653.3(d) 

𝑆𝐿𝑂(All)= minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per ND-3653.1 

 =minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per ND-3654.2 (a) 
 = minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per ND-3655 (a)(2) 

𝑆ℎ= material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10 

𝑆𝑦        = material yield strength at maximum of CAEPIPE Input temperatures T1 through 

T10 

As an option, the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above equations for SLO may be replaced 

with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > Analysis > Pressure. 
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Note: 

Movements at anchors and nozzles due to seismic event and due to reversing and non-
reversing dynamic loads are to be input as “specified displacements” for seismic and they will 
be included as a part of the Occasional Stress evaluation given above. 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation (10a) of ND-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Table ND-3673.2(b)-1 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per ND-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per ND-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

f    = stress range reduction factor from Table ND-3611.2(e)-1 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of ND-3653.2(c) (in case the option “Include Axial force in stress 
calculations” is turned OFF).. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) +

0.75𝑖𝑀𝐴
𝑍

+
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐻 + 𝑆𝐴 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 11of ND-3653.2(c)as follows. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] +
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐻 + 𝑆𝐴 

0.75i shall not be less than 1.0. 

where 

𝑃    = maximum of CAEPIPE Input pressures P1 through P10 

𝐷   = outside diameter 

𝑡𝑛  = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 
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𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per ND-3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per ND-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

𝑆𝐻  = material allowable stress at maximum of CAEPIPE Input temperatures T1 through 
T10 

𝑓 = stress range reduction factor from Table ND-3611.2(e)-1 

Settlement Stress 

The stress (𝑆𝑆) due to single non-repeated anchor movement (e.g., predicted building 
settlement) is calculated from Equation (10b) of ND-3653.2. 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from Table ND-3673.2(b)-1 

𝑀𝐷 = resultant moment due to any single nonrepeated anchor movement (e.g., predicted 
building settlement) 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 

𝑍     = section modulus; for reduced outlets, effective section modulus as per ND-3653.3(d) 
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Additional Note for Welding elbow or Pipe bend: 
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.  

 
Additional Note for Reinforced fabricated tee: 
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where 
r’m is the mean radius of the branch leg. 
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Additional Note for Circumferential fillet welded or socket welded joints: 

Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3 
respectively in CAEPIPE for the following reasons. 

5. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded 
flanges. 

6. The definition of Cx as per Note 11 of Table ND-3673.2(b)-1 contradicts with the definition 
of Cx as defined in Notes (3) and (4) of Figure ND-4427-1.  
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NCD-
3641.1. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃𝑎 = allowable pressure 

𝑆 = allowable stress for the material at the Design Temperature  

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, after deducting mechanical and corrosion allowance 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter 

𝑑 = nominal inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NCD-3652 (in case the option “Include Axial 
force in stress calculations” is turned OFF). 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) + 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from Table NCD-3673.2(b)-1 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = nominal outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑀𝐴 = resultant moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10  

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 8 of NCD-3652 as follows. 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹𝑆
𝐴
)
𝑠𝑢𝑠𝑡

] + 𝐵2
𝑀𝐴
𝑍
≤ 1.5𝑆ℎ
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where 

𝐹𝑆 = axial force due to sustained loads 

𝐴 = nominal metal area 

As an option, as suggested in NCD-3651 (a), the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above 

equations for SL may be replaced with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > 

Analysis > Pressure. 

Occasional Stress 

The occasional stress (𝑆𝐿𝑂) due to sustained loads (pressure, weight and other sustained 
mechanical loads) and stress due to occasional loads (such as thrusts from relief and safety 
valve loads, pressure and flow transients, and reversing and nonreversing dynamic loads, if 
the Design Specification requires calculation of moments due to reversing and nonreversing 
dynamic loads) is calculated from Equation 9a of NCD-3653.1 (in case the option 
“Include Axial force in stress calculations” is turned OFF). 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑓𝑝𝑃𝐷

4𝑡𝑛
)+ 𝐵2 (

𝑀𝐴 +𝑀𝐵
𝑍

) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 9a of NCD-3653.1as follows. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑓𝑝𝑃𝐷

4𝑡𝑛
) + (

𝐹𝑆
𝐴
)
𝑠𝑢𝑠𝑡

+ (
𝐹𝑂
𝐴
)
𝑜𝑐𝑐𝑎

] + 𝐵2 (
𝑀𝐴 +𝑀𝐵

𝑍
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

where 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐵 = resultant moment due to occasional loads, inclusive of seismic anchor movements   
and movements due to reversing and non-reversing dynamic loads 

 = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑓𝑝 = peak pressure factor input into CAEPIPE 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = nominal outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆𝐿𝑂(All)= minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NCD-3653.1 

 = minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NCD-3654.2 (a) 
 = minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NCD-3655 (a)(2) 

𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10 

𝑆𝑦        = material yield strength at maximum of CAEPIPE Input temperatures T1 through 

T10 

𝐹𝑂 = axial force due to occasional loads 
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𝐴 = nominal metal area 

As an option, as suggested in NCD-3651 (a), the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above 

equations for SLO may be replaced with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > 

Analysis > Pressure. 

Note: 

Movements at anchors and nozzles due to seismic event and due to reversing and 
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they 
will be included as a part of the Occasional Stress evaluation given above. 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation (10a) of NCD-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Table NCD-3673.2(b)-1 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NCD-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

f    = stress range reduction factor from Table NCD-3611.2(e)-1 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NCD-3653.2(c) (in case the option “Include Axial force in stress 
calculations” is turned OFF).. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) +

0.75𝑖𝑀𝐴
𝑍

+
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐻 + 𝑆𝐴 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 11 of NCD-3653.2(c) as follows. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] +
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐻 + 𝑆𝐴 

0.75i shall not be less than 1.0. 

where 
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𝑃    = maximum of CAEPIPE Input pressures P1 through P10 

𝐷   = nominal outside diameter 

𝑡𝑛  = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 

inclusive of moment ONLY due to thermal anchor movements = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NCD-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

𝑆𝐻  = material allowable stress at maximum of CAEPIPE Input temperatures T1 through 
T10 

𝑓 = stress range reduction factor from Table NCD-3611.2(e)-1 

Settlement Stress 

The stress (𝑆𝑆) due to single nonrepeated anchor movement (e.g., predicted building 
settlement) is calculated from Equation (10b) of NCD-3653.2. 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from Table NCD-3673.2(b)-1 

𝑀𝐷 = resultant moment due to any single non-repeated anchor movement (e.g., predicted 
building settlement) 

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 
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Additional Note for Welding elbow or Pipe bend: 
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.  

 
Additional Note for Reinforced fabricated tee: 
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where 
r’m is the mean radius of the branch leg. 
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Additional Note for Circumferential fillet welded or socket welded joints: 

Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3 
respectively in CAEPIPE for the following reasons. 

1. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded 
flanges. 

2. The definition of Cx as per Note 11 of Table NCD-3673.2(b)-1 contradicts with the 
definition of Cx as defined in Notes (3) and (4) of Figure NCD-4427-1.  
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NCD-
3641.1. 

𝑃𝑎 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃𝑎 = allowable pressure 

𝑆 = allowable stress for the material at the Design Temperature  

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, after deducting mechanical and corrosion allowance 

 = 𝑡𝑛 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡𝑛 = nominal pipe thickness 

𝐷 = nominal outside diameter 

𝑑 = nominal inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝐷/𝑡𝑚 ≥ 6 

 = 𝑑/(𝐷 + 𝑑) for 𝐷/𝑡𝑚 < 6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NCD-3652 (in case the option “Include Axial 
force in stress calculations” is turned OFF). 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) + 𝐵2

𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐵1, 𝐵2 = primary stress indices from Table NCD-3673.2(b)-1 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = nominal outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑀𝐴 = resultant moment due to sustained loads = √𝑀𝐴𝑋
2 +𝑀𝐴𝑌

2 +𝑀𝐴𝑍
2  

𝑍 = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10  
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In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 8 of NCD-3652 as follows. 

𝑆𝐿 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹𝑆
𝐴
)
𝑠𝑢𝑠𝑡

] + 𝐵2
𝑀𝐴
𝑍
≤ 1.5𝑆ℎ 

where 

𝐹𝑆 = axial force due to sustained loads 

𝐴 = nominal metal area 

As an option, as suggested in NCD-3651 (a), the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above 

equations for SL may be replaced with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > 

Analysis > Pressure. 

Occasional Stress 

The occasional stress (𝑆𝐿𝑂) due to sustained loads (pressure, weight and other sustained 
mechanical loads) and stress due to occasional loads (such as thrusts from relief and safety 
valve loads, pressure and flow transients, and reversing and nonreversing dynamic loads, if 
the Design Specification requires calculation of moments due to reversing and nonreversing 
dynamic loads) is calculated from Equation 9a of NCD-3653.1 (in case the option 
“Include Axial force in stress calculations” is turned OFF). 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 (
𝑓𝑝𝑃𝐷

4𝑡𝑛
)+ 𝐵2 (

𝑀𝐴 +𝑀𝐵
𝑍

) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 9a of NCD-3653.1as follows. 

𝑆𝐿𝑂 = 2. 𝐵1. 𝐴𝐵𝑆 [(
𝑓𝑝𝑃𝐷

4𝑡𝑛
) + (

𝐹𝑆
𝐴
)
𝑠𝑢𝑠𝑡

+ (
𝐹𝑂
𝐴
)
𝑜𝑐𝑐𝑎

] + 𝐵2 (
𝑀𝐴 +𝑀𝐵

𝑍
) ≤ 𝑆𝐿𝑂(𝐴𝑙𝑙) 

where 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝐴𝑋
2 +𝑀𝐴𝑌

2 +𝑀𝐴𝑍
2  

𝑀𝐵 = resultant moment due to occasional loads, inclusive of seismic anchor movements 
and movements due to reversing and non-reversing dynamic loads 

 = √𝑀𝐵𝑋
2 +𝑀𝐵𝑌

2 +𝑀𝐵𝑍
2  

𝑓𝑝 = peak pressure factor input into CAEPIPE 

𝑃 = maximum of CAEPIPE Input pressures P1 through P10 

𝐷 = nominal outside diameter 

𝑡𝑛 = nominal wall thickness 

𝑍 = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆𝐿𝑂(All)= minimum (1.80Sh, 1.5Sy) for Level B Service Limits as per NCD-3653.1 

 =minimum (2.25Sh, 1.8Sy) for Level C Service Limits as per NCD-3654.2 (a) 
 = minimum (3.0Sh, 2.0Sy) for Level D Service Limits as per NCD-3655 (a)(2) 
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𝑆ℎ        = material allowable stress at maximum of CAEPIPE Input temperatures T1 
through T10 

𝑆𝑦        = material yield strength at maximum of CAEPIPE Input temperatures T1 through 

T10 

𝐹𝑂 = axial force due to occasional loads 

𝐴 = nominal metal area 

As an option, as suggested in NCD-3651 (a), the pressure stress term (
𝑃𝐷

4𝑡𝑛
) in the above 

equations for SLO may be replaced with the expression (
𝑃𝑑2

𝐷2−𝑑2
) using the CAEPIPE Options > 

Analysis > Pressure. 

Note: 

Movements at anchors and nozzles due to seismic event and due to reversing and 
nonreversing dynamic loads are to be input as “specified displacements” for seismic and they 
will be included as a part of the Occasional Stress evaluation given above. 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation (10a) of NCD-3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Table NCD-3673.2(b)-1 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 
inclusive of moment ONLY due to thermal anchor movements 

= √𝑀𝐶𝑋
2 +𝑀𝐶𝑌

2 +𝑀𝐶𝑍
2  

𝑍     = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NCD-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

f    = stress range reduction factor from Table NCD-3611.2(e)-1 

Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NCD-3653.2(c) (in case the option “Include Axial force in stress 
calculations” is turned OFF).. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 (
𝑃𝐷

4𝑡𝑛
) +

0.75𝑖𝑀𝐴
𝑍

+
𝑖𝑀𝐶

𝑍
≤ 𝑆𝐻 + 𝑆𝐴 
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In case the option “Include Axial force in stress calculations” is turned ON, then 
CAEPIPE evaluates Equation 11 of NCD-3653.2(c) as follows. 

𝑆𝑇𝐸 = 𝐴𝐵𝑆 [(
𝑃𝐷

4𝑡𝑛
) + (

𝐹

𝐴
)
𝑠𝑢𝑠𝑡

] +
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐻 + 𝑆𝐴 

0.75i shall not be less than 1.0. 

where 

𝑃    = maximum of CAEPIPE Input pressures P1 through P10 

𝐷   = nominal outside diameter 

𝑡𝑛  = nominal wall thickness 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝐴𝑋
2 +𝑀𝐴𝑌

2 +𝑀𝐴𝑍
2  

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 
inclusive of moment ONLY due to thermal anchor movements 

= √𝑀𝐶𝑋
2 +𝑀𝐶𝑌

2 +𝑀𝐶𝑍
2  

𝑍     = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 

𝑆𝐴 = allowable stress range for expansion stress = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per NCD-
3611.2(e) 

𝑆𝑐   = basic allowable stress at minimum metal temperature expected during the 
displacement cycle under analysis 

𝑆ℎ   = basic allowable stress at maximum metal temperature expected during the 
displacement cycle under analysis 

𝑆𝐻  = material allowable stress at maximum of CAEPIPE Input temperatures T1 through 
T10 

𝑓 = stress range reduction factor from Table NCD-3611.2(e)-1 

Settlement Stress 

The stress (𝑆𝑆) due to single nonrepeated anchor movement (e.g., predicted building 
settlement) is calculated from Equation (10b) of NCD-3653.2. 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from Table NCD-3673.2(b)-1 

𝑀𝐷 = resultant moment due to any single non-repeated anchor movement (e.g., predicted 

building settlement) = √𝑀𝐷𝑋
2 +𝑀𝐷𝑌

2 +𝑀𝐷𝑍
2  

𝑆𝑐   = allowable stress at the Reference Temperature in CAEPIPE 

𝑍     = section modulus; for reduced outlets, effective section modulus as per NCD-
3653.3(d) 
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Additional Note for Welding elbow or Pipe bend: 
If the value of B1 = (0.4h – 0.1) < 0.0, then B1 is set to 0.0.  

 
Additional Note for Reinforced fabricated tee: 
For calculating the value of rps and t’e, the value of re is assumed to be equal to 2 x r’m, where 
r’m is the mean radius of the branch leg. 
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Additional Note for Circumferential fillet welded or socket welded joints: 

Values of B1, B2 and Stress Intensification Factor (SIF) are taken as 0.75, 1.50 and 1.3 
respectively in CAEPIPE for the following reasons. 

3. There is no provision to input the value of Cx in CAEPIPE for fillet and socket welded 
flanges. 

4. The definition of Cx as per Note 11 of Table NCD-3673.2(b)-1 contradicts with the 
definition of Cx as defined in Notes (3) and (4) of Figure NCD-4427-1.  
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General 

The Code Compliance requirements provided in this Section as per ASME NM.1 are valid for above ground 
installation of Thermoplastic Piping Systems. 

Analysis of buried piping (i.e., restrained piping) as per Non-mandatory Appendix B of this code is not yet 
implemented in CAEPIPE. 

Allowable Pressure 

(a) Straight Pipes made of materials other than HDPE 

The allowable pressure for straight pipes made of materials other than HDPE is calculated using eq. 
(2-3-3) in para. 2-3.2.1.1 (b). 

𝑃𝑎 =
2𝑆𝑡𝑎

(𝐷𝑜 − 𝑡𝑎)
 

(b) Bends/Elbows/Miters made of materials other than HDPE 

The allowable pressure for Bends/Elbows made of materials other than HDPE is calculated using 
eq. (2-3-5b) in para. 2-3.2.2 (b). 

𝑃𝑎 = 𝐷𝐹
2𝑆𝑡𝑎

(𝐷𝑜 − 𝑡𝑎)
 

(c) Straight Pipes/Bends/Elbows made of HDPE 

The allowable pressure for Pipes/Bends/Elbows made of HDPE is calculated using eq. (2-3-5a) in 
para. 2-3.2.2 (b). 

𝑃𝑎 = 𝐺𝑆𝑅
2𝑆𝑡𝑎

(𝐷𝑜 − 𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
S = maximum allowable stress from ASME NM.3.3 Table 1-1-1 at Design Temperature input in 
CAEPIPE 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

DF = Design Factor from Table 2-3.2.2-2 corresponding to Molded fittings = 0.6 

GSR = Geometry Shape Rating (GSR) for HDPE Fittings from Table 2-3.2.2-1 corresponding to 
Molded fittings = 1.0 
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(d) Miter Bends made of HDPE 

For miter bends, the allowable pressure is calculated in CAEPIPE as lesser of Eqs. 2-3-6 and 2-3-7 
with  <= 22.5 deg. 

𝑃𝑎 = 𝑚𝑖𝑛 [
𝑆. 𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 0.5𝑟)
,

𝑆. 𝑡𝑎
2

𝑟(𝑡𝑎 + 0.622𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
] 

where 

r = mean radius of pipe = (D - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Notes: 

As per para. 2-3.2.4, equation given above to compute allowable internal pressure for Miter Bend is valid 

only when   <= 22.5 deg. Hence, CAEPIPE will leave the Allowable Pressure row BLANK for Miter 

Bend elements where   > 22.5 degree in Code Compliance Results.  

Sustained Stress 

The longitudinal stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from para. 2-3.3.1.1 and eq. (2-3-8). 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through Layout 

Window > Options > Analysis > Pressure. 

𝑃 = internal design pressure that shall be not less than the maximum sustained operating pressure within 
the piping system, including the effects of static head (as per para. 2-1.2.2 (a)) = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from Appendix IV and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding pressure) 

= √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 
2 below. 

 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 
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Notes: 

1. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will replace 

the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal material area 

2. Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

where 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Occasional Stress 

The longitudinal stresses 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind is calculated using eq. (2-3-9) of para. 2-3.3.1.2. Wind and 
earthquake are not considered to act concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress = |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
| This pressure option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 
2 below. 

𝑖 = stress intensification factor from Appendix IV and 0.75i shall not be less than 1.0 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief valve 

loads, from pressure and flow transients, earthquake/wind, etc. =√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

k = 1.2 corresponding to the event duration occurring for not more than 1 h at any one time and not more 
than 80 h/yr 
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Note: 

1. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will replace 

the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, from 
pressure and flow transients, earthquake/wind, etc. 

A = nominal material Area 

2.  Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

where 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (2-3.-11) in para. 2-3.3.1.3 (a) and 
(b). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Appendix IV 

𝑀𝐶 = resultant of bending moment range due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 
2 below. 

𝑆𝐴 = allowable stress range, SA, as given in ASME NM.3.3 based on the fatigue properties for the 
given material at the given temperature as per para. 2-2.3.3(b). SA is a user input in CAEPIPE 
Material Properties. 

Note: 

1. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 
compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force range due to reference displacement load range. 
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A = nominal material area 

2.  Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Settlement Stress 

Stress range (𝑆𝑆) caused by applied noncyclic secondary axial and longitudinal loads is calculated 
using eq. (2-3.-12) in para. 2-3.3.1.4 (a) and (b). 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 2. 𝑆ℎ 

where 

𝑖 = stress intensification factor from Appendix IV 

𝑀𝐶 = noncyclic resultant moment loading due to settlement = √(𝑀𝐷𝑥)
2 + (𝑀𝐷𝑦)

2
+ (𝑀𝐷𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 
below. 

𝑆ℎ = allowable stress at CAEPIPE reference temperature 

Note: 

Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Hydrotest Stress 

The longitudinal stress 𝑆𝐻 due to test pressure, weight and other sustained mechanical loads is calculated 
from para. 2-3.3.4 and eq. (2-3-8). 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝑇

𝑍
≤ 𝑆𝐿𝐴 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through Layout 

Window > Options > Analysis > Pressure. 

𝑃 = Test pressure input for Hydrotest load 

𝐷 = nominal outside diameter 
d = nominal inside diameter  
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𝑖 = stress intensification factor from Appendix IV and 0.75i shall not be less than 1.0 

𝑀𝑇 = resultant bending moment due to weight and other sustained mechanical loads (excluding pressure) 

= √(𝑀𝑇𝑥)
2 + (𝑀𝑇𝑦)

2
+ (𝑀𝑇𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 
2 below. 

 

𝑆𝐿𝐴 = 1.2 Sh where, 𝑆ℎ = allowable stress at CAEPIPE reference temperature 

Notes: 

1. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal material area 

2. Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

where 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 
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Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) 
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Notes: 

1. SIF computation for “Sidewall fusion branch connection” (Branch Connection) in CAEPIPE is valid only when Branch OD / Run OD is less than 0.4 as 
per Note 5 above. As the code is NOT explicit about the SIF to be used when Branch OD / Run OD >= 0.4, CAEPIPE uses the same SIF equation even 
for Branch Connection with Branch OD / Run OD > 0.4.  

2. In case the user wants to input at a node a SIFs for a component which is not listed above, then user can input the desired value using the data type “User SIF” 
at that node. See the Section titled “User SIF” in CAEPIPE Technical Reference Manual for further details. 
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General 

The Code Compliance requirements provided in this Section as per ASME NM.1 are valid for above ground 
installation of Thermoplastic Piping Systems. 

Analysis of buried piping (i.e., restrained piping) as per Non-mandatory Appendix B of this code is not yet 
implemented in CAEPIPE. 

Allowable Pressure 

(e) Straight Pipes/Bends/Elbows/Miters made of materials other than HDPE 

The allowable pressure for Straight Pipes/Bends/Elbows/Miters made of materials other than HDPE 
is calculated using eq. (2-3-5b) in para. 2-3.2.2 (c). 

𝑃𝑎 = 𝐷𝐹
2𝑆𝑡𝑎

(𝐷𝑜 − 𝑡𝑎)
 

(f) Straight Pipes/Bends/Elbows made of HDPE 

The allowable pressure for Pipes/Bends/Elbows made of HDPE is calculated using eq. (2-3-5a) in 
para. 2-3.2.2 (b). 

𝑃𝑎 = 𝐺𝑆𝑅
2𝑆𝑡𝑎

(𝐷𝑜 − 𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
S = maximum allowable stress from ASME NM.3.3 Table 1-1-1 at Design Temperature input in 
CAEPIPE 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be included 
in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

DF = Design Factor from Table 2-3.2.2-2 for materials other than HDPE 

DF = 1.0 for straight pipes and DF = 0.6 for molded fittings, solvent welded 

GSR = Geometry Shape Rating (GSR) from Table 2-3.2.2-1 for HDPE materials  

GSR = 1.0 for straight pipes and molded fittings 
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(g) Miter Bends made of HDPE 

For miter bends, the allowable pressure is calculated in CAEPIPE as lesser of Eqs. 2-3-6 and 2-3-7 
with  <= 22.5 deg. 

𝑃𝑎 = 𝑚𝑖𝑛 [
𝑆. 𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 + 0.5𝑟)
,

𝑆. 𝑡𝑎
2

𝑟(𝑡𝑎 + 0.622𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
] 

where 

r = mean radius of pipe = (D - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Notes: 

As per para. 2-3.2.4, equation given above to compute allowable internal pressure for Miter Bend is valid 

only when   <= 22.5 deg. Hence, CAEPIPE will leave the Allowable Pressure row BLANK for Miter 

Bend elements where   > 22.5 degree in Code Compliance Results.  

Sustained Stress 

The longitudinal stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from para. 2-3.3.1.1 and eq. (2-3-8). 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
 as per Eqs. 2-2-3 and 2-2-4 in para. 2-2.3.3 (a)(3). This pressure option 

can be selected in CAEPIPE through Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head (as per para. 2-2.3.3 (a)(3)) = maximum of 
CAEPIPE input pressures P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from Appendix IV and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding pressure) = 

√(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 2 
below. 

 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 
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Notes: 

3. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will replace 

the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal material area 

4. Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

where 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Occasional Stress 

The longitudinal stresses 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind is calculated using eq. (2-3-9) of para. 2-3.3.1.2. Wind and 
earthquake are not considered to act concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress = |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
|. This pressure option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 2 
below. 

𝑖 = stress intensification factor from Appendix IV and 0.75i shall not be less than 1.0 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief valve 

loads, from pressure and flow transients, earthquake/wind, etc. =√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

k = 1.2 corresponding to the occasional event duration occurring for not more than 1 h at any one time and 
not more than 80 h/yr 
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Note: 

2. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will replace 

the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, from 
pressure and flow transients, earthquake/wind, etc. 

A = nominal material Area 

2.  Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

where 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (2-3-11) in para. 2-3.3.1.3 (a) and (b). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from Appendix IV 

𝑀𝐶 = resultant of bending moment range due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 2 
below. 

𝑆𝐴 = allowable stress range, SA, as given in ASME NM.3.3 based on the fatigue properties for the 
given material at the given temperature as per para. 2-2.3.3(b). SA is a user input in CAEPIPE Material 
Properties. 

Note: 

2. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 
compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force range due to reference displacement load range. 



Thermoplastic Piping Systems 
ASME NM.1 (2020) 

399 
 

 

A = nominal material area 

2.  Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Settlement Stress 

Stress range (𝑆𝑆) caused by applied noncyclic secondary axial / longitudinal loads is calculated using 
eq. (2-3-12) in para. 2-3.3.1.4 (a) and (b). 

𝑆𝑆 =
𝑖𝑀𝐷
𝑍

≤ 2. 𝑆ℎ 

where 

𝑖 = stress intensification factor from Appendix IV 

𝑀𝐶 = noncyclic resultant moment loading due to settlement = √(𝑀𝐷𝑥)
2 + (𝑀𝐷𝑦)

2
+ (𝑀𝐷𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 
below. 

𝑆ℎ = allowable stress at CAEPIPE reference temperature 

Note: 

Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 

Hydrotest Stress 

The longitudinal stress 𝑆𝐻 due to test pressure, weight and other sustained mechanical loads is calculated 
from para. 2-2.3.4 and eq. (2-3-8). 

𝑆𝐿𝑇 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝑇

𝑍
≤ 𝑆𝐿𝐴 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through Layout 

Window > Options > Analysis > Pressure. 

𝑃 = Test pressure input for Hydrotest load 

𝐷 = nominal outside diameter 
d = nominal inside diameter  



Thermoplastic Piping Systems 
ASME NM.1 (2020) 

400 
 

 

𝑖 = stress intensification factor from Appendix IV and 0.75i shall not be less than 1.0 

𝑀𝑇 = resultant bending moment due to weight and other sustained mechanical loads (excluding pressure) = 

√(𝑀𝑇𝑥)
2 + (𝑀𝑇𝑦)

2
+ (𝑀𝑇𝑧)

2 

𝑍 = un-corroded section modulus; for a branch, effective section modulus as per para. 2-3.3.3(a). See Note 2 
below. 

 

𝑆𝐿𝐴 = 1.2 Sh where, 𝑆ℎ = allowable stress at CAEPIPE reference temperature 

Notes: 

3. When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal material area 

4. Branch Section modulus “Z” as per para. 2-3.3.3(a), 

for Run pipe = 
𝜋(𝐷𝑜ℎ

4 −𝑑ℎ
4)

32𝐷𝑜ℎ
 and Branch Pipe = 

𝜋(𝐷𝑜𝑏
4 −𝑑𝑏

4)

32𝐷𝑜𝑏
 

where 

Doh = Outside Diameter of header 
Dob = Outside Diameter of branch 
dh = Inside Diameter of header 
db = Inside Diameter of branch 
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Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) 

 



Thermoplastic Piping Systems 
ASME NM.1 (2020) 

402 
 

 

 

 

 

Notes: 

3. SIF computation for “Sidewall fusion branch connection” (Branch Connection) in CAEPIPE is valid only when Branch OD / Run OD is less 
than 0.4 as per Note 5 above. As the code is NOT explicit about the SIF to be used when Branch OD / Run OD >= 0.4, CAEPIPE uses the 
same SIF equation even for Branch Connection with Branch OD / Run OD > 0.4.  

4. In case the user wants to input at a node a SIFs for a component which is not listed above, then user can input the desired value using the data 
type “User SIF” at that node. See the Section titled “User SIF” in CAEPIPE Technical Reference Manual for further details. 
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General 

The Code Compliance requirements provided in this Section as per ASME NM.2 are valid for above ground 
installation of GRP/FRP Piping. 

Section 2-6.3 of ASME NM 2 (2022) refers to AWWA Manual M45 (second edition) for Buried GRP/FRP 
Piping Analysis. AWWA Manual M45 is also referred by ISO 14692-3 for detailed analysis of Buried 
GRP/FRP Piping.  Code Compliance as per ISO 14692-3 is built into CAEPIPE Version 12.00 or later. 
Hence, for Buried GRP/FRP Piping Analysis, ISO 14692-3 can be selected in CAEPIPE for Code 
Compliance checks. 

Allowable Pressure 

Straight Pipes and Bends 

For straight pipes and bends, CAEPIPE calculates allowable pressure using Eq. (2-3-2) of para.2-
3.2.2 and Eqs. (2-3-6) of para. 2-3.3.1 and Eqs. (2-3-9), (2-3-10) & (2-3-11) of para. 2-3.3.2 (a) & (b). 

𝑃𝑎 =
2. 𝑆𝐻(2:1). 𝑡𝑎

𝐾1. 𝐷.𝑚
 

where 

Pa= allowable pressure 

𝑆𝐻(2:1) = design hoop allowable stress at Design Temperature (can be obtained from applicable 

table in ASME NM.3.3) 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE as per para. 2-3.2.1 (a)) 

tn = nominal pipe/bend thickness 

D = outside diameter of pipe/bend, to be conservative 

m = 1.0 for straight pipes and at the side wall on the bend / elbow centerline radius 

K1 = 1.0 for Pipe with Type I and Type II laminates  

K1 = 1.2 for Bends / Elbows with Type I and Type II laminates 

Note: 

Allowable pressure at the “intrados” of a bend can be manually computed by dividing the CAEPIPE 
computed allowable pressure for that bend by the factor “m” given by Eq. (2-3-7) in para. 2-3.3.1. 
Similarly, allowable pressure at the “Extrados” of a bend can be manually computed by diving the 
CAEPIPE computed allowable pressure for that bend by the factor “m” given by Eq. (2-3-8) in 
para. 2-3.3.1. 

For closely spaced miter bends, the allowable pressure computed by CAEPIPE shall be the lesser of 
the two values calculated from Eqs. 2-3-9 and 2-3-10 with  <= 22.5 deg. 

𝑃𝑎 = 𝑚𝑖𝑛 [
𝑆𝐻(2:1). 𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 0.5𝑟)
,

𝑆𝐻(2:1). 𝑡𝑎
2

𝑟(𝑡𝑎 + 0.643𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
] 
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For widely spaced miter bends with   <= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE by Eq. 2-3-9 

𝑃𝑎 =
𝑆𝐻(2:1). 𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
 

For widely spaced miter bends and closely spaced miter bends with   > 22.5 deg, the allowable 
pressure is calculated in CAEPIPE by Eq. 2-3-11 

𝑃𝑎 =
𝑆𝐻(2:1). 𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
 

where 

r = mean radius of pipe = (D - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Integrally Molded Tee fittings 

For integrally molded Tee fittings, CAEPIPE calculates allowable pressure for Run and Branch of a 
Tee using Eq. (2-3-18) of para.2-3.4. 

For Tee Run 

𝑃𝑎𝑅 =
2. 𝑆𝐻(2:1). 𝑡𝑎𝑅

𝐷𝑅 . 𝑚
 

For Tee Branch 

𝑃𝑎𝐵 =
2. 𝑆𝐻(2:1). 𝑡𝑎𝐵

𝐷𝐵. 𝑚
 

where 

PaR= allowable pressure for Run 

PaB= allowable pressure for Branch 

𝑆𝐻(2:1) = design hoop allowable stress (can be obtained from applicable table in ASME NM.3.3) at 

Design Temperature input in CAEPIPE load dialog. 

m = pressure stress multiplier for integral tees = 1.4𝜆𝑧
0.25

 

𝜆𝑧 = geometry factor as given below 
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For equal tees (i.e., DB = DR) 

𝜆𝑧 = 
𝐷𝑅
2. 𝑡𝑎𝑅

 

For unequal or reducing tees (i.e., DB < DR) 

𝜆𝑧 = (
𝐷𝐵
2. 𝑡𝑎𝐵

)
2

(
2𝑡𝑎𝑅
𝐷𝑅

) 

where 

taR= available Run thickness for pressure design = tnR × (1 - mill tolerance/100) - corrosion 
allowance 

taB= available Branch thickness for pressure design = tnB × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE as per para. 2-3.2.1 (a)) 

tnR = nominal thickness of Run  

tnB = nominal thickness of Branch  

DR = inside diameter of the main run pipe structural wall = Run OD – 2 * taR 

DB = inside diameter of the tee branch pipe structural wall = Branch OD – 2 * taB 

Sustained Load 

(a) The Hoop Stress (SHL) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Eq. (2-4-1) of para. 2-4.4.4 (a)(1) and compared against the limit given 
in para. 2-4.4.4 (b)(1). 

𝑆𝐻𝐿 = √[
𝑚𝑃𝐷𝑚
2𝑇𝑠

+
√(𝑖𝑖ℎ𝑀𝑖)

2 + (𝑖𝑜ℎ𝑀𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡

𝑍
)
2

≤ 𝑆𝐻.𝑚𝑎𝑥  

(b) The Longitudinal Stress (SAL) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated from Eqs. (2-4-2a) & (2-4-2b) of para. 2-4.4.4 (a)(2) and 
compared against the limit given in para. 2-4.4.4 (b)(1). 

𝑆𝐴𝐿1 = √[
𝑃𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴
𝐴𝑠
−
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡

𝑍
)
2

 

𝑆𝐴𝐿2 = √[
𝑃𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴
𝐴𝑠
+
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡

𝑍
)
2
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𝑆𝐴𝐿.𝑚𝑖𝑛 =  𝑚𝑖𝑛𝑖𝑚𝑢𝑚(𝑆𝐴𝐿1, 𝑆𝐴𝐿2) ≤ 𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝐿.𝑚𝑎𝑥 =  𝑚𝑎𝑥𝑖𝑚𝑢𝑚(𝑆𝐴𝐿1, 𝑆𝐴𝐿2) ≤ 𝑆𝐴.𝑚𝑎𝑥 

where 

P = maximum of CAEPIPE input pressures P1 through P10 

Do = outside diameter  

TS = corroded wall thickness = tn - corrosion allowance 

tn = nominal thickness 

Dis = inside diameter = Do - 2TS 

m = pressure stress multiplier from Appendix III 

iih = stress intensification factor, hoop stress due to in-plane moment as per Appendix III 

ioh = stress intensification factor, hoop stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

ii = stress intensification factor, axial stress due to in-plane moment as per Appendix III 

io = stress intensification factor, axial stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

Mi, Mo, Mt = in-plane, out-of-plane and torsional moment respectively due to weight and other 
sustained mechanical loads 

FA = axial force due to weight and other sustained mechanical loads (excluding pressure) 

Z = section modulus = 𝜋[𝐷𝑜
4 − (𝐷𝑜 − 2𝑇𝑠)

4]/32𝐷𝑜 

AS = area of cross-section = 𝜋[𝐷𝑜
2 − 𝐷𝑖𝑠

2 ]/4 

SA.max = axial allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 .. T10)] 

SAL.min = minimum longitudinal stress due to pressure, weight and other sustained mechanical loads 

SAL.max = maximum longitudinal stress due to pressure, weight and other sustained mechanical loads 

Occasional Load (Sustained + Occasional) 

(a) The Hoop stress (SHO) due to sustained and occasional loads is calculated from Eq. (2-4-1) of 
para. 2-4.4.4 (a)(1) as the combined stress due to (a) sustained loads such as pressure, weight 
and other sustained mechanical loads and (b) occasional loads such as earthquake or wind and 
compared against the limit given in para. 2-4.4.4 (b)(2). Wind and earthquake are not considered 
to act concurrently as per para. 2-2.3.8 (a). 

𝑆𝐻𝑂 = 𝑆𝐻𝐿 +√[
𝑚(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑚

2𝑇𝑠
+
√(𝑖𝑖ℎ𝑀𝑖𝑜)

2 + (𝑖𝑜ℎ𝑀𝑜𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

≤ 1.33𝑆𝐻.𝑚𝑎𝑥 
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(b) The Longitudinal stress (SAO) due to sustained and occasional is calculated is calculated from 
Eqs. (2-4-2a) and (2-4-2b) of para. 2-4.4.4 (a)(2) as the combined stress due to (a) sustained loads 
such as pressure, weight and other sustained mechanical loads and (b) occasional loads such as 
earthquake or wind and compared against the limit given in para.  2-4.4.4 (b)(2). Wind and 
earthquake are not considered to act concurrently as per para. 2-2.3.8 (a). 

𝑆𝐴𝑂1 = √[
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝑂
𝐴𝑠

−
√(𝑖𝑖𝑀𝑖𝑜)

2 + (𝑖𝑜𝑀𝑜𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

≤ 1.33𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝑂2 = √[
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝑂
𝐴𝑠

+
√(𝑖𝑖𝑀𝑖𝑜)

2 + (𝑖𝑜𝑀𝑜𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

≤ 1.33𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝑂.𝑚𝑖𝑛 = 𝑆𝐴𝐿.𝑚𝑖𝑛 +𝑚𝑖𝑛𝑖𝑚𝑢𝑚(𝑆𝐴𝑂1 , 𝑆𝐴𝑂2) ≤ 1.33 𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝑂.𝑚𝑎𝑥 = 𝑆𝐴𝐿.𝑚𝑎𝑥 +𝑚𝑎𝑥𝑖𝑚𝑢𝑚(𝑆𝐴𝑂1, 𝑆𝐴𝑂2) ≤ 1.33 𝑆𝐴.𝑚𝑎𝑥  

where 

P = maximum of CAEPIPE pressures P1 through P10 

Ppeak = peak pressure = (peak pressure factor in CAEPIPE) x P 

TS = corroded wall thickness = tn - corrosion allowance 

tn = nominal thickness 

Do = outside diameter of the component 

Dis = inside diameter = Do - 2TS 

m = pressure stress multiplier from Appendix III 

iih = stress intensification factor, hoop stress due to in-plane moment as per Appendix III 

ioh = stress intensification factor, hoop stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

ii = stress intensification factor, axial stress due to in-plane moment as per Appendix III 

io = stress intensification factor, axial stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

FAO = axial force due to occasional loads such as wind or seismic, etc. 

Mio, Moo, Mto = in-plane, out-of-plane and torsional moment respectively due to occasional loads 
such as wind or seismic, etc. 

Z = section modulus = 𝜋[𝐷𝑜
4 − (𝐷𝑜 − 2𝑇𝑠)

4]/32𝐷𝑜 

AS = area of cross-section = 𝜋[𝐷𝑜
2 − 𝐷𝑖𝑠

2 ]/4 

SH.max = hoop allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 .. T10)] 
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SA.max = axial allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 .. T10)] 

SAO.min = minimum longitudinal stress due to occasional loads such as wind or seismic, etc. 

SAO.max = maximum longitudinal stress due to occasional loads such as wind or seismic, etc. 

Operating Load (Sustained + Expansion) 

(c) The Hoop Stress (SHE) due to operating loads (pressure, weight, other sustained mechanical 
loads and thermal displacement) is calculated from Eq. (2-4-1) of para. 2-4.4.4 (a)(1) and 
compared against the limit given in para. 2-4.4.4 (b)(1). 

𝑆𝐻𝐸 = √[
𝑚P𝑛𝐷𝑚
2𝑇𝑠

+
√(𝑖𝑖ℎ𝑀𝑖𝐸)

2 + (𝑖𝑜ℎ𝑀𝑜𝐸)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐸

𝑍
)
2

≤ 1.1𝑆𝐻.𝑚𝑎𝑥 

(a) The Longitudinal stress (SAE) due to operating loads (pressure, weight, other sustained 
mechanical loads and thermal displacement) is calculated from Eqs. (2-4-2a) and (2-4-2b) of 
para. 2-4.4.4 (a)(2) and compared against the limit given in para. 2-4.4.4 (b)(1). 

𝑆𝐴𝐸1 = √[
P𝑛𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝐸
𝐴𝑠

−
√(𝑖𝑖𝑀𝑖𝐸)

2 + (𝑖𝑜𝑀𝑜𝐸)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

 

𝑆𝐴𝐸2 = √[
P𝑛𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝐸
𝐴𝑠

+
√(𝑖𝑖𝑀𝑖𝐸)

2 + (𝑖𝑜𝑀𝑜𝐸)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

 

𝑆𝐴𝐸.𝑚𝑖𝑛 =  𝑚𝑖𝑛𝑖𝑚𝑢𝑚(𝑆𝐴𝐸1, 𝑆𝐴𝐸2) ≤ 1.1 𝑆𝐴.𝑚𝑎𝑥 

𝑆𝐴𝐸.𝑚𝑎𝑥 =  𝑚𝑎𝑥𝑖𝑚𝑢𝑚(𝑆𝐴𝐸1, 𝑆𝐴𝐸2) ≤ 1.1 𝑆𝐴.𝑚𝑎𝑥  

where 

P𝑛 = internal operating pressure P1 through P10. For example, for Operating Load 1, P𝑛 = P1 

TS = corroded wall thickness = tn - corrosion allowance 

tn = nominal component thickness 

Do = outside diameter of the component 

Dis = inside diameter = Do - 2TS 

m = pressure stress multiplier from Appendix III 

iih = stress intensification factor, hoop stress due to in-plane moment as per Appendix III 

ioh = stress intensification factor, hoop stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

ii = stress intensification factor, axial stress due to in-plane moment as per Appendix III 

io = stress intensification factor, axial stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 
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FAE = axial force due to operating load such as weight, other sustained mechanical loads and thermal 
displacement 

MiE, MoE, MtE = in-plane, out-of-plane and torsional moment respectively due to weight, other 
sustained mechanical loads and thermal displacement 

Z = section modulus = 𝜋[𝐷𝑜
4 − (𝐷𝑜 − 2𝑇𝑠)

4]/32𝐷𝑜 

AS = area of cross-section = 𝜋[𝐷𝑜
2 − 𝐷𝑖𝑠

2 ]/4 

SH.max = hoop allowable stress at operating temperatures T1 through T10  

SA.max = axial allowable stress at operating temperature. For example, for Operating Load 1, 
Operating temperature is T1. 

SAE.min = minimum longitudinal stress due to weight, other sustained mechanical loads and thermal 
displacement 

SAE.max = maximum longitudinal stress due to weight, other sustained mechanical loads and thermal 
displacement 
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Flexibility Factors (FFs), Stress Intensification Factors (SIFs) and Pressure Stress 
Multipliers (PSMs) 

The FFs, SIFs and PSMs as per ASME NM.2 code are given below (extracted from Appendix III of the 
code). How they are implemented in CAEPIPE is described below. 

1. Flexibility Factors, Stress Intensification Factors and Pressure Multipliers are calculated as 
per Appendix III of ASME NM.2 only for Type I and Type II components in CAEPIPE at 
this time. Type I and Type II components can be differentiated in CAEPIPE by selecting 
the Material Type as “FR – Fiber/Glass Reinforced Plastics (FRP)” OR “F1 – Fiber/Glass 
Reinforced Plastics (FRP) Type I” and “F2 – Fiber/Glass Reinforced Plastics (FRP) Type 
II” respectively. 

2. Flexibility factor (k) for all components except for Bends & Mitres is set as 1.0 internally in 
CAEPIPE. 

3. Flexibility factor (k) for Bend / Mitre is 1.0 when Radius is NOT equal to long radius (i.e., k 
= 1.00 when Radius is <= 1.35D or >= 1.65D, where D is Outside Diameter). 

4. Flexibility factor (k) for long radius Bend and Mitre is 1.0 when the Diameter / Thickness 
ratio is greater than 140. i.e., k = 1.00 when D/t > 140. 

5. Flexibility factor (k) for long radius Bend and Mitre is 1.0 when Pipe Diameter is greater 
than 48”. 

6. Since thicknesses at intrados and extrados are not input at this time, thickness input at Bend 
/ Mitre dialog or Thickness of section (when thickness field at Bend / Mitre dialog is left 
blank) (= tn

 = nominal thickness) is considered in computing “ti”, “te”, “tis” and “tes” in the 
calculation, i.e.,  

tis = tes = tn – mill tolerance – corrosion allowance 

ti = te = tn – mill tolerance  

where,  

tn = nominal thickness = thickness input at Bend / Mitre dialog or Thickness of section 

7. Correction factor (𝛼2) is accounted as 1.00 in Stress Intensification Factor (SIF) calculation 
for the Bend / Mitre as intrados and extrados thicknesses cannot be input at this time in 
CAEPIPE. 

8. Correction factor (𝛼3) is accounted as 1.00 in Pressure Stress Multiplier (m) calculation for 
the Bend / Mitre as intrados and extrados thicknesses cannot be input at this time in 
CAEPIPE. 

9. Minimum value of Longitudinal Stress SIF and Shear Stress SIF for all components is 1.00.  

10. Hoop SIF for all components (excepting Bend / Mitre) is 0.0. For Bend / Mitre, Minimum 
Hoop Stress SIF is 1.00. 

11. Minimum Pressure Stress Multiplier is 1.00 for all components.  

12. Pressure Stress Multiplier is 1.0 for both Type I and Type II Tees when the Diameter is 
greater than 24”. 
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Flexibility Factors (FFs) 

Elbows 

 

TEES      Reducers 
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Stress Intensification Factors (SIFs) 

Elbows 

Correction factor 𝜶𝟐 is not included in the SIF calculation for Elbows as the Bend/Elbow in CAEPIPE can 
only have uniform thickness around its entire circumference.  

 

TEES         Reducers 
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Pressure Stress Multipliers 

Elbows 

 

TEES 

 

Reducers 
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General 

The Code Compliance requirements provided in this Section as per ASME NM.2 are valid for above 
ground installation of GRP/FRP Piping. 

Section 2-6.3 of ASME NM 2 (2020) refers to AWWA Manual M45 (second edition) for Buried 
GRP/FRP Piping Analysis. AWWA Manual M45 is also referred by ISO 14692-3 for detailed analysis 
of Buried GRP/FRP Piping.  Code Compliance as per ISO 14692-3 is built into CAEPIPE Version 
12.00 or later. Hence, for Buried GRP/FRP Piping Analysis, ISO 14692-3 can be selected in CAEPIPE 
for Code Compliance checks. 

Allowable Pressure 

Straight Pipes and Bends 

For straight pipes and bends, CAEPIPE calculates allowable pressure using Eq. (2-3-2) of 
para.2-3.2.2 and Eqs. (2-3-6) of para. 2-3.3.1 and Eqs. (2-3-9), (2-3-10) & (2-3-11) of para. 2-
3.3.2 (a) & (b). 

𝑃𝑎 =
2. 𝑆. 𝑡𝑎
𝐾1. 𝐷. 𝑚

 

where 

Pa= allowable pressure 

S = design hoop allowable stress at Design Temperature (can be obtained from applicable table 
in ASME NM.3.3) 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE as per para. 2-3.2.1 (a)) 

tn = nominal pipe/bend thickness 

D = outside diameter of pipe/bend, to be conservative 

m = 1.0 for straight pipes and at the side wall on the bend / elbow centerline radius 

K1 = 1.0 for Pipe with Type I and Type II laminates  

K1 = 1.2 for Bends / Elbows with Type I and Type II laminates 

Note: 

Allowable pressure at the “intrados” of a bend can be manually computed by dividing the 
CAEPIPE computed allowable pressure for that bend by the factor “m” given by Eq. (2-3-7) in 
para. 2-3.3.1. Similarly, allowable pressure at the “Extrados” of a bend can be manually 
computed by diving the CAEPIPE computed allowable pressure for that bend by the factor 
“m” given by Eq. (2-3-8) in para. 2-3.3.1. 

For closely spaced miter bends, the allowable pressure computed by CAEPIPE shall be the 
lesser of the two values calculated from Eqs. 2-3-9 and 2-3-10 with  <= 22.5 deg. 
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𝑃𝑎 = 𝑚𝑖𝑛 [
𝑆. 𝑡𝑎(𝑅 − 𝑟)

𝑟(𝑅 − 0.5𝑟)
,

𝑆. 𝑡𝑎
2

𝑟(𝑡𝑎 + 0.643𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
] 

For widely spaced miter bends with   <= 22.5 deg, the allowable pressure is calculated in 
CAEPIPE by Eq. 2-3-9 

𝑃𝑎 =
𝑆. 𝑡𝑎

2

𝑟(𝑡𝑎 + 0.643𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
 

For widely spaced miter bends and closely spaced miter bends with   > 22.5 deg, the allowable 
pressure is calculated in CAEPIPE by Eq. 2-3-11 

𝑃𝑎 =
𝑆. 𝑡𝑎

2

𝑟(𝑡𝑎 + 1.25 𝑡𝑎𝑛𝜃√𝑟. 𝑡𝑎)
 

where 

r = mean radius of pipe = (D - tn)/2 

R = equivalent bend radius of the miter (an input in CAEPIPE for Miter) 

 = miter half angle = 































0.1
2

0.1
tan 1

r

R
 

Integrally Molded Tee fittings 

For integrally molded Tee fittings, CAEPIPE calculates allowable pressure for Run and Branch 
of a Tee using Eq. (2-3-18) of para.2-3.4. 

For Tee Run 

𝑃𝑎𝑅 =
2. 𝑆. 𝑡𝑎𝑅
𝐷𝑅 . 𝑚

 

For Tee Branch 

𝑃𝑎𝐵 =
2. 𝑆. 𝑡𝑎𝐵
𝐷𝐵 . 𝑚

 

where 

PaR= allowable pressure for Run 

PaB= allowable pressure for Branch 

S = design hoop allowable stress (can be obtained from applicable table in ASME NM.3.3) at 
Design Temperature input in CAEPIPE load dialog. 

m = pressure stress multiplier for integral tees = 1.4𝜆𝑧
0.25

 

𝜆𝑧 = geometry factor as given below 
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For equal tees (i.e., DB = DR) 

𝜆𝑧 = 
𝐷𝑅
2. 𝑡𝑎𝑅

 

For unequal or reducing tees (i.e., DB < DR) 

𝜆𝑧 = (
𝐷𝐵
2. 𝑡𝑎𝐵

)
2

(
2𝑡𝑎𝑅
𝐷𝑅

) 

where 

taR= available Run thickness for pressure design = tnR × (1 - mill tolerance/100) - corrosion 
allowance 

taB= available Branch thickness for pressure design = tnB × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE as per para. 2-3.2.1 (a)) 

tnR = nominal thickness of Run  

tnB = nominal thickness of Branch  

DR = inside diameter of the main run pipe structural wall = Run OD – 2 * taR 

DB = inside diameter of the tee branch pipe structural wall = Branch OD – 2 * taB 

Sustained Load 

(d) The Hoop Stress (SHL) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated from Eq. (2-4-1) of para. 2-4.4.4 (a) and compared against 
the limit given in para. 2-4.4.4 (c). 

𝑆𝐻𝐿 = √[
𝑚𝑃𝐷𝑚
2𝑇𝑠

+
√(𝑖𝑖ℎ𝑀𝑖)

2 + (𝑖𝑜ℎ𝑀𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡

𝑍
)
2

≤ 𝑆𝐻.𝑚𝑎𝑥  

(e) The Longitudinal Stress (SAL) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated from Eqs. (2-4-2a) & (2-4-2b) of para. 2-4.4.4 (b) and 
compared against the limit given in para. 2-4.4.4 (c). 

𝑆𝐴𝐿1 = √[
𝑃𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴
𝐴𝑠
−
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡

𝑍
)
2

 

𝑆𝐴𝐿2 = √[
𝑃𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴
𝐴𝑠
+
√(𝑖𝑖𝑀𝑖)

2 + (𝑖𝑜𝑀𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡

𝑍
)
2
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𝑆𝐴𝐿.𝑚𝑖𝑛 =  𝑚𝑖𝑛𝑖𝑚𝑢𝑚(𝑆𝐴𝐿1, 𝑆𝐴𝐿2) ≤ 𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝐿.𝑚𝑎𝑥 =  𝑚𝑎𝑥𝑖𝑚𝑢𝑚(𝑆𝐴𝐿1, 𝑆𝐴𝐿2) ≤ 𝑆𝐴.𝑚𝑎𝑥 

where 

P = maximum of CAEPIPE input pressures P1 through P10 

Do = outside diameter  

TS = corroded wall thickness = tn - corrosion allowance 

tn = nominal thickness 

Dis = inside diameter = Do - 2TS 

m = pressure stress multiplier from Appendix III 

iih = stress intensification factor, hoop stress due to in-plane moment as per Appendix III 

ioh = stress intensification factor, hoop stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

ii = stress intensification factor, axial stress due to in-plane moment as per Appendix III 

io = stress intensification factor, axial stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

Mi, Mo, Mt = in-plane, out-of-plane and torsional moment respectively due to weight and other 
sustained mechanical loads 

FA = axial force due to weight and other sustained mechanical loads (excluding pressure) 

Z = section modulus = 𝜋[𝐷𝑜
4 − (𝐷𝑜 − 2𝑇𝑠)

4]/32𝐷𝑜 

AS = area of cross-section = 𝜋[𝐷𝑜
2 − 𝐷𝑖𝑠

2 ]/4 

SA.max = axial allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 .. T10)] 

SAL.min = minimum longitudinal stress due to pressure, weight and other sustained mechanical 
loads 

SAL.max = maximum longitudinal stress due to pressure, weight and other sustained mechanical 
loads 
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Occasional Load (Sustained + Occasional) 

(c) The Hoop stress (SHO) due to sustained and occasional loads is calculated from Eq. (2-4-1) 
of para. 2-4.4.4 (a) as the combined stress due to (a) sustained loads such as pressure, 
weight and other sustained mechanical loads and (b) occasional loads such as earthquake 
or wind and compared against the limit given in para. 2-4.4.4 (d). Wind and earthquake are 
not considered to act concurrently as per para. 2-2.3.8 (a). 

𝑆𝐻𝑂 = 𝑆𝐻𝐿 + √[
𝑚(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑚

2𝑇𝑠
+
√(𝑖𝑖ℎ𝑀𝑖𝑜)

2 + (𝑖𝑜ℎ𝑀𝑜𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

≤ 𝑘. 𝑆𝐻.𝑚𝑎𝑥  

(d) The Longitudinal stress (SAO) due to sustained and occasional is calculated is calculated 
from Eqs. (2-4-2a) and (2-4-2b) of para. 2-4.4.4 (b) as the combined stress due to (a) 
sustained loads such as pressure, weight and other sustained mechanical loads and (b) 
occasional loads such as earthquake or wind and compared against the limit given in para.  
2-4.4.4 (d). Wind and earthquake are not considered to act concurrently as per para. 2-2.3.8 
(a). 

𝑆𝐴𝑂1 = √[
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝑂
𝐴𝑠

−
√(𝑖𝑖𝑀𝑖𝑜)

2 + (𝑖𝑜𝑀𝑜𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

≤ 𝑘. 𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝑂2 = √[
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝑂
𝐴𝑠

+
√(𝑖𝑖𝑀𝑖𝑜)

2 + (𝑖𝑜𝑀𝑜𝑜)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

≤ 𝑘. 𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝑂.𝑚𝑖𝑛 = 𝑆𝐴𝐿.𝑚𝑖𝑛 +𝑚𝑖𝑛𝑖𝑚𝑢𝑚(𝑆𝐴𝑂1 , 𝑆𝐴𝑂2) ≤ 1.33 𝑆𝐴.𝑚𝑎𝑥  

𝑆𝐴𝑂.𝑚𝑎𝑥 = 𝑆𝐴𝐿.𝑚𝑎𝑥 +𝑚𝑎𝑥𝑖𝑚𝑢𝑚(𝑆𝐴𝑂1, 𝑆𝐴𝑂2) ≤ 1.33 𝑆𝐴.𝑚𝑎𝑥  

where 

P = maximum of CAEPIPE pressures P1 through P10 

Ppeak = peak pressure = (peak pressure factor in CAEPIPE) x P 

TS = corroded wall thickness = tn - corrosion allowance 

tn = nominal thickness 

Do = outside diameter of the component 

Dis = inside diameter = Do - 2TS 

m = pressure stress multiplier from Appendix III 

iih = stress intensification factor, hoop stress due to in-plane moment as per Appendix III 

ioh = stress intensification factor, hoop stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

ii = stress intensification factor, axial stress due to in-plane moment as per Appendix III 
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io = stress intensification factor, axial stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

FAO = axial force due to occasional loads such as wind or seismic, etc. 

Mio, Moo, Mto = in-plane, out-of-plane and torsional moment respectively due to occasional 
loads such as wind or seismic, etc. 

Z = section modulus = 𝜋[𝐷𝑜
4 − (𝐷𝑜 − 2𝑇𝑠)

4]/32𝐷𝑜 

AS = area of cross-section = 𝜋[𝐷𝑜
2 − 𝐷𝑖𝑠

2 ]/4 

k = 1.33 corresponding to the occasional event duration occurring for not more than 1 hr at any one 
time and not more than 80 hr/yr 

SH.max = hoop allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 .. 
T10)] 

SA.max = axial allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 .. T10)] 

SAO.min = minimum longitudinal stress due to occasional loads such as wind or seismic, etc. 

SAO.max = maximum longitudinal stress due to occasional loads such as wind or seismic, etc. 

Operating Load (Sustained + Expansion) 

(f) The Hoop Stress (SHE) due to operating loads (pressure, weight, other sustained 
mechanical loads and thermal displacement) is calculated from Eq. (2-4-1) of para. 2-4.4.4 
(a) and compared against the limit given in para. 2-4.4.4 (c). 

𝑆𝐻𝐸 = √[
𝑚P𝑛𝐷𝑚
2𝑇𝑠

+
√(𝑖𝑖ℎ𝑀𝑖𝐸)

2 + (𝑖𝑜ℎ𝑀𝑜𝐸)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝐸

𝑍
)
2

≤ 1.1𝑆𝐻.𝑚𝑎𝑥 

(b) The Longitudinal stress (SAE) due to operating loads (pressure, weight, other sustained 
mechanical loads and thermal displacement) is calculated from Eqs. (2-4-2a) and (2-4-2b) 
of para. 2-4.4.4 (b) and compared against the limit given in para. 2-4.4.4 (c). 

𝑆𝐴𝐸1 = √[
P𝑛𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝐸
𝐴𝑠

−
√(𝑖𝑖𝑀𝑖𝐸)

2 + (𝑖𝑜𝑀𝑜𝐸)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

 

𝑆𝐴𝐸2 = √[
P𝑛𝐷𝑖𝑠

2

𝐷𝑜
2 − 𝐷𝑖𝑠

2 +
𝐹𝐴𝐸
𝐴𝑠

+
√(𝑖𝑖𝑀𝑖𝐸)

2 + (𝑖𝑜𝑀𝑜𝐸)
2

𝑍
]

2

+ (
𝑖𝑡𝑀𝑡𝑜

𝑍
)
2

 

𝑆𝐴𝐸.𝑚𝑖𝑛 =  𝑚𝑖𝑛𝑖𝑚𝑢𝑚(𝑆𝐴𝐸1, 𝑆𝐴𝐸2) ≤ 1.1 𝑆𝐴.𝑚𝑎𝑥 

𝑆𝐴𝐸.𝑚𝑎𝑥 =  𝑚𝑎𝑥𝑖𝑚𝑢𝑚(𝑆𝐴𝐸1, 𝑆𝐴𝐸2) ≤ 1.1 𝑆𝐴.𝑚𝑎𝑥  

where 

P𝑛 = internal operating pressure P1 through P10. For example, for Operating Load 1, P𝑛 = P1 

TS = corroded wall thickness = tn - corrosion allowance 
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tn = nominal component thickness 

Do = outside diameter of the component 

Dis = inside diameter = Do - 2TS 

m = pressure stress multiplier from Appendix III 

iih = stress intensification factor, hoop stress due to in-plane moment as per Appendix III 

ioh = stress intensification factor, hoop stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

ii = stress intensification factor, axial stress due to in-plane moment as per Appendix III 

io = stress intensification factor, axial stress due to out-of-plane moment as per Appendix III 

it = torsional stress intensification factor as per Appendix III 

FAE = axial force due to operating load such as weight, other sustained mechanical loads and 
thermal displacement 

MiE, MoE, MtE = in-plane, out-of-plane and torsional moment respectively due to weight, other 
sustained mechanical loads and thermal displacement 

Z = section modulus = 𝜋[𝐷𝑜
4 − (𝐷𝑜 − 2𝑇𝑠)

4]/32𝐷𝑜 

AS = area of cross-section = 𝜋[𝐷𝑜
2 − 𝐷𝑖𝑠

2 ]/4 

SH.max = hoop allowable stress at operating temperatures T1 through T10  

SA.max = axial allowable stress at operating temperature. For example, for Operating Load 1, 
Operating temperature is T1. 

SAE.min = minimum longitudinal stress due to weight, other sustained mechanical loads and 
thermal displacement 

SAE.max = maximum longitudinal stress due to weight, other sustained mechanical loads and 
thermal displacement 
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Flexibility Factors (FFs), Stress Intensification Factors (SIFs) and Pressure Stress 
Multipliers (PSMs) 

The FFs, SIFs and PSMs as per ASME NM.2 code are given below (extracted from Appendix III of 
the code). How they are implemented in CAEPIPE is described below. 

1. Flexibility Factors, Stress Intensification Factors and Pressure Multipliers are calculated 
as per Appendix III of ASME NM.2 only for Type I and Type II components in 
CAEPIPE at this time. Type I and Type II components can be differentiated in 
CAEPIPE by selecting the Material Type as “FR – Fiber/Glass Reinforced Plastics 
(FRP)” OR “F1 – Fiber/Glass Reinforced Plastics (FRP) Type I” and “F2 – 
Fiber/Glass Reinforced Plastics (FRP) Type II” respectively. 

2. Flexibility factor (k) for all components except for Bends & Mitres is set as 1.0 
internally in CAEPIPE. 

3. Flexibility factor (k) for Bend / Mitre is 1.0 when Radius is NOT equal to long radius 
(i.e., k = 1.00 when Radius is <= 1.35D or >= 1.65D, where D is Outside Diameter). 

4. Flexibility factor (k) for long radius Bend and Mitre is 1.0 when the Diameter / 
Thickness ratio is greater than 140. i.e., k = 1.00 when D/t > 140. 

5. Flexibility factor (k) for long radius Bend and Mitre is 1.0 when Pipe Diameter is 
greater than 48”. 

6. Since thicknesses at intrados and extrados are not input at this time, thickness input at 
Bend / Mitre dialog or Thickness of section (when thickness field at Bend / Mitre 
dialog is left blank) (= tn

 = nominal thickness) is considered in computing “ti”, “te”, “tis” 
and “tes” in the calculation, i.e.,  

tis = tes = tn – mill tolerance – corrosion allowance 
ti = te = tn – mill tolerance  
where,  
tn = nominal thickness = thickness input at Bend / Mitre dialog or Thickness of section 

7. Correction factor (𝛼2) is accounted as 1.00 in Stress Intensification Factor (SIF) 
calculation for the Bend / Mitre as intrados and extrados thicknesses cannot be input at 
this time in CAEPIPE. 

8. Correction factor (𝛼3) is accounted as 1.00 in Pressure Stress Multiplier (m) calculation 
for the Bend / Mitre as intrados and extrados thicknesses cannot be input at this time 
in CAEPIPE. 

9. Minimum value of Longitudinal Stress SIF and Shear Stress SIF for all components is 
1.00.  

10. Hoop SIF for all components (excepting Bend / Mitre) is 0.0. For Bend / Mitre, 
Minimum Hoop Stress SIF is 1.00. 

11. Minimum Pressure Stress Multiplier is 1.00 for all components.  

12. Pressure Stress Multiplier is 1.0 for both Type I and Type II Tees when the Diameter is 
greater than 24”. 
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Flexibility Factors (FFs) 

Elbows 

 

TEES      Reducers 
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Stress Intensification Factors (SIFs) 

Elbows 

Correction factor 𝜶𝟐 is not included in the SIF calculation for Elbows as the Bend/Elbow in CAEPIPE 
can only have uniform thickness around its entire circumference.  

 

TEES         Reducers 
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Pressure Stress Multipliers 

Elbows 

 

TEES 

 

Reducers 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from 4.2(4). 

𝑃 =
2𝑓𝑒𝑡𝑓

𝐷 − 2𝑡𝑓
 

where 

𝑃 = allowable pressure 

𝑓 = allowable stress 

𝑒 = joint factor (input as material property) 

𝑡𝑓 = minimum required thickness, including mechanical and corrosion allowances 

 = nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 

𝐷 = outside diameter 

𝑃 =
𝑓𝑒

𝑋(1 + 0.6427 𝑡𝑎𝑛 𝛼√𝑋)
 

where 

𝛼 = miter angle 

𝑋 = (𝐷 − 2𝑡𝑓)/2𝑡𝑓 

Stresses 

Stresses are calculated according to 4.11. 

Sustained stresses are due to pressure, weight and other sustained mechanical loads. 

Maximum value is 0.8 × proof stress value or rupture stress value in hot condition. 

Expansion stresses are due to thermal (including specified displacements) and pressure 
loadings. Maximum value is lower of 

1) 0.9 × proof stress at room temperature plus 0.9 × proof stress at design temperature.  

2) 0.9 × proof stress at room temperature plus rupture stress at design temperature.  

Hot stresses are due to pressure, deadweight, other sustained mechanical loads, thermal and 
cold pull loadings. Maximum value is the rupture stress at design temperature. 

Occasional stresses (which are due to seismic, dynamic or wind loadings) are not calculated. 
If these are to be evaluated, ASME B31.1 code should be used according to Inquiry Case 
806/2 : November 1986 to BS 806 : 1986. 
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Stresses on Straight Pipes and Bends (4.11.4) 

The combined stress 𝑓𝑐 on straight pipes and bends including miter bends is calculated from 
(28). 

𝐹𝐶 = 𝐹
2 + 4𝑓𝑆

2 

where 

𝐹 = greater of 𝑓𝑇 or 𝑓𝐿 

𝑓𝑇 = transverse stress (4.11.4.2) 
 = transverse pressure stress + transverse bending stress 

𝑓𝐿 = longitudinal stress (4.11.4.3) 
 = longitudinal pressure stress + longitudinal bending stress 

𝑓𝑆 = torsional stress (4.11.4.4) 

Transverse Stress 𝒇𝑻  (4.11.4.2) 

The  transverse  pressure  stress  on  both  straight  pipes  and  bends  excluding  miter  
bends  is calculated from (29). 

𝑝𝑑

2𝑡
+ 0.5𝑝 

The transverse pressure stress on miter bends is calculated from (30) 

(
𝑝𝑑

2𝑡
+ 0.5𝑝)(1 + 0.6427 𝑡𝑎𝑛 𝛼√

𝑑 + 𝑡

2𝑡
) 

The transverse bending stress on straight pipe is zero. 

The transverse bending stress on bends including miter bends is calculated from (31) 

𝑟

𝐼
(𝑀𝑖𝐹𝑇𝑖)

2 + (𝑀𝑜𝐹𝑇𝑜)
2 

where 

𝑑 = inside diameter 

𝑡 = thickness 

𝑝 = pressure 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝐹𝑇𝑖 = in-plane transverse stress intensification factor 

𝐹𝑇𝑜 = out-of-plane transverse stress intensification factor 

𝑟 = mean radius of pipe 

𝐼 = moment of inertia 

𝐷 = outside diameter 

𝛼 = miter angle 
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Longitudinal Stress 𝒇𝑳 (4.11.4.3) 

The longitudinal pressure stress on both straight pipes and bends including miter bends is 
calculated form (32) 

𝑝𝑑2

4𝑡(𝑑 + 𝑡)
 

The longitudinal bending stress on straight pipe is calculated from (33). 

𝑑 + 2𝑡

2𝐼
√𝑀𝑖

2 +𝑀𝑜
2 

The longitudinal bending stress on bends including miter bends is calculated from (34). 

𝑟

𝐼
√(𝑀𝑖𝐹𝐿𝑖)

2 + (𝑀𝑜𝐹𝐿𝑜)
2 

where 

𝐹𝐿𝑖 = in-plane longitudinal stress intensification factor 

𝐹𝐿𝑜 = out-of-plane longitudinal stress intensification factor 

Torsional Stress𝒇𝑺  (4.11.4.4) 

The  torsional  stress  for  both  straight  pipes  and  bends  including  miter  bends  is  
calculated from (35). 

𝑓𝑆 = 𝑀𝑡
𝑑 + 2𝑡

4𝐼
 

where 

𝑀𝑡 = torsional moment 

Stress at Branch Junction (4.11.5) 

The combined stress at a branch junction is calculated from (36) 

𝑓𝐶𝐵 = 𝑓𝐵
2 + 4𝑓𝑆𝐵

2  

where 

𝑓𝐵 = transverse pressure stress at the junction plus nondirectional bending stress 

𝑓𝑆𝐵 = torsional stress at the junction 
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Transverse Pressure Stress at Branch Junction (4.11.5.2) 

The transverse pressure stress at branch junction is calculated from (37) 

𝑝𝑚 (
𝑑1 + 𝑡𝑎
2𝑡𝑎

) 

where 

𝑑1 = mean radius of main pipe 

𝑡𝑎 = minimum thickness of main pipe 

𝑝 = design pressure 

𝑚 = stress multiplier, or equal to: 
  (a) for branch junctions where both r2/r1 and t2/t1 are less than or equal to 0.3 

  𝑚 = 1.8 +
2.8𝑟2

𝑟1
√
𝑟1

𝑡1
 

  (b) for branch junctions where either r2/r1 and t2/t1 are greater than 0.3 

  𝑚 = 2.5𝑍1
0.2042 for 𝑑2/𝑑1 ≤ 0.7 

  𝑚 = 2.5𝑍1
0.2415 for 𝑑2/𝑑1 > 0.7 

  𝑍1 = (𝑟2/𝑡2)
2𝑡1/𝑟1 

  𝑟1 = mean radius of main pipe 

  𝑟2 = mean radius of branch pipe 

  𝑡1 = thickness of main pipe 

  𝑡2 = thickness of branch pipe 

Non-directional Bending Stress at Branch Junction (4.11.5.3) 

For the main pipe, the bending stress is calculated from (40) 

𝑟1
𝐼
√(𝑀𝑖𝐵𝑖)2 + (𝑀𝑜𝐵𝑜)2 

where 

𝑟1 = mean radius of pipe 

𝐼 = moment of inertia of main pipe 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝐵𝑖 = in-plane branch stress intensification factor (Fig.4.11.1(6)) 

𝐵𝑜 = out-of-plane branch stress intensification factor (Fig.4.11.1(6)) 
For the branch pipe, the bending stress is calculated from 

𝑟2
𝐼
√(𝑀𝑖𝐵𝑖)2 + (𝑀𝑜𝐵𝑜)2 

where 

𝑟2 = mean radius of branch pipe 

𝐼 = calculated from 𝜋𝑟2
3𝐵𝑜𝑡2 or 𝜋𝑟2

3𝑡1 whichever gives the lower value 
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Sustained Stress 

The Allowable Stress Design (ASD) provisions as given in Section 5.6.2.2 of DNV-ST-F101 (2021) 
code are implemented in CAEPIPE as detailed below. 

(a) The hoop stress is defined by the following formula as per Section 5.6.2.2 

𝜎ℎ(𝑠) = 
𝑃𝐷𝑟,𝑚𝑖𝑛
2. 𝑡2

 

(b) The longitudinal / axial stresses are defined by the following formulae as per Section 
5.6.2.2 

𝜎𝑎(𝑠) =
𝐹𝑎(𝑠)

𝐴𝑟
+
𝑃𝐷𝑟,𝑚𝑖𝑛

4.𝑡2
=

𝐹𝑎(𝑠)
𝜋

4
(𝑂𝐷𝑟,𝑚𝑖𝑛

2− 𝐼𝐷𝑟
2)

 +
𝑃𝐷𝑟,𝑚𝑖𝑛

4.𝑡2
 

𝜎𝑏(𝑠) =
√(𝑆𝐼𝐹𝑎𝑖.𝑀𝑖(𝑠))

2
+ (𝑆𝐼𝐹𝑎𝑜. 𝑀𝑜(𝑠))

2

𝑍𝑟
 

𝑍𝑟 =
𝜋

32

(𝑂𝐷𝑟,𝑚𝑖𝑛
4− 𝐼𝐷𝑟

4)

𝑂𝐷𝑟,𝑚𝑖𝑛
  

(c) Torsional stress is defined by the following formula as per Section 5.6.2.2 

Torsional Stress = 𝜎𝑡(𝑠) =
𝑀𝑡(𝑠)

2𝑍𝑟
 

where 

P = maximum of CAEPIPE input pressures P1 through P10, where the maximum operating pressure 
Pi (with i between 1 & 10) = the difference between the corresponding internal pressure Pi and 

external pressure Pe = (𝑃𝑖 − 𝑃𝑒) 

𝑡2 = minimum pipe wall thickness  

    = nominal thickness x (1 – mill tolerance/100) – corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

𝑂𝐷𝑟,𝑚𝑖𝑛= minimum outside diameter of the pipe wall = Outer Diameter in CAEPIPE 

𝐷𝑟,𝑚𝑖𝑛 = mean diameter of the pipe wall = 𝑂𝐷𝑟,𝑚𝑖𝑛 − 𝑡2 

𝐼𝐷𝑟= inside diameter of the pipe wall = 𝑂𝐷𝑟,𝑚𝑖𝑛 − 2. 𝑡2 

𝐴𝑟= inside metallic area of the pipe 

𝑆𝐼𝐹𝑎𝑖, 𝑆𝐼𝐹𝑎𝑜 = in-plane and out-of-plane stress longitudinal/axial intensification factors as per 
Appendix D of ASME B31.8 (2020).  

𝑀𝑖(𝑠),𝑀𝑜(𝑠),𝑀𝑡(𝑠) = in-plane, out-of-plane bending moment and torsional moment respectively due 

to weight and other sustained mechanical loads (excluding pressure) 

𝑍𝑟= minimum pipe wall section modulus. 

𝐹𝑎(𝑠)= axial force due to weight and other sustained mechanical loads (excluding pressure). 
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(d) Equivalent stress, Von Mises, is computed as given below. 

Equivalent Stress, Von Mises at One Extreme Surface of Pipe 

In CAEPIPE, Equivalent Stress, Von Mises, at One Extreme Surface of Pipe is computed as given 
below. 

𝑇1(𝑠) = 
𝜎ℎ(𝑠)−𝜎𝑎(𝑠)−𝜎𝑏(𝑠)

2
 

𝑈1(𝑠)= √T1(𝑠)
2 + (𝜎𝑡(𝑠))

2
 

Sigma l = 𝜎1(𝑠) = 
𝜎ℎ(𝑠)+𝜎𝑎(𝑠)+𝜎𝑏(𝑠)

2
+ 𝑈1(𝑠) 

Sigma 2 = 𝜎2(𝑠) = 
𝜎ℎ(𝑠)+𝜎𝑎(𝑠)+𝜎𝑏(𝑠)

2
 – 𝑈1(𝑠) 

𝑉𝑜𝑛𝑀𝑖𝑠𝑒𝑠_𝑡(𝑠)= √(𝝈𝟏(𝒔))
𝟐
− 𝝈𝟏(𝒔)𝝈𝟐(𝒔) + (𝝈𝟐(𝒔))

𝟐
 

𝑀𝑎𝑥_𝑡(𝑠)= 𝝈𝟏(𝒔); 𝑀𝑖𝑛_𝑡(𝑠)= 𝝈𝟐(𝒔) 

Equivalent Stress, Von Mises at Other Extreme Surface of Pipe 

In CAEPIPE, Equivalent Stress, Von Mises, at Other Extreme Surface of Pipe is computed as given 
below. 

𝑇2(𝑠)  = 
𝜎ℎ(𝑠)−𝜎𝑎(𝑠)+𝜎𝑏(𝑠)

2
 

𝑈2(𝑠)  = √T2(𝑠)
2 + (𝜎𝑡(𝑠))

2
 

Sigma l = 𝜎1(𝑠) = 
𝜎ℎ(𝑠)+𝜎𝑎(𝑠)−𝜎𝑏(𝑠)

2
+ 𝑈2(𝑠) 

Sigma 2 = 𝜎2(𝑠) = 
𝜎ℎ(𝑠)+𝜎𝑎(𝑠)−𝜎𝑏(𝑠)

2
− 𝑈2(𝑠)  

𝑉𝑜𝑛𝑀𝑖𝑠𝑒𝑠_𝑏(𝑠)= √(𝝈𝟏(𝒔))
𝟐
− 𝝈𝟏(𝒔)𝝈𝟐(𝒔) + (𝝈𝟐(𝒔))

𝟐
 

𝑀𝑎𝑥_𝑏(𝑠)= 𝝈𝟏(𝒔); 𝑀𝑖𝑛_𝑏(𝑠)= 𝝈𝟐(𝒔) 

Based on the above (d), for the entire Pipe Cross-section at a Node  

𝐄𝐪𝐮𝐢𝐯𝐚𝐥𝐞𝐧𝐭 𝐒𝐭𝐫𝐞𝐬𝐬, 𝐕𝐨𝐧𝐌𝐢𝐬𝐞𝐬(𝐬) = 𝑴𝒂𝒙 [𝑽𝒐𝒏𝑴𝒊𝒔𝒆𝒔_𝒕(𝒔), 𝑽𝒐𝒏𝑴𝒊𝒔𝒆𝒔_𝒃(𝒔)] ≤  𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟏) 

𝐌𝐚𝐱. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒔) = 𝑴𝒂𝒙 [𝑴𝒂𝒙_𝒕(𝒔),𝑴𝒂𝒙_𝒃(𝒔)] ≤  𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟐) 

𝐌𝐢𝐧. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒔) = 𝑴𝒊𝒏 [𝑴𝒊𝒏_𝒕(𝒔),𝑴𝒊𝒏_𝒃(𝒔)] ≤  𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟐) 

where 

𝜂 = design factor for equivalent stress check as per Table 5-15 of DNV-ST-F101 code. This can be 

selected in CAEPIPE through Layout Window > Options > Analysis > Design factor.  

𝑓𝑦 = Yield strength at room temperature. 
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Operating Stress 

(a) The hoop stress is defined by the following formula as per Section 5.6.2.2 

𝜎ℎ(𝑜𝑝) = 
𝑃𝐷𝑟,𝑚𝑖𝑛
2. 𝑡2

 

(b) The longitudinal / axial stresses are defined by the following formulae as per Section 
5.6.2.2 

𝜎𝑎(𝑜𝑝) =
𝐹𝑎(𝑜𝑝)

𝐴𝑟
+
𝑃𝐷𝑟,𝑚𝑖𝑛

4.𝑡2
=

𝐹𝑎(𝑜𝑝)
𝜋

4
(𝑂𝐷𝑟,𝑚𝑖𝑛

2− 𝐼𝐷𝑟
2)

 +
𝑃𝐷𝑟,𝑚𝑖𝑛

4.𝑡2
 

𝜎𝑏(𝑜𝑝) =
√(𝑆𝐼𝐹𝑎𝑖. 𝑀𝑖(𝑜𝑝))

2
+ (𝑆𝐼𝐹𝑎𝑜. 𝑀𝑜(𝑜𝑝))

2

𝑍𝑟
 

𝑍𝑟 =
𝜋

32

(𝑂𝐷𝑟,𝑚𝑖𝑛
4− 𝐼𝐷𝑟

4)

𝑂𝐷𝑟,𝑚𝑖𝑛
  

(c) Torsional stress is defined by the following formula as per Section 5.6.2.2 

Torsional Stress = 𝜎𝑡(𝑠) =
𝑀𝑡(𝑜𝑝)

2𝑍𝑟
 

where 

P = CAEPIPE input pressures P1 through P10 (= P1 for Operating 1, P2 for Operating 2, …, P10 
for Operating 10, where the Operating pressure Pi with I between 1 & 10) = the difference between 

the corresponding internal pressure Pi and external pressure Pe = (𝑃𝑖 − 𝑃𝑒). 

𝑡2 = minimum pipe wall thickness  

    = nominal thickness x (1 – mill tolerance/100) – corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

𝑂𝐷𝑟,𝑚𝑖𝑛= minimum outside diameter of the pipe wall = Outer Diameter in CAEPIPE 

𝐷𝑟,𝑚𝑖𝑛 = mean diameter of the pipe wall = 𝑂𝐷𝑟,𝑚𝑖𝑛 − 𝑡2 

𝐼𝐷𝑟= inside diameter of the pipe wall = 𝑂𝐷𝑟,𝑚𝑖𝑛 − 2. 𝑡2 

𝐴𝑟= inside metallic area of the pipe 

𝑆𝐼𝐹𝑎𝑖, 𝑆𝐼𝐹𝑎𝑜 = in-plane and out-of-plane stress longitudinal/axial intensification factors as per 
Appendix D of ASME B31.8 (2020).  

𝑀𝑖(𝑜𝑝), 𝑀𝑜(𝑜𝑝),𝑀𝑡(𝑜𝑝) = in-plane, out-of-plane bending moment and torsional moment respectively 

due to weight, other sustained mechanical loads (excluding pressure) and thermal expansion including 
thermal movements at supports. 

𝑍𝑟= minimum pipe wall section modulus. 

𝐹𝑎(𝑜𝑝)= axial force due to weight, other sustained mechanical loads and thermal displacement 

(excluding pressure). 
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(d) Equivalent stress, Von Mises, is computed as given below. 

Equivalent Stress, Von Mises at One Extreme Surface of Pipe 

In CAEPIPE, Equivalent Stress, Von Mises, at One Extreme Surface of Pipe is computed as given 
below. 

𝑇1(𝑜𝑝) = 
𝜎ℎ(𝑜𝑝)−𝜎𝑎(𝑜𝑝)−𝜎𝑏(𝑜𝑝)

2
 

𝑈1(𝑜𝑝)= √T1(𝑜𝑝)
2 + (𝜎𝑡(𝑜𝑝))

2
 

Sigma l = 𝜎1(𝑜𝑝) = 
𝜎ℎ(𝑜𝑝)+𝜎𝑎(𝑜𝑝)+𝜎𝑏(𝑜𝑝)

2
+ 𝑈1(𝑜𝑝) 

Sigma 2 = 𝜎2(𝑜𝑝) = 
𝜎ℎ(𝑜𝑝)+𝜎𝑎(𝑜𝑝)+𝜎𝑏(𝑜𝑝)

2
 – 𝑈1(𝑜𝑝) 

𝑉𝑜𝑛𝑀𝑖𝑠𝑒𝑠_𝑡(𝑜𝑝)= √(𝝈𝟏(𝒐𝒑))
𝟐
− 𝝈𝟏(𝒐𝒑)𝝈𝟐(𝒐𝒑) + (𝝈𝟐(𝒐𝒑))

𝟐
 

𝑀𝑎𝑥_𝑡(𝑜𝑝)= 𝝈𝟏(𝒐𝒑); 𝑀𝑖𝑛_𝑡(𝑜𝑝)= 𝝈𝟐(𝒐𝒑) 

Equivalent Stress, Von Mises at Other Extreme Surface of Pipe 

In CAEPIPE, Equivalent Stress, Von Mises, at Other Extreme Surface of Pipe is computed as given 
below. 

𝑇2(𝑜𝑝)  = 
𝜎ℎ(𝑜𝑝)−𝜎𝑎(𝑜𝑝)+𝜎𝑏(𝑜𝑝)

2
 

𝑈2(𝑜𝑝)  = √T2(𝑜𝑝)
2 + (𝜎𝑡(𝑜𝑝))

2
 

Sigma l = 𝜎1(𝑜𝑝) = 
𝜎ℎ(𝑜𝑝)+𝜎𝑎(𝑜𝑝)−𝜎𝑏(𝑜𝑝)

2
+ 𝑈2(𝑜𝑝) 

Sigma 2 = 𝜎2(𝑜𝑝) = 
𝜎ℎ(𝑜𝑝)+𝜎𝑎(𝑜𝑝)−𝜎𝑏(𝑜𝑝)

2
− 𝑈2(𝑜𝑝)  

𝑉𝑜𝑛𝑀𝑖𝑠𝑒𝑠_𝑏(𝑜𝑝)= √(𝝈𝟏(𝒐𝒑))
𝟐
− 𝝈𝟏(𝒐𝒑)𝝈𝟐(𝒐𝒑) + (𝝈𝟐(𝒐𝒑))

𝟐
 

𝑀𝑎𝑥_𝑏(𝑜𝑝)= 𝝈𝟏(𝒐𝒑); 𝑀𝑖𝑛_𝑏(𝑜𝑝)= 𝝈𝟐(𝒐𝒑) 

Based on the above (d), for the entire Pipe Cross-section at a Node  

𝐄𝐪𝐮𝐢𝐯𝐚𝐥𝐞𝐧𝐭 𝐒𝐭𝐫𝐞𝐬𝐬, 𝐕𝐨𝐧𝐌𝐢𝐬𝐞𝐬(𝐨𝐩) = 𝑴𝒂𝒙 [𝑽𝒐𝒏𝑴𝒊𝒔𝒆𝒔_𝒕(𝒐𝒑), 𝑽𝒐𝒏𝑴𝒊𝒔𝒆𝒔_𝒃(𝒐𝒑)]

≤  𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟏) 

𝐌𝐚𝐱. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐𝒑) = 𝑴𝒂𝒙 [𝑴𝒂𝒙_𝒕(𝒐𝒑),𝑴𝒂𝒙_𝒃(𝒐𝒑)] ≤  𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟐) 

𝐌𝐢𝐧. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐𝒑) = 𝑴𝒊𝒏 [𝑴𝒊𝒏_𝒕(𝒐𝒑),𝑴𝒊𝒏_𝒃(𝒐𝒑)] ≤  𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟐) 

where 

𝜂 = design factor for equivalent stress check as per Table 5-15 of DNV-ST-F101 code. This can be 

selected in CAEPIPE through Layout Window > Options > Analysis > Design factor.  

𝑓𝑦 = Yield strength at room temperature. 
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Sustained + Occasional Stress  

(a) The hoop stress is defined by the following formula as per Section 5.6.2.2 

𝜎ℎ(𝑜) = 
(𝑃𝑝𝑒𝑎𝑘 − 𝑃)𝐷𝑟,𝑚𝑖𝑛

2. 𝑡2
 

(b) The longitudinal / axial stresses are defined by the following formulae as per Section 
5.6.2.2 

𝜎𝑎(𝑜) =
𝐹𝑎(𝑜)

𝐴𝑟
+
𝑃𝐷𝑟,𝑚𝑖𝑛

4.𝑡2
=

𝐹𝑎(𝑜)
𝜋

4
(𝑂𝐷𝑟,𝑚𝑖𝑛

2− 𝐼𝐷𝑟
2)

 +
𝑃𝐷𝑟,𝑚𝑖𝑛

4.𝑡2
 

𝜎𝑏(𝑜) =
√(𝑆𝐼𝐹𝑎𝑖.𝑀𝑖(𝑜))

2
+ (𝑆𝐼𝐹𝑎𝑜. 𝑀𝑜(𝑜))

2

𝑍𝑟
 

𝑍𝑟 =
𝜋

32

(𝑂𝐷𝑟,𝑚𝑖𝑛
4− 𝐼𝐷𝑟

4)

𝑂𝐷𝑟,𝑚𝑖𝑛
  

(c) Torsional stress is defined by the following formulae as per Section 5.6.2.2 

Torsional Stress = 𝜎𝑡(𝑜) =
𝑀𝑡(𝑜)

2𝑍𝑟
 

where 

P = maximum of CAEPIPE input pressures P1 through P10, where the maximum operating pressure 
Pi (with i between 1 & 10) = the difference between the corresponding internal pressure Pi and 

external pressure Pe = (𝑃𝑖 − 𝑃𝑒) 

Ppeak = peak pressure = peak pressure factor x P 

𝑡2 = minimum pipe wall thickness  

    = nominal thickness x (1 – mill tolerance/100) – corrosion allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

𝑂𝐷𝑟,𝑚𝑖𝑛= minimum outside diameter of the pipe wall = Outer Diameter in CAEPIPE 

𝐷𝑟,𝑚𝑖𝑛 = mean diameter of the pipe wall = 𝑂𝐷𝑟,𝑚𝑖𝑛 − 𝑡2 

𝐼𝐷𝑟= inside diameter of the pipe wall = 𝑂𝐷𝑟,𝑚𝑖𝑛 − 2. 𝑡2 

𝐴𝑟= inside metallic area of the pipe 

𝑆𝐼𝐹𝑎𝑖, 𝑆𝐼𝐹𝑎𝑜 = in-plane and out-of-plane stress longitudinal/axial intensification factors as per 
Appendix D of ASME B31.8 (2020).  

𝑀𝑖(𝑜),𝑀𝑜(𝑜),𝑀𝑡(𝑜) = in-plane, out-of-plane bending moment and torsional moment respectively due 

to occasional loads such as flow transients, earthquake, wind, etc. 

𝑍𝑟= minimum reinforced pipe wall section modulus. 

𝐹𝑎(𝑜)= axial force due to occasional loads such as flow transients, earthquake, wind, etc. 
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(d) Equivalent stress, Von Mises, is computed as given below. 

Equivalent Stress, Von Mises at One Extreme Surface of Pipe 

In CAEPIPE, Equivalent Stress, Von Mises, at One Extreme Surface of Pipe is computed as given 
below. 

𝑇1(𝑜) = 
𝜎ℎ(𝑜)−𝜎𝑎(𝑜)−𝜎𝑏(𝑜)

2
 

𝑈1(𝑜)= √T1(𝑜)
2 + (𝜎𝑡(𝑜))

2
 

Sigma l = 𝜎1(𝑜) = 
𝜎ℎ(𝑜)+𝜎𝑎(𝑜)+𝜎𝑏(𝑜)

2
+ 𝑈1(𝑜) 

Sigma 2 = 𝜎2(𝑜) = 
𝜎ℎ(𝑜)+𝜎𝑎(𝑜)+𝜎𝑏(𝑜)

2
 – 𝑈1(𝑜) 

𝑉𝑜𝑛𝑀𝑖𝑠𝑒𝑠_𝑡(𝑜)= √(𝝈𝟏(𝒐))
𝟐
− 𝝈𝟏(𝒐)𝝈𝟐(𝒐) + (𝝈𝟐(𝒐))

𝟐
 

𝑀𝑎𝑥_𝑡(𝑜)= 𝝈𝟏(𝒐); 𝑀𝑖𝑛_𝑡(𝑜)= 𝝈𝟐(𝒐) 

Equivalent Stress, Von Mises at Other Extreme Surface of Pipe 

In CAEPIPE, Equivalent Stress, Von Mises, at Other Extreme Surface of Pipe is computed as given 
below. 

𝑇2(𝑜)  = 
𝜎ℎ(𝑜)−𝜎𝑎(𝑜)+𝜎𝑏(𝑜)

2
 

𝑈2(𝑜)  = √T2(𝑜)
2 + (𝜎𝑡(𝑜))

2
 

Sigma l = 𝜎1(𝑜) = 
𝜎ℎ(𝑜)+𝜎𝑎(𝑜)−𝜎𝑏(𝑜)

2
+ 𝑈2(𝑜) 

Sigma 2 = 𝜎2(𝑜) = 
𝜎ℎ(𝑜)+𝜎𝑎(𝑜)−𝜎𝑏(𝑜)

2
− 𝑈2(𝑜)  

𝑉𝑜𝑛𝑀𝑖𝑠𝑒𝑠_𝑏(𝑜)= √(𝝈𝟏(𝒐))
𝟐
− 𝝈𝟏(𝒐)𝝈𝟐(𝒐) + (𝝈𝟐(𝒐))

𝟐
 

𝑀𝑎𝑥_𝑏(𝑜)= 𝝈𝟏(𝒐); 𝑀𝑖𝑛_𝑏(𝑜)= 𝝈𝟐(𝒐) 

Based on the above (d), for the entire Pipe Cross-section at a Node  

𝐄𝐪𝐮𝐢𝐯𝐚𝐥𝐞𝐧𝐭 𝐒𝐭𝐫𝐞𝐬𝐬, 𝐕𝐨𝐧𝐌𝐢𝐬𝐞𝐬(𝐨) = 𝑴𝒂𝒙 [𝑽𝒐𝒏𝑴𝒊𝒔𝒆𝒔_𝒕(𝒐), 𝑽𝒐𝒏𝑴𝒊𝒔𝒆𝒔_𝒃(𝒐)] 

𝐌𝐚𝐱. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐) = 𝑴𝒂𝒙 [𝑴𝒂𝒙_𝒕(𝒐),𝑴𝒂𝒙_𝒃(𝒐)] 

𝐌𝐢𝐧. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐) = 𝑴𝒊𝒏 [𝑴𝒊𝒏_𝒕(𝒐),𝑴𝒊𝒏_𝒃(𝒐)] 

Sustained + Occasional Stress at a Node  
𝐄𝐪𝐮𝐢𝐯𝐚𝐥𝐞𝐧𝐭 𝐒𝐭𝐫𝐞𝐬𝐬, 𝐕𝐨𝐧𝐌𝐢𝐬𝐞𝐬(𝐬𝐨) = 𝐕𝐨𝐧𝐌𝐢𝐬𝐞𝐬(𝐬) + 𝐕𝐨𝐧𝐌𝐢𝐬𝐞𝐬(𝐨) ≤ 𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟏) 

𝐌𝐚𝐱. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐) =  𝐌𝐚𝐱. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒔) +𝐌𝐚𝐱. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐)
≤ 𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟐) 

𝐌𝐢𝐧. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐) = 𝐌𝐢𝐧. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒔) +𝐌𝐢𝐧. 𝐏𝐫𝐢𝐧𝐜𝐢𝐩𝐚𝐥 𝐒𝐭𝐫𝐞𝐬𝐬(𝒐)
≤ 𝜼. 𝒇𝒚…𝑬𝒒. (𝟓. 𝟓𝟐) 

where 

𝜂 = design factor for equivalent stress check as per Table 5-15 of DNV-ST-F101 code. This can be 

selected in CAEPIPE through Layout Window > Options > Analysis > Design factor.  



Submarine pipeline systems 
DNV-ST-F101 (2021) 

 

435 
 

 

𝑓𝑦 = Yield strength at room temperature. 

Stress Intensification Factors (SIFs) and Flexibility Factors (FFs) 

For structural design of components and bends, Table 5-14 of DNV-ST-F101 refers to ASME B31.4 
or ASME B31.8. Hence, Stress Intensification Factors (SIFs) for DNV-ST-F101 code are computed 
as per SIF equations provided in Appendix D of ASME B31.8 (2020) as given below. 

In addition, Section 5.6.2.2 of DNV-ST-F101 states the following “The moment and axial loads are 
calculated based on pipe type finite elements, not including the benefit of reduced stiffness in bends”. In view of the 
above, flexibility factors for Bends and Miter Bends are set as 1.0 internally in CAEPIPE for this 
code. Also, the analysis options “Include Bourdon Effect” and “Use Pressure Correction for Bends” 
are not available for DNV-ST-F101 Code. 
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using the equation provided 
in para. 5.2.1 for straight pipes and bends. 

𝑃𝑎 =
2𝑓𝑆𝑦𝑡𝑡𝑎

𝐷𝑋
 

 

where 

Pa= allowable pressure 

Syt = specified minimum yield strength  

ta= available thickness for pressure design  

  = tn × (1 - mill tolerance/100) - corrosion allowance “c” (as per para. 8.3.3) 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

D = outside diameter 

f = design factor from Table 2. 

Stress from Normal Sustained Loads 

The von Mises equivalent stress (𝑆𝐿) due to Normal Sustained Loads (pressure, weight and 
other sustained loads inclusive of snow/ice loading) is calculated as per para. 6.3, para. 8.5.2 
and Appendix 3 for all components in CAEPIPE and compared with the acceptance limit 
given in para. 8.5.3, as given below. 

𝑆𝐿 = √(𝑆ℎ − 𝑆𝑎)2 + (𝑆ℎ𝑆𝑎) + 3𝑆𝑞
2 ≤ 𝑆𝑠 

where 

For Bends, Miter Bends and Welding Elbows 

𝑆𝑎 = 𝑖𝑡 [
𝑃𝐷𝑜
4𝑡𝑠

+
4𝐹

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
] ±

𝑖𝑡32𝑀𝑏𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆ℎ = 𝑖𝑝 [
𝑃𝐷𝑜
2𝑡𝑠

] ±
𝑖𝑏32𝑀𝑏𝐷0

𝜋[𝐷𝑜
4 −𝐷𝑖

4]
 

 

𝑆𝑞 = 𝑖𝑞 [
16𝐷𝑜𝑀𝑞

𝜋[𝐷𝑜
4 −𝐷𝑖

4]
] + 𝑖𝑠

4𝑉𝑇

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
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For Other components such as Straight Pipes, Reducers, Branch Pipes, Header Pipes, etc. 

𝑆𝑎 = 𝑖𝑡 [
𝑃𝐷𝑜
4𝑡𝑠

+
4𝐹

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
] ±

𝑖𝑏32𝑀𝑏𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆ℎ = 𝑖𝑝 [
𝑃𝐷𝑜
2𝑡𝑠

] 

 

𝑆𝑞 = 𝑖𝑞 [
16𝐷𝑜𝑀𝑞

𝜋[𝐷𝑜
4 −𝐷𝑖

4]
] + 𝑖𝑠

4𝑉𝑇

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 (inclusive of any overpressure 
as per para. 5.2.3) 

𝐷𝑜 = outside diameter 

𝐷𝑖 = inside diameter 

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 8.3.3 

𝑖𝑝, 𝑖𝑏 , 𝑖𝑡, 𝑖𝑞 , 𝑖𝑠= sustained stress concentration factor (SCF) for pressure, bending, thrust, 

torsion and shear computed as per Appendix 4. 

𝑆ℎ = sustained hoop stress 

𝑆𝑎 = sustained axial stress  

𝑆𝑞 = sustained shear stress 

F = axial force due to sustained loads 

𝑀𝑏 = bending moment due to sustained loads = √𝑀𝑖
2 +𝑀𝑜

2 

𝑀𝑞 = torsional moment due to sustained loads  

𝑉𝑇 = shear force due to sustained loads = √𝑉𝑖
2 + 𝑉𝑜

2 

𝑀𝑖 = in-plane bending moment due to sustained loads 

𝑀𝑜 = out-of-plane bending moment due to sustained loads  

𝑉𝑖 = in-plane shear force (local fy from CAEPIPE) due to sustained loads 

𝑉𝑜 = out-of-plane shear force (local fz from CAEPIPE) due to sustained loads 

𝑆𝑠 = allowable equivalent stress for Normal condition from Table 3 (given below). 
 
Note:  

In CAEPIPE, any wind load input is always considered as an “Abnormal” sustained load 
(and NOT as a Normal sustained load). 

In addition, CAEPIPE always considers snow/ice loading as a “Normal” sustained load (and 
NOT as an Abnormal sustained load). 

In CAEPIPE, the effect of cold-pull/cold spring is included only in support loads and not 
included in stress calculations as many piping codes do not allow credit for any reduction in 
stresses due to cold spring since the displacement range is unaffected.On the other hand, 
piping codes allow reduction in support loads due to cold spring (which can be helpful at the 
equipment).  
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Stress from Abnormal Sustained Loads 

The von Mises equivalent stress (𝑆𝐿𝑜) due to Abnormal Sustained Loads is calculated as per 

para. 6.4, para. 8.5.2 and Appendix 3 for all components as the Sum of stress (𝑆𝐿) due to 

Normal Sustained Loads (pressure, weight and other sustained loads) and stress (𝑆𝑜) due to 
Abnormal Sustained Loads (i.e., occasional loads) such as earthquake or wind. Wind and 

earthquake are not considered as acting concurrently. The resulting stress 𝑆𝐿𝑜 is compared 
with the acceptance limit given in para. 8.5.3. 

𝑆𝐿𝑜 ≤ 𝑆𝑠𝑎𝑏 

where 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑆𝑂, where 𝑆𝐿 is computed as above. 
 

𝑆𝑜 = √(𝑆ℎ𝑜 − 𝑆𝑎𝑜)2 + (𝑆ℎ𝑜𝑆𝑎𝑜) + 3𝑆𝑞𝑜
2
 

For Bends, Miter Bends and Welding Elbows 

𝑆𝑎0 = 𝑖𝑡 [
𝑃𝑝𝑒𝑎𝑘𝐷𝑜

4𝑡𝑠
+

4𝐹𝑜

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
] ±

𝑖𝑡32𝑀𝑏0𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆ℎ𝑜 = 𝑖𝑝 [
𝑃𝑝𝑒𝑎𝑘𝐷𝑜

2𝑡𝑠
] ±

𝑖𝑏32𝑀𝑏0𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆𝑞𝑜 = 𝑖𝑞 [
16𝐷𝑜𝑀𝑞𝑜

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
] + 𝑖𝑠

4𝑉𝑇𝑜

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
 

 

For Other components such as Straight Pipes, Reducers, Branch Pipes, Header Pipes, etc., 

𝑆𝑎0 = 𝑖𝑡 [
𝑃𝑝𝑒𝑎𝑘𝐷𝑜

4𝑡𝑠
+

4𝐹𝑜

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
] ±

𝑖𝑏32𝑀𝑏0𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆ℎ𝑜 = 𝑖𝑝 [
𝑃𝑝𝑒𝑎𝑘𝐷𝑜

2𝑡𝑠
] 

 

𝑆𝑞𝑜 = 𝑖𝑞 [
16𝐷𝑜𝑀𝑞𝑜

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
] + 𝑖𝑠

4𝑉𝑇𝑜

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
 

 

𝑃𝑝𝑒𝑎𝑘= peak pressure = (peak pressure factor in CAEPIPE – 1.0) x P 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷𝑜 = outside diameter 

𝐷𝑖 = inside diameter 

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 8.3.3 
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𝑖𝑝, 𝑖𝑏 , 𝑖𝑡, 𝑖𝑞 , 𝑖𝑠= sustained stress concentration factor (SCF) for pressure, bending, thrust, 

torsion and shear computed as per Appendix 4. 

𝑆ℎ𝑜 = occasional hoop stress 

𝑆𝑎𝑜 = occasional axial stress  

𝑆𝑞𝑜 = occasional shear stress 

𝐹𝑜 = axial force due to occasional loads 

𝑀𝑏𝑜 = bending moment due to occasional loads = √𝑀𝑖𝑜
2 +𝑀𝑜𝑜

2 

𝑀𝑞𝑜 = torsional moment due to occasional loads 

𝑉𝑇𝑜 = shear force due to occasional loads = √𝑉𝑖𝑜
2 + 𝑉𝑜𝑜

2 

𝑀𝑖𝑜 = in-plane bending moment due to occasional loads 

𝑀𝑜𝑜 = out-of-plane bending moment due to occasional loads 

𝑉𝑖𝑜 = in-plane shear force (local fy from CAEPIPE) due to occasional loads 

𝑉𝑜𝑜 = out-of-plane shear force (local fz from CAEPIPE) due to occasional loads 

𝑆𝑠𝑎𝑏 = allowable equivalent stress for Abnormal condition from Table 3 (given below). 
 
Note:  

In CAEPIPE, any ground settlement input is considered in computing “Shakedown Stress” 
(which is covered next) and NOT as an Abnormal sustained load. 

 
Table 3: Allowable Stress for Normal and Abnormal Sustained Loads  

 

Expansion Stress (Shakedown Stress) 

The von Mises equivalent stress (𝑆𝐸) range due to thermal expansion is calculated as per 
para. 8.5.4 and Appendix 3 for all components in CAEPIPE and compared with the 
acceptance limit given in para. 8.5.5, as given below. 

𝑆𝐸 ≤ 0.5𝐾𝑆𝐷(𝑆𝑦 + 𝑆𝑌𝑇) 

where 

𝑆𝐸 = √(𝑆ℎ𝑒 − 𝑆𝑎𝑒)2 + (𝑆ℎ𝑒𝑆𝑎𝑒) + 3𝑆𝑞𝑒
2
 

For Bends, Miter Bends and Welding Elbows 
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𝑆𝑎𝑒 = 𝑖𝑡 [
𝑃𝐷𝑜
4𝑡𝑠

+
4𝐹𝑒

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
] ±

𝑖𝑡32𝑀𝑏𝑒𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆ℎ𝑒 = 𝑖𝑝 [
𝑃𝐷𝑜
2𝑡𝑠

] ±
𝑖𝑏32𝑀𝑏𝑒𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆𝑞𝑒 = 𝑖𝑞 [
16𝐷𝑜𝑀𝑞𝑒

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
] + 𝑖𝑠

4𝑉𝑇𝑒

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
 

 

For Other components such as Straight Pipes, Reducers, Branch Pipes, Header Pipes, etc., 

𝑆𝑎𝑒 = 𝑖𝑡 [
𝑃𝐷𝑜
4𝑡𝑠

+
4𝐹𝑒

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
] ±

𝑖𝑏32𝑀𝑏𝑒𝐷0

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
 

 

𝑆ℎ𝑒 = 𝑖𝑝 [
𝑃𝐷𝑜
2𝑡𝑠

] 

 

𝑆𝑞𝑒 = 𝑖𝑞 [
16𝐷𝑜𝑀𝑞𝑒

𝜋[𝐷𝑜
4 − 𝐷𝑖

4]
] + 𝑖𝑠

4𝑉𝑇𝑒

𝜋[𝐷𝑜
2 − 𝐷𝑖

2]
 

 

𝑃 = operating pressure corresponding to the temperature considered for displacement cycle 
under analysis. For example, P = P1 from CAEPIPE for Expansion T1. 

𝐷𝑜 = outside diameter 

𝐷𝑖 = inside diameter 

𝑡𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 8.3.3 

𝑖𝑝, 𝑖𝑏 , 𝑖𝑡, 𝑖𝑞 , 𝑖𝑠= cyclic stress concentration factor (SCF) for pressure, bending, thrust, torsion 

and shear computed as per Appendix 4. 

𝑆ℎ𝑒 = thermal expansion hoop stress 

𝑆𝑎𝑒 = thermal expansion axial stress  

𝑆𝑞𝑒 = thermal expansion shear stress 

𝐹𝑒 = axial force due to thermal expansion 

𝑀𝑏𝑒 = bending moment due to thermal expansion = √𝑀𝑖𝑒
2 +𝑀𝑜𝑒

2 

𝑀𝑞𝑒 = torsional moment due to thermal expansion 

𝑉𝑇𝑒 = shear force due to thermal expansion = √𝑉𝑖𝑒
2 + 𝑉𝑜𝑒

2 

𝑀𝑖𝑒 = in-plane bending moment due to thermal expansion 

𝑀𝑜𝑒 = out-of-plane bending moment due to thermal expansion 

𝑉𝑖𝑒 = in-plane shear force (local fy from CAEPIPE) due to thermal expansion 

𝑉𝑜𝑒 = out-of-plane shear force (local fz from CAEPIPE) due to thermal expansion 

𝐾𝑆𝐷 = shakedown factor for the material from Table 4.  
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KSD = 1.8 for Carbon Steel (CS) and 2.0 for Austenitic Steel (AS). For other materials, it is 
assumed to be 1.8. 

𝑆𝑦 = yield stress of material at room temperature (reference temperature in CAEPIPE). 

𝑆𝑌𝑇= yield stress of material at maximum of CAEPIPE input temperatures T1 through T10. 

Fatigue Analysis 

Fatigue compliance checks as described in para. 6.7, para. 8.5.6, para. 8.5.7 and Appendix 5 
are not included in CAEPIPE analysis. 

Stress Concentration Factors (SCF) 
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Welding TEE 
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Extruded TEE 
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Reinforced Fabricated TEE 
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Unreinforced Fabricated TEE 
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Sustained and Cyclic SCF for Welds and Threaded Joints in CAEPIPE 

Type 
Ip 

Pressure 
Ib 

Bending 
It 

Thrust 
Iq 

Torsion 
Is 

Shear 

Buttweld 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
2.00 1.30 1.30 1.00 2.00 

Tapered 
Transition 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
1.80 2.10 2.00 1.00 2.00 

Filletweld 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
2.00 1.30 1.30 1.00 2.00 

Concave 
Filletweld 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
2.00 1.30 1.30 1.00 2.00 

Threaded 
Joint 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
1.00 2.30 2.30 1.00 1.00 

 

Sustained and Cyclic SCF for Flanges in CAEPIPE 

Type 
Ip 

Pressure 
Ib 

Bending 
It 

Thrust 
Iq 

Torsion 
Is 

Shear 

Weldneck 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
1.00 1.00 1.00 1.00 1.00 

Double 
Welded 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
1.00 1.20 1.20 1.00 1.00 

Single, 
Fillet & 
Socket 
Welded 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
2.00 1.30 1.30 1.00 1.00 

Lap Joint 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
2.00 1.60 1.60 1.00 1.00 

Threaded 

Sustained SCF 
1.00 1.00 1.00 1.00 1.00 

Cyclic SCF 
2.00 2.30 2.30 1.00 1.00 
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Vertical deflection in Buried Piping Systems 

The predicted vertical pipe deflection, ∆𝑦 as a fraction of Dr,min shall be less than 5% as per para. 7.7.2. This 
predicted vertical deflection as a fraction of Dr,min shall be calculated as per Formula (9) of para. 7.7.2. The same 
Formula in English units is given below , which is Eq. (5-8) as per Section 5.7.3 of AWWA Manual M45 
(second edition). 

∆y

Dr,min
=

(DLWC +WL)Kx
0.149PS + 0.061Ms

 

where 

DL = deflection lag factor to compensate for the time-consolidation rate of the soil as per Section. 

5.7.3 and Section. 5.7.3.3 of AWWA Manual M45 (second edition) = 1.05 (assumed) 

WC = vertical soil load on pipe =
𝜸𝒔𝑯

𝟏𝟒𝟒
 

WL = live load on the pipe from surface traffic =
𝑴𝑷𝑷𝑰𝒇

𝑳𝟏𝑳𝟐
 

KX = bedding coefficient, dimensionless as per Section. 5.7.3.4 of AWWA Manual 
M45 (second edition) = 0.083 (for uniform-shaped bottom support) 

𝛾𝑠 = unit weight of overburden, lb/ft3 

H = burial depth to top of pipe, ft 

𝐼𝑓 = Impact factor = 1 + 0.33 [(96 – h)/96] ≥ 1.0 

In order to be conservative, formulae for calculations of L1 and L2 given below are for Single Axle Truck 
travelling perpendicular to the pipe on an unpaved surface or a road with flexible pavement, as per Section 
5.7.3.6 of AWWA Manual M45 (second edition). 

L1 = load width parallel to direction of travel (in) = 𝑡𝑙 + 𝐿𝐿𝐷𝐹 (ℎ)  

h = depth of cover (in) 

hint = depth at which load from wheels interact (in) = (72 – 𝑡𝑤)/𝐿𝐿𝐷𝐹 

𝐿𝐿𝐷𝐹 = factor to account for live load distribution with depth of fill . See Section 5.7.3.6 of AWWA Manual 
M45 (second edition)] = 1.15 for backfill SC1 and SC2 or 1.0 for other backfills 

tl = length of tire foot print = 10 inch as per Section 5.7.3.6 of AWWA Manual M45 (second edition) 

tw = width of tire foot print = 20 inch as per Section 5.7.3.6 of AWWA Manual M45 (second edition) 

When ℎ ≤  ℎ𝑖𝑛𝑡 , then  

𝐿2 = load width perpendicular to direction of travel (in) = 𝑡𝑤 + 𝐿𝐿𝐷𝐹 (ℎ)  

When ℎ >  ℎ𝑖𝑛𝑡 , then  

𝐿2 = load width perpendicular to direction of travel (in) = [𝑡𝑤 + 72 +  𝐿𝐿𝐷𝐹 (ℎ)]/2  

P = wheel load magnitude = 20,000 lb for AASHTO HS-25 truck or 16000 lb for AASHTO HS-20 truck as 
per Section 5.7.3.6 of AWWA Manual M45 (second edition) 

MP = multiple presence factor = 1.2 

PS = pipe stiffness (psi). Determined by conducting parallel-plate loading tests in accordance with 

ASTM D2412 with a vertical diameter reduction of 5% = EI/(0.149r3) as per Chapter 4, AWWA 

Manual M23 (second edition) 
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where 

E = ring flexural (i.e., bending) modulus, psi 

I = moment of inertia of unit length (in3) = (1/12) t3 

r = mean pipe radius = (OD – t)/2, where t = thickness of buried pipe 

Ms = composite constrained soil modulus = 𝑺𝒄. 𝑴𝒔𝒃 as per Section 5.7.3.8 of AWWA Manual M45 
(second edition). Values of Sc and Msb are provided in Tables 5.5 and 5.4 of AWWA Manual M45 
(second edition). 

Sustained Load  

(a) The sum of the hoop stresses is defined by the following formulae as per para. 7.8 
of ISO 14692-3 code. 

𝜎ℎ𝑝𝑠 = 
𝑃𝐷𝑟,𝑚𝑖𝑛
2𝑡𝑟,𝑚𝑖𝑛

 

𝜎ℎ𝑢𝑠 = 𝑟𝑐. 𝐷𝑓 . 𝐸ℎ𝑏 .
∆y

Dr,min
.
t𝑟,𝑚𝑖𝑛

Dr,min
 (applicable only when the piping is buried and the value of 𝜎ℎ𝑢𝑠 is Tensile) 

𝝈𝒉𝒔,𝒔𝒖𝒎 = (𝝈𝒉𝒑𝒔 + 𝝈𝒉𝒖𝒔) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒉,𝑳𝑻 as per para. 6.4 

(b) The sum of the axial stresses is defined by the following formulae as per para. 7.8 
of ISO 14692-3 code. 

𝜎𝑎𝑠,𝑠𝑢𝑚 = (𝜎𝑎𝑝𝑠 ± 𝜎𝑎𝑏𝑠 + 𝜎𝑎𝑓𝑠) ≤  𝑓2. 𝐴0. 𝐴2. 𝐴3. 𝜎𝑎,𝐿𝑇 as per para. 6.4 

𝜎𝑎𝑝𝑠 = 
𝑃𝐷𝑟,𝑚𝑖𝑛

4𝑡𝑟,𝑚𝑖𝑛
 for Unrestrained piping (i.e., for all above ground piping in CAEPIPE) 

𝜎𝑎𝑝𝑠 = 𝜈 
𝑃𝐷𝑟,𝑚𝑖𝑛

2𝑡𝑟,𝑚𝑖𝑛
 for Restrained piping (i.e., only for buried piping in CAEPIPE) 

𝜎𝑎𝑏𝑠 = 𝑎𝑥𝑖𝑎𝑙 𝑠𝑡𝑟𝑒𝑠𝑠 =  
√(𝑆𝐼𝐹𝑎𝑖. 𝑀𝑖𝑠)2 + (𝑆𝐼𝐹𝑎𝑜 . 𝑀𝑜𝑠)2

𝑍𝑟
 

𝑍𝑟 =
𝜋

32

(𝑂𝐷𝑟,𝑚𝑖𝑛
4− 𝐼𝐷𝑟

4)

𝑂𝐷𝑟,𝑚𝑖𝑛
  

𝜎𝑎𝑓𝑠 =
𝐹𝑎𝑠

𝐴𝑟
=

𝐹𝑎𝑠
𝜋

4
(𝑂𝐷𝑟,𝑚𝑖𝑛

2− 𝐼𝐷𝑟
2)

  

𝝈𝒂𝒔,𝒔𝒖𝒎(𝐦𝐢𝐧) = (𝝈𝒂𝒑𝒔 − 𝝈𝒂𝒃𝒔 + 𝝈𝒂𝒇𝒔) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒂,𝑳𝑻 as per para. 6.4 

𝝈𝒂𝒔,𝒔𝒖𝒎(𝐦𝐚𝐱) = (𝝈𝒂𝒑𝒔 + 𝝈𝒂𝒃𝒔 + 𝝈𝒂𝒇𝒔) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒂,𝑳𝑻 as per para. 6.4 

where 

P = maximum of CAEPIPE pressures P1 through P10 

𝑡𝑟,𝑚𝑖𝑛 = minimum reinforced pipe wall thickness (in) 

𝐷𝑟,𝑚𝑖𝑛 = mean diameter of the minimum reinforced pipe wall (in) 
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𝑟𝑐 = rerounding coefficient  

𝑟𝑐 = 0 when P > 3 MPa (145 psi) and  

𝑟𝑐 = 1 – P/3 when P <= 3 MPa (145 psi) 

𝐷𝑓 = shape factor from Table 5.1 of AWWA Manual M45 (second edition) 

∆𝑦

𝐷𝑟,𝑚𝑖𝑛
 = predicted vertical pipe deflection as given above 

𝐸ℎ𝑏 = hoop bending (flexural) modulus (psi) 

𝐼𝐷𝑟= inside diameter of the reinforced pipe wall 

𝑂𝐷𝑟,𝑚𝑖𝑛= minimum outside diameter of the reinforced pipe wall 

𝑆𝐼𝐹𝑎𝑖= axial in-plane stress intensification factor 

𝑆𝐼𝐹𝑎𝑜= axial out-of-plane stress intensification factor 

𝑀𝑖𝑠, 𝑀𝑜𝑠 = in-plane and out-of-plane bending moment respectively due to weight and other 
sustained mechanical loads (excluding pressure) 

𝑍𝑟= minimum reinforced pipe wall section modulus 

𝐹𝑎𝑠= axial force due to weight and other sustained mechanical loads (excluding pressure) 

𝐴𝑟= minimum reinforced pipe wall cross section 

𝑓2 = part factor for loading  

𝑓2 = 0.67 for Sustained load case from para. 6.2 and Table 1 of ISO 14692-3 code 

𝐴0 = partial factor for design life = 1.00 (default) (see Note below) 

𝐴2 = partial factor for chemical resistance = 1.00 (default) (see Note below) 

𝐴3 = partial factor for cyclic service = 1.00 (default) (see Note below) 

𝜎ℎ,𝐿𝑇 = long term envelope hoop allowable stress 

𝜎𝑎,𝐿𝑇 = long term envelope axial allowable stress 

Note: 

Values of 𝐴0, 𝐴2 & 𝐴3 can be input into CAEPIPE through Layout Window > Options > 
Analysis. 

  



Petroleum and natural gas industries Glass Reinforced Plastics (GRP) Piping 
ISO 14692-3 (2017) 

458 
 

 

Operating Load (Sustained + Expansion) 

(a) The sum of the hoop stresses is defined by the following formulae as per para. 7.8 
of ISO 14692-3 code. 

𝜎ℎ𝑝𝑜 = 
𝑃𝑖𝐷𝑟,𝑚𝑖𝑛
2𝑡𝑟,𝑚𝑖𝑛

 

𝜎ℎ𝑢𝑜 = 𝑟𝑐 . 𝐷𝑓 . 𝐸ℎ𝑏 .
∆y

Dr,min
.
t𝑟,𝑚𝑖𝑛

Dr,min
 (applicable only when the piping is buried and the value of 𝜎ℎ𝑢𝑜 is Tensile) 

𝝈𝒉𝒐,𝒔𝒖𝒎 = (𝝈𝒉𝒑𝒐 + 𝝈𝒉𝒖𝒐) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒉,𝑳𝑻 as per para. 6.4 

(b) The sum of the axial stresses is defined by the following formulae as per para. 7.8 
of ISO 14692-3 code. 

𝜎𝑎𝑜,𝑠𝑢𝑚 = (𝜎𝑎𝑝𝑜 ± 𝜎𝑎𝑏𝑜 + 𝜎𝑎𝑓𝑜) ≤  𝑓2. 𝐴0. 𝐴2. 𝐴3. 𝜎𝑎,𝐿𝑇 as per para. 6.4 

𝜎𝑎𝑝𝑜 = 
𝑃𝑖𝐷𝑟,𝑚𝑖𝑛

4𝑡𝑟,𝑚𝑖𝑛
 for Unrestrained piping (i.e., for all above ground piping in CAEPIPE) 

𝜎𝑎𝑝𝑜 = 𝜈 
𝑃𝑖𝐷𝑟,𝑚𝑖𝑛

2𝑡𝑟,𝑚𝑖𝑛
 for Restrained piping (i.e., only for buried piping in CAEPIPE) 

𝜎𝑎𝑏𝑜 = 𝑎𝑥𝑖𝑎𝑙 𝑠𝑡𝑟𝑒𝑠𝑠 =  
√(𝑆𝐼𝐹𝑎𝑖 . 𝑀𝑖𝑜)

2 + (𝑆𝐼𝐹𝑎𝑜 . 𝑀𝑜𝑜)
2

𝑍𝑟
 

𝑍𝑟 =
𝜋

32

(𝑂𝐷𝑟,𝑚𝑖𝑛
4− 𝐼𝐷𝑟

4)

𝑂𝐷𝑟,𝑚𝑖𝑛
  

𝜎𝑎𝑓𝑜 =
𝐹𝑎𝑜

𝐴𝑟
=

𝐹𝑎𝑜
𝜋

4
(𝑂𝐷𝑟,𝑚𝑖𝑛

2− 𝐼𝐷𝑟
2)

  

𝝈𝒂𝒐,𝒔𝒖𝒎(𝐦𝐢𝐧) = (𝝈𝒂𝒑𝒐 − 𝝈𝒂𝒃𝒐 + 𝝈𝒂𝒇𝒐) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒂,𝑳𝑻 as per para. 6.4 

𝝈𝒂𝒐,𝒔𝒖𝒎(𝐦𝐚𝐱) = (𝝈𝒂𝒑𝒐 + 𝝈𝒂𝒃𝒐 + 𝝈𝒂𝒇𝒐) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒂,𝑳𝑻 as per para. 6.4 

where 

𝑃𝑖 = internal design pressure P1 through P10. For example, for operating load case 1, 

𝑃𝑖 = 𝑃1  

𝑀𝑖𝑜, 𝑀𝑜𝑜 = in-plane and out-of-plane moment respectively due to weight, other sustained 
mechanical loads (excluding pressure) and self-limiting displacements (Thermal load T1 
through T10). 

𝐹𝑎𝑜= axial force due to weight, other sustained mechanical loads (excluding pressure) and 
self-limiting displacement load 

𝑓2 = part factor for loading  

𝑓2 = 0.83 for Operating load case from para. 6.2 and Table 1 of ISO 14692-3 code 

All other parameters are defined under Sustained Load. 
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Occasional Load (Sustained + Occasional) 

(a) The sum of the hoop stresses is defined by the following formulae as per para. 7.8 
of ISO 14692-3 code. 

𝜎ℎ𝑝𝑐 = 
𝑃𝑜𝐷𝑟,𝑚𝑖𝑛
2𝑡𝑟,𝑚𝑖𝑛

 

𝜎ℎ𝑢𝑐 = 𝑟𝑐. 𝐷𝑓 . 𝐸ℎ𝑏 .
∆y

Dr,min
.
t𝑟,𝑚𝑖𝑛

Dr,min
 (applicable only when the piping is buried and the value of 𝜎ℎ𝑢𝑐 is Tensile) 

𝝈𝒉𝒄,𝒔𝒖𝒎 = (𝝈𝒉𝒑𝒄 + 𝝈𝒉𝒖𝒄) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒉,𝑳𝑻 as per para. 6.4 

(b) The sum of the axial stresses is defined by the following formulae as per para. 7.8 
of ISO 14692-3 code. 

𝜎𝑎𝑐,𝑠𝑢𝑚 = (𝜎𝑎𝑝𝑐 ± 𝜎𝑎𝑏𝑐 + 𝜎𝑎𝑓𝑐) ≤  𝑓2. 𝐴0. 𝐴2. 𝐴3. 𝜎𝑎,𝐿𝑇 as per para. 6.4 

𝜎𝑎𝑝𝑐 = 
𝑃𝑜𝐷𝑟,𝑚𝑖𝑛

4𝑡𝑟,𝑚𝑖𝑛
 for Unrestrained piping (i.e., for all above ground piping in CAEPIPE) 

𝜎𝑎𝑝𝑐 = 𝜈 
𝑃𝑜𝐷𝑟,𝑚𝑖𝑛

2𝑡𝑟,𝑚𝑖𝑛
 for Restrained piping (i.e., only for buried piping in CAEPIPE) 

𝜎𝑎𝑏𝑐 = 𝑎𝑥𝑖𝑎𝑙 𝑠𝑡𝑟𝑒𝑠𝑠 =  𝜎𝑎𝑏𝑠 + 
√(𝑆𝐼𝐹𝑎𝑖 . 𝑀𝑖𝑐)

2 + (𝑆𝐼𝐹𝑎𝑜 . 𝑀𝑜𝑐)
2

𝑍𝑟
 

𝑍𝑟 =
𝜋

32

(𝑂𝐷𝑟,𝑚𝑖𝑛
4− 𝐼𝐷𝑟

4)

𝑂𝐷𝑟,𝑚𝑖𝑛
  

𝜎𝑎𝑓𝑐 =
𝐹𝑎𝑐

𝐴𝑟
= 𝜎𝑎𝑓𝑠 +

𝐹𝑎𝑐
𝜋

4
(𝑂𝐷𝑟,𝑚𝑖𝑛

2− 𝐼𝐷𝑟
2)

  

𝝈𝒂,𝒔𝒖𝒎(𝐦𝐢𝐧) = (𝝈𝒂𝒑𝒄 − 𝝈𝒂𝒃𝒄 + 𝝈𝒂𝒇𝒄) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒂,𝑳𝑻 as per para. 6.4 

𝝈𝒂,𝒔𝒖𝒎(𝐦𝐚𝐱) = (𝝈𝒂𝒑𝒄 + 𝝈𝒂𝒃𝒄 + 𝝈𝒂𝒇𝒄) ≤  𝒇𝟐. 𝑨𝟎. 𝑨𝟐. 𝑨𝟑. 𝝈𝒂,𝑳𝑻 as per para. 6.4 

where 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = maximum of CAEPIPE pressures P1 through P10 

𝑀𝑖𝑐, 𝑀𝑜𝑐 = in-plane and out-of-plane moment respectively due to weight, other sustained 
mechanical loads (excluding pressure), and occasional loads such as thrusts from 
pressure/safety relief valve loads, from pressure and flow transients, earthquake, wind, etc. 

𝐹𝑎𝑐= axial force due to weight, other sustained mechanical loads (excluding pressure), and 
occasional loads such as thrusts from pressure/safety relief valve loads, from pressure and 
flow transients, earthquake, wind, etc. 

𝑓2 = part factor for loading  

𝑓2 = 0.89 for Occasional load case from para. 6.2 and Table 1 of ISO 14692-3 code 
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Flexibility Factors and Stress Intensification Factors [Refer to Annex B of ISO 14692-3 
(2017)] 

Flexibility Factor for Bend and Miter Bend 

 

The “axial pressure correction factor δa” is given by formula (B.3): 

 

 

 

Note: 

If thickness field is input in the Bend / Miter dialog then that thickness will be used as “tb” in the above 
calculation. On the other hand, if the thickness field is left blank then CAEPIPE will use the pipe thickness as 
“tb” in the above calculation. 

Flexibility Factor for TEE 

Flexibility factor for TEE is 1.0 
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Stress Intensification Factors (SIF) 

Bends and Miters (in line with Section B.3 of Annex B of ISO 14692-3) 

Sl. 
No. 

Designation In-plane Stress 
intensification factor 

(SIFai) 

Out-of-plane Stress 
intensification factor 

(SIFao) 

1 Bends 2.3 2.3 

2 Miters – Closely Spaced 2.3 2.3 

3 Miters – Widely Spaced 2.3 2.3 

TEEs (in line with Section B.3 of Annex B of ISO 14692-3) 

Sl. 
No. 

Designation In-plane Stress 
intensification factor 

(SIFai) 

Out-of-plane Stress 
intensification factor 

(SIFao) 

1 Integral TEE 2.3 2.3 

Reducers 

ISO 14692-3 does not provide SIFs for Reducers. Hence, in CAEPIPE, SIFs for the Reducer Types will be 
assigned internally as listed below when used in the Stress model.  

Sl. 
No. 

Designation In-plane Stress 
intensification factor 

(SIFai) 

Out-of-plane Stress 
intensification factor 

(SIFao) 

1 Concentric Reducer 1.0 1.0 

2 Eccentric Reducer 1.0 1.0 

Threaded Joint 

ISO 14692-3 does not provide SIFs for Threaded Joint. Hence, in CAEPIPE, SIF for the Threaded Joint be 
assigned internally as listed below when used in the Stress model.  

Sl. 
No. 

Designation In-plane Stress 
intensification factor 

(SIFai) 

Out-of-plane Stress 
intensification factor 

(SIFao) 

1 Threaded Joints 2.3 2.3 

Flanges 

ISO 14692-3 does not provide SIFs for Flanges. Hence, in CAEPIPE, SIFs for the Flange Types will be 
assigned internally as listed below when used in the Stress model.  

Sl. 
No. 

Designation In-plane Stress 
intensification factor 

(SIFai) 

Out-of-plane Stress 
intensification factor 

(SIFao) 

1 Weld Neck Flange 1.0 1.0 

2 Double Welded Slip on Flange 1.0 1.0 
3 Single Welded Slip on Flange 1.0 1.0 
4 Fillet Welded Flange 1.0 1.0 
5 Socket Welded Flange 1.0 1.0 
6 Lap Joint Flange 1.0 1.0 
7 Threaded Flange 1.0 1.0 
8 Threaded Joint 1.0 1.0 

In case the user wants to input at a node a different value for any of the SIFs listed above, the user can input 
the desired value using the data type “User SIF” at that node. Any value input in the “User SIF” field will 
always replace any internally calculated or internally set value. 
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Allowable Pressure 

A.2.1 Straight pipes: For straight pipes, the allowable internal pressure is calculated from 

Equations (A.1) and (A.2): 

𝑃𝑎 =
2𝜎𝑑𝑧𝑡𝑚𝑖𝑛
𝛾𝑎𝑑𝑜

                                                                                                                        (𝐴. 1) 

where,   

𝑃𝑎= allowable pressure 

𝑑𝑜= outside diameter of the pipe 

𝑧 = joint efficiency factor 

𝑡𝑚𝑖𝑛 = 𝑡𝑛 − (𝑐1 + 𝑐2)                                                                                                           (𝐴. 2) 

𝑡𝑛= nominal wall thickness of the pipe 

𝑐1 = mill/fabrication tolerance (input as a % of thickness) 

𝑐2= corrosion allowance 

𝜎𝑑 = allowable stress (i.e., design stress) = 𝑅𝑒(𝑇)/𝛾𝑚 , where 𝑅𝑒(𝑇) is the specified minimum 

yield strength at design temperature (sec 5.2.3.1), where design temperature is a CAEPIPE 

input, and 𝛾
𝑚

 = 1.1, the partial safety factor for strength of material per sec. 7.2.2.1 

𝛾
𝑎
 = 1.25 = partial load factor for LC2 and LC3 cases from Table 9 in sec.6.4.2. 

A.2.2 Bends:  The allowable internal pressure for bends is calculated as 

𝑃𝑎 =
2𝜎𝑑𝑧 𝑡𝑚𝑖𝑛
𝛾𝑎𝑑𝑜𝐼

                                                                                                                          

𝐼 =
𝑅 − 0.25𝑑𝑖
𝑅 − 0.5𝑑𝑚

                                                                                                                     (𝐴. 3) 

𝑑𝑖= inside diameter of the pipe 

𝑑𝑚= mean diameter of the pipe 

R = bend radius 

A.4 Reducers and extensions: shall withstand the same internal pressure as the connecting 

pipes where the half angle 𝛼, at the apex of the component does not exceed 30 degrees,  

  
The allowable internal pressure is calculated from  

𝑃𝑎 = 𝑚𝑖𝑛 {
2𝜎𝑑𝑧 cos 𝛼  𝑡𝑛1,𝑚𝑖𝑛

𝛾
𝑎
. 𝑑𝑜1

,
2𝜎𝑑𝑧 cos 𝛼   𝑡𝑛2,𝑚𝑖𝑛

𝛾
𝑎
. 𝑑𝑜2

} 

where: 

 𝑡𝑛1,𝑚𝑖𝑛 = 𝑡𝑛1 − (𝑐1 + 𝑐2) 
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 𝑡𝑛2,𝑚𝑖𝑛 = 𝑡𝑛2 − (𝑐1 + 𝑐2) 

 𝑡𝑛1, 𝑎𝑛𝑑 𝑡𝑛2   is nominal wall thickness of pipe at inlet and outlet of reducer. 

 𝑑𝑜1, 𝑎𝑛𝑑 𝑑𝑜2  is nominal outer diameter at inlet and outlet of reducer. 

 
Note 1: CAEPIPE permits to model the reducers with α ≤ 30o.  Reducers with α > 30o 

cannot be modeled, because the stress concetration factors are not explcitly given in C.3.5 

for reducers with α > 30o.  

Note 2: The above allowable pressures calculated by CAEPIPE are valid only for pipes and 
components delivered with the required certificate as per sec. 5.2.2.  

For pipes and components delivered without the required certificate as per sec. 5.2.2, the 

allowable pressures 𝑃𝑎  computed by CAEPIPE as given above should be manually divided 

by an extra safety coefficient 𝛾𝑚,𝑦𝑖𝑒𝑙𝑑 = 1.2 (sec. 5.2.3.1) to arrive at lower allowable 

pressures for such uncertified pipes and components. 

Evaluation of Stresses  

Stress components and internal forces as per sec. 6.6.2 of the code are defined as: 

 
Axial stress 

(∆𝜎𝑎)+ = 𝑖𝑎1
∆𝑁𝑥

𝐴
+ 𝑖𝑎2

√∆𝑀𝑦
2+∆𝑀𝑧

2

𝑊
      

and   

 (∆𝜎𝑎)− = 𝑖𝑎1
∆𝑁𝑥

𝐴
− 𝑖𝑎2

√∆𝑀𝑦
2+∆𝑀𝑧

2

𝑊
 

 
Shear Stress 

(∆𝜏)+ = 𝑖𝑎3
∆𝑀𝑥

2𝑊
+ 𝑖𝑎4

2√∆𝑉𝑦
2+∆𝑉𝑧

2

𝐴
  and  

(∆𝜏)− = 𝑖𝑎3
∆𝑀𝑥

2𝑊
− 𝑖𝑎4

2√∆𝑉𝑦
2+∆𝑉𝑧

2

𝐴
  

 
Membrane Tangential Stress 

(∆𝜎𝑡)𝑚 = 𝑖𝑎𝑝
𝑝∙𝑑𝑖

2𝑡𝑚𝑖𝑛
     

 
(Membrane + Bending) Tangential Stress 

(∆𝜎𝑡)𝑚𝑏 = 𝑖𝑎𝑝
𝑝∙𝑑𝑖

2𝑡𝑚𝑖𝑛
+ 𝑖𝑎5

√∆𝑀𝑦
2+∆𝑀𝑧

2

𝑊
+ 𝜎𝑞  

 

The equivalent stress as per sec. 6.6.3  is calculated from the axial and tangential stress 
components (calculated with sign) by von Mises for either membrane stress or membrane + 

bending stress (𝒎|𝒎𝒃) 

𝑺𝒎|𝒎𝒃 = 𝒎𝒂𝒙 {S1𝑚|𝑚𝑏 , S2𝑚|𝑚𝑏 , S3𝑚|𝑚𝑏 , S4𝑚|𝑚𝑏 , |(∆𝜎𝑎)+|, |(∆𝜎𝑎)−|} 
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where, 

S1𝑚|𝑚𝑏 =√(∆𝜎𝑎)+
2 − (∆𝜎𝑎)+ ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏

2 + 3(∆𝜏)+
2  

S2𝑚|𝑚𝑏 =√(∆𝜎𝑎)−2 − (∆𝜎𝑎)− ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏
2 + 3(∆𝜏)+

2  

S3𝑚|𝑚𝑏 =√(∆𝜎𝑎)+
2 − (∆𝜎𝑎)+ ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏

2 + 3(∆𝜏)−2  

S4𝑚|𝑚𝑏 =√(∆𝜎𝑎)−2 − (∆𝜎𝑎)− ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏
2 + 3(∆𝜏)−2  

𝑁𝑥 = Axial force (positive for tension), (pressure, temperature and soil reaction)  

𝑀𝑥 = Torsional moment  

𝑀𝑦 and 𝑀𝑧 =  Bending moment  

A = Metal area of pipe 
W = Section modulus 

𝑉𝑦 and 𝑉𝑧  = Shear force  

p = Internal pressure 

𝑑𝑖 = Inside diameter of the steel service pipe.  

𝑡𝑚𝑖𝑛 = Minimum pipe wall thickness = 𝑡𝑛 − (𝑐1 + 𝑐2) 
𝑖𝑎1 = Stress concentration factor for axial stresses from normal force 

𝑖𝑎2 = Stress concentration factor for axial stresses from bending moments 

𝑖𝑎3 = Stress concentration factor for shear stresses from torsion 

𝑖𝑎4 = Stress concentration factor for shear stresses from shear forces 

𝑖𝑎𝑝 = Stress concentration factor for hoop stresses from pressure 

Area and section modulus are calculated, as per 6.6.2, as follows: 

𝐴 = 𝜋 × (𝑑𝑜 − 𝑡𝑛) × 𝑡𝑛                                              (45) 

𝑊 =
𝜋

32×𝑑𝑜
[𝑑𝑜
4 − (𝑑𝑜 − 2𝑡𝑛)

4]                                 (46) 

𝑑𝑜 = Outer diameter of the steel service pipe  

𝑡𝑛 = nominal pipe wall thickness  

𝑐1 = Correction to wall thickness for fabrication tolerance 

𝑐2 = Correction to wall thickness for corrosion allowance 
 

𝑆𝑚  = Membrane stress  

𝑆𝑚𝑏 = Resulting stress of membrane stress and bending stress  
 

𝜎𝑎 = Axial (normal) stress 

𝜎𝑡 = Tangential stress 

𝜏 = Shear stress  

𝜎𝑝 = Hoop stress from internal pressure 

𝜎𝑞 = Ovalisation stress from soil pressure, traffic, lateral soil reactions, etc. (see sec. 6.6.4) to 

be manually computed by the user and input into soil model dialog of CAEPIPE at this time. 
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Forced Control Action  LC2 (sec. 7.2.2.2)     

In CAEPIPE, the LC2 case (both 𝑆𝑚 and 𝑆𝑟𝑒𝑠) is evaluated for sustained loads (W+P) which 
include weight (of pipe, fluid, and insulation) at maximum operating pressure. The 
displacements specified as settlement at anchor and nozzle locations are also included in 
force-controlled action.   

1) 𝑺𝒎 =  Membrane stress A1: 

𝑆𝑚 ≤ 𝑆𝑚𝑎 (= 𝑅𝑒(𝑇)/𝛾𝑚) 

𝑆𝑚 = is the equilibrium membrane stress 

𝑆𝑚𝑎  = is the allowable membrane stress (= 𝑅𝑒(𝑇)/𝛾𝑚) 

𝑅𝑒(𝑇) = Specified minimum yield strength at maximum operating temperature  

𝛾𝑚 = 1.1  is the partial safety factor for the base material, as per sec. 7.2.2.2.  
 

2)  𝑺𝒓𝒆𝒔 = Membrane  + Bending stress  A1: 

𝑆𝑟𝑒𝑠(= 𝑆𝑚𝑏)  ≤ 𝑆𝑟𝑒𝑠𝑎  

𝑆𝑟𝑒𝑠 (= 𝑆𝑚𝑏) is the resulting stress of equilibrium membrane stress and equilibrium 
bending stress  

𝑆𝑟𝑒𝑠𝑎  = is the allowable resulting stress (including membrane + bending) 
 

𝑆𝑟𝑒𝑠𝑎 =

{
 
 

 
 1.5 

𝑅𝑒(𝑇)

𝛾𝑚
for 𝑆𝑚 ≤ 0.67

𝑅𝑒(𝑇)

𝛾𝑚

2.5 
𝑅𝑒(𝑇)

𝛾𝑚
− 1.5 𝑆𝑚 for 0.67

𝑅𝑒(𝑇)

𝛾𝑚
< 𝑆𝑚 ≤

𝑅𝑒(𝑇)

𝛾𝑚

 

 

Note: The above stresses calculated by CAEPIPE is valid only for pipes and components 

delivered with the required certificate as per sec. 5.2.2, where 𝛾𝑚 =  1.1 as per sec. 7.2.2.2. 

For pipes and components delivered without the required certificate as per sec. 5.2.2, the 

allowable stresses 𝑆𝑚𝑎 and 𝑆𝑟𝑒𝑠𝑎 computed by CAEPIPE as given above should be manually 
divided by an extra safety coefficient 𝛾𝑚,𝑦𝑖𝑒𝑙𝑑  = 1.2 (sec. 5.2.3.1) to arrive at the corresponding 

lower allowable stresses for such uncertified pipes and components. 

Stepwise plastic deformation LC3 (sec. 7.2.2.3) 

In CAEPIPE, the LC3 case is evaluated for each operating load case (Weight of pipe, fluid & 
insulation + Pressure + Temperature) and at each set of operating pressure and 
temperature.  

𝑆𝑝𝑑 =  Force  +  Deformation stress A2 

Limit state A2 concerns incremental collapse and stress ratcheting. The limit state for stress 
ratcheting for fully restrained sections is obtained from: 

𝑆𝑝𝑑 ≤ 𝑆𝑝𝑑𝑎  

𝑆𝑝𝑑 is the maximum of axial stress due to plastic deformation. 
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𝑆𝑝𝑑 = 𝒎𝒂𝒙{(∆𝜎𝑎)+, (∆𝜎𝑎)−}  

The allowable/limit state for stress ratcheting for fully restrained sections is obtained from: 

𝑆𝑝𝑑𝑎 = 𝑅𝑒(𝑇) [√1 −
3

4
(

𝜎𝑝

𝑅𝑒(𝑇)
)
2

+√𝛾2 −
3

4
(

𝜎𝑝

𝑅𝑒(𝑇)
)
2

]   (79) 

𝑅𝑒(𝑇) = Specific minimum yield strength at operating temperature  

𝜎𝑝 (= 𝑃𝑑𝑜 2𝑧𝑡𝑚𝑖𝑛⁄  ) = hoop stress at operating pressure.    (78) 

𝛾 = 0.7, is a safety factor 

Note: EN13941-1:2019 does not specify stress concentration factors for calculating 𝑆𝑝𝑑. In 

CAEPIPE, the stress concentration factors for  𝑆𝑝𝑑  calculations are considered the same as 

those for resulting stresses for each component given in Tables C1, C3, C4, and C6. 

TEES 

 In CAEPIPE,  and  are calculated separately 
for run pipe and branch pipe with sectional forces 
chosen as follows: 

For stresses in the run pipe, the forces and 
moments determined in the run at the 
intersection between the centerlines of the pipes 
are used.  

For stresses in the branch pipe, the forces and 
moments determined in the branch at a distance 

of 0.5 𝑑𝑟𝑜 from the centreline of the run pipe are 
used. 

Note: CAEPIPE automatically refines the 
elements connected to the node point with a 
defined tee. Two (2) nodes on Run Pipe (one on 
either side of the Branch SIF node) at a distance 
equal to Run Pipe OD and one (1) node on 
Branch Pipe at a distance equal to Run pipe OD/2 from the Branch SIF node are 
internally added with appropriate node numbers.   

 As per sec. 6.6.7, the stresses at the intersection of run pipe are calculated after 

combining the axial and shear stresses from the run pipe and branch element as follows. 

(∆𝜎𝑎)±(𝑟𝑢𝑛 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛) =  (∆𝜎𝑎)± (𝑟𝑢𝑛) +   ∆𝜎𝑎 (𝑏𝑟𝑎𝑛𝑐ℎ)           (63) 

(∆𝜏)±(𝑟𝑢𝑛 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛)  =  (∆𝜏)± (𝑟𝑢𝑛)   +  ∆𝜏 (𝑏𝑟𝑎𝑛𝑐ℎ)                 (64) 

In CAEPIPE, 

∆𝜎𝑎 (𝑏𝑟𝑎𝑛𝑐ℎ) = {
(∆𝜎𝑎)+ (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜎𝑎)+| > |(∆𝜎𝑎)−|

(∆𝜎𝑎)− (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜎𝑎)−| ≥ |(∆𝜎𝑎)+|
 

 

∆𝜏 (𝑏𝑟𝑎𝑛𝑐ℎ) = {
(∆𝜏)+ (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜏)+| > |(∆𝜏)−|

(∆𝜏)− (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜏)−| ≥ |(∆𝜏)+|
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Modeling buried pipe bilinear restraints 

Longitudinal/Axial soil stiffness (sec. 6.5.3.1) 

Cohesionless Soil Cohesive Soil 

For sandy soils, the ultimate axial load per unit 
length   

𝐹𝑢 = 𝜇 (
1+𝐾𝑜

2
𝜋𝐷𝑐𝜎𝑣 + 𝐺 − 𝛾𝑠 ∙ 𝜋 (

𝐷𝑐

2
)
2
)                     (8) 

where,  
𝐾𝑜  = coefficient of horizontal soil pressure at rest  
𝐾𝑜 = 1 − sin𝜑

′                                                    
𝜑′ - the effective angle of Internal friction of soil 
𝜎𝑣  - Effective (normal) intergranular soil stress at 
pipe center level.  
𝜇 =  tan 𝛿                                                                          (12)      

        is the friction coefficient, sec.6.5.3.2 
δ = Angle of interface friction between soil and 
(casing) pipe. 

The ultimate axial/longitudinal load per unit length   
𝐹𝑢 = 𝜋 𝐷𝑐𝐶𝑓 ∙ 𝐶𝑠  

 
where 
𝐹𝑢 - Ultimate axial soil load  
𝐶𝑠 – Cohesion strength.  
𝐶𝑓  - Cohesion factor 

 

For granular soils  

𝜎𝑣 = 𝛾𝑠𝐻𝑤 + 𝛾𝑠𝑤(𝑍 − 𝐻𝑤) for 𝐻𝑤 < 𝑍     (9)   

𝜎𝑣 = 𝛾𝑠𝑍 for 𝐻𝑤 ≥ 𝑍                                 (10) 

𝛾𝑠𝑤 = 𝛾′𝑠𝑤 − 𝛾𝑤                                          (11) 
 

𝐷𝑐 = Outer diameter of the casing  
G = Effective self-weight of the factory-made pipe assembly (including pipe fill) per meter of 
pipe length 

𝛾𝑠= Effective weight of soil above ground water table  

𝛾𝑠𝑤 = Effective weight of soil below ground water table = 𝛾′𝑠𝑤 − 𝛾𝑤  

𝛾′𝑠𝑤 = Effective weight of saturated soil below ground water table  

𝛾𝑤 = Effective weight of water  
Z = Depth of buried pipe (measured to pipe centerline)  

𝐻𝑤 = Depth of ground water table below grade 

For sandy soils, the relative displacement 𝑢𝑢 between the pipe and surrounding soil required 

to reach the maximum friction resistance fu is approx. 𝑢𝑢 = 3 mm = 0.003m. 

Axial soil stiffness = 𝐹𝑢/𝑢𝑢    
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Horizontal/Lateral soil stiffness (sec. 6.5.4.1) 

The coefficient of horizontal/lateral soil reaction or horizontal/lateral bedding constant is 
defined as the ratio between horizontal/lateral soil pressure and horizontal/lateral movement 
of the pipe system. 

The ultimate horizontal/lateral soil resistance 𝑃𝑢 is assessed using the equivalent equation for 
side support: 

Cohesionless Soil Cohesive Soil 

For sandy soils, the ultimate horizontal/lateral 
load per unit length   
 
𝑃𝑢 =  𝛾 ∙ 𝑍 ∙ 𝐾𝑞 ∙ 𝐷𝑐                                         (16) 

 
𝛾 = Soil density 
Z = depth of buried pipe (measured to pipe 
centerline) 
𝐾𝑞 = soil pressure coefficient for sand (Fig 10) 

The ultimate horizontal/lateral load per unit 
length   
 

𝑃𝑢 = (𝐾𝑞 ∙ 𝛾 ∙ 𝑍 + 0.7 𝛼 ∙ 𝐾𝑐 ∙ 𝑐
′) ∙ 𝐷𝑐          (17) 

 
𝛼  = 0.6, in case of open excavation;  and  
𝛼  =1.0, in case of jacking methods; 

𝑐′ =  𝐶𝑓 ∙ 𝐶𝑠 Effective cohesion of the soil  

𝐾𝑐 = soil pressure coefficient for clay (Fig 10) 
 

 

In Figure 10 the values on the right side (45°, 30°, etc.) represent the effective internal angle 

of friction of the soil 𝜑′, H is soil cover above pipe (see Figure 5 in EN13941-1) and D is 
considered as outer diameter of casing Dc (see Figure 13 in EN13941-1). 

The ultimate horizontal/lateral displacement 𝑣𝑢 is not defined precisely. The results of a 
number of tests with small diameter pipes are summarized in Table 12. 

   Table 12 – Ultimate horizontal/lateral displacement 𝑣𝑢 

𝒗𝒖/Z % 

Casing Diameter Dc Loose sand Dense sand 

75 mm
a
 4.5 2.7 

120 mm 3 2 

≥ 300 mm 2 1.5 

Values obtained by interpolation. 
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For buried pipes without expansion cushions, a fair relationship between horizontal pipe 
movement and corresponding soil restraint is given by 

𝑝

𝑝𝑢
=

𝑣 𝑣𝑢⁄

0.15 + 0.85 𝑣 𝑣𝑢⁄
                                                                                  (15) 

At 70% of ultimate horizontal load i.e., 𝑝 𝑝𝑢⁄ = 0.7, the horizontal displacement is 
calculated as 

0.7(0.15 + 0.85 𝑣 𝑣𝑢⁄ ) = 𝑣 𝑣𝑢⁄  

𝑣70% = 0.2593 𝑣𝑢 

Vertical soil stiffnesses  

To compute vertically upward and downward stiffnesses, the ultimate loads in vertical 
direction are considered as the same as those for other piping codes in CAEPIPE. For 
details, refer to the Section titled “Buried Piping” in the Technical Reference Manual. The 
vertical yield displacement for the soil is assumed to be D/25, where D is the outside 
diameter of the pipe.  

Combined lateral stiffness of PUR, expansion cushions and soil (sec. 6.5.5) 

 

PUR Cushion Soil Combined 

𝑘ℎ,1 =
𝐸𝑝𝑢𝑟

𝑡𝑝𝑢𝑟
           (19a) 

𝑘1 = 𝑘ℎ,1𝑑𝑜          (19b) 

𝑘ℎ,2 =
𝐸𝑐𝑢

𝑡𝑐𝑢
             (20a) 

𝑘2 = 𝑘ℎ,2𝐷𝑐           (20b) 

 

𝑘ℎ,3 =
0.7 𝑝𝑢

𝑣70%
          (21a) 

𝑘3 = 𝑘ℎ,3𝐷𝑐𝑢        (21b) 

 

1

𝑘
= ∑

1

𝑘𝑖
                  (22) 

 

 

where, 

𝑑𝑜 = Outside diameter of steel service pipe 

𝐷𝑐 = Outer diameter of casing 

𝐷𝑐𝑢= Equivalent outside diameter of expansion cushion. 

Polyurethane foam thermal insulation (sec. 5.3) 

In CAEPIPE, for EN13941-1 code, the insulation for pipe is considered as PUR, and the 

elastic modulus for PUR is internally set as 𝐸𝑃𝑈𝑅 = 10.0 𝑀𝑃𝑎. 
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The elastic modulus 𝐸𝑐𝑢 for expansion cushion shall be input in soil dialog as per section 
5.6.3. 

NOTE 1: The above methodology of combining stiffnesses of PUR, expansion 
cushions and soil is also applied in the vertically downward and upward directions. 

NOTE 2:  Expansion Cushion is very flexible, whereas PUR is stiffer.  Surrounding soil is 
much stiffer than PUR. So, the line bedding constant ‘k2’ for Expansion Cushion is much 
less than the line bedding constant ‘k1’ for PUR, which, in turn, is much less than the line 
bedding constant ‘k3’ for the surrounding soil, where the line bedding constant is the same as 
stiffness. In short, k2 << k1<<<k3. 

The combined stiffness ‘k’ computed using Equation (22) will be less than the Expansion 
Cushion stiffness, ‘k2’. Due to this low value of combined stiffness ‘k’, sometimes non-linear 
iterative solution may not converge. In such case of non-convergence, re-perform the 
analysis without including Expansion Cushion. If the solution still not converges, then re-
perform with just surrounding soil (i.e., without including stiffnesses of both PUR and 
Expansion Cushion). In this case, the weight per unit length of insulation PUR shall be input 
as “Additional weight” in CAEPIPE’s Loads dialog. 

C.2 Flexibility factors for pipe components (see Annex C) 

C.2.1 Bends 

Flexibility Factor for bending (in-plane 
& out-of-plane) 

Bend Radius Equation 

𝑘𝑏 =
1.24 ∙ 𝑑𝑚

2

4 ∙ 𝑡𝑛 ∙ 𝑅
≥ 1 

𝑅 ≤ 1.5 𝑑𝑜 (𝐶. 1) 
 

1.24 ∙ 𝑑𝑚
2

4 ∙ 𝑡𝑛 ∙ 𝑅
< 𝑘𝑏 <

1.65 ∙ 𝑑𝑚
2

4 ∙ 𝑡𝑛 ∙ 𝑅
 

1.5 𝑑𝑜 < 𝑅 < 2.5𝑑𝑜 (𝐶. 2) 
 

𝑘𝑏 =
1.65 ∙ 𝑑𝑚

2

4 ∙ 𝑡𝑛 ∙ 𝑅
 

𝑅 ≥ 2.5𝑑𝑜 (𝐶. 3) 
 

The stiffening effect of adjacent straight pipes is included in the factor kb given by Eq. (C.1). 
Such stiffening effect by adjacent straight pipes is less for larger radii bends for which Eq. 
(C.2) and Eq. (C.3) apply. 

Intervening values are obtained by interpolation. For bend angles between 90° and 0°, the 

flexibility factor 𝑘𝑏 for bending is linearly interpolated between flexibility factors for 90° 

bend and for straight pipe (𝑖. 𝑒. , 𝑘𝑏 = 1). The flexibility factors for normal forces, shear 
forces and torque are equal to 1.0.  

For pipe bends, the internal pressure will counteract ovalization. This is considered by 

dividing 𝑘𝑏 with 

1 + 6
𝑝

𝐸
(
𝑑𝑚
2𝑡
)
7/3

(
𝑑𝑚
2𝑅
)
−1/3

                                                                                           (𝐶. 4) 
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For miter bends, the flexibility factors are not provided in EN 13941-1 (2021). Hence, the 
flexibility factor as given in ASME B31J (2017) is used for all types of miter bends. 

𝑘𝑏 = 1.52 (
𝑑𝑚
2

4 ∙ 𝑡𝑛 ∙ 𝑅
)

5/6

 

 

C.2.2 T-pieces 

The flexibility factor for T pieces equals 1. 

For 𝑑𝑏𝑜 𝑑𝑟𝑜⁄ ≤ 0.8 the flexibility of the connection between the branch pipe and run pipe 
may be taken into account by applying the following spring factor to the branch pipe at the 
point where the axis of the branch intersects the outside of the run pipe. 

For in-plane bending, 𝑀𝑏𝑦,  

𝑐𝑦 =
𝐸 ∙ 𝐼𝑏
𝑘𝑦 ∙ 𝑑𝑟𝑜

                                                                                                                    (𝐶. 5) 

𝑘𝑦 = 0.2 (
𝑑𝑟𝑜
𝑡𝑟
) ∙ (

𝑡𝑟
𝑡𝑏
∙
𝑑𝑏𝑜
𝑑𝑟𝑜

)
0.5

∙
𝑡𝑏
𝑡𝑟
                                                                                (𝐶. 6) 

For out-of-plane bending, 𝑀𝑏𝑧,  

𝑐𝑧 =
𝐸 ∙ 𝐼𝑏
𝑘𝑧 ∙ 𝑑𝑟𝑜

                                                                                                                    (𝐶. 7) 

𝑘𝑧 = 0.1 (
𝑑𝑟𝑜
𝑡𝑟
)
1.5

∙ (
𝑡𝑟
𝑡𝑏
∙
𝑑𝑏𝑜
𝑑𝑟𝑜

)
0.5

∙
𝑡𝑏
𝑡𝑟
                                                                          (𝐶. 8) 

Note: CAEPIPE automatically refines the elements connected to the node point with a 
defined tee, by adding two (2) nodes on Run Pipe (one on either side of the Branch SIF 
node) at a distance equal to Run Pipe OD and one (1) node on Branch Pipe at a distance 
equal to Run pipe OD/2 from the Branch SIF node. Flexibility Factors for Branch Pipe (Leg 
3), as stated above in equations (C.5) – (C-8), are applied to the branch pipe.  For Equal 
TEEs, the Run and Branch should be differentiated in the CAEPIPE model by 
defining the Branch OD as slightly less than the Run OD through CAEPIPE 
Sections input.  

C.3 Stress concentration factors in pipe elements 

Note: The stress concentration factors 𝒊𝒂𝟏 to 𝒊𝒂𝟓 and 𝒊𝒂𝒑  are either = 0 or  >= 1 for all 

types of stress evaluation.  Stress concentration factors = 0, meaning “no contribution of the 
term in computing stresses”. 
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C.3.2.1 Stress concentration factors for bends and miter bends: Simplified method 

Table C.1 Stress concentration factors for bends 

 𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 𝒊𝒂𝟓 𝒊𝒂𝒑 

𝑺𝒎 1 
0.9 ∙ (

𝑑𝑚
2

4𝑡𝑛𝑅
)

2/3

 
1 1 0 𝑅 − 0.25𝑑𝑖

𝑅 − 0.5𝑑𝑚
 

𝑺𝒓𝒆𝒔 1 
0.9 ∙ (

𝑑𝑚
2

4𝑡𝑛𝑅
)

2/3

 
1 1 

1.8 ∙ (
𝑑𝑚
2

4𝑡𝑛𝑅
)

2/3

 
𝑅 − 0.25𝑑𝑖
𝑅 − 0.5𝑑𝑚

 

If the bracing effect of over pressure has been considered when calculating the flexibility of 
the pipe bend, 

𝒊𝒂𝟐 and 𝒊𝒂𝟓 shall be divided by f, where 

𝑓 =  1 + 3.25
𝑝

𝐸
(
𝑑𝑚
2𝑡
)
5/2

(
𝑑𝑚
2𝑅
)
−2/3

                                                                         (𝐶. 9) 

with 𝒊𝒂𝟐 and 𝒊𝒂𝟓 valued at a minimum of 1.0 after the above division. 

C.3.3 T-pieces 

Table C.3 Stress concentration factors for membrane stresses in point B of T-pieces (all 
types) 

Membrane stresses 

𝑺𝒎 

𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 

Run pipe 

Branch pipe 

𝑟𝑟 ∙ 𝑘2 

𝑟𝑏 ∙ 𝑘 

𝑟𝑟 ∙ 𝑘1 

𝑟𝑏 ∙ 𝑘 

2𝑟𝑟 ∙ 𝑘1 

𝑟𝑏 ∙ 𝑘 

𝑟𝑟 ∙ 𝑘1 

𝑟𝑏 ∙ 𝑘 

Table C.4 – T-pieces: Stress concentration factors for resulting stresses in point B 

Resulting stresses 

𝑺𝒓𝒆𝒔 

𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 

Directly welded T-piece CAEPIPE: Unreinforced fabricated Tee 

Run pipe 

Branch pipe 

1.2𝑘2 

𝑘 

𝑘1 

𝑘 

2𝑘1 

𝑘 

𝑘1 

𝑘 

Forged T-piece CAEPIPE: Welding Tee 

Run pipe 

Branch pipe 

0.7𝑘2 

0.4𝑘 

0.6𝑘1 

0.4𝑘 

1.2𝑘1 

0.4𝑘 

0.6𝑘1 

0.4𝑘 

T-piece with drawn collar CAEPIPE: Extruded Tee 

Run pipe 

Branch pipe 

0.8𝑘2 

0.7𝑘 

0.7𝑘1 

0.7𝑘 

1.4𝑘1 

0.7𝑘 

0.7𝑘1 

0.7𝑘 

𝑘1 =  0.523 (
1

𝑑𝑟𝑚
)
1/3

(
1

𝑡𝑟
)
2/3

𝑑𝑏𝑚 + 2.5 (1 −
𝑑𝑏𝑚
𝑑𝑟𝑚

)
3/2

                                      (𝐶. 17) 

𝑘2 =  0.65 (
1

𝑑𝑟𝑚
)
5/6

(
1

𝑡𝑟
)
2/3

(𝑑𝑏𝑚)
3/2 + 2.5 (1 −

𝑑𝑏𝑚
𝑑𝑟𝑚

𝑡𝑏
𝑡𝑟
)
9/5
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𝑘 =  0.567 (
𝑑𝑟𝑚
𝑡𝑟
)
2/3

                                                                                                              

Reduction factors for membrane stresses: 

𝑟𝑟 = 0.56 
𝑡𝑏

𝑡𝑟
 (2 −

𝑑𝑏𝑚

𝑑𝑟𝑚
)
5/3

       (C.18) 

𝑟𝑏 = 0.83 √
𝑑𝑏𝑚

𝑑𝑟𝑚
 for 𝑁𝑏 ≤

1

𝑑𝑏𝑚
(√𝑀𝑏𝑦

2 +𝑀𝑏𝑧
2 )    (C.19) 

𝑟𝑏 = 0.83  for 𝑁𝑏 >
1

𝑑𝑏𝑚
(√𝑀𝑏𝑦

2 +𝑀𝑏𝑧
2 ) 

Reducers 

Reducers with defined radius of curvature r 

 

 

Table C.6. Stress concentration factors for reducers 

 𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 𝒊𝒂𝟓 𝒊𝒂𝒑 

𝑺𝒎 1 1 1 0 0 1/cos 

𝑺𝒓𝒆𝒔 𝑘 𝑘 1 0 0 1/cos  

 

𝑘 = 0.5 + 0.01 ∙ 𝛼 √
𝑑𝑜,𝑚𝑖𝑛
𝑡1𝑛

                                                                                             (𝐶. 21) 

𝛼  is inserted in degrees. The expression for k is only valid if the following requirements are 

met:  

the transitional part is concentric; 𝛼 ≤ 30𝑜 and 𝑑𝑜,𝑚𝑖𝑛 𝑡𝑙,𝑛⁄  and 𝑑𝑜,𝑚𝑎𝑥 𝑡𝑛⁄  are both smaller 

than 100. 
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Allowable Pressure 

A.2.1 Straight pipes: For straight pipes, the allowable internal pressure is calculated from 

Equations (A.1) and (A.2): 

𝑃𝑎 =
2𝜎𝑑𝑧𝑡𝑚𝑖𝑛

𝑑𝑜
                                                                                                                        (𝐴. 1) 

where,  

𝑡𝑚𝑖𝑛 = 𝑡𝑛 − (𝑐1 + 𝑐2)                                                                                                           (𝐴. 2) 

𝑃𝑎= allowable pressure 

𝑑𝑜= outside diameter of the pipe 

𝑧 = joint efficiency factor 

𝑡𝑛= nominal wall thickness of the pipe. 

𝑐1 = mill/fabrication tolerance (input as a % of thickness) 

𝑐2= corrosion allowance 

𝜎𝑑 = allowable stress (i.e., design stress) = 𝑅𝑒(𝑇), yield stress at design temperature (sec 

5.2.3.1), where design temperature is a CAEPIPE input 

Note: The above allowable pressure calculated by CAEPIPE is valid only for pipes and 
components delivered with the required certificate as per sec. 5.2.2.  

For pipes and components delivered without the required certificate, the allowable pressure 

𝑃𝑎  computed by CAEPIPE should be manually divided by 𝛾𝑚,𝑦𝑖𝑒𝑙𝑑 = 1.2. (sec. 5.2.3.1) 

A.2.2 Bends:  The allowable internal pressure for bends is calculated as 

𝑃𝑎 =
2𝜎𝑑𝑧 𝑡𝑚𝑖𝑛
𝑑𝑜𝐼

                                                                                                                          

𝐼 =
𝑅 − 0.25𝑑𝑖
𝑅 − 0.5𝑑𝑚

                                                                                                                     (𝐴. 3) 

𝑑𝑖= inside diameter of the pipe 

𝑑𝑚= mean diameter of the pipe 

A.4 Reducers and extensions: shall withstand the same internal pressure as the connecting 

pipes where the half angle 𝛼, at the apex of the component does not exceed 30 degrees,  

  
The allowable internal pressure is calculated from  

𝑃𝑎 = 𝑚𝑖𝑛 {
2𝜎𝑑𝑧 cos 𝛼  𝑡𝑛1,𝑚𝑖𝑛

𝑑𝑜1
,
2𝜎𝑑𝑧 cos 𝛼   𝑡𝑛2,𝑚𝑖𝑛

𝑑𝑜2
} 

 
where: 
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 𝑡𝑛1,𝑚𝑖𝑛 = 𝑡𝑛1 − (𝑐1 + 𝑐2) 
 𝑡𝑛2,𝑚𝑖𝑛 = 𝑡𝑛2 − (𝑐1 + 𝑐2) 

 𝑡𝑛1, 𝑎𝑛𝑑 𝑡𝑛2   is nominal wall thickness of pipe at inlet and outlet of reducer. 

 𝑑𝑜1, 𝑎𝑛𝑑 𝑑𝑜2  is nominal outer diameter at inlet and outlet of reducer. 

 
Note: CAEPIPE permits to model the reducers with α ≤ 30o.  Reducers with α > 30o 

cannot be modeled, because the stress concetration factors are not explcitly given in C.3.5 

for reducers with α > 30o.  

Evaluation of Stresses  

Stress components and internal forces as per sec. 6.6.2 of the code are defined as: 

 
Axial stress 

(∆𝜎𝑎)+ = 𝑖𝑎1
∆𝑁𝑥

𝐴
+ 𝑖𝑎2

√∆𝑀𝑦
2+∆𝑀𝑧

2

𝑊
      

and   

 (∆𝜎𝑎)− = 𝑖𝑎1
∆𝑁𝑥

𝐴
− 𝑖𝑎2

√∆𝑀𝑦
2+∆𝑀𝑧

2

𝑊
 

 
Shear Stress 

(∆𝜏)+ = 𝑖𝑎3
∆𝑀𝑥

2𝑊
+ 𝑖𝑎4

2√∆𝑉𝑦
2+∆𝑉𝑧

2

𝐴
  and  

(∆𝜏)− = 𝑖𝑎3
∆𝑀𝑥

2𝑊
− 𝑖𝑎4

2√∆𝑉𝑦
2+∆𝑉𝑧

2

𝐴
  

 
Membrane Tangential Stress 

(∆𝜎𝑡)𝑚 = 𝑖𝑎𝑝
𝑝∙𝑑𝑖

2𝑡𝑚𝑖𝑛
     

 
(Membrane + Bending) Tangential Stress 

(∆𝜎𝑡)𝑚𝑏 = 𝑖𝑎𝑝
𝑝∙𝑑𝑖

2𝑡𝑚𝑖𝑛
+ 𝑖𝑎5

√∆𝑀𝑦
2+∆𝑀𝑧

2

𝑊
+ 𝜎𝑞  

 

The equivalent stress as per sec. 6.6.3  is calculated from the axial and tangential stress 
components (calculated with sign) by von Mises for either membrane stress or membrane + 

bending stress (𝒎|𝒎𝒃) 

𝑺𝒎|𝒎𝒃 = 𝒎𝒂𝒙 {S1𝑚|𝑚𝑏 , S2𝑚|𝑚𝑏 , S3𝑚|𝑚𝑏 , S4𝑚|𝑚𝑏 , |(∆𝜎𝑎)+|, |(∆𝜎𝑎)−|} 
where, 

S1𝑚|𝑚𝑏 =√(∆𝜎𝑎)+
2 − (∆𝜎𝑎)+ ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏

2 + 3(∆𝜏)+
2  

S2𝑚|𝑚𝑏 =√(∆𝜎𝑎)−2 − (∆𝜎𝑎)− ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏
2 + 3(∆𝜏)+

2  

S3𝑚|𝑚𝑏 =√(∆𝜎𝑎)+
2 − (∆𝜎𝑎)+ ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏

2 + 3(∆𝜏)−2  
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S4𝑚|𝑚𝑏 =√(∆𝜎𝑎)−2 − (∆𝜎𝑎)− ∙ (∆𝜎𝑡)𝒎|𝑚𝑏 + (∆𝜎𝑡)𝑚|𝑚𝑏
2 + 3(∆𝜏)−2  

𝑁𝑥 = Axial force (positive for tension), (pressure, temperature and soil reaction)  

𝑀𝑥 = Torsional moment  

𝑀𝑦 and 𝑀𝑧 =  Bending moment  

A = Metal area of pipe 
W = Section modulus 

𝑉𝑦 and 𝑉𝑧  = Shear force  

p = Internal pressure 

𝑑𝑖 = Inside diameter of the steel service pipe.  

𝑡𝑚𝑖𝑛 = Minimum pipe wall thickness = 𝑡𝑛 − (𝑐1 + 𝑐2) 
𝑖𝑎1 = Stress concentration factor for axial stresses from normal force 

𝑖𝑎2 = Stress concentration factor for axial stresses from bending moments 

𝑖𝑎3 = Stress concentration factor for shear stresses from torsion 

𝑖𝑎4 = Stress concentration factor for shear stresses from shear force 

𝑖𝑎𝑝 = Stress concentration factor for hoop stresses from pressure 

Area and section modulus are calculated, as per 6.6.2, as follows: 

𝐴 = 𝜋 × (𝑑𝑜 − 𝑡𝑛) × 𝑡𝑛                                              (45) 

𝑊 =
𝜋

32×𝑑𝑜
[𝑑𝑜
4 − (𝑑𝑜 − 2𝑡𝑛)

4]                                 (46) 

𝑑𝑜 = Outer diameter of the steel service pipe  

𝑡𝑛 = nominal pipe wall thickness  

𝑐1 = Correction to wall thickness for fabrication tolerance 

𝑐2 = Correction to wall thickness for corrosion allowance 
 

𝑆𝑚  = Membrane stress  

𝑆𝑚𝑏 = Resulting stress of membrane stress and bending stress  
 

𝜎𝑎 = Axial (normal) stress 

𝜎𝑡 = Tangential stress 

𝜏 = Shear stress  

𝜎𝑝 = Hoop stress from internal pressure 

𝜎𝑞 = Ovalisation stress from soil pressure, traffic, etc. to be manually computed by the user 

and input into soil model dialog of CAEPIPE at this time. 

Forced Control Action  LC2 (sec. 7.2.2.2);     

In CAEPIPE, the LC2 case (both 𝑆𝑚 and 𝑆𝑟𝑒𝑠) is evaluated for sustained loads (W+P) which 
include weight (of pipe, fluid, and insulation) at maximum operating pressure. The 
displacements specified as settlement at anchor and nozzle locations are also included in 
force-controlled action.   

3) 𝑺𝒎 =  Membrane stress A1: 
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𝑆𝑚 ≤ 𝑆𝑚𝑎 (= 𝑅𝑒(𝑇)/𝛾𝑚) 

𝑆𝑚 = is the equilibrium membrane stress 

𝑆𝑚𝑎  = is the allowable membrane stress (= 𝑅𝑒(𝑇)/𝛾𝑚) 

𝑅𝑒(𝑇) = Specific minimum yield strength at maximum operating temperature  

𝛾𝑚 = 1.25  is the partial safety factor for the base material, as per sec. 7.2.2.2.  
 

4)  𝑺𝒓𝒆𝒔 = Membrane  + Bending stress  A1: 

𝑆𝑟𝑒𝑠(= 𝑆𝑚𝑏)  ≤ 𝑆𝑟𝑒𝑠𝑎  

𝑆𝑟𝑒𝑠 (= 𝑆𝑚𝑏) is the resulting stress of equilibrium membrane stress and equilibrium 
bending stress  

𝑆𝑟𝑒𝑠𝑎  = is the allowable resulting stress (including membrane + bending) 
 

𝑆𝑟𝑒𝑠𝑎 =

{
 
 

 
 1.5 

𝑅𝑒(𝑇)

𝛾𝑚
for 𝑆𝑚 ≤ 0.67

𝑅𝑒(𝑇)

𝛾𝑚

2.5 
𝑅𝑒(𝑇)

𝛾𝑚
− 1.5 𝑆𝑚 for 0.67

𝑅𝑒(𝑇)

𝛾𝑚
≤ 𝑆𝑚 ≤

𝑅𝑒(𝑇)

𝛾𝑚

 

 

Note: The above stresses calculated by CAEPIPE is valid only for pipes and components 

delivered with the required certificate as per sec. 5.2.2, where 𝛾𝑚 =  1.25. 

For pipes and components delivered without the required certificate, the allowable stresses 

should be calculated manually by the user with  𝛾𝑚 = (1.2 ∗ 1.25) as per sec.5.2.3.1 

Stepwise plastic deformation LC3 (sec. 7.2.2.3); 

In CAEPIPE, the LC3 case is evaluated for each operating load case (Weight of pipe, fluid & 
insulation + Pressure + Temperature) and at each set of operating pressure and 
temperature.  

𝑆𝑝𝑑 =  Force  +  Deformation stress A2 

Limit state A2 concerns incremental collapse and stress ratcheting. The limit state for stress 
ratcheting for fully restrained sections is obtained from: 

𝑆𝑝𝑑 ≤ 𝑆𝑝𝑑𝑎  

𝑆𝑝𝑑 is the maximum of axial stress due to plastic deformation. 

𝑆𝑝𝑑 = 𝒎𝒂𝒙{(∆𝜎𝑎)+, (∆𝜎𝑎)−}  

The allowable/limit state for stress ratcheting for fully restrained sections is obtained from: 

𝑆𝑝𝑑𝑎 = 𝑅𝑒(𝑇) [√1 −
3

4
(
𝜎𝑝

𝑅𝑒(𝑇)
)
2

+√𝛾2 −
3

4
(
𝜎𝑝

𝑅𝑒(𝑇)
)
2

] 

𝑅𝑒(𝑇) = Specific minimum yield strength at operating temperature  

𝜎𝑝 (= 𝑃𝑑𝑜 2𝑧𝑡𝑚𝑖𝑛⁄  ) = hoop stress at operating pressure. (eqn. 78) 
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𝛾 = 0.7, is a safety factor 

Note: EN13941-1:2019 does not specify stress concentration factors for calculating 𝑆𝑝𝑑. In 

CAEPIPE, the stress concentration factors for  𝑆𝑝𝑑  calculations are considered the same as 

those for resulting stresses for each component given in Tables C1, C3, C4, and C6. 

TEES 

 In CAEPIPE,  and  are calculated separately 
for run pipe and branch pipe with sectional forces 
chosen as follows: 

For stresses in the run pipe, the forces and 
moments determined in the run at the 
intersection between the centerlines of the pipes 
are used.  

For stresses in the branch pipe, the forces and 
moments determined in the branch at a distance 

of 0.5 𝑑𝑟𝑜 from the centreline of the run pipe are 
used. 

Note: CAEPIPE automatically refines the 
elements connected to the node point with a 
defined tee. Two (2) nodes on Run Pipe (one on 
either side of the Branch SIF node) at a distance 
equal to Run Pipe OD and one (1) node on 
Branch Pipe at a distance equal to Run pipe OD/2 from the Branch SIF node are 
internally added with appropriate node numbers.   

 As per sec. 6.6.7, the stresses at the intersection of run pipe are calculated after 

combining the axial and shear stresses from the run pipe and branch element as follows. 

(∆𝜎𝑎)±(𝑟𝑢𝑛 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛) =  (∆𝜎𝑎)± (𝑟𝑢𝑛) +   ∆𝜎𝑎 (𝑏𝑟𝑎𝑛𝑐ℎ)           (63) 

(∆𝜏)±(𝑟𝑢𝑛 𝑖𝑛𝑡𝑒𝑟𝑠𝑒𝑐𝑡𝑖𝑜𝑛)  =  (∆𝜏)± (𝑟𝑢𝑛)   +  ∆𝜏 (𝑏𝑟𝑎𝑛𝑐ℎ)                 (64) 

 

In CAEPIPE, 

∆𝜎𝑎 (𝑏𝑟𝑎𝑛𝑐ℎ) = {
(∆𝜎𝑎)+ (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜎𝑎)+| > |(∆𝜎𝑎)−|

(∆𝜎𝑎)− (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜎𝑎)−| ≥ |(∆𝜎𝑎)+|
 

 

∆𝜏 (𝑏𝑟𝑎𝑛𝑐ℎ) = {
(∆𝜏)+ (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜏)+| > |(∆𝜏)−|

(∆𝜏)− (𝑏𝑟𝑎𝑛𝑐ℎ) 𝑖𝑓 |(∆𝜏)−| ≥ |(∆𝜏)+|
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Modeling buried pipe bilinear restraints 

Longitudinal/Axial soil stiffness (sec. 6.5.3.1) 

Cohesionless Soil Cohesive Soil 

For sandy soils, the ultimate axial load per unit 
length   

𝐹𝑢 = 𝜇 (
1+𝐾𝑜

2
𝜋𝐷𝑐𝜎𝑣 + 𝐺 − 𝛾𝑠 ∙ 𝜋 (

𝐷𝑐

2
)
2
)                     (8) 

where,  

𝐾𝑜 = coefficient of horizontal soil pressure at rest  

𝐾𝑜 = 1 − sin𝜑
′                                                    

𝜑′ - the effective angle of Internal friction of soil 

𝜎𝑣  - Effective (normal) intergranular soil stress at 
pipe center level.  
𝜇 =  tan 𝛿                                                                          (12)      
        is the friction coefficient, sec.6.5.3.2 
δ = Angle of interface friction between soil and 
(casing) pipe. 

The ultimate axial/longitudinal load per unit length   

𝐹𝑢 = 𝜋 𝐷𝑐𝐶𝑓 ∙ 𝐶𝑠  
 
where 

𝐹𝑢 - Ultimate axial soil load  

𝐶𝑠 – Cohesion strength.  

𝐶𝑓  - Cohesion factor 

 

For granular soils  

𝜎𝑣 = 𝛾𝑠𝐻𝑤 + 𝛾𝑠𝑤(𝑍 − 𝐻𝑤) for 𝐻𝑤 < 𝑍     (9)   

𝜎𝑣 = 𝛾𝑠𝑍 for 𝐻𝑤 ≥ 𝑍                                 (10) 

𝛾𝑠𝑤 = 𝛾′𝑠𝑤 − 𝛾𝑤                                          (11) 
 

𝐷𝑐 = Outer diameter of the casing  
G = Effective self-weight of the factory-made pipe assembly (including pipe fill) per meter of 
pipe length 

𝛾𝑠= Effective weight of soil above ground water table  

𝛾𝑠𝑤 = Effective weight of soil below ground water table = 𝛾′𝑠𝑤 − 𝛾𝑤  

𝛾′𝑠𝑤 = Effective weight of saturated soil below ground water table  

𝛾𝑤 = Effective weight of water  
Z = Depth of burial (measured to centerline of pipe assembly)  

𝐻𝑤 = Depth of ground water table below grade 

For sandy soils, the relative displacement 𝑢𝑢 between the pipe and surrounding soil required 

to reach the maximum friction resistance fu is approx. 𝑢𝑢 = 3 mm = 0.003m. 

Axial soil stiffness = 𝐹𝑢/𝑢𝑢    
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Horizontal/Lateral soil stiffness (sec. 6.5.4.1) 

The coefficient of horizontal/lateral soil reaction or horizontal/lateral bedding constant is 
defined as the ratio between horizontal/lateral soil pressure and horizontal/lateral movement 
of the pipe system. 

The ultimate horizontal/lateral soil resistance 𝑃𝑢 is assessed using the equivalent equation for 
side support: 

Cohesionless Soil Cohesive Soil 

For sandy soils, the ultimate horizontal/lateral load per 
unit length   
 

𝑃𝑢 =  𝛾 ∙ 𝑍 ∙ 𝐾𝑞 ∙ 𝐷𝑐                                         (16) 

 

𝛾 = Soil density 
Z = depth of the buried pipe 

𝐾𝑞  = soil pressure coefficient for sand (Fig 10) 

The ultimate horizontal/lateral load per unit length   
 

𝑃𝑢 = (𝐾𝑞 ∙ 𝛾 ∙ 𝑍 + 0.7 𝛼 ∙ 𝐾𝑐 ∙ 𝑐
′) ∙ 𝐷𝑐          (17) 

 

𝛼  = 0.6, in case of open excavation;  and  

𝛼  =1.0, in case of jacking methods; 

𝑐′ =  𝐶𝑓 ∙ 𝐶𝑠 Effective cohesion of the soil  

𝐾𝑐 = soil pressure coefficient for clay (Fig 10) 
 

 

In Figure 10 the values on the right side (45°, 30°, etc.) represent the effective internal angle 

of friction of the soil 𝜑′, H is soil cover above pipe (see Figure 5 in EN13941-1) and D is 
considered as outer diameter of casing Dc (see Figure 13 in EN13941-1). 

The ultimate horizontal/lateral displacement 𝑣𝑢 is not defined precisely. The results of a 
number of tests with small diameter pipes are summarized in Table 12. 

   Table 12 – Ultimate horizontal/lateral displacement 𝑣𝑢 

𝒗𝒖/Z % 

Casing Diameter Dc Loose sand Dense sand 

75 mma 4.5 2.7 

120 mm 3 2 

≥ 300 mm 2 1.5 

Values obtained by interpolation. 



EN13941-1:2019 
 

481 
 

 

For buried pipes without expansion cushions, a fair relationship between horizontal pipe 
movement and corresponding soil restraint is given by 

𝑝

𝑝𝑢
=

𝑣 𝑣𝑢⁄

0.15 + 0.85 𝑣 𝑣𝑢⁄
                                                                                  (15) 

At 70% of ultimate horizontal load i.e., 𝑝 𝑝𝑢⁄ = 0.7, the horizontal displacement is 
calculated as 

0.7(0.15 + 0.85 𝑣 𝑣𝑢⁄ ) = 𝑣 𝑣𝑢⁄  

𝑣70% = 0.2593 𝑣𝑢 

Vertical soil stiffnesses  

To compute vertically upward and downward stiffnesses, the ultimate loads in vertical 
direction are considered as the same as those for other piping codes in CAEPIPE. For 
details, refer to the Section titled “Buried Piping” in the Technical Reference Manual. The 
vertical yield displacement for the soil is assumed to be D/25, where D is the outside 
diameter of the pipe.  

Combined lateral stiffness of PUR, expansion cushions and soil (sec. 6.5.5) 

 

PUR Cushion Soil Combined 

𝑘ℎ,1 =
𝐸𝑝𝑢𝑟

𝑡𝑝𝑢𝑟
           (19a) 

𝑘1 = 𝑘ℎ,1𝑑𝑜          

(19b) 

𝑘ℎ,2 =
𝐸𝑐𝑢

𝑡𝑐𝑢
             (20a) 

𝑘2 = 𝑘ℎ,2𝐷𝑐          (20b) 

 

𝑘ℎ,3 =
0.7 𝑝𝑢

𝑣70%
          (21a) 

𝑘3 = 𝑘ℎ,3𝐷𝑐𝑢        (21b) 

 

1

𝑘
= ∑

1

𝑘𝑖
                  (22) 

 

 

where, 

𝑑𝑜 = Outside diameter of steel service pipe 

𝐷𝑐 = Outer diameter of casing 

𝐷𝑐𝑢= Equivalent outside diameter of expansion cushion. 

Polyurethane foam thermal insulation (sec. 5.3) 

In CAEPIPE, for EN13941-1 code, the insulation for pipe is considered as PUR, and the 

elastic modulus for PUR is internally set as 𝐸𝑃𝑈𝑅 = 10.0 𝑀𝑃𝑎. 
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The elastic modulus 𝐸𝑐𝑢 for expansion cushion shall be input in soil dialog as per section 
5.6.3. 

NOTE 1: The above methodology of combining stiffnesses of PUR, expansion 
cushions and soil is also applied in the vertically downward and upward directions. 

NOTE 2:  Expansion Cushion is very flexible, whereas PUR is stiffer.  Surrounding soil is 
much stiffer than PUR. So, the line bedding constant ‘k2’ for Expansion Cushion is much 
less than the line bedding constant ‘k1’ for PUR, which, in turn, is much less than the line 
bedding constant ‘k3’ for the surrounding soil, where the line bedding constant is the same as 
stiffness. In short, k2 << k1<<<k3. 

The combined stiffness ‘k’ computed using Equation (22) will be less than the Expansion 
Cushion stiffness, ‘k2’. Due to this low value of combined stiffness ‘k’, sometimes non-linear 
iterative solution may not converge. In such case of non-convergence, re-perform the 
analysis without including Expansion Cushion. If the solution still not converges, then re-
perform with just surrounding soil (i.e., without including stiffnesses of both PUR and 
Expansion Cushion). In this case, the weight per unit length of insulation PUR shall be input 
as “Additional weight” in CAEPIPE’s Loads dialog. 

C.2 Flexibility factors for pipe components (see Annex C) 

C.2.1 Bends 

Flexibility Factor for bending Bend Radius Equation 

𝑘𝑏 =
1.24 ∙ 𝑑𝑚

2

4 ∙ 𝑡𝑛 ∙ 𝑅
≥ 1 

𝑅 ≤ 1.5 𝑑𝑜 (𝐶. 1) 
 

1.24 ∙ 𝑑𝑚
2

4 ∙ 𝑡𝑛 ∙ 𝑅
< 𝑘𝑏 <

1.65 ∙ 𝑑𝑚
2

4 ∙ 𝑡𝑛 ∙ 𝑅
 

1.5 𝑑𝑜 < 𝑅 < 2.5𝑑𝑜 (𝐶. 2) 
 

𝑘𝑏 =
1.65 ∙ 𝑑𝑚

2

4 ∙ 𝑡𝑛 ∙ 𝑅
 

𝑅 ≥ 2.5𝑑𝑜 (𝐶. 3) 
 

Intervening values are obtained by interpolation. For bend angles between 90° and 0°, the 

flexibility factor 𝑘𝑏 for bending is linearly interpolated between flexibility factor at 90° and  

for straight pipe (𝑖. 𝑒. , 𝑘𝑏 = 1). The flexibility factor for normal forces, shear forces and 
torque equals 1.  

For pipe bends, the internal pressure will counteract ovalization. This is considered by 

dividing 𝑘𝑏 with 

1 + 6
𝑝

𝐸
(
𝑑𝑚
2𝑡
)
7/3

(
𝑑𝑚
2𝑅
)
−1/3

                                                                                           (𝐶. 4) 

For miter bends, the flexibility factors are not provided in EN 13941-1 (2019). Hence, the 
flexibility factor as given in ASME B31J (2017) is used for all types of miter bends. 

𝑘𝑏 = 1.52 (
𝑑𝑚
2

4 ∙ 𝑡𝑛 ∙ 𝑅
)

5/6

 

 

  



EN13941-1:2019 
 

483 
 

 

C.2.2 T-pieces 

The flexibility factor for T pieces equals 1. 

For 𝑑𝑏𝑜 𝑑𝑟𝑜⁄ ≤ 0.8 the flexibility of the connection between the branch pipe and run pipe 
may be taken into account by applying the following spring factor to the branch pipe at the 
point where the axis of the branch intersects the outside of the run pipe. 

For in-plane bending, 𝑀𝑏𝑦,  

𝑐𝑦 =
𝐸 ∙ 𝐼𝑏
𝑘𝑦 ∙ 𝑑𝑟𝑜

                                                                                                                    (𝐶. 5) 

𝑘𝑦 = 0.2 (
𝑑𝑟𝑜
𝑡𝑟
) ∙ (

𝑡𝑟
𝑡𝑏
∙
𝑑𝑏𝑜
𝑑𝑟𝑜

)
0.5

∙
𝑡𝑏
𝑡𝑟
                                                                                (𝐶. 6) 

For out-of-plane bending, 𝑀𝑏𝑧,  

𝑐𝑧 =
𝐸 ∙ 𝐼𝑏
𝑘𝑧 ∙ 𝑑𝑟𝑜

                                                                                                                    (𝐶. 7) 

𝑘𝑧 = 0.1 (
𝑑𝑟𝑜
𝑡𝑟
)
1.5

∙ (
𝑡𝑟
𝑡𝑏
∙
𝑑𝑏𝑜
𝑑𝑟𝑜

)
0.5

∙
𝑡𝑏
𝑡𝑟
                                                                          (𝐶. 8) 

Note: CAEPIPE automatically refines the elements connected to the node point with a 
defined tee, by adding two (2) nodes on Run Pipe (one on either side of the Branch SIF 
node) at a distance equal to Run Pipe OD and one (1) node on Branch Pipe at a distance 
equal to Run pipe OD/2 from the Branch SIF node. Flexibility Factors for Branch Pipe (Leg 
3), as stated above in equations (C.5) – (C-8), are applied to the branch pipe.  For Equal 
TEEs, the Run and Branch should be differentiated in the CAEPIPE model by 
defining the Branch OD as slightly less than the Run OD through CAEPIPE 
Sections input.  

C.3 Stress concentration factors in pipe elements 

Note: The stress concentration factors 𝒊𝒂𝟏 to 𝒊𝒂𝟓 and 𝒊𝒂𝒑  are either = 0 or  >= 1 for all 

types of stress evaluation.  Stress concentration factors = 0, meaning “no contribution of the 
term in computing stresses”. 

C.3.2.1 Stress concentration factors for bends and miter bends: Simplified method 

Table C.1 Stress concentration factors for bends 

 𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 𝒊𝒂𝟓 𝒊𝒂𝒑 

𝑺𝒎 1 
0.9 ∙ (

𝑑𝑚
2

4𝑡𝑛𝑅
)

2/3

 
1 1 0 𝑅 − 0.25𝑑𝑖

𝑅 − 0.5𝑑𝑚
 

𝑺𝒓𝒆𝒔 1 
0.9 ∙ (

𝑑𝑚
2

4𝑡𝑛𝑅
)

2/3

 
1 1 

1.8 ∙ (
𝑑𝑚
2

4𝑡𝑛𝑅
)

2/3

 

𝑅 − 0.25𝑑𝑖
𝑅 − 0.5𝑑𝑚

 

If the bracing effect of over pressure has been considered when calculating the flexibility of 
the pipe bend, 

𝒊𝒂𝟐 and 𝒊𝒂𝟓 shall be divided by f 
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𝑓 =  1 + 3.25
𝑝

𝐸
(
𝑑𝑚
2𝑡
)
5/2

(
𝑑𝑚
2𝑅
)
−2/3

                                                                         (𝐶. 9) 

With 𝒊𝒂𝟐 and 𝒊𝒂𝟓 valued at a minimum of 1.0 after the above division. 

C.3.3 T-pieces 

Table C.3 Stress concentration factors for membrane stresses in point B of T-pieces (all 
types) 

Membrane stresses 

𝑺𝒎 

𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 

Run pipe 

Branch pipe 

𝑟𝑟 ∙ 𝑘2 

𝑟𝑏 ∙ 𝑘 

𝑟𝑟 ∙ 𝑘1 

𝑟𝑏 ∙ 𝑘 

2𝑟𝑟 ∙ 𝑘1 

𝑟𝑏 ∙ 𝑘 

𝑟𝑟 ∙ 𝑘1 

𝑟𝑏 ∙ 𝑘 

Table C.4 – T-pieces: Stress concentration factors for resulting stresses in point B 

Resulting stresses 

𝑺𝒓𝒆𝒔 

𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 

Directly welded T-piece CAEPIPE: Unreinforced fabricated Tee 

Run pipe 

Branch pipe 

1.2𝑘2 

𝑘 

𝑘1 

𝑘 

2𝑘1 

𝑘 

𝑘1 

𝑘 

Forged T-piece CAEPIPE: Welding Tee 

Run pipe 

Branch pipe 

0.7𝑘2 

0.4𝑘 

0.6𝑘1 

0.4𝑘 

1.2𝑘1 

0.4𝑘 

0.6𝑘1 

0.4𝑘 

T-piece with drawn collar CAEPIPE: Extruded Tee 

Run pipe 

Branch pipe 

0.8𝑘2 

0.7𝑘 

0.7𝑘1 

0.7𝑘 

1.4𝑘1 

0.7𝑘 

0.7𝑘1 

0.7𝑘 

 

𝑘1 =  0.523 (
1

𝑑𝑟𝑚
)
1/3

(
1

𝑡𝑟
)
2/3

𝑑𝑏𝑚 + 2.5 (1 −
𝑑𝑏𝑚
𝑑𝑟𝑚

)
3/2

                                      (𝐶. 17) 

𝑘2 =  0.65 (
1

𝑑𝑟𝑚
)
5/6

(
1

𝑡𝑟
)
2/3

(𝑑𝑏𝑚)
3/2 + 2.5 (1 −

𝑑𝑏𝑚
𝑑𝑟𝑚

𝑡𝑏
𝑡𝑟
)
9/5

                                      

𝑘 =  0.567 (
𝑑𝑟𝑚
𝑡𝑟
)
2/3

                                                                                                              

Reduction factors for membrane stresses: 

𝑟𝑟 = 0.56 
𝑡𝑏
𝑡𝑟
 (2 −

𝑑𝑏𝑚
𝑑𝑟𝑚

)
5/3

                                                                                         (𝐶. 18) 

𝑟𝑏 = 0.83 √
𝑑𝑏𝑚
𝑑𝑟𝑚

                                                                                                             (𝐶. 19) 
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Reducers 

Reducers with defined radius of curvature r 

Table C.6. Stress concentration factors for reducers 

 𝒊𝒂𝟏 𝒊𝒂𝟐 𝒊𝒂𝟑 𝒊𝒂𝟒 𝒊𝒂𝟓 𝒊𝒂𝒑 

𝑺𝒎 1 1 1 0 0 1/cos 

𝑺𝒓𝒆𝒔 𝑘 𝑘 1 0 0 1/cos  

 

𝑘 = 0.5 + 0.01 ∙ 𝛼 √
𝑑𝑜,𝑚𝑖𝑛
𝑡1𝑛

                                                                                             (𝐶. 21) 

𝛼  is inserted in degrees. The expression for k is only valid if the following requirements are 

met:  

the transitional part is concentric; 𝛼 ≤ 30𝑜 and 𝑑𝑜,𝑚𝑖𝑛 𝑡𝑙,𝑛⁄  and 𝑑𝑜,𝑚𝑎𝑥 𝑡𝑛⁄  are both smaller 

than 100. 
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Allowable Pressure 

The allowable pressure for straight pipes is calculated from equation (6.1-1) or (6.1-3) 
depending on the ratio between outer and inner diameters. 

For 𝐷𝑜/𝐷𝑖 ≤ 1.7 

𝑃 =
2𝑓𝑧𝑒

𝐷𝑜 − 𝑒
 

For 𝐷𝑜/𝐷𝑖 > 1.7 

𝑃 = 𝑓𝑧
(1 − 𝑎2)

(1 + 𝑎2)
 

where 

𝑃 = allowable pressure  

𝑓 = allowable stress at Design Temperature as input into CAEPIPE Material properties 

𝑧 = joint factor (input as material property in CAEPIPE) 

𝑒 = pipe wall thickness without allowances and tolerances  

= nominal pipe thickness × (1 – mill tolerance/100 – corrosion allowance “c”) 

(In the pipe section where higher nominal thickness is ordered in order to accommodate 
either threading or grooving or erosion or any other thinning allowance, then such additional 
thickness required for threading/grooving/erosion/thinning etc. should be included in 
corrosion allowance “c” in CAEPIPE to compute allowable pressure for that pipe section.) 

𝐷𝑜 = outer diameter 

𝐷𝑖 = un-corroded inner diameter 

𝑎 = 1 −
2𝑒

𝐷𝑜
 

For pipe bends 

Clause 6.2.1 of the code explicitly states “These calculation rules take into account that upon 
applying internal pressure to a pipe bend, higher stresses occur on the intrados of the bend 
(and lower stresses on the extrados of the bend) than on a straight pipe with identical wall 
thickness.”  

So, for pipe bends the maximum allowable pressure is calculated using the equivalent pipe 
wall thickness eequi 

𝑒𝑒𝑞𝑢𝑖  = 
𝑒

𝑡𝑓
 

where 

𝑡𝑓 = [
𝑅/𝐷𝑜 − 0.25

𝑅/𝐷𝑜 − 0.50
] 

 

𝑅 = radius of bend 
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For closely spaced miter bends, the allowable pressure is calculated from equations (6.3.4-1) 
and (6.3.4-2). 

𝑃 = 𝑚𝑖𝑛 [
𝑓𝑧𝑒2

𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
,
𝑓𝑧𝑒(𝑅𝑠 − 𝑟)

𝑟(𝑅𝑠 − 𝑟/2)
]𝑤𝑖𝑡ℎ 𝜃 ≤ 22.50  

 
For widely spaced miter bends, the allowable pressure is calculated from equations (6.3.4-1), 
(6.3.4-2) and (6.3.5-1) 

𝑃 = 𝑚𝑖𝑛 [
𝑓𝑧𝑒2

𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
,
𝑓𝑧𝑒(𝑅𝑠 − 𝑟)

𝑟(𝑅𝑠 − 𝑟/2)
]𝑤𝑖𝑡ℎ 𝜃 ≤ 22.50  

𝑃 =
𝑓𝑧𝑒2

𝑟(𝑒 + 1.25 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
𝑤𝑖𝑡ℎ 𝜃 > 22.50 

where 

𝑟 = mean radius of pipe = (𝐷𝑜 − e)/2 

𝑅𝑆 = effective bend radius of the miter 

θ = miter half angle 

Sustained Stress 

The primary stress (σ1) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated from equation (12.3.2-2) 

𝜎1 = √⌈
𝑖𝑄𝐴𝑄𝑥𝐴
𝐴𝑐

+
√(0.75𝑖𝑖𝑀𝑖𝐴)2 + (0.75𝑖𝑜𝑀𝑜𝐴)2

𝑍𝑐
⌉

2

+ [
𝑖𝑡𝑀𝑡𝐴

𝑍𝑐
]
2

≤ 𝑓𝑓 

where 

QxA = max[|𝑄𝑥𝑆|, |
𝑃𝑐𝜋𝑑𝑖𝑐

2

4
+ 𝑄𝑥𝑆|] 

𝑃𝑐𝜋𝑑𝑖𝑐
2

4
 = internal pressure forces due to unrelieved axial expansion joints etc. 

QxS = axial force from other sustained mechanical loads (such as pipe weight, fluid weight 
etc.) [excluding that from pressure] 

Pc = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)] 

dic = corroded inside diameter = do – (2.ec) 

do = outside diameter 

ec = corroded thickness = en – corrosion allowance  

en = nominal pipe thickness 

Ac = area of cross section of the corroded pipe = 
𝜋

4
(𝑑𝑜

2 − 𝑑𝑖𝑐
2 ) 
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MiA = in-plane bending moment from the sustained mechanical loads [excluding that from 
pressure] 

MoA = out-of-plane bending moment from the sustained mechanical loads [excluding that 
from pressure] 

MtA = torsional moment from the sustained mechanical loads [excluding that from pressure] 

iQA = stress intensification factor for axial forces for sustained mechanical loads = 1.0 

ii = In-plane stress intensification factor from the Tables given at the end of this section  

io = Out-of-plane stress intensification factor from the Tables given at the end of this section 

it = stress intensification factor for torsional moments = 1.0 

Zc = corroded section modulus for pipe = 
𝜋

32𝑑𝑜
(𝑑𝑜

4 − 𝑑𝑖𝑐
4 );  

for branch connections/reduced outlets, as per Table H.3 of EN 13480-3:2017/A2:2020,  

Zc = 𝑚𝑖𝑛 [𝑖
𝜋((𝑑𝑚,𝑏+𝑒𝑛,𝑏)

4
−(𝑑𝑚,𝑏+𝑒𝑛,𝑏−2𝑒𝑐,𝑏)

4
)

32(𝑑𝑚,𝑏+𝑒𝑛,𝑏)
,
𝜋

4
(𝑑𝑚,𝑏 + 𝑒𝑛,𝑏)

2
𝑒𝑐]  

where i is taken as In-plane SIF ii 

ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature 
under consideration [i.e., max(T1 through T10)], where 

f = min(Rp0.2t/1.5 ; Rm/2.4) at max(T1 through T10); f is input into CAEPIPE material 
properties 

fcr = design stress in creep range at max(T1 through T10); fcr is input into CAEPIPE material 
properties 

Rp0.2t = minimum 0.2% proof strength at max(T1 through T10) 

Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input) 

Note:   Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the material properties 
table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5; Rm/2.4) is input for each 
temperature.  

If a stress model created using CAEPIPE version earlier than 7.50 is read into CAEPIPE Version 7.50 
or later version, the material properties should be updated appropriately by the CAEPIPE User. 

Sustained plus Occasional Stress 

The primary stress (𝜎2) due to sustained and occasional loads is calculated from equation 
(12.3.3-4) as the combined stress due to (a) sustained loads such as pressure, weight and 
other sustained mechanical loads and (b) occasional loads such as earthquake or wind. Wind 
and earthquake are not considered to act concurrently. 
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𝜎2 = √⌈
𝑖𝑄𝐴𝑄𝑥
𝐴𝑐

+
√[0.75𝑖𝑖(𝑀𝑖𝐴 +𝑀𝑖𝐵)]

2 + [0.75𝑖𝑜(𝑀𝑜𝐴 +𝑀𝑜𝐵)]
2

𝑍𝑐
⌉

2

+ [
𝑖𝑡𝑀𝑡𝐴 + 𝑖𝑡𝑀𝑡𝐵

𝑍𝑐
]
2

≤ 𝑘𝑓𝑓 

 
where 
MiB = in-plane bending moment from occasional or exceptional loads 

MoB = out-of-plane bending moment from occasional or exceptional loads 

MtB = torsional moment from occasional or exceptional loads 

For reversing loads (unsigned occasional load cases, e.g. earthquake) 

Qx = max[|𝑄𝑥𝐴| + |𝑄𝑥𝐵|, |
𝑃𝑏𝜋𝑑𝑖𝑐

2

4
+ 𝑄𝑥𝐴| + |𝑄𝑥𝐵|] as per equation (12.3.3-2) 

Both signs of MiB and MoB are considered 

For non-reversing loads (signed occasional load cases, e.g. wind) 

Qx = max[|𝑄𝑥𝐴|, |𝑄𝑥𝐴 + 𝑄𝑥𝐵|, |
𝑃𝑏𝜋𝑑𝑖𝑐

2

4
+ 𝑄𝑥𝐴| , |

𝑃𝑏𝜋𝑑𝑖𝑐
2

4
+ 𝑄𝑥𝐴 + 𝑄𝑥𝐵|] as per equation 

(12.3.3-3) 

Pb = Peak pressure during occasional loading = Peak Pressure Factor x Pc 

Pc = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)] 

QxA = axial force due to sustained mechanical loads [excluding that from pressure] 

QxB = axial force due to occasional loads [excluding that from pressure] 

Ac = area of cross section of the corroded pipe = 
𝜋

4
(𝑑𝑜

2 − 𝑑𝑖𝑐
2 ) 

Zc = corroded section modulus = 
𝜋

32𝑑𝑜
(𝑑𝑜

4 − 𝑑𝑖𝑐
4 ); 

for branch connections/reduced outlets, as per Table H.3 of EN 13480-3:2017/A2:2020,  

Zc = 𝑚𝑖𝑛 [𝑖
𝜋((𝑑𝑚,𝑏+𝑒𝑛,𝑏)

4
−(𝑑𝑚,𝑏+𝑒𝑛,𝑏−2𝑒𝑐,𝑏)

4
)

32(𝑑𝑚,𝑏+𝑒𝑛,𝑏)
,
𝜋

4
(𝑑𝑚,𝑏 + 𝑒𝑛,𝑏)

2
𝑒𝑐]  

where i is taken as In-plane SIF ii 

ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature 
under consideration [i.e., max(T1 through T10)], where 

f = min(Rp0.2t/1.5 ; Rm/2.4) at max(T1 through T10); f is input into CAEPIPE material 
properties 

fcr = design stress in creep range at max(T1 through T10); fcr is input into CAEPIPE material 
properties 

Rp0.2t = minimum 0.2% proof strength at max(T1 through T10) 
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Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input) 

𝑘=1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 

CAEPIPE, the default value for 𝑘=1.2; user can change this default value through Layout 
window > Options > Analysis > Code > EN13480. 

Note:   Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the material properties 
table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5; Rm/2.4) is input for each 
temperature.  

If a stress model created using CAEPIPE version earlier than 7.50 is read into CAEPIPE Version 7.50 
or later version, the material properties should be updated appropriately by the CAEPIPE User. 

Expansion Stress 

The secondary stress (𝜎3) due to thermal expansion is calculated from equation (12.3.4-3) 

𝜎3 = √⌈
𝑖𝑄𝐶𝑄𝑥𝐶
𝐴

+
√(𝑖𝑖𝑀𝑖𝐶)2 + (𝑖𝑜𝑀𝑜𝐶)2

𝑍
⌉

2

+ [
𝑖𝑡𝑀𝑡𝐶

𝑍
]
2

≤ 𝑓𝑎 

where 

𝑀𝑖𝐶  = in-plane moment range due to thermal expansion and alternating loads 

𝑀𝑜𝐶  = out-of-plane moment range due to thermal expansion and alternating loads 

𝑀𝑡𝐶  = torsional moment range due to thermal expansion and alternating loads 
iQC = stress intensification factor for axial forces due to thermal expansion and alternating 
loads = 1.0 

QxC = range of axial force due to thermal expansion and alternating loads 

en = nominal pipe thickness 

do = outside diameter 

di = inside diameter = do – 2 en 

A = un-corroded nominal area of cross-section = 
𝜋

4
(𝑑𝑜

2 − 𝑑𝑖
2) 

Z = un-corroded section modulus for pipe = 
𝜋

32𝑑𝑜
(𝑑𝑜

4 − 𝑑𝑖
4);  

for branch connections/reduced outlets, as per Table H.3 of EN 13480-3:2017/A2:2020,  

Z = 𝑚𝑖𝑛 [𝑖
𝜋((𝑑𝑚,𝑏+𝑒𝑛,𝑏)

4
−(𝑑𝑚,𝑏−𝑒𝑛,𝑏)

4
)

32(𝑑𝑚,𝑏+𝑒𝑛,𝑏)
,
𝜋

4
(𝑑𝑚,𝑏 + 𝑒𝑛,𝑏)

2
𝑒𝑛]  

where i is taken as In-plane SIF ii 

𝑓𝑎 = 𝑈(1.25𝑓𝑐 + 0.25𝑓ℎ)
𝐸ℎ

𝐸𝑐
  as per equation (12.1.3-1) 

U = cyclic stress range reduction factor taken from Table 12.1.3-1 
𝐸𝐶  = modulus of elasticity at the minimum metal temperature consistent with the loading 

under consideration 
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𝐸ℎ = modulus of elasticity at the maximum metal temperature consistent with the loading 
under consideration 

𝑓𝑐  = min(Rm/3; f), where f = min(Rp0.2t/1.5 ; Rm/2.4) at room temperature (Tref) as per 
equation (12.1.3-2) 

𝑓ℎ = basic allowable stress at maximum metal temperature consistent with the loading under 
consideration = min(fc; f; fcr) as per equation (12.1.3-3), with fc determined at minimum 
metal temperature consistent with the loading under consideration and f determined at 
maximum metal temperature consistent with the loading under consideration. 

fcr = design stress in creep range at max(T1 through T10); fcr is input into CAEPIPE material 
properties 

For example, for the thermal range (T1-T2), with T1 = 3000 C, T2 = 1000 C and Tref = 210C, 
Ec is determined at T2 = 1000C and Eh is determined at T1 =3000C. 

fc as per Equation (12.1.3-2) listed above is determined at Tref = 210C. 

The value of fc used in calculating fh is determined at T2 = 1000C [= min(100, 300)]; the 
value of f used in calculating fh is determined at T1 = 3000 C [= max(100, 300)] and the value 
of fcr is taken at T1 = 3000C (if available) 

If the above condition in equation (12.3.4-3) is not met, equation (12.3.4-2) as listed below 
may be used. 

𝜎4 = 𝜎1 + 𝜎3 ≤ 𝑓𝑓 + 𝑓𝑎 

Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎5), due to sustained, thermal and 
alternating loadings shall satisfy the equation (12.3.5-2) below. 

𝜎5 = 𝜎1 +√[
𝑖𝑄𝐶𝑄𝑥𝐶
3𝐴

+
√(0.75𝑖𝑖𝑀𝑖𝐶)2 + (0.75𝑖𝑜𝑀𝑜𝐶)2

3𝑍
]

2

+ [
𝑖𝑡𝑀𝑡𝐶

3𝑍
]
2

≤ 𝑓𝑐𝑟 

where 

crf = design stress in creep range at max(T1 through T10); fcr is input into material 

properties. 

Stresses due to a single non-repeated Support Movement (settlement) 

The stress (𝜎6) due to a single non-repeated support movement (settlement) is calculated 
from equation (12.3.6-2) 

𝜎6 = √⌈
𝑖𝑄𝐷𝑄𝑥𝐷
𝐴

+
√(𝑖𝑖𝑀𝑖𝐷)2 + (𝑖𝑜𝑀𝑜𝐷)2

𝑍
⌉

2

+ [
𝑖𝑡𝑀𝑡𝐷

𝑍
]
2

≤ 𝑓𝐷 

where 
 



EN 13480-3:2017/A2:2020 
 

492 
 

 

𝑀𝑖𝐷 = in-plane moment due to non-repeated anchor/restraint movement 

𝑀𝑜𝐷 = out-of-plane moment due to non-repeated anchor/restraint movement 

𝑀𝑡𝐷 = torsional moment due to non-repeated anchor/restraint movement 
iQD = stress intensification factor for axial forces due to non-repeated anchor/restraint 
movement = 1.0 

QxD = axial force due to non-repeated anchor/restraint movement 

A and Z are the same as defined under Expansion Stress given above 

𝑓𝐷 = allowable stress = min(2Rp0.2t; Rm) 

Since only f and Rm are input into CAEPIPE, the above allowable stress criterion can be 
rewritten as follows. 

𝑓𝐷 = 3f, if [f < (Rm/2.4)]; otherwise 

𝑓𝐷 = Rm ,if [f = (Rm/2.4)] 

where 
f = allowable stress @ Reference Temperature (Tref) entered in CAEPIPE. 

Stresses on Buried Piping as per EN 13480-6 (2017) 

The axial stress (𝑆𝐿) due to combined pressure and temperature change effects is calculated 
from equation 1 of Clause 5.2.4 of EN 13480-6 (2017). 

𝑆𝐿 = η𝑆𝑃 − Eα(∆𝑇) ≤ 0.9𝑆𝑦 

where 
 

𝑆𝑃 = circumferential stress due to maximum of CAEPIPE input pressures [i.e., max(P1 
through P10)] 

η= Poisson’s ratio 

∆𝑇= maximum temperature range 

𝑆𝑦= Yield Strength = 1.5 x f (when not input in CAEPIPE Material property) 
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SIFs for Reducer and Welds are computed as per Table H.1 as given below. 
 

 
 

 

 
 
See Notes given at the end of this Section  
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SIFs for Flanges and Threaded Joints are computed as given below. 
 

Sl. 
No. 

Designation Flexibility 
factor 

Stress 
intensification 

factor i 
1 Weld Neck Flange 1 1.0 
2 Double Welded Slip on Flange 1 1.2 
3 Single Welded Slip on Flange 1 1.3 
4 Fillet Welded Flange 1 1.3 
5 Socket Welded Flange 1 1.3 
6 Lap Joint Flange 1 1.6 
7 Threaded Flange 1 2.3 
8 Threaded Joint 1 2.3 

 
Note:  
In-plane and out-of-plane SIF values are the same for Reducers, Welds, Flanges and 
Threaded Joints (computed as per Table H.1 as well as the Table provided above). 
 
CAEPIPE internally incorporates the SIF values and Flexibility factors as given by the above 
three (3) Tables for any stress model. 
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Allowable Pressure 

The allowable pressure for straight pipes is calculated from equation 6.1-1 or 6.1-3 
depending on the ratio between inner and outer diameter. 

For 𝐷𝑜/𝐷𝑖 ≤ 1.7 

𝑃 =
2𝑓𝑧𝑒

𝐷𝑜 − 𝑒
 

For 𝐷𝑜/𝐷𝑖 > 1.7 

𝑃 = 𝑓𝑧
(1 − 𝑎2)

(1 + 𝑎2)
 

where 

𝑃 = allowable pressure  

𝑓 = allowable stress 

𝑧 = joint factor (input as material property in CAEPIPE) 

𝑒 = nominal pipe thickness × (1 – mill tolerance %/100 – corrosion allowance)“c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

𝐷𝑜 = outer diameter 

𝐷𝑖 = inner diameter 

𝑎 = 1 −
2𝑒

𝐷𝑜
 

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall thickness 

e𝑒𝑞𝑢𝑖− 

𝑒𝑒𝑞𝑢𝑖 =
𝑒

𝑡𝑓
 

where 

tf = (
𝑅/𝐷−0.25

𝑅/𝐷−0.50
) 

𝑅 = radius on bend 

For closely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1 
and 6.3.4-2. 

𝑃 = 𝑚𝑖𝑛 [
𝑓𝑧𝑒2

𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
,
𝑓𝑧𝑒(𝑅𝑠 − 𝑟)

𝑟(𝑅𝑠 − 𝑟/2)
]𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5  

 



SS-EN 13480-3:2017 
 

499 
 

 

For widely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1, 
6.3.4-2 and 6.3.5-1 

𝑃 = 𝑚𝑖𝑛 [
𝑓𝑧𝑒2

𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
,
𝑓𝑧𝑒(𝑅𝑠 − 𝑟)

𝑟(𝑅𝑠 − 𝑟/2)
]𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5  

𝑃 =
𝑓𝑧𝑒2

𝑟(𝑒 + 1.25 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
𝑤𝑖𝑡ℎ𝜃 ≤ 22.5 

where 

𝑟 = mean radius of pipe = (𝐷 − t)/2 

𝑅𝑆 = effective bend radius of the miter 

θ = miter half angle 

Sustained Stress 

The stress ( 1 ) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation (12.3.2-1) 

f
A

n

o f
Z

iM

e

PD


75.0

4
1

 

where 

P = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)] 

Do = outside diameter 

en = nominal pipe thickness  

i stress intensification factor; the product of 0.75ishall not be less than 1.0 

AM resulting bending moment due to sustained loads 

Z = un-corroded section modulus; for reduced outlets / branch connections, effective 
section modulus 

ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature 
under consideration [i.e., max(T1 through T10)], where 

f = min(Rp0.2t/1.5 ; Rm/2.4) 

fcr = design stress in creep range at max(T1 through T10) 

Rp0.2t = minimum 0.2% proof strength at max(T1 through T10) 

Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input) 

Note:   Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the 
material properties table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5; 
Rm/2.4) is input for each temperature.  
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If a stress model created using an earlier version of CAEPIPE is read into Version 7.50 of 
CAEPIPE, then in the 7.50 model file, the material properties should be updated 
appropriately. 

Sustained plus Occasional Stress 

The stress (𝜎2) due to sustained and occasional loads is calculated from equation (12.3.3-1) 
as the sum of stress due to sustained loads such as due to pressure, weight and other 
sustained mechanical loads and stress due to occasional loads such as earthquake or wind. 
Wind and earthquake are not considered concurrently 

f
BA

n

o kf
Z

iM

Z

iM

e

PD


75.075.0

4
2

 
where 

𝑀𝐵 = resultant bending moment due to occasional load 

𝑘=1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 

CAEPIPE 𝑘=1.2; user can change this input in Layout window > Options > Analysis > 
Code > EN13480. 

Expansion Stress 

The stress (𝜎3) due to thermal expansion is calculated from equation (12.3.4-1) 

𝜎3 =
𝑖𝑀𝐶

𝑍
≤ 𝑓𝑎 

where 

𝑀𝐶  = resultant moment due to thermal expansion and alternating loads 
Z = un-corroded section modulus; for reduced outlets / branch connections, effective 

section modulus 

1)-(12.1.3Equation per  as)25.025.1(
c

h
hCa

E

E
ffUf   

U = cyclic stress range reduction factor taken from Table 12.1.3-1 
𝐸𝐶  = modulus of elasticity at the minimum metal temperature consistent with the loading 

under consideration 
𝐸ℎ = modulus of elasticity at the maximum metal temperature consistent with the loading 

under consideration 
𝑓𝑐  = min(Rm/3; f), where f = min(Rp0.2t/1.5 ; Rm/2.4) at room temperature (Tref) as per 

Equation (12.1.3-2) 
𝑓ℎ = basic allowable stress at maximum metal temperature consistent with the loading under 

consideration = min(fc; f; fcr) as per Equation 12.1.3-3, with fc determined at minimum 
metal temperature consistent with the loading under consideration and f determined at 
maximum metal temperature consistent with the loading under consideration. 
 
For example, for the thermal range (T1-T2), with T1 = 3000 C, T2 = 1000 C and Tref = 
210C,Ec is determined at T2 = 1000C and Eh is determined at T1 =3000C  
fc as per Equation (12.1.3-2) listed above is determined at Tref = 210C, the value of fc 
used in calculating fh is determined at T2 = 1000C the value of f used in calculating fh is 
determined at T1 = 300 0C andthe value of fcr is taken at T1 = 3000C (if available) 



SS-EN 13480-3:2017 
 

501 
 

 

If the above condition in equation (12.3.4-1) is not met, equation (12.3.4-2) may be used. 

af
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Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎3), due to sustained, thermal and 
alternating loadings shall satisfy the equation (12.3.5-1) below. 

𝜎5 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐶

3𝑍
≤ 𝑓𝑐𝑟 

where 

crf = design stress in creep range at max(T1 through T10) 

Stresses due to single non-repeated Support Movement (settlement) 

The stress (𝜎6) due to a single non-repeated support movement (settlement) is calculated 
from equation (12.3.6-1) 

𝜎6 =
𝑖𝑀𝐷

3𝑍
≤ 𝜎6𝑎 

where 
 

𝑀𝐷 = resultant moment from a single non-repeated anchor movement (settlement) 
 

𝜎6𝑎 = allowable stress = min(2Rp0.2t; Rm) 

Since only f and Rm are input into CAEPIPE, the above allowable stress criterion can be 
rewritten as follows. 

𝜎6𝑎 = 3f, if [f < (Rm/2.4)]; otherwise 

𝜎6𝑎 = Rm ,if [f = (Rm/2.4)] 

where 
f = allowable stress @ Reference Temperature (Tref) entered in CAEPIPE. 

Stresses on Buried Piping as per EN 13480-6 (2017) 

The axial stress (𝑆𝐿) due to combined pressure and temperature change effects is calculated 
from equation 1 of Clause 5.2.4 of EN 13480-6 (2017). 

𝑆𝐿 = η𝑆𝑃 − Eα(∆𝑇) ≤ 0.9𝑆𝑦 

where 
 

𝑆𝑃 = circumferential stress due to maximum of CAEPIPE input pressures [i.e., max(P1 
through P10)] 

η= Poisson’s ratio 

∆𝑇= maximum temperature range 
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𝑆𝑦= Yield Strength = 1.5 x f 
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SIFs for Reducer and Weldsare computed as per Table H.1 as given below. 
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SIFs for Flanges and Threaded Joints are computed as given below. 
 

Sl. 
No. 

Designation Flexibility 
factor 

Stress 
intensification 

factor i 
1 Weld Neck Flange 1 1.0 
2 Double Welded Slip on Flange 1 1.2 
3 Single Welded Slip on Flange 1 1.3 
4 Fillet Welded Flange 1 1.3 
5 Socket Welded Flange 1 1.3 
6 Lap Joint Flange 1 1.6 
7 Threaded Flange 1 2.3 
8 Threaded Joint 1 2.3 

 
Note:  
In-plane and out-of-plane SIF values are the same for Reducers, Welds, Flanges and 
Threaded Joints (computed as per Table H.1 as well as the Table provided above). 
 
CAEPIPE internally incorporates the SIF values and Flexibility factors as given by the above 
three (3) Tables in any stress model.
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Allowable Pressure 

The allowable pressure for straight pipes is calculated from equation 6.1-1 or 6.1-3 
depending on the ratio between inner and outer diameter. 

For 𝐷𝑜/𝐷𝑖 ≤ 1.7 

𝑃 =
2𝑓𝑧𝑒

𝐷𝑜 − 𝑒
 

For 𝐷𝑜/𝐷𝑖 > 1.7 

𝑃 = 𝑓𝑧
(1 − 𝑎2)

(1 + 𝑎2)
 

where 

𝑃 = allowable pressure  

𝑓 = allowable stress 

𝑧 = joint factor (input as material property in CAEPIPE) 

𝑒 = nominal pipe thickness × (1 – mill tolerance %/100 – corrosion allowance)“c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

𝐷𝑜 = outer diameter 

𝐷𝑖 = inner diameter 

𝑎 = 1 −
2𝑒

𝐷𝑜
 

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall thickness 

e𝑒𝑞𝑢𝑖− 

𝑒𝑒𝑞𝑢𝑖 =
𝑒

𝑡𝑓
 

where 

tf = (
𝑅/𝐷−0.25

𝑅/𝐷−0.50
) 

𝑅 = radius on bend 

For closely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1 
and 6.3.4-2. 

𝑃 = 𝑚𝑖𝑛 [
𝑓𝑧𝑒2

𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
,
𝑓𝑧𝑒(𝑅𝑠 − 𝑟)

𝑟(𝑅𝑠 − 𝑟/2)
]𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5  
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For widely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1, 
6.3.4-2 and 6.3.5-1 

𝑃 = 𝑚𝑖𝑛 [
𝑓𝑧𝑒2

𝑟(𝑒 + 0.643 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
,
𝑓𝑧𝑒(𝑅𝑠 − 𝑟)

𝑟(𝑅𝑠 − 𝑟/2)
]𝑤𝑖𝑡ℎ 𝜃 ≤ 22.5  

𝑃 =
𝑓𝑧𝑒2

𝑟(𝑒 + 1.25 𝑡𝑎𝑛 𝜃 √𝑟𝑒)
𝑤𝑖𝑡ℎ𝜃 ≤ 22.5 

where 

𝑟 = mean radius of pipe = (𝐷 − t)/2 

𝑅𝑆 = effective bend radius of the miter 

θ = miter half angle 

Sustained Stress 

The stress ( 1 ) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation (12.3.2-1) 
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where 

P = maximum of CAEPIPE input pressures [i.e., max(P1 through P10)] 

Do = outside diameter 

en = nominal pipe thickness  

i stress intensification factor; the product of 0.75ishall not be less than 1.0 

AM resulting bending moment due to sustained loads 

Z = un-corroded section modulus; for reduced outlets / branch connections, effective 
section modulus 

ff = min(f; fcr) = design stress for flexibility analysis at the maximum operating temperature 
under consideration [i.e., max(T1 through T10)], where 

f = min(Rp0.2t/1.5 ; Rm/2.4) 

fcr = design stress in creep range at max(T1 through T10) 

Rp0.2t = minimum 0.2% proof strength at max(T1 through T10) 

Rm = Tensile Strength (= Tensile as shown in CAEPIPE material input) 

Note:   Starting Version 7.50 of CAEPIPE, the value of “ff” is no longer input in the 
material properties table. Instead, the value of “f” which is calculated as min(Rp0.2t/1.5; 
Rm/2.4) is input for each temperature.  
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If a stress model created using an earlier version of CAEPIPE is read into Version 7.50 of 
CAEPIPE, then in the 7.50 model file, the material properties should be updated 
appropriately. 

Sustained plus Occasional Stress 

The stress (𝜎2) due to sustained and occasional loads is calculated from equation (12.3.3-1) 
as the sum of stress due to sustained loads such as due to pressure, weight and other 
sustained mechanical loads and stress due to occasional loads such as earthquake or wind. 
Wind and earthquake are not considered concurrently 

f
BA

n

o kf
Z

iM

Z

iM

e

PD


75.075.0

4
2

 
where 

𝑀𝐵 = resultant bending moment due to occasional load 

𝑘=1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 

CAEPIPE𝑘=1.2; user can change this input in Layout window> Options > Analysis > Code 
>EN13480. 

Expansion Stress 

The stress (𝜎3) due to thermal expansion is calculated from equation (12.3.4-1) 

𝜎3 =
𝑖𝑀𝐶

𝑍
≤ 𝑓𝑎 

where 

𝑀𝐶  = resultant moment due to thermal expansion and alternating loads 
Z = un-corroded section modulus; for reduced outlets / branch connections, effective 

section modulus 

1)-(12.1.3Equation per  as)25.025.1(
c

h
hCa

E

E
ffUf   

U = cyclic stress range reduction factor taken from Table 12.1.3-1 
𝐸𝐶  = modulus of elasticity at the minimum metal temperature consistent with the loading 

under consideration 
𝐸ℎ = modulus of elasticity at the maximum metal temperature consistent with the loading 

under consideration 
𝑓𝑐  = min(Rm/3; f), where f = min(Rp0.2t/1.5 ; Rm/2.4) at room temperature (Tref) as per 

Equation (12.1.3-2) 
𝑓ℎ = basic allowable stress at maximum metal temperature consistent with the loading under 

consideration = min(fc; f; fcr) as per Equation 12.1.3-3, with fc determined at minimum 
metal temperature consistent with the loading under consideration and f determined at 
maximum metal temperature consistent with the loading under consideration. 
 
For example, for the thermal range (T1-T2), with T1 = 3000 C, T2 = 1000 C and Tref = 
210C,Ec is determined at T2 = 1000C and Eh is determined at T1 =3000C  
fc as per Equation (12.1.3-2) listed above is determined at Tref = 210C, the value of fc 
used in calculating fh is determined at T2 = 1000C the value of f used in calculating fh is 
determined at T1 = 300 0C andthe value of fcr is taken at T1 = 3000C (if available) 
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If the above condition in equation (12.3.4-1) is not met, equation (12.3.4-2) may be used. 

af
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o ff
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Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎3), due to sustained, thermal and 
alternating loadings shall satisfy the equation (12.3.5-1) below. 

𝜎5 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐶

3𝑍
≤ 𝑓𝑐𝑟 

where 

crf = design stress in creep range at max(T1 through T10) 

Stresses due to single non-repeated Support Movement (settlement) 

Settlement evaluation as per Equation (12.3.6-1) of EN 13480-3 (2012) is not yet 
implemented in CAEPIPE. 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 6.3. 

𝑝 =
2𝑓𝑧𝐿𝑇𝑒𝑓𝑓

𝐷𝑚 − 𝑇𝑒𝑓𝑓
 

where 

𝑝 = allowable pressure 

𝑓 = allowable stress 

𝑧𝐿 = joint efficiency of longitudinal weld (input as material property) 

𝑇𝑒𝑓𝑓= nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑚 = pressure coefficient 

 = 1.0 for 𝐷/d<1.6 

 = 0.25(𝐷/d)+0.6 for 1.6 ≤ 𝐷/d≤2.0 

Sustained Stress 

Stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from Equation 9.32. 

𝑆𝐿 =
𝑝𝐷

4𝑇𝑒𝑓𝑓𝑧𝐶
+
0.75𝑘1𝑀𝐴

𝑊
≤ 𝑓2 

where 

𝑝 = maximum pressure 

𝑧𝐶 = joint efficiency of circumferential weld (input as material property) 

𝑘1 = stress intensification factor. The product 0.75𝑘1 shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to sustained loads 

𝑊 = section modulus, for reduced outlets, effective section modulus 

𝑓2 = hot allowable stress 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of the stress due to sustained loads (𝑆𝐿) and the 

stress (𝑆𝑂) due to occasional loads such as earthquake or wind from Equation 9.33. Wind 
and earthquake are not considered concurrently. 

𝑆𝐿𝑂 =
𝑝𝐷

4𝑇𝑒𝑓𝑓𝑧𝐶
+
0.75𝑘1(𝑀𝐴 +𝑀𝐵)

𝑊
≤ 1.2𝑓2 

where 

𝑀𝐵 = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation 9.34. 

𝑆𝐸 =
𝑘1𝑀𝐶
𝑊

≤ 𝑆𝑟 

Alternatively, Equation 9.35 may be used. 

𝑆𝐿 + 𝑆𝐸 ≤ 𝑓2 + 𝑆𝑟 

where 

𝑀𝐶 = resultant bending moment due to thermal expansion. 

𝑆𝑟 = 𝑓𝑟(1.17𝑅1 + 0.17𝑅2) 
𝑓𝑟 = stress range reduction factor taken from Table 9.1. 

𝑅1 = smaller of 𝑓1 and 0.267𝑅m 

𝑅2 = smaller of 𝑓2 and 0.367𝑅m 

𝑓1 = allowable stress at cold condition 

𝑓2 = allowable stress at hot condition 

𝑅m = tensile strength at room temperature 
At moderate temperatures (up to 370º C) for carbon steel, low alloy steel and chromium steel 
(specified as CS material type) and up to 425º C for austenitic stainless steel (specified as AS 

material type), the limits 0.267𝑅m and 0.367𝑅m are disregarded and𝑆𝑟 is selected as smaller 

of 𝑆𝑟
′and 𝑆𝑟

′′, 

where 

𝑆𝑟
′  = 1.17𝑓1 + 0.20𝑓2 

𝑆𝑟
′′ = 290𝑓r − 𝑓2 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 6.3. 

𝑝 =
2𝑓𝑧𝐿𝑇𝑒𝑓𝑓

𝐷𝑚 − 𝑇𝑒𝑓𝑓
 

where 

𝑝 = allowable pressure 

𝑓 = allowable stress 

𝑧𝐿 = joint efficiency of longitudinal weld (input as material property) 

𝑇𝑒𝑓𝑓= nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑚 = pressure coefficient 

 = 1.0 for 𝐷/d<1.6 

 = 0.25(𝐷/d)+0.6 for 1.6 ≤ 𝐷/d≤2.0 

Sustained Stress 

Stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from Equation 10.7. 

𝑆𝐿 =
𝑝𝐷

4𝑇𝑒𝑓𝑓𝑧𝐶
+
0.75𝑘1𝑀𝐴

𝑊
≤ 𝑓2 

where 

𝑝 = maximum pressure 

𝑧𝐶 = joint efficiency of circumferential weld (input as material property) 

𝑘1 = stress intensification factor. The product 0.75𝑘1 shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to sustained loads 

𝑊 = section modulus, for reduced outlets, effective section modulus 

𝑓2 = hot allowable stress 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of the stress due to sustained loads (𝑆𝐿) and the 

stress (𝑆𝑂) due to occasional loads such as earthquake or wind from Equation 10.8. Wind 
and earthquake are not considered concurrently. 

𝑆𝐿𝑂 =
𝑝𝐷

4𝑇𝑒𝑓𝑓𝑧𝐶
+
0.75𝑘1(𝑀𝐴 +𝑀𝐵)

𝑊
≤ 1.2𝑓2 

where 

𝑀𝐵 = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆E) due to thermal expansion is calculated from Equation 10.9. 

𝑆𝐸 =
𝑘1𝑀𝐶
𝑊

≤ 𝑆𝑟 

Alternatively, Equation 10.10 may be used. 

𝑆𝐿 + 𝑆𝐸 ≤ 𝑓2 + 𝑆𝑟 

where 

𝑀𝐶 = resultant bending moment due to thermal expansion. 

𝑆𝑟 = smaller of 𝑆𝑟
′  and 𝑆𝑟

′′ 

𝑆𝑟
′  = 1.25𝑓1 + 0.25𝑓2 

𝑆𝑟
′′ = 𝑓𝑟𝑅𝑠 − 𝑓2 

𝑓𝑟 = stress range reduction factor 

𝑓1 = allowable stress at cold condition 

𝑓2 = allowable stress at hot condition 

𝑅𝑠 = permissible extent of stress for 7000 load cycles for different materials 

 𝑅𝑠is determined by material type as follows: 
  

 Material   Type RS 
 Carbon and low alloy steel CS 290 
 Austenitic stainless steel AS 400 
 Copper alloys, annealed CA 150 
 Copper alloys, cold worked CC 100 
 Aluminum   AL 130 
 Titanium   TI 200 

The stress range reduction factor 𝑓𝑟 depends on the number of thermal cycles (NE). For 
moderate high temperatures (≤ 370º C for carbon, low alloy and chromium steel and ≤ 425º 

C for austenitic stainless steel), 𝑓𝑟 is calculated from 

𝑓𝑟 = (7000/𝑁𝐸)
0.2𝑁𝐸 > 100 (𝑖. 𝑒. , 𝑓𝑟 ≤ 2.34) 

At higher temperatures, 𝑆𝑟 shall not be greater than 𝑓𝑟(1.25𝑅1 + 0.25𝑅2) and 𝑓𝑟 shall not 
be greater than 1.0. 

where 

𝑅1 = smaller of 𝑓1 and 0.25𝑅𝑚 

𝑅2 = smaller of 𝑓2 and 0.25𝑅𝑚 

𝑅𝑚 = tensile strength at room temperature 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated using eq. (2) in para. C 
3641.1. 

𝑃𝑎 =
2𝑆𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
S = allowable stress for the material at the design temperature (i.e., at Tdesign input into 
CAEPIPE). This value is given in the applicable tables of Annex Z I. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

𝑌 = coefficient = 0.4.  

𝑌 =
𝑑

(𝑑+𝐷𝑜)
 when Do/ta< 6 

where, d = nominal inside diameter 

Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from eq. (6) of para. C 3652. 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head = maximum of CAEPIPE input pressures 
P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus and should be computed as stated in para. C 3658 (b) and (d) 

𝑍 =  𝜋𝑟2𝑡𝑛; for reduced outlets; 𝑍 =  𝜋(𝑟𝑚
′ )𝑡𝑠 

𝑟 = mean cross-sectional radius; for reduced outlet, 𝑟𝑚
′ = branch mean cross-sectional radius 
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tn= nominal wall thickness 

ts= effective branch wall thickness = lesser of Tr or i.Tb 

Tb = nominal branch wall thickness 

Tr = nominal run pipe wall thickness 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal metal area 

Occasional Stress 

The stress 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind, shall meet eq. (10) of para. C 3654 (a). Wind and 
earthquake are not considered to act concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress = |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
| This pressure option can be selected in 

CAEPIPE through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

k = 1.2 for Level B 

k = 1.8 for Level C 

k = 2.4 for Level D 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake/wind, etc. = 

√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 
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Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, 
from pressure and flow transients, earthquake/wind, etc. 

A = nominal metal Area 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (7) in para. C 3653.2 (a). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from C 3680. 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per C 3653.3 (a) 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table C 3653.3 (c) 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force due to thermal load range under analysis. 

A = nominal metal area 
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Sustained + Expansion Stress 

The sum of Sustained Stress due to pressure, weight, other sustained loads and Stress range 
due to thermal expansion is calculated using eq. (8) of para. C 3653.2 (b). 

𝑆𝑇𝐸 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
+ 
𝑖𝑀𝐶

𝑍
≤ 𝑆ℎ + 𝑆𝐴 

Where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head = maximum of CAEPIPE input pressures 
P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per C 3653.3 (a) 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table C 3653.3 (c) 
Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| and term 

𝑖𝑀𝐶

𝑍
 with |

𝐹𝐶

𝐴
| +

𝑖𝑀𝐶

𝑍
 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

𝐹𝐶 = axial force due to thermal load range under analysis 

A = nominal metal area 
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Settlement Stress 

The stress range (𝑆𝑆) due to single, noncyclic displacement stress range (e.g., predicted 
settlement or uplift or movement of pipe support structures such as buildings, pipe racks, 
anchors, etc.) is calculated from eq. (9) in para. C 3653.2 (c). 

𝑆𝐸 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from C 3680. 

𝑀𝐷 = resultant bending moment due to any single noncyclic anchor movement (e.g., predicted 

building settlement)  = √(𝑀𝐷𝑥)
2 + (𝑀𝐷𝑦)

2
+ (𝑀𝐷𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

SC = basic allowable stress at room temperature (i.e., Tref in CAEPIPE)  

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SS as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝐹𝐶 = axial force due to any single noncyclic anchor movement (e.g., predicted building settlement) 

A = nominal metal area 

Hydrotest Stress 

The sum of longitudinal stress (SLT) due to test pressure and dead loads for test condition is 
calculated from eq. (10) in para. C 3657. 

𝑆𝐿𝑇 = |𝑆𝑙𝑝| +
0.75𝑖(𝑀𝐴 +𝑀𝐵)

𝑍
≤ 1.6𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝑚𝑎𝑥𝐷

4𝑡𝑛
 or 

𝑃𝑚𝑎𝑥𝑑
2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

𝑃𝑚𝑎𝑥 = Test pressure = hydrotest pressure input into CAEPIPE  

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and test fluid (excluding pressure) = 

√(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐵 = resultant bending moment due to occasional loads = 0 (as occasional loads are not to be 
considered during the test condition) 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 
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𝑆ℎ = hot allowable stress at test temperature (i.e., at Tref in CAEPIPE)  

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and test fluid (excluding pressure) 

A = nominal metal area 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated using eq. (2) in para. C 
3641.1. 

𝑃𝑎 =
2𝑆𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
S = allowable stress for the material at the design temperature (i.e., at Tdesign input into 
CAEPIPE). This value is given in the applicable tables of Annex Z I. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

𝑌 = coefficient = 0.4.  

𝑌 =
𝑑

(𝑑+𝐷𝑜)
 when Do/ta< 6 

where, d = nominal inside diameter 

Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from eq. (6) of para. C 3652. 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head = maximum of CAEPIPE input pressures 
P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus and should be computed as stated in para. C 3658 (b) and (d) 

𝑍 =  𝜋𝑟2𝑡𝑛; for reduced outlets; 𝑍 =  𝜋(𝑟𝑚
′ )𝑡𝑠 

𝑟 =mean cross-sectional radius; for reduced outlet, 𝑟𝑚
′ = branch mean cross-sectional radius 
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tn= nominal wall thickness 

ts= effective branch wall thickness = lesser of Tr or i.Tb 

Tb = nominal branch wall thickness 

Tr = nominal run pipe wall thickness 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal metal area 

Occasional Stress 

The stress 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind, shall meet eq. (10) of para. C 3654 (a). Wind and 
earthquake are not considered to act concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress = |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
| This pressure option can be selected in 

CAEPIPE through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

k = 1.2 for Level B 

k = 1.8 for Level C 

k = 2.4 for Level D 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake/wind, etc. = 

√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 
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Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, 
from pressure and flow transients, earthquake/wind, etc. 

A = nominal metal Area 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (7) in para. C 3653.2 (a). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from C 3680. 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per C 3653.3 (a) 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table C 3653.3 (c) 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force due to thermal load range under analysis. 

A = nominal metal area 
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Sustained + Expansion Stress 

The sum of Sustained Stress due to pressure, weight, other sustained loads and Stress range 
due to thermal expansion is calculated using eq. (8) of para. C 3653.2 (b). 

𝑆𝑇𝐸 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
+ 
𝑖𝑀𝐶

𝑍
≤ 𝑆ℎ + 𝑆𝐴 

Where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head = maximum of CAEPIPE input pressures 
P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per C 3653.3 (a) 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table C 3653.3 (c) 
Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| and term 

𝑖𝑀𝐶

𝑍
 with |

𝐹𝐶

𝐴
| +

𝑖𝑀𝐶

𝑍
 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

𝐹𝐶 = axial force due to thermal load range under analysis 

A = nominal metal area 
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Settlement Stress 

The stress range (𝑆𝑆) due to single, noncyclic displacement stress range (e.g., predicted 
settlement or uplift or movement of pipe support structures such as buildings, pipe racks, 
anchors, etc.) is calculated from eq. (9) in para. C 3653.2 (c). 

𝑆𝐸 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from C 3680. 

𝑀𝐷 = resultant bending moment due to any single noncyclic anchor movement (e.g., predicted 

building settlement)  = √(𝑀𝐷𝑥)
2 + (𝑀𝐷𝑦)

2
+ (𝑀𝐷𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

SC = basic allowable stress at room temperature (i.e., Tref in CAEPIPE)  

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SS as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝐹𝐶 = axial force due to any single noncyclic anchor movement (e.g., predicted building settlement) 

A = nominal metal area 

Hydrotest Stress 

The sum of longitudinal stress (SLT) due to test pressure and dead loads for test condition is 
calculated from eq. (10) in para. C 3657. 

𝑆𝐿𝑇 = |𝑆𝑙𝑝| +
0.75𝑖(𝑀𝐴 +𝑀𝐵)

𝑍
≤ 1.6𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝑚𝑎𝑥𝐷

4𝑡𝑛
 or 

𝑃𝑚𝑎𝑥𝑑
2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

𝑃𝑚𝑎𝑥 = Test pressure = hydrotest pressure input into CAEPIPE  

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and test fluid (excluding pressure) = 

√(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐵 = resultant bending moment due to occasional loads = 0 (as occasional loads are not to be 
considered during the test condition) 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 
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𝑆ℎ = hot allowable stress at test temperature (i.e., at Tref in CAEPIPE)  

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and test fluid (excluding pressure) 

A = nominal metal area 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated using eq. (2) in para. C 
3641.1. 

𝑃𝑎 =
2𝑆𝑡𝑎

(𝐷𝑜 − 2𝑌𝑡𝑎)
 

where 

𝑃𝑎 = allowable pressure 
S = allowable stress for the material at the design temperature (i.e., at Tdesign input into 
CAEPIPE). This value is given in the applicable tables of Annex Z I. 

ta= available thickness for pressure design = tn × (1 - mill tolerance/100) - corrosion 
allowance 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance in CAEPIPE) 

tn= nominal pipe thickness 

Do= nominal outside diameter of pipe 

𝑌 = coefficient = 0.4.  

𝑌 =
𝑑

(𝑑+𝐷𝑜)
 when Do/ta< 6 

where, d = nominal inside diameter 

Sustained Stress 

The stress 𝑆𝐿 due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from eq. (6) of para. C 3652. 

𝑆𝐿 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head = maximum of CAEPIPE input pressures 
P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑍 = un-corroded section modulus and should be computed as stated in para. C 3658 (b) and (d) 

𝑍 =  𝜋𝑟2𝑡𝑛; for reduced outlets; 𝑍 =  𝜋(𝑟𝑚
′ )𝑡𝑠 

𝑟 =mean cross-sectional radius; for reduced outlet, 𝑟𝑚
′ = branch mean cross-sectional radius 
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tn= nominal wall thickness 

ts= effective branch wall thickness = lesser of Tr or i.Tb 

Tb = nominal branch wall thickness 

Tr = nominal run pipe wall thickness 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

A = nominal metal area 

Occasional Stress 

The stress 𝑆𝐿𝑂, calculated as the sum of stress due to sustained loads 𝑆𝐿 and stress due to 

occasional loads 𝑆𝑂 such as earthquake or wind, shall meet eq. (10) of para. C 3654 (a). Wind and 
earthquake are not considered to act concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 + |𝑆𝑙𝑝𝑜| +
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘. 𝑆ℎ 

𝑆𝑙𝑝𝑜= peak pressure stress = |
(𝑃𝑜−𝑃)𝑑

2

𝐷2−𝑑2
|  𝑜𝑟 |

(𝑃𝑜−𝑃)𝐷

4𝑡𝑛
| This pressure option can be selected in 

CAEPIPE through Layout Window > Options > Analysis > Pressure. 

Po = peak pressure = (peak pressure factor in CAEPIPE) x P 

P = Maximum of CAEPIPE input pressures P1 through P10 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

k = 1.2 for Level B 

k = 1.8 for Level C 

k = 2.4 for Level D 

𝑀𝐵 = resultant bending moment due to occasional loads such as thrusts from pressure/safety relief 
valve loads, from pressure and flow transients, earthquake/wind, etc. = 

√(𝑀𝐵𝑥)
2 + (𝑀𝐵𝑦)

2
+ (𝑀𝐵𝑧)

2 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 
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Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝𝑜| with |𝑆𝑙𝑝𝑜 +
𝐹𝐵

𝐴
| 

where 

𝐹𝐵 = axial force due to occasional loads such as thrusts from pressure/safety relief valve loads, 
from pressure and flow transients, earthquake/wind, etc. 

A = nominal metal Area 

Expansion Stress Range 

Stress range (𝑆𝐸) due to thermal expansion is calculated using eq. (7) in para. C 3653.2 (a). 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑖 = stress intensification factor from C 3680. 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per C 3653.3 (a) 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table C 3653.3 (c) 

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SE as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝐹𝐶 = axial force due to thermal load range under analysis. 

A = nominal metal area 
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Sustained + Expansion Stress 

The sum of Sustained Stress due to pressure, weight, other sustained loads and Stress range 
due to thermal expansion is calculated using eq. (8) of para. C 3653.2 (b). 

𝑆𝑇𝐸 = |𝑆𝑙𝑝| +
0.75𝑖𝑀𝐴

𝑍
+ 
𝑖𝑀𝐶

𝑍
≤ 𝑆ℎ + 𝑆𝐴 

Where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝐷

4𝑡𝑛
 or 

𝑃𝑑2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE through 

Layout Window > Options > Analysis > Pressure. 

𝑃 = internal pressure including the effects of static head = maximum of CAEPIPE input pressures 
P1 through P10 

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and other sustained mechanical loads (excluding 

pressure) = √(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐶 = resultant bending moment due to the thermal load range under analysis = 

√(𝑀𝐶𝑥)
2 + (𝑀𝐶𝑦)

2
+ (𝑀𝐶𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

𝑆ℎ = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 through T10)] 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) as per C 3653.3 (a) 

SC = basic allowable stress at minimum metal temperature expected during the thermal stress 
range under analysis 

Sh = basic allowable stress at maximum metal temperature expected during the thermal stress 
range under analysis 

f = stress range reduction factor from Table C 3653.3 (c) 
Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| and term 

𝑖𝑀𝐶

𝑍
 with |

𝐹𝐶

𝐴
| +

𝑖𝑀𝐶

𝑍
 

where 

𝐹𝐴 = axial force due to weight and other sustained mechanical loads excluding pressure 

𝐹𝐶 = axial force due to thermal load range under analysis 

A = nominal metal area 
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Settlement Stress 

The stress range (𝑆𝑆) due to single, noncyclic displacement stress range (e.g., predicted 
settlement or uplift or movement of pipe support structures such as buildings, pipe racks, 
anchors, etc.) is calculated from eq. (9) in para. C 3653.2 (c). 

𝑆𝐸 =
𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝑖 = stress intensification factor from C 3680. 

𝑀𝐷 = resultant bending moment due to any single noncyclic anchor movement (e.g., predicted 

building settlement)  = √(𝑀𝐷𝑥)
2 + (𝑀𝐷𝑦)

2
+ (𝑀𝐷𝑧)

2 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 

SC = basic allowable stress at room temperature (i.e., Tref in CAEPIPE)  

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE 
will compute SS as given below. 

𝑆𝐸 = |
𝐹𝐶
𝐴
| +

𝑖𝑀𝐷
𝑍

≤ 3𝑆𝐶 

where 

𝐹𝐶 = axial force due to any single noncyclic anchor movement (e.g., predicted building settlement) 

A = nominal metal area 

Hydrotest Stress 

The sum of longitudinal stress (SLT) due to test pressure and dead loads for test condition is 
calculated from eq. (10) in para. C 3657. 

𝑆𝐿𝑇 = |𝑆𝑙𝑝| +
0.75𝑖(𝑀𝐴 +𝑀𝐵)

𝑍
≤ 1.6𝑆ℎ 

where 

𝑆𝑙𝑝 = pressure stress = 
𝑃𝑚𝑎𝑥𝐷

4𝑡𝑛
 or 

𝑃𝑚𝑎𝑥𝑑
2

𝐷2−𝑑2
. This pressure option can be selected in CAEPIPE 

through Layout Window > Options > Analysis > Pressure. 

𝑃𝑚𝑎𝑥 = Test pressure = hydrotest pressure input into CAEPIPE  

𝐷 = nominal outside diameter 
d = nominal inside diameter  

𝑖 = stress intensification factor from C 3680 and 0.75i shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to weight and test fluid (excluding pressure) = 

√(𝑀𝐴𝑥)
2 + (𝑀𝐴𝑦)

2
+ (𝑀𝐴𝑧)

2 

𝑀𝐵 = resultant bending moment due to occasional loads = 0 (as occasional loads are not to be 
considered during the test condition) 

𝑍 = un-corroded section modulus as defined above (see write-up for “Sustained Stress”) 
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𝑆ℎ = hot allowable stress at test temperature (i.e., at Tref in CAEPIPE)  

Note: 

When the option “Include axial force in stress calculations” is turned ON, then CAEPIPE will 

replace the term |𝑆𝑙𝑝| with |𝑆𝑙𝑝 +
𝐹𝐴

𝐴
| 

where 

𝐹𝐴 = axial force due to weight and test fluid (excluding pressure) 

A = nominal metal area 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 2 of C 
3641.1. 

𝑃 =
2𝑆𝐸𝑡𝑚
𝐷 − 2𝑌𝑡𝑚

 

where 

𝑃 = allowable pressure 

𝑆 = allowable stress 

𝐸 = joint factor (input as material property) 

𝑡𝑚 = minimum required thickness, including mechanical and corrosion allowance 

 = 𝑡 ×(1 – mill tolerance/100) – corrosion allowance 

𝑡 = nominal pipe thickness 

𝐷 = outside diameter 

𝑑 = inside diameter 

𝑌 = pressure coefficient 

 = 0.4 for 𝑡 < 𝐷/6 

 = 𝑑/(𝐷 + 𝑑) for 𝑡 ≥ 𝐷/6 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 6 of C 3652. 

𝑆𝐿 =
𝑃𝐷

4𝑡
+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑃 = maximum pressure 

𝐷 = outside diameter 

𝑡 = nominal wall thickness 

𝑖 = stress intensification factor. The product 0.75𝑖, shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus, for reduced outlets, effective section modulus 

𝑆ℎ = hot allowable stress 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasional loads (𝑆𝑂), such as earthquake or wind from Equation 10 of C 3654. Wind and 
earthquake are not considered concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 +
0.75𝑖𝑀𝐵

𝑍
≤ 1.2𝑆ℎ 

where 

𝑀𝐵 = resultant moment due to occasional loads 
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Expansion Stress 

The stress (SE) due to thermal expansion is calculated from Equation 7 of C 3653.2. 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑀𝐶 = resultant moment due to thermal expansion 

𝑆𝐴 = 𝑓(1.25𝑆𝑐 + 0.25𝑆ℎ) 
𝑆𝑐 = allowable stress at cold temperature 

𝑓 = stress range reduction factor from Table C 3653.3 
The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 8 of C 3653.2. 

𝑆𝑇𝐸 = 𝑆𝐿 + 𝑆𝐸 ≤ 𝑆ℎ + 𝑆𝐴 
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Allowable Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (C2.2.2-2) for 
straight pipes and Eq. (C2.3.2-1) for bends from paras. C2.2.2. and C2.3.2.respectively 

𝑃 =
2𝑓𝑧𝑒

𝐷 − 𝑒
 

where 

𝑃 = allowable pressure 

𝑓 = allowable stress 

𝑧 = joint factor (input as material property in CAEPIPE) 

e = nominal pipe thickness× (1 – mill tolerance/100) – corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. shouldbe 
included in corrosion allowance in CAEPIPE) 

𝐷 = outside diameter 

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall 

thickness 𝑒𝑒𝑞𝑢𝑖 
 

𝑒𝑒𝑞𝑢𝑖  = 
𝑒

𝑡𝑓
 

where 

𝑡𝑓 = [
𝑅/𝐷𝑜 − 0.25

𝑅/𝐷𝑜 − 0.50
] 

For closely spaced miter bends, the allowable pressure is calculated from 

𝑃 = min [(
2𝑓𝑧𝑒

𝐷𝑚
.

𝑒

𝑒 + 0.643 tan𝜃√0.5𝐷𝑚𝑒
) , (

2𝑓𝑧𝑒

𝐷𝑚
.
𝑅 − 0.5𝐷𝑚
𝑅 − 0.25𝐷𝑚

)]  with 𝜃 ≤ 22.5 

For widely spaced miter bends, the allowable pressure is calculated from 

𝑃 = min [(
2𝑓𝑧𝑒

𝐷𝑚
.

𝑒

𝑒 + 0.643 tan 𝜃√0.5𝐷𝑚𝑒
) , (

2𝑓𝑧𝑒

𝐷𝑚
.
𝑅 − 0.5𝐷𝑚
𝑅 − 0.25𝐷𝑚

)]with 𝜃 ≤ 22.5 

𝑃 = (
2𝑓𝑧𝑒

𝐷𝑚
.

𝑒

𝑒 + 1.25 tan 𝜃√0.5𝐷𝑚𝑒
)  with 𝜃 ≤ 22.5 

where 

𝐷𝑚 = mean diameter of pipe = D-tn 

𝑅 = effective bend radius of the miter 

𝜃 = miter half angle 

𝑡𝑛 = nominal thickness 
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Sustained Stress 

The stress (𝜎1) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eq. (C10.3.2) from para. C10.3.2. 

𝜎1 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑓ℎ 

Where  

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷𝑜 = outside diameter 

𝑒 = nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c” 

𝑖 = stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be 
less than 1.0 

𝑀𝐴 = resulting bending moment due to sustained loads 

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 
 section modulus 

𝑓ℎ = hot allowable stress 

Sustained plus Occasional Stress 

The stress (𝜎2) due to sustained and occasional loads is calculated as the sum of stress due 
to sustained loads such as due to pressure, weight and other sustained mechanical loads and 
stress due to occasional loads such as earthquake or wind. Wind and earthquake are not 
considered concurrently (see para. C10.3.3) 

𝜎2 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘𝑓ℎ 

where, 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷𝑜 = outside diameter 

𝑀𝐵 = resultant bending moment due to occasional load 

𝑘 = 1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 
 CAEPIPE k =1.2 is used for occasional loading. 

𝑒 = nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c” 

Expansion Stress 

The stress (𝜎3) due to thermal expansion is calculated from Eq. C10.3.4-1from para. 
C10.3.4. 

𝜎3 =
𝑖𝑀𝐶

𝑍
+≤ 𝑓𝑎 

where, 
 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 
inclusive of thermal anchor movements  



CODETI (2013) 
 

574 
 

 

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 
 section modulus 

𝑓𝑎 = 𝑈(1.25𝑓𝐶 + 0.25𝑓ℎ)
𝐸ℎ

𝐸𝑐
 Eq. (C10.2.4.2-1) of para. C10.2.4.2. 

𝑖 = stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be 
less than 1.0 

𝑈 = cyclic stress range reduction factor from Table C10.2.4.3 and are mentioned below. 

Number of cycle Stress range reduction factor 𝑈 

𝑓𝑎 <= 7000  1.0 

7001 to 140000 0.9 

14001 to 220000 0.8 
22001 to 0.7 0.7 
45001 to 100000 0.6 
100001 to 2000000 0.5 

 
𝑓𝐶 = basic allowable stress as minimum metal temperature expected during the 

 displacement cycle under analysis 
𝑓ℎ = basic allowable stress as maximum metal temperature expected during the 

 displacement cycle under analysis 
𝐸𝐶 = elastic modulus at cold temperature 
𝐸ℎ = elastic modulus at hot temperature  
 
Sustained + Expansion Stress 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation C10.3.4-2 of para. C10.3.4. 

𝜎4 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶

𝑍
≤ 𝑓𝐻 + 𝑓𝑎 

where, 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷𝑜 = outside diameter 

𝑒 = nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c” 

𝑀𝐴 = resulting bending moment due to sustained loads 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 
inclusive of thermal anchor movements  

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 
 section modulus 

𝑖 = stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be 
less than 1.0 

𝑓𝑎 = 𝑈(1.25𝑓𝐶 + 0.25𝑓ℎ)
𝐸ℎ

𝐸𝑐
 Eq. (C10.2.4.2-1) of para. C10.2.4.2. 

𝑓𝐶 = basic allowable stress as minimum metal temperature expected during the 
 displacement cycle under analysis 

𝑓ℎ = basic allowable stress as maximum metal temperature expected during the 
 displacement cycle under analysis 

𝐸𝐶 = elastic modulus at cold temperature  
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𝐸ℎ = elastic modulus at hot temperature 
𝑓𝐻 = allowable stress at Maximum of CAEPIPE input temperatures T1 through T10 
 

Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎5), due to sustained, thermal and 
alternating loadings shall satisfy the Eq. C10.3.4-3 of para. C10.3.4. 

𝜎5 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐶

3𝑍
≤ 𝑓𝑐𝑟 

where, 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷𝑜 = outside diameter 

𝑒 = nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c” 

𝑀𝐴 = resulting bending moment due to sustained loads 

𝑀𝐶  = range of resultant moments due to displacement cycle between two thermal states 
inclusive of thermal anchor movements  

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 
 section modulus 

𝑖 = stress intensification factor from Table C10.2.6-1; the product of 0.75i shall not be 
less than 1.0 

𝑓𝑐𝑟 =  allowable creep stress value 
  



CODETI (2013) 
 

576 
 

 

 

  



CODETI (2013) 
 

577 
 

 

 
  



CODETI (2013) 
 

578 
 

 

 
  



CODETI (2013) 
 

579 
 

 

 
  



CODETI (2013) 
 

580 
 

 

 
  



CODETI (2013) 
 

581 
 

 

 
  



CODETI (2013) 
 

582 
 

 

 
  



CODETI (2013) 
 

583 
 

 

 
  



CODETI (2013) 
 

584 
 

 



CODETI (2013) 
 

585 
 

 

  



CODETI (2006)  
[Superseded by CODETI (2013)] 

 

586 
 

 

Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from 

𝑃 =
2𝑓𝑧𝑒

𝐷 − 𝑒
 

where 

𝑃 = allowable pressure 

𝑓 = allowable stress 

𝑧 = joint factor (input as material property in CAEPIPE) 

e = nominal pipe thickness× (1 – mill tolerance/100) – corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. shouldbe 
included in corrosion allowance in CAEPIPE) 

𝐷=outside diameter 

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall 

thickness𝑒𝑒𝑞𝑢𝑖 
 

𝑒𝑒𝑞𝑢𝑖  = 
𝑒

𝑡𝑓
 

Where 

𝑡𝑓 = [
𝑅/𝐷 − 0.25

𝑅/𝐷 − 0.50
] 

For closely spaced miter bends, the allowable pressure is calculated from 

𝑃 = min [(
2𝑓𝑧𝑒

𝐷𝑚
.

𝑒

𝑒 + 0.643 tan𝜃√0.5𝐷𝑚𝑒
) , (

2𝑓𝑧𝑒

𝐷𝑚
.
𝑅 − 0.5𝐷𝑚
𝑅 − 0.25𝐷𝑚

)]  with 𝜃 ≤ 22.5 

For widely spaced miter bends, the allowable pressure is calculated from 

𝑃 = min [(
2𝑓𝑧𝑒

𝐷𝑚
.

𝑒

𝑒 + 0.643 tan 𝜃√0.5𝐷𝑚𝑒
) , (

2𝑓𝑧𝑒

𝐷𝑚
.
𝑅 − 0.5𝐷𝑚
𝑅 − 0.25𝐷𝑚

)]with 𝜃 ≤ 22.5 

𝑃 = (
2𝑓𝑧𝑒

𝐷𝑚
.

𝑒

𝑒 + 1.25 tan 𝜃√0.5𝐷𝑚𝑒
)  with 𝜃 ≤ 22.5 

Where 

𝐷𝑚 = mean diameter of pipe = D-tn 

𝑅 = effective bend radius of the miter 

𝜃 = miter half angle 

𝑡𝑛 = nominal thickness 
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Sustained Stress 

The stress (𝜎1) due to sustained loads (pressure, weight and other sustained mechanical 
loads) iscalculated from 

𝜎1 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑓ℎ 

Where  

𝑃 = maximum of CAEPIPE input pressures P1, P2 and P3 

𝐷𝑜 = outside diameter 

𝑒 = nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c” 

𝑖 = stress intensification factor; the product of 0.75i shall not be less than 1.0 

𝑀𝐴 = resulting bending moment due to sustained loads 

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 
 section modulus 

𝑓ℎ = hot allowable stress 

Sustained plus Occasional Stress 

The stress (𝜎2) due to sustained and occasional loads is calculated as the sum of stress due 
to sustained loads such as due to pressure, weight and other sustained mechanical loads and 
stress due to occasional loads such as earthquake or wind. Wind and earthquake are not 
considered concurrently 

𝜎2 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐵

𝑍
≤ 𝑘𝑓ℎ 

𝑀𝐵 = resultant bending moment due to occasional load 

𝑘 = 1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 
 CAEPIPE k =1.2 is used for occasional loading. 

Expansion Stress 

The stress (𝜎3) due to thermal expansion is calculated from 

𝜎3 =
𝑖𝑀𝐶

𝑍
+≤ 𝑓𝑎 

 

𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 
 section modulus 

𝑓𝑎 = 𝑈(1.25𝑓𝐶 + 0.25𝑓ℎ)
𝐸ℎ

𝐸𝑐
 

𝑈 = cyclic stress range reduction factor as mentioned below 
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Number of cycle Stress range reduction factor 𝑈 

𝑓𝑎 <= 7000  1.0 

7001 to 140000 0.9 

14001 to 220000 0.8 
22001 to 0.7 0.7 
45001 to 100000 0.6 
100001 to 2000000 0.5 

 

𝑓𝐶  = allowable stress at cold temperature 

𝑓𝐶  =  allowable stress at hot temperature 

𝐸𝐶 = elastic modulus at cold temperature 

𝐸ℎ = elastic modulus at hot temperature 

𝜎4 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
𝑖𝑀𝐶

𝑍
≤ 𝑓ℎ + 𝑓𝑎 

Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎5), due to sustained, thermal and 
alternating loadings shall satisfy the equation below. 

𝜎5 =
𝑃𝐷𝑜
4𝑒

+
0.75𝑖𝑀𝐴

𝑍
+
0.75𝑖𝑀𝐶

3𝑍
≤ 𝑓𝑐𝑟 

Where 

𝑓𝑐𝑟 =  allowable creep stress value 
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Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from 

𝑆𝐿 =
𝑃(𝐷 − 𝑡)

4𝑡
+
0.75𝑖𝑀𝐴

𝑍
≤ 𝑆ℎ 

where 

𝑃 = maximum pressure 

𝐷 = outside diameter 

𝑡 = nominal wall thickness 

𝑖 = stress intensification factor. The product 0.75𝑖, shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to sustained loads = √𝑀𝑋
2 +𝑀𝑌

2 +𝑀𝑍
2 

𝑍 = section modulus, for reduced outlets, effective section modulus 

𝑆ℎ = hot allowable stress: smaller of: 
  0.67 yield stress at temperature 
  0.44 tensile strength at 20º C 
  0.67 rupture stress (after 100,000 hours at temperature) 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝐿) and stress due 

to occasionalloads (𝑆𝑂),such as earthquake or wind. Wind and earthquake are not considered 
concurrently. 

𝑆𝐿𝑂 = 𝑆𝐿 +
0.75𝑖𝑀𝐵

𝑍
≤ 1.2𝑆ℎ 

where 

𝑀𝐵 = resultant moment due to occasional loads 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from 

𝑆𝐸 =
𝑖𝑀𝐶
𝑍

≤ 𝑆𝐴 

where 

𝑀𝐶 = resultant moment due to thermal expansion  

𝑆𝐴 = smaller of: 

  𝐶𝑓 (0.8 yield strength at 20º C + 0.13 hot yield strength) 

  𝐶𝑓 (0.8 yield strength at 20º C + 0.2 x 0.67 rupture stress) 

𝐶𝑓 = stress range reduction factor 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 6.3. 

𝑝 =
2𝜎𝑡𝑛𝑧𝐿𝑠𝑒𝑓𝑓

𝐷𝑦𝑚− 𝑠𝑒𝑓𝑓
 

where 

𝑝 = allowable pressure 

𝜎𝑡𝑛 = allowable stress 

𝑧𝐿 = joint efficiency of longitudinal weld (input as material property) 

𝑠𝑒𝑓𝑓= nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 

𝐷𝑦 = outside diameter 

𝐷𝑖 = inside diameter= 𝐷𝑦 − 𝑠𝑒𝑓𝑓 

𝑚 = pressure coefficient 

 = 1.0 for 𝐷𝑦/𝐷𝑖<1.6 

 = 0.25(𝐷𝑦/𝐷𝑖)+0.6 for 1.6≤𝐷𝑦/𝐷𝑖≤2.0 

Sustained Stress 

Stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from Equation 9.37. 

𝑆𝐿 =
𝑝𝑚𝑎𝑥𝐷𝑦

4𝑠𝑒𝑓𝑓𝑧𝐶
+
0.75𝑘1𝑀𝐴

𝑊𝑦
≤ 𝜎𝑡𝑛2 

 

where 

𝑝𝑚𝑎𝑥 = maximum pressure 

𝑧𝐶 = joint efficiency of circumferential weld (input as material property) 

𝑘1 = stress intensification factor. The product 0.75𝑘1shall not be less than 1.0 

𝑀𝐴 = resultant bending moment due to sustained loads 

𝑊𝑦 = section modulus, for reduced outlets, effective section modulus 

𝜎𝑡𝑛2 = hot allowable stress 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of the stress due to sustained loads (𝑆𝐿) and the 

stress (𝑆𝑂) due to occasional loads such as earthquake or wind from Equation 9.38. Wind 
and earthquake are not considered concurrently. 

𝑆𝐿𝑂 =
𝑝𝑚𝑎𝑥𝐷𝑦

4𝑠𝑒𝑓𝑓𝑧𝐶
+
0.75𝑘1(𝑀𝐴 +𝑀𝐵)

𝑊𝑦
≤ 1.2𝜎𝑡𝑛2 

where 

𝑀𝐵 = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from Equation 9.39. 

𝑆𝐸 =
𝑘1𝑀𝐶
𝑊𝑦

≤ 𝑆𝑟 

where 

𝑀𝐶 = resultant bending moment due to thermal expansion 

𝑆𝑟 = 𝑓(1.17𝜎1 + 0.17𝜎2) from Equation 9.43 

𝑓 = stress range reduction factor taken from Table 9.1 

𝜎1 = smaller of 𝜎𝑡𝑛1 and 0.267𝑅𝑚 

𝜎2 = smaller of 𝜎𝑡𝑛2 and 0.367𝑅𝑚 

𝜎𝑡𝑛1= allowable stress at cold condition 

𝜎𝑡𝑛2= allowable stress at hot condition 

𝑅𝑚 = tensile strength at room temperature 
At moderate temperatures (up to 370º C) for carbon steel, low alloy steel and chromium steel 
(specified as CS material type) and up to 425º C for austenitic stainless steel (specified as AS 

material type), the limits 0.267𝑅𝑚 and 0.367𝑅𝑚 are disregarded and 𝑆𝑟 is selected as smaller 

of 𝑆𝑟
′and 𝑆𝑟

′′, 

where 

𝑆𝑟
′  = 1.17𝜎𝑡𝑛1 + 0.20𝜎𝑡𝑛2 

𝑆𝑟
′′ = 290𝑓 − 𝜎𝑡𝑛2 
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Allowable Pressure 

The allowable pressure is calculated from 5.3.2.1. 

𝑃 = 2𝑆𝑡𝐹𝐿𝐽𝑇/D 

where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength 

𝑡 = minimum wall thickness 

 = nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance 

𝐹 = design factor = 0.8 for steel pipe (from 5.2.3) 

𝐿 = location factor (from Table 5.1) 

𝐽 = joint factor (from Table 5.2), input as material property 

𝑇 = temperature derating factor for steel pipe (from Table 5.3) 

𝐷 = outside diameter 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) and wind loads, is calculated from (5.6.3.5) 

𝑆𝐿 =
𝑃𝐷

4𝑡
+ 𝑖

𝑀

𝑍
≤ 𝑆𝐹𝐿𝐽𝑇 

 

where 

𝑃 = maximum pressure 

𝐷 = outside diameter 

𝑡 = minimum wall thickness 

𝑖 = stress intensification factor 

𝑀 = resultant bending moment due to sustained loads 

𝑍 = corroded section modulus 

𝑆 = specified minimum yield strength 

𝐹 = design factor 

𝐿 = location factor 

𝐽 = joint factor 

𝑇 = temperature derating factor 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained and wind loads (𝑆𝐿) and 

stress due to occasional loads (𝑆𝑂), such as earthquake. The allowable stress for occasional 
stress is not given in the code, therefore it is conservatively taken the same as the sustained 
stress allowable. 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑖
𝑀

𝑍
≤ 𝑆𝐹𝐿𝐽𝑇 

where 
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𝑀 = resultant bending moment due to occasional loads 

Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from (5.6.3.3). 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 0.72𝑆𝑇 

where 

𝑆𝑏 = resultant bending stress= 𝑖𝑀𝑏/Z 

𝑆𝑡 = torsional stress  = 𝑀𝑡/2Z 

𝑀𝑏 = resultant bending moment due to expansion loads 

𝑀𝑡 = torsional moment due to expansion loads 

Z = un-corroded section modulus 
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Allowable Pressure 

The allowable pressure is calculated from 5.4.2.1. 

𝑃 = 2𝑆𝑡𝐹𝐿𝐽𝑇/D 

where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength 

𝑡 = minimum wall thickness 

 = nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance 

𝐹 = design factor = 0.8 for steel pipe (from 5.2.3) 

𝐿 = location factor (from Table 5.1) 

𝐽 = joint factor (from Table 5.2), input as material property 

𝑇 = temperature derating factor for steel pipe (from Table 5.3) 

𝐷 = outside diameter 

Sustained Stress 

The stress (𝑆𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) and wind loads, is calculated from (5.19.3.5) 

𝑆𝐿 =
𝑃𝐷

4𝑡
+ 𝑖

𝑀

𝑍
≤ 𝑆𝐹𝐿𝐽𝑇 

where 

𝑃 = maximum pressure 

𝐷 = outside diameter 

𝑡 = minimum wall thickness 

𝑖 = stress intensification factor 

𝑀 = resultant bending moment due to sustained loads 

𝑍 = corroded section modulus 

𝑆 = specified minimum yield strength 

𝐹 = design factor 

𝐿 = location factor 

𝐽 = joint factor 

𝑇 = temperature derating factor 

Occasional Stress 

The stress (𝑆𝐿𝑂) is calculated as the sum of stress due to sustained and wind loads (𝑆𝐿) and 

stress due to occasional loads (𝑆𝑂), such as earthquake. The allowable stress for occasional 
stress is not given in the code, therefore it is conservatively taken the same as the sustained 
stress allowable. 

𝑆𝐿𝑂 = 𝑆𝐿 + 𝑖
𝑀

𝑍
≤ 𝑆𝐹𝐿𝐽𝑇 

where 

𝑀 = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝐸) due to thermal expansion is calculated from (5.6.3.3). 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 0.72𝑆𝑇 

where 

𝑆𝑏 = resultant bending stress= 𝑖𝑀𝑏/Z 

𝑆𝑡 = torsional stress  = 𝑀𝑡/2Z 

𝑀𝑏 = resultant bending moment due to expansion loads 

𝑀𝑡 = torsional moment due to expansion loads 

Z = un-corroded section modulus 
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Allowable Pressure 

For straight pipe, the allowable pressure for a given wall thickness shall be determined by the 
following formula from Clause 4.3.5.1. 

𝑃 = 𝐹𝐿𝐽𝑇 (
2𝑆𝑡

𝐷
) 

where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength, input as material property in CAEPIPE  

𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) − 
corrosion allowance (see Note below) 

𝐹 = design factor = 0.8 as per Clause 4.3.6. 

𝐿 = location factor (from Table 4.2), input into CAEPIPE analysis option 

𝐽 = joint factor (from Table 4.3), input as material property in CAEPIPE 

𝑇 = temperature factor for steel pipe (from Table 4.4), determined based on Design 
Temperature input into CAEPIPE 

𝐷 = outside diameter 

Note: 

Corrosion allowance input into CAEPIPE should include corrosion/erosion allowance and 
allowance for grooving and threading. 

Sustained + Occasional Stress (Unrestrained Piping = Un-buried Piping) 

The sum of longitudinal pressure stress and the total bending stress due to sustained force 
(pressure, weight and other sustained mechanical loads) and occasional loads (such as wind, 
seismic, etc.) shall be limited in accordance with the following formula from Clause 4.8.5. 

0.5𝑆ℎ + 𝑠𝐵 ≤ 𝑆𝐹𝐿𝑇 

where 

𝑆ℎ = hoop stress due to pressure P, as computed using formula given in Clause 4.6.5 = 
𝑃𝐷

2𝑡
 

𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads 

= 
𝑖𝑀𝐵

𝑍𝐶
 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter of pipe 

𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) − 
corrosion allowance (see Note above for corrosion allowance) 

𝑖 = stress intensification factor (from Table 4.8) 

𝑀𝐵 = resultant bending moment due to sustained and occasional loads 

𝑍𝐶  = corroded section modulus computed using corroded wall thickness = Nominal wall 
thickness – corrosion allowance, in which mill tolerance is not deducted. 

𝑆 = specified minimum yield strength 

𝐹 = design factor = 0.8 as per Clause 4.3.6 
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𝐿 = location factor (from Table 4.2) 

𝑇 = temperature factor for steel pipe (from Table 4.4) determined based on Maximum 
Temperature input into CAEPIPE (T1 through T10) 

Expansion Stress (Unrestrained Piping = Un-buried Piping) 

The thermal expansion stress range (𝑆𝐸) for those portions of pipeline systems shall be 
limited in accordance with the formulae given in Clauses 4.8.3 and 4.8.4. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 0.72𝑆𝑇 

where 

𝑆𝑏 = resultant bending stress= 𝑖𝑀𝑏/Z 

𝑆𝑡 = torsional stress = 𝑀𝑡/(2Z) 
𝑀𝑏 = resultant bending moment due to expansion loads 

𝑀𝑡 = torsional moment due to expansion loads 

𝑍 = un-corroded section modulus 

𝑖 = stress intensification factor (from Table 4.8) 

𝑆 = specified minimum yield strength 

𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.  

𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓) (see Note 3 below) 

 
Combined Stress (Restrained Piping = Buried Piping) 

For those portions of restrained pipelines, the combined stress shall be limited in accordance 
with the formula given in Clause 4.7.2.1. 

𝑆ℎ − 𝑆𝐿 + 𝑠𝐵 ≤ 𝑆𝑇 

where 

𝑆ℎ = hoop stress due to pressure P, as determined using formula given in Clause 4.6.5 = 
𝑃𝐷

2𝑡
 

𝑆𝐿 = longitudinal compressive stress as determined using the formula given in Clause 4.7.1  

     = 𝑆𝐿 = 𝜗𝑆ℎ − 𝐸𝑐𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓) (see Notes below) 

𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads 

= 
𝑖𝑀𝐵

𝑍𝐶
  

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter of pipe 

𝑡 = minimum wall thickness 

  = nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance (see Note 
above) 

𝑖 = stress intensification factor (from Table 4.8) 

𝑀𝐵 = resultant bending moment due to sustained and occasional loads 

𝑍𝐶  = corroded section modulus computed using corroded wall thickness = Nominal wall 
thickness – corrosion allowance, in which mill tolerance is not deducted. 
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𝜗 = Poisson’s ratio, input as material property in CAEPIPE 

𝑇𝑜𝑝𝑟 = operating temperature under consideration. See Note 2 below.  

𝑇𝑟𝑒𝑓 = ambient temperature at the time of restraint = Reference temperature in CAEPIPE 

𝐸𝑐 = modulus of elasticity of steel at 𝑇𝑟𝑒𝑓 

𝛼 = coefficient of thermal expansion at 𝑇𝑜𝑝𝑟 defined above 

𝑆 = specified minimum yield strength 

𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.  

𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓) (see Note 3 below) 

 
Note:  

1. Evaluation as per Clause 4.7.2.1 (listed above) for Restrained Piping shall be 
performed in CAEPIPE only when the value of SL computed as listed above is 
negative (compressive). 

2. If there are more than one thermal load defined in CAEPIPE, for example T1 and 
T2, then CAEPIPE calculates longitudinal stress (SL) due to  

Thermal expansion range from 𝑇𝑟𝑒𝑓 to T1 as 

𝐸𝑐𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓) =  𝐸𝑐𝛼𝑇1(𝑇1 − 𝑇𝑟𝑒𝑓) 

Thermal expansion range from 𝑇𝑟𝑒𝑓 to T2 as 

𝐸𝑐𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓) =  𝐸𝑐𝛼𝑇2(𝑇2 − 𝑇𝑟𝑒𝑓) 

Thermal expansion range from T1 to T2 as 

𝐸𝑐𝛼(𝑇𝑛 − 𝑇𝑚) =  𝐸𝑐𝛼𝑛(𝑇𝑛 − 𝑇𝑟𝑒𝑓) − 𝐸𝑐𝛼𝑚(𝑇𝑚 − 𝑇𝑟𝑒𝑓), where n = 1 and m = 2 

3. If there are more than one thermal load defined in CAEPIPE, for example T1 and 
T2, then CAEPIPE determines Temperature factor (T) as given below. 

Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇1 as maximum(𝑇1, 𝑇𝑟𝑒𝑓) 

Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇2 as maximum(𝑇2, 𝑇𝑟𝑒𝑓) 

Thermal expansion range from 𝑻𝟏 to 𝑻𝟐 as maximum(𝑻𝟏, 𝑻𝟐) 
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Allowable Pressure 

For straight pipe, the allowable pressure for a given wall thickness shall be determined by the 
following formula from Clause 4.3.5.1. 

𝑃 = 𝐹𝐿𝐽𝑇 (
2𝑆𝑡

𝐷
) 

where 

𝑃 = allowable pressure 

𝑆 = specified minimum yield strength, input as material property in CAEPIPE  

𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) − 
corrosion allowance (see Note below) 

𝐹 = design factor = 0.8 as per Clause 4.3.6. 

𝐿 = location factor (from Table 4.2), input into CAEPIPE analysis option 

𝐽 = joint factor (from Table 4.3), input as material property in CAEPIPE 

𝑇 = temperature factor for steel pipe (from Table 4.4), determined based on Design 
Temperature input into CAEPIPE 

𝐷 = outside diameter 

Note: 

Corrosion allowance input into CAEPIPE should include corrosion/erosion allowance and 
allowance for grooving and threading. 

Sustained + Occasional Stress (Unrestrained Piping = Un-buried Piping) 

The sum of longitudinal pressure stress and the total bending stress due to sustained force 
(pressure, weight and other sustained mechanical loads) and occasional loads (such as wind, 
seismic, etc.) shall be limited in accordance with the following formula from Clause 4.8.5. 

0.5𝑆ℎ + 𝑠𝐵 ≤ 𝑆𝐹𝐿𝑇 

where 

𝑆ℎ = hoop stress due to pressure P, as computed using formula given in Clause 4.6.5 = 
𝑃𝐷

2𝑡
 

𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads 

= 
𝑖𝑀𝐵

𝑍𝐶
 

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter of pipe 

𝑡 = minimum wall thickness = nominal wall thickness × (1 − mill tolerance/100) − 
corrosion allowance (see Note above for corrosion allowance) 

𝑖 = stress intensification factor (from Table 4.8) 

𝑀𝐵 = resultant bending moment due to sustained and occasional loads 

𝑍𝐶  = corroded section modulus computed using corroded wall thickness = Nominal wall 
thickness – corrosion allowance, in which mill tolerance is not deducted. 

𝑆 = specified minimum yield strength 



Oil and gas pipeline systems 
CSA Z662 (2015) 

[superseded by CSA Z662 (2019)] 

 

618 
 

 

𝐹 = design factor = 0.8 as per Clause 4.3.6 

𝐿 = location factor (from Table 4.2) 

𝑇 = temperature factor for steel pipe (from Table 4.4) determined based on Maximum 
Temperature input into CAEPIPE (T1 through T10) 

Expansion Stress (Unrestrained Piping = Un-buried Piping) 

The thermal expansion stress range (𝑆𝐸) for those portions of pipeline systems shall be 
limited in accordance with the formulae given in Clauses 4.8.3 and 4.8.4. 

𝑆𝐸 = √𝑆𝑏
2 + 4𝑆𝑡

2 ≤ 0.72𝑆𝑇 

where 

𝑆𝑏 = resultant bending stress= 𝑖𝑀𝑏/Z 

𝑆𝑡 = torsional stress = 𝑀𝑡/(2Z) 
𝑀𝑏 = resultant bending moment due to expansion loads 

𝑀𝑡 = torsional moment due to expansion loads 

𝑍 = un-corroded section modulus 

𝑖 = stress intensification factor (from Table 4.8) 

𝑆 = specified minimum yield strength 

𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.  

𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓) (see Note 3 below) 

 
Combined Stress (Restrained Piping = Buried Piping) 

For those portions of restrained pipelines, the combined stress shall be limited in accordance 
with the formula given in Clause 4.7.2.1. 

𝑆ℎ − 𝑆𝐿 + 𝑠𝐵 ≤ 𝑆𝑇 

where 

𝑆ℎ = hoop stress due to pressure P, as determined using formula given in Clause 4.6.5 = 
𝑃𝐷

2𝑡
 

𝑆𝐿 = longitudinal compressive stress as determined using the formula given in Clause 4.7.1  

     = 𝑆𝐿 = 𝜗𝑆ℎ − 𝐸𝑐𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓) (see Notes below) 

𝑆𝐵 = absolute value of beam bending stresses resulting from sustained and occasional loads 

= 
𝑖𝑀𝐵

𝑍𝐶
  

𝑃 = maximum of CAEPIPE input pressures P1 through P10 

𝐷 = outside diameter of pipe 

𝑡 = minimum wall thickness 

  = nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance (see Note 
above) 

𝑖 = stress intensification factor (from Table 4.8) 

𝑀𝐵 = resultant bending moment due to sustained and occasional loads 
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𝑍𝐶  = corroded section modulus computed using corroded wall thickness = Nominal wall 
thickness – corrosion allowance, in which mill tolerance is not deducted. 

𝜗 = Poisson’s ratio, input as material property in CAEPIPE 

𝑇𝑜𝑝𝑟 = operating temperature under consideration. See Note 2 below.  

𝑇𝑟𝑒𝑓 = ambient temperature at the time of restraint = Reference temperature in CAEPIPE 

𝐸𝑐 = modulus of elasticity of steel at 𝑇𝑟𝑒𝑓 

𝛼 = coefficient of thermal expansion at 𝑇𝑜𝑝𝑟 defined above 

𝑆 = specified minimum yield strength 

𝑇 = temperature factor for steel pipe (from Table 4.4), determined at Thot.  

𝑇ℎ𝑜𝑡 = maximum(𝑇𝑜𝑝𝑟 , 𝑇𝑟𝑒𝑓) (see Note 3 below) 

 
Note:  

1. Evaluation as per Clause 4.7.2.1 (listed above) for Restrained Piping shall be 
performed in CAEPIPE only when the value of SL computed as listed above is 
negative (compressive). 

2. If there are more than one thermal load defined in CAEPIPE, for example T1 and 
T2, then CAEPIPE calculates longitudinal stress (SL) due to  

Thermal expansion range from 𝑇𝑟𝑒𝑓 to T1 as 

𝐸𝑐𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓) =  𝐸𝑐𝛼𝑇1(𝑇1 − 𝑇𝑟𝑒𝑓) 

Thermal expansion range from 𝑇𝑟𝑒𝑓 to T2 as 

𝐸𝑐𝛼(𝑇𝑜𝑝𝑟 − 𝑇𝑟𝑒𝑓) =  𝐸𝑐𝛼𝑇2(𝑇2 − 𝑇𝑟𝑒𝑓) 

Thermal expansion range from T1 to T2 as 

𝐸𝑐𝛼(𝑇𝑛 − 𝑇𝑚) =  𝐸𝑐𝛼𝑛(𝑇𝑛 − 𝑇𝑟𝑒𝑓) − 𝐸𝑐𝛼𝑚(𝑇𝑚 − 𝑇𝑟𝑒𝑓), where n = 1 and m = 2 

3. If there are more than one thermal load defined in CAEPIPE, for example T1 and 
T2, then CAEPIPE determines Temperature factor (T) as given below. 

Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇1 as maximum(𝑇1, 𝑇𝑟𝑒𝑓) 

Thermal expansion range from 𝑇𝑟𝑒𝑓 to 𝑇2 as maximum(𝑇2, 𝑇𝑟𝑒𝑓) 

Thermal expansion range from 𝑇1 to 𝑇2 as maximum(𝑇1, 𝑇2) 



Oil and gas pipeline systems 
CSA Z662 (2015) 

[superseded by CSA Z662 (2019)] 

 

620 
 

 

 



Oil and gas pipeline systems 
CSA Z662 (2015) 

[superseded by CSA Z662 (2019)] 

 

621 
 

 

 



FRP Stress 
 

622 
 

 

Fiber Reinforced Plastic Pipe Stress 

Hoop stress: 𝑆𝐻 =
𝑃𝐷

2𝑡𝑚
 

Axial stress: 𝑆𝐴 =
𝑃𝐷

4𝑡𝑚
+
𝐹

𝐴
 

Bending stress: 𝑆𝐵 =
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

Torsional stress: 𝑆𝑇 =
𝑀𝑡

2𝑍
 

Longitudinal maximum = Axial + Bending = SA + SB 

Longitudinal Minimum = Axial – Bending = SA - SB 

where 

𝑃 = pressure 

𝐷 = outside diameter 

𝑡𝑚 = minimum thickness 
 = nominal thickness x (1 – mill tolerance/100) – corrosion allowance 

𝑖𝑖 = in-plane stress intensification factor 

𝑖𝑜 = out of plane stress intensification factor 

𝑀𝑖 = in plane bending moment 

𝑀𝑜 = out of plane bending moment 

𝑀𝑡 = torque 

𝑍 = section modulus 

𝐹 = axial force 

𝐴 = cross-section area 
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Von Mises Stress and Maximum & Minimum Principal Stresses 

Hoop stress: 𝑆𝐻 =
𝑃𝐷

2𝑡𝑚
 

Axial stress: 𝑆𝐴 =
𝑃𝐷

4t
+
𝐹

𝐴
 

Bending stress: 𝑆𝐵 =
√(𝑖𝑖𝑀𝑖)

2+(𝑖𝑜𝑀𝑜)2

𝑍
 

Torsional stress: 𝑆𝑇 =
𝑀𝑡

2𝑍
 

(a) At one Extreme Surface of Pipe 

T1 = 
𝑆𝐻−𝑆𝐴−𝑆𝐵

2
 

U1 = √𝑇12 + (𝑆𝑇)2 

Sigma l =𝜎1 = 
𝑆𝐻+𝑆𝐴+𝑆𝐵

2
 + U1 

Sigma 2 =𝜎2 = 
𝑆𝐻+𝑆𝐴+𝑆𝐵

2
 - U1 

VonMises_t = √(𝝈𝟏)
𝟐 − 𝝈𝟏𝝈𝟐 + (𝝈𝟐)

𝟐 

Max_t = 𝝈𝟏 

Min_t = 𝝈𝟐 

(b) At the other Extreme Surface of Pipe 

T2 = 
𝑆𝐻−𝑆𝐴+𝑆𝐵

2
 

U2 = √𝑇22 + (𝑆𝑇)2 

Sigma l =𝜎1 = 
𝑆𝐻+𝑆𝐴−𝑆𝐵

2
 + U2 

Sigma 2 =𝜎2 = 
𝑆𝐻+𝑆𝐴−𝑆𝐵

2
 – U2 

VonMises_b = √(𝝈𝟏)𝟐 − 𝝈𝟏𝝈𝟐 + (𝝈𝟐)𝟐 

Max_b = 𝝈𝟏 

Min_b = 𝝈𝟐 

(c) For the entire Pipe Cross-section at a Node  

VonMises Stress = Max(VonMises_t, VonMises_b) 

Maximum Principal Stress = Max(Max_t, Max_b) 

Minimum Principal Stress = Min(Min_t, Min_b) 
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where 

𝑃 = pressure 

𝐷 = outside diameter 
t = nominal thickness 

𝑡𝑚 = minimum thickness = t x (1 – mill tolerance/100) – corrosion allowance 

𝑖𝑖 = in-plane stress intensification factor 

𝑖𝑜 = out-of-plane stress intensification factor 

𝑀𝑖 = in-plane bending moment 

𝑀𝑜 = out-of-plane bending moment 

𝑀𝑡 = torque 

𝑍 = section modulus 

𝐹 = axial force 

𝐴 = cross-section area 
 
Stress Intensification Factors (SIFs) 
 
CAEPIPE computes Stress Intensification Factors (SIFs) for “None” code as per SIF 
equations provided in ASME B31.3 as given below. 
 
For “Piping code = None” and a non-FRP material, the in-plane and out-of-plane Stress 
Intensification Factors (SIF) for a 90° bend/elbow are taken to be the same as those 
computed using Appendix D of ASME B31.3 (appended below for reference). 
 
For a bend with bend angle less than 90°, the in-plane and out-of-plane SIFsarecomputed 
using the procedure given in ASME/BPVC Section III, Division1, Case N-319-2 “Alternate 
Procedure for Evaluation of Stresses in Butt Welding Elbows in Class 1 Piping.” 
 
For better clarity, when piping code = None, the SIF for a bend of other than 90 deg is as 
follows:  
 
The SIF for curved pipe of arc lengths between 0 and 180 deg can be estimated by 
multiplying the SIF for 90 deg bend as given by ASME B31.3 code by a scalar 
multiplier.  This scalar multiplier is arrived at by taking the ratio of the involved Bending 
stress index C(2z) values as given below.  
 
Scalar multiplier = [C(2z) value for the required angle bend / C(2z) value for 90 deg bend] , 
where the C(2z) values are taken from ASME/BPVC Section III, Division 1, Code Case N-
319-2 document titled "Alternate Procedure for Evaluation of Stresses in Butt Welding 
Elbows in Class 1 Piping", which are listed below.  
 
C(2z) = 1.95/h^(2/3) for bend angles of 90 deg or greater  
 
C(2z) = 1.75/h^(0.56) for a bend angle of 45 deg 
 
C(2z) = 1.0 for a bend angle of 0 deg (straight pipe)  
 



Piping Code=NONE 
 

625 
 

 

For other bend angles, the C(2z) values can be interpolated between the above C(2z) values.  
 
As an example, a 45 deg bend SIF could be reasonably estimated to be {SIF for B31 90 deg 
bend} x [C(2z) for a 45 deg bend / C(2z) for a 90 deg bend]. You may note that the Scalar 
multiplier is 1.0 for bend angles greater than 90 deg.   
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This function is available to users who wish to inspect or examine high stress areas (Non-
Destructive Evaluation, NDE) where piping has high “operating stresses” or examine stress 
areas that are higher than 35% of the allowable stress for Impact Testing as per para. 523.2.2 
(f)(4) of ASME B31.5 (2017) code or examine stress ratios for Impact Test Exemption as per 
para . 323.2.2 (b)(3) of ASME B31.3 (2022) code. 

While piping codes do not consider the operating condition (W+P+T) as a required load case for code 
compliance, you may, however, evaluate this load case the same way as you would do for other 
code compliance cases such as Sustained (W+P) and Expansion (T). CAEPIPE will show 
columns displaying Operating Stress (Sopr) and Allowable stress (Sall) alongside the code 
required stresses even though the Operating Stress is not a code requirement. 

To display these columns, you will have to turn them on first:(mouse right click) > Show 
Operating Stress for NDE for all codes excepting ASME B31.5 and ASME B31.3. For 
ASME B31.5 Code, this option will change as “Show Operating Stress for Impact Test”. 
Similarly, for ASME B31.3 Code, this option will change as “Show Operating Stress for 
Impact Test Exemption”. 

 

The allowable stress for NDE is NOT specified nor recommended by piping codes but, as 
mentioned above, may aid in identifying regions of high combined stress in the piping 
system, which may warrant a closer examination in engineering judgment. 
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Particulars Allowable Pressure Pipe Weight Sustained Stress Expansion Stress Occasional Stress 

ASME B31.1 

Pipe Thickness 

used 

 

Nominal Thk. x (1-mill 

tolerance/100) – Corrosion 

allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 

used 
- - 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

ASME B31.3 

Pipe Thickness 

used 

 

Nominal Thk. x (1-mill 

tolerance/100) – Corrosion 

allowance 

Nominal Thickness 
Nominal Thickness - Corrosion 

allowance 
- 

Nominal Thickness – Corrosion 

allowance 

Section Modulus 

used 
- - 

Corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Corroded Section Modulus; 

For Branch, effective section 

modulus 

ASME B31.4 

Pipe Thickness 

used 

 

Nominal Thk. x (1-mill 

tolerance/100) – Corrosion 

allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 

used 
- - 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Un-corroded Section Modulus; 

For Branch effective section 

modulus 

ASME B31.5 

Pipe Thickness 

used 

 

Nominal Thk. x (1-mill 

tolerance/100) – Corrosion 

allowance 

Nominal Thickness 
Nominal Thickness – Corrosion 

allowance 
- 

Nominal Thickness – Corrosion 

allowance 
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Particulars Allowable Pressure Pipe Weight Sustained Stress Expansion Stress Occasional Stress 

Section Modulus 

used 
- - 

Corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Corroded Section Modulus; 

For Branch, effective section 

modulus 

ASME B31.8 and ASME B31.12 PL 

Pipe Thickness 

used 

 

Nominal Thk. Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 

used 
- - 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

ASME B31.9 

Pipe Thickness 

used 

 

Nominal Thk. x (1-mill 

tolerance/100) – Corrosion 

allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 

used 
- - 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

ASME B31.12 

Pipe Thickness 

used 

 

Nominal Thk. x (1-mill 

tolerance/100) – Corrosion 

allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 

used 
- - 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

Un-corroded Section Modulus; 

For Branch, effective section modulus 

Un-corroded Section Modulus; 

For Branch, effective section 

modulus 

 

Note: 

1. Corrosion allowance includes thickness required for threading, grooving, erosion, corrosion etc. 

2. Un-corroded section modulus = section modulus calculated using the nominal thickness. 
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3. Corroded section modulus = section modulus calculated using the “corroded thickness”. Corroded thickness = nominal thickness – corrosion allowance 

4. Effective section modulus = section modulus calculated using effective branch thickness, which is lesser of iitb or th 

where, tb = branch nominal thickness, th = header nominal thickness, ii = in-plane SIF at branch 
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Method 1: B31G Original Method (0.67dL) 

Failure Stress (SF) of Corroded Pipeline is computed as per Section 2.2 (a) titled “Level 1 
Evaluation” as detailed below. 

For Z <= 20 

𝑆𝐹 = 𝑆𝑓𝑙𝑜𝑤 [
1 −

2

3
(
𝑑

𝑡
)

1 −
2

3
(
𝑑

𝑡𝑀
)
] 

For Z > 20 

𝑆𝐹 = 𝑆𝑓𝑙𝑜𝑤 (1 −
𝑑

𝑡
) 

𝑃𝐹 =
2𝑆𝐹𝑡

𝐷
 

𝐿𝑎𝑙𝑙 = 1.12. 𝐵√𝐷. 𝑡 

𝐵 = √(

𝑑

𝑡

1.1
𝑑

𝑡
− 0.15

)

2

− 1 

 

where 

SF= failure stress 

Sflow = flow stress = 1.1 SMYS  

SMYS = Minimum Metal Yield Strength at Reference Temperature 

d = measured maximum depth of corrosion 
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t = pipe wall thickness 

M = bulging magnification factor = √1 + 0.8𝑍 

Z = 
𝐿2

𝐷𝑡
 

L = length of metal loss 

D = pipe outside diameter 

PF= failure pressure 

PFS= safe pressure = PF/Safety Factor; where Safety factor is input by the user 

Lall = Maximum Allowable Defect Length 

Method 2: B31G Modified Method (0.85dL) 

Failure Stress (SF) of Corroded Pipeline is computed as per Section 2.2 (b) titled “Level 1 
Evaluation” as detailed below. 

For Z <= 50 

M = √1 + 0.6275𝑍 − 0.003375𝑍2 

For Z > 50 

M = 0.032𝑍 + 3.3 

𝑆𝐹 = 𝑆𝑓𝑙𝑜𝑤 [
1 − 0.85 (

𝑑

𝑡
)

1 − 0.85 (
𝑑

𝑡𝑀
)
] 

𝑃𝐹 =
2𝑆𝐹𝑡

𝐷
 

𝐿𝑎𝑙𝑙 = 1.12. 𝐵√𝐷. 𝑡 

𝐵 = √(

𝑑

𝑡

1.1
𝑑

𝑡
− 0.15

)

2

− 1 

where 

SF= failure stress 

Sflow = flow stress = SMYS + 10000 psi (69 MPa) 

SMYS = Minimum Metal Yield Strength at Reference Temperature 

d = measured maximum depth of corrosion 

t = pipe wall thickness 

M = bulging magnification factor 
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Z = 
𝐿2

𝐷𝑡
 

L = length of metal loss 

D = pipe outside diameter 

PF= failure pressure 

PFS= safe pressure = PF/Safety Factor; where Safety factor is input by the user 

Lall = Maximum Allowable Defect Length 

Method 3: Exact Trapezoid 

Failure Stress (SF) of Corroded Pipeline is computed as per Section 2.3 titled “Level 2 
Evaluation” as detailed below. In this method, corroded area ‘A’ is numerically computed 
using the trapezoid method 

𝑆𝐹 = 𝑆𝑓𝑙𝑜𝑤 (
1 −

𝐴

𝐴𝑜

1 −
𝐴

𝐴𝑜𝑀

) 

𝑃𝐹 =
2𝑆𝐹𝑡

𝐷
 

𝐿𝑎𝑙𝑙 = 1.12. 𝐵√𝐷. 𝑡 

𝐵 = √(

𝑑

𝑡

1.1
𝑑

𝑡
− 0.15

)

2

− 1 

 

For Z <= 50 

M = √1 + 0.6275𝑍 − 0.003375𝑍2 

For Z > 50 

M = 0.032𝑍 + 3.3 

where 

SF= failure stress 

Sflow = flow stress = SMYS + 10000 psi (69 MPa) 

SMYS = Minimum Metal Yield Strength at Reference Temperature 

M = bulging magnification factor 

Z = 
𝐿2

𝐷𝑡
 

L = length of metal loss 



Remaining Strength of Corroded Pipelines 

ASME B31G (2023) 

 

A = corroded area numerically computed using the trapezoid method 

Ao = L.t 

D = pipe outside diameter 

t = pipe wall thickness 

PF= failure pressure 

PFS= safe pressure = PF/Safety Factor; where Safety factor is input by the user 

d/t = A/Ao 

Method 4: Equivalent Area 

Failure Stress (SF) of Corroded Pipeline is computed as per Section 2.3 as detailed below. In 
this method, corroded area ‘A’ is numerically computed using the Equivalent Area method 

For Ze <= 50 

M = √1 + 0.6275𝑍𝑒 − 0.003375𝑍𝑒
2 

For Ze > 50 

M = 0.032𝑍𝑒 + 3.3 

𝑆𝐹 = 𝑆𝑓𝑙𝑜𝑤 (
1 −

𝐴

𝐴𝑜

1 −
𝐴

𝐴𝑜𝑀

) 

𝑃𝐹 =
2𝑆𝐹𝑡

𝐷
 

𝐿𝑎𝑙𝑙 = 1.12. 𝐵√𝐷. 𝑡 

𝐵 = √(

𝐴

𝐴𝑜

1.1
𝐴

𝐴𝑜
− 0.15

)

2

− 1 

where 

SF= failure stress 
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Sflow = flow stress = SMYS + 10000 psi (69 MPa) 

SMYS = Minimum Metal Yield Strength at Reference Temperature 

M = bulging magnification factor 

Le = equivalent flaw length =L. 
(
𝑑1+𝑑2+𝑑3+⋯…+𝑑𝑛

𝑛
)

𝑑
 

d1, d2,…dn = measured depth of corrosion at node 1, 2, …n 

L = length of metal loss 

d = measured maximum depth of corrosion 

Ze = 
𝐿𝑒
2

𝐷𝑡
 

D = pipe outside diameter 

t = pipe wall thickness 

A = corroded area = 𝐿. (
𝑑1+𝑑2+𝑑3+⋯…+𝑑𝑛

𝑛
) 

Ao = L.t 

PF= failure pressure 

PFS= safe pressure = PF/Safety Factor; where Safety factor is input by the user 

Method 5: Effective Area Method 

Failure Stress (SF) of Corroded Pipeline is computed as per Section 2.3 titled “Level 2 
Evaluation” as detailed below.  

In the effective area method, each pit is assessed with a combination of other corroded 
regions in an iterative procedure. The numbers of calculations performed are n!/2(n-2)!, 
where n = number of pits. For example, if one takes seven (7) pit readings, the program will 
make 21 iterations as shown below. 



Remaining Strength of Corroded Pipelines 

ASME B31G (2023) 

 

 

𝑆𝐹 = 𝑚𝑖𝑛 [𝑆𝑓𝑙𝑜𝑤 (
1 −

𝐴𝑖

𝐴𝑜𝑖

1 −
𝐴𝑖

𝐴𝑜𝑖𝑀𝑖

)] 

𝑃𝐹 =
2𝑆𝐹𝑡

𝐷
 

𝐿𝑎𝑙𝑙 = 𝑚𝑖𝑛(1.12. 𝐵𝑖√𝐷. 𝑡) 

𝐵𝑖 = √(

𝐴𝑖

𝐴𝑜𝑖

1.1
𝐴𝑖

𝐴𝑜𝑖
− 0.15

)

2

− 1 

 

For Zi <= 50 

Mi = √1 + 0.6275𝑍𝑖 − 0.003375𝑍𝑖
2 

For Zi > 50 

Mi = 0.032𝑍𝑖 + 3.3 

where 

SF= failure stress 
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Sflow = flow stress = SMYS + 10000 psi (69 MPa) 

SMYS = Minimum Metal Yield Strength at Reference Temperature 

M = bulging magnification factor 

Zi = 
𝐿𝑖2

𝐷𝑡
 

Li = length of possible failure area #i 

Ai = possible failure area #i. Area Ai numerically calculated using the trapezoid method 

Aoi = Li.t 

D = pipe outside diameter 

t = pipe wall thickness 

PF= failure pressure 

PFS= safe pressure = PF/Safety Factor; where Safety factor is input by the user 
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Simplified Fatigue Evaluation 

Given below are the equations that are used in computing the total number of “equivalent 
reference displacement stress range cycles (N)” for Simplified Fatigue Evaluation.  

𝑁 = 𝑁𝐸 + ∑(𝑞𝑖
5. 𝑁𝑖)  𝑓𝑜𝑟 𝑖 = 1,2, … , 𝑛   Eq. 1 

𝑁 = 𝑁𝐸 + ∑(𝑞𝑖
3. 𝑁𝑖)  𝑓𝑜𝑟 𝑖 = 1,2, … , 𝑛   Eq. 2 

𝑁 = 𝑁𝐸 + ∑(𝑞𝑖. 𝑁𝑖)  𝑓𝑜𝑟 𝑖 = 1,2, … , 𝑛   Eq. 3 

where 

NE = number of cycles of the reference displacement stress range, SE  

Ni = number of cycles associated with the displacement stress range, Si 

qi = Si/SE 

SE = reference displacement stress range, psi (kPa) = Maximum stress range computed 
among the displacement stress ranges selected by the user for Simplified Fatigue Evaluation. 

Si = maximum computed stress range for the ith displacement stress range. 

Table given below lists the specific equation used in computing total number of “equivalent 
reference displacement stress range cycles (N)”, for different piping codes.  

Once the “equivalent reference displacement stress range cycles (N)” is computed, then 
CAEPIPE uses this “N” to compute the Stress Range Reduction Factor (f or U) as per the 
piping code selected for analysis.  

Sl. 
No. 

Piping Code and Description 
Equation 
Number 

1 ASME B31.1 (2022) - Power Piping Eq. 1 

2 ASME B31.1 (1967) - Power Piping Eq. 1 

3 ASME B31.1 (1973) - Power Piping Eq. 1 

4 ASME B31.1 (1977) - Power Piping Eq. 1 

5 ASME B31.1 (1980) - Power Piping Eq. 1 

6 ASME B31.3 (2022) - Process Piping Eq. 2 

7 ASME B31.4 (2022) - Pipeline Transportation Systems for Liquids and Slurries Eq. 1 

8 ASME B31.5 (2022) - Refrigeration Piping and Heat Transfer Components Eq. 1 

9 ASME B31.8 (2022) - Gas Transmission and Distribution Piping Systems Eq. 1 

10 ASME B31.9 (2020) - Building Services Piping Eq. 1 

11 
ASME B31.12 IP (2019) - Hydrogen Piping 
ASME B31.12 IP (2023) – Hydrogen Piping 

Eq. 3 
Eq. 2 

12 
ASME B31.12 PL (2019) - Hydrogen Pipelines 
ASME B31.12 PL (2023) – Hydrogen Pipelines 

Eq. 3 
Eq. 2 

13 ASME NM.1 (2022) - Thermoplastic Piping Systems Not Applicable 

14 
ASME NM.2 (2022) - Glass-Fiber-Reinforced Thermosetting-Resin Piping Systems 
(GRP/FRP) Not Applicable 

15 ASME Class 2 (1980) - ASME Section III, Subsection NC - Class 2 Eq. 1 

16 ASME Class 2 (1986) - ASME Section III, Subsection NC - Class 2 Eq. 1 

17 ASME Class 2 (1992) - ASME Section III, Subsection NC - Class 2 Eq. 1 

18 ASME Class 2 (2015) - ASME Section III, Subsection NC - Class 2 Eq. 1 

19 ASME Class 2 (2017) ASME Section III, Subsection NC - Class 2 Eq. 1 



 

 

Sl. 
No. 

Piping Code and Description 
Equation 
Number 

20 ASME Class 2 (2021) - ASME Section III, Subsection NC - Class 2 Eq. 1 

21 ASME Class 2 (2023) - ASME Section III, Subsection NC - Class 2 Eq. 1 

22 ASME Class 3 (2017) - ASME Section III, Subsection ND - Class 3 Eq. 1 

23 ASME Class 3 (2021) - ASME Section III, Subsection ND - Class 3 Eq. 1 

24 ASME Class 3 (2023) - ASME Section III, Subsection ND - Class 3 Eq. 1 

25 
ISO 14692-3 (2017) - Petroleum and Natural Gas Industries - Glass Reinforced 
Plastics (GRP/FRP) Piping Not Applicable 

26 EN 13480 (2020) - Metallic industrial piping Eq. 1 

27 EN 13941 (2019) - District heating pipes Not Applicable 

28 
BS 806 (1986) - Construction of Ferrous Piping Installations for and in Connection 
with Land Boilers (British) Not Applicable 

29 DNV-ST-F101 – Submarine pipeline systems Not Applicable 

30 
IGEM (2012) - Institution of Gas Engineers and Managers (IGEM) IGE/TD/12 Edition 
2 (UK) Not Applicable 

31 Norwegian (1983) - Process design Eq. 1 

32 Norwegian (1990) - Process design Eq. 1 

33 
RCC-M (1985) - Design and Construction Rules for Mechanical Components of PWR 
Nuclear Islands (French) Eq. 1 

34 
RCC-M (2018) - Design and Construction Rules for Mechanical Components of PWR 
Nuclear Islands (French) Eq. 1 

35 
RCC-M (2020) - Design and Construction Rules for Mechanical Components of PWR 
Nuclear Islands (French) Eq. 1 

36 
RCC-M (2022) - Design and Construction Rules for Mechanical Components of PWR 
Nuclear Islands (French) Eq. 1 

37 
CODETI (2013) - CODE DE CONSTRUCTION DES TUYAUTERIES INDUSTRIELLES 
(French) Eq. 1 

38 Stoomwezen (1989) - Dutch Power piping code Eq. 1 

39 Swedish (1978) – Swedish piping code Eq. 1 

40 Z183 (1990) - Oil Pipeline Systems (Canadian) Eq. 1 

41 Z184 (1992) - Gas Pipeline Systems (Canadian) Eq. 1 

42 Z662 (2019) - Oil & Gas Pipeline Systems (Canadian) Eq. 1 

43 
NONE (for AWWA M11 applications, and for applications in aircraft, aerospace & 
defence industries) Not Applicable 

 
Detailed Fatigue Evaluation 

Detailed Fatigue Evaluation is performed as per Miner’s Rule which is based on Cumulative 
Damage Theory. 

Miner’s Rule is based on the concept that fatigue damage accumulates over time and that 
failure occurs when the accumulated damage reaches a critical value, typically set to 1. The 
rule is expressed mathematically as: 

𝐷 = ∑
𝑛𝑖
𝑁𝑖

 

where, D = Total cumulative damage, ni = Actual number of cycles at alternating stress level 
i, Ni = Number of cycles to Failure at stress level i (from the S-N curve). 



 

 

When the total damage D equals or exceeds 1.0, then the fatigue evaluation is considered to 
have failed. 

Example Calculation 

Assume a piping system experiences the following cyclic loading conditions: 

 Expansion (T1): Alternating Stress amplitude of 15000 psi, with 5000 cycles. 

 Expansion (T2): Alternating Stress amplitude of 30000 psi, with 2000 cycles. 

The alternating stress amplitudes listed above are one-half of the stress range values 
(=SE/2.0) at a particular Node for Expansion (T1) and Expansion (T2) cases respectively.  

From the sample S-N curve given below,  

 

 At Alternating Stress 15000 psi: N1 (Number of cycles to failure) = 1E+6 cycles. 

 At Alternating Stress 30000 psi: N2 (Number of cycles to failure) = 1E+4 cycles. 

Calculate damage: 

 Damage at 15000 psi: n1/N1 = 5000/1E+6 = 0.005 

 Damage at 30000 psi: n2/N2 = 2000/1E+4 = 0.200 

 Total Cumulative Damage: D = 0.005 + 0.2 = 0.205 

Since D < 1.0, the component meets the Fatigue requirement for the given cyclic loading 

conditions, though it will have consumed 20.5% of its total allowable fatigue life. 

Actual Number of Cycles to be Input for Simplified and Detailed Fatigue Analysis:  

In CAEPIPE, the actual number of cycles associated with each selected expansion load case 
can be entered as shown below. When Simplified or Detailed Fatigue Analysis is enabled, 
CAEPIPE utilizes this table (containing the actual number of cycles for the selected load 
cases) to perform both Simplified and Detailed Fatigue Analysis. Please note, as stated above, 



 

 

when any of the load cases is not to be included in the Fatigue Evaluation, then leave the 
‘Number of Cycles (N)’ field for that load case BLANK as shown below. 

 

When Simplified Fatigue Analysis is turned ON, CAEPIPE uses the above table for 
calculating the “equivalent reference displacement stress range cycles (N)”, which then is 
used to compute the stress range reduction factor (‘f’ or ‘U’) as detailed in the section titled 
‘Simplified Fatigue Evaluation’ in the CAEPIPE Code Compliance Manual. 

Similarly, when the Detailed Fatigue Analysis is turned ON, CAEPIPE uses the above table 
to compute the “Cumulative Damage (D)” as outlined in the section titled ‘Detailed Fatigue 
Evaluation’ in the CAEPIPE Code Compliance Manual. 

For better clarity, refer to the example given below for inputting the Fatigue Cycle table: 

Consider a piping system that operates at three different temperature levels, each with a 
corresponding number of cycles over its service life and with the reference temperature of 

700𝐹. 

20 cycles of 𝑇1 = 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛 (𝑇1) = 𝑇1 − 𝑇𝑟𝑒𝑓 = 270
0𝐹 − 700𝐹 = 2000𝐹  

10 cycles of 𝑇2 = 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛 (𝑇2) = 𝑇2 − 𝑇𝑟𝑒𝑓 = −800𝐹 − 700𝐹 = −1500𝐹   

100 cycles of 𝑇3 = 𝐸𝑥𝑝𝑎𝑛𝑠𝑖𝑜𝑛 (𝑇3) = 𝑇3 − 𝑇𝑟𝑒𝑓 = −300𝐹 − 700𝐹 = −1000𝐹  

With reference to the above temperature ranges, the number of cycles that can be entered in 
CAEPIPE for each load case are as follows.  

 For Expansion (𝑇1), the number of cycles=20 

 For Expansion (𝑇2), the number of cycles=10 

 For Expansion (𝑇3), the number of cycles=100 

 For Expansion (𝑇1 − 𝑇2), the number of cycles = Min( 𝑇1, 𝑇2) = Min(20,10) = 10 

 For Expansion (𝑇1 − 𝑇3), the number of cycles = Min( 𝑇1, 𝑇3) = Min(20,100) = 20 

 For Expansion (𝑇2 − 𝑇3), the number of cycles = Min( 𝑇2, 𝑇3) = Min(10,100) = 10 

  



 

 

Accordingly, the Fatigue Cycle table in CAEPIPE is to be input as shown below. 

 

The above approach to input the number of cycles is conservative as the sum of the Number 
of Cycles input is greater than the sum of actual number of cycles (i.e., [170 = 
20+10+100+10+20+10] > [130 = 20+10+100]). There may be alternate ways to input the 
number of cycles, such as “combining” or "lumping" the ranges of variations to produce the 
maximum effect as stated in Clause NB-3553 ‘Fatigue Usage’ of ASME Section III, 
Subsection NB (2021).  
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API 610 (11th Edition, 2010) / ISO 13709:2009 for Pumps  

The allowable nozzle forces and moments for pumps are taken from Table 4 of the eleventh 
edition of API Standard 610 / ISO 13709.  
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The coordinate systems and nozzle orientations for various pump configurations are shown 
next. 
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Criteria for Piping Design  

The criteria for piping design are taken from Appendix F of the API 610. 
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Verification of API 610 Pump Compliance 

Implementation of API 610 Pump Compliance in CAEPIPE is verified using the sample 
provided in API Standard 610, 11th Edition and presented in this section. 

 

 

CAEPIPE model corresponding to the above API Publication sample 
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Results from API 610, 11th Edition 
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Results from CAEPIPE Rotating Equipment Report 
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Coordinate System for ASME B73.1, B73.3 and B73.5M horizontal end suction 
pumps 

 
Figure 1 – Coordinate system for ASME B73.1, B73.3 and B73.5M horizontal end suction 
pumps 

A1.0 Definitions (refer to Figure above) 

Fxs = applied force on X-axis on suction nozzle, to be assessed using equation sets 1-5 

Fys = applied force on Y-axis on suction nozzle, to be assessed using equation sets 1-5 

Fzs = applied force on Z-axis on suction nozzle, to be assessed using equation sets 1-5 

Mxs = applied moment about X-axis on suction nozzle, to be assessed using equation sets 1-5 

Mys = applied moment about Y-axis on suction nozzle, to be assessed using equation sets 1-5 

Mzs = applied moment about Z-axis on suction nozzle, to be assessed using equation sets 1-5 

Fxd = applied force on X-axis on discharge nozzle, to be assessed using equation sets 1-5 

Fyd = applied force on Y-axis on discharge nozzle, to be assessed using equation sets 1-5 

Fzd = applied force on Z-axis on discharge nozzle, to be assessed using equation sets 1-5 

Mxd = applied moment about X-axis on discharge nozzle, to be assessed using equation sets 
1-5 

Myd = applied moment about Y-axis on discharge nozzle, to be assessed using equation sets 
1-5 

Mzd = applied moment about Z-axis on discharge nozzle, to be assessed using equation sets 
1-5 

Fxs max = maximum value of force on X-axis on suction nozzle, to be used with equation sets 
1-5 

Fys max = maximum value of force on Y-axis on suction nozzle, to be used with equation sets 
1-5 

Fzs max = maximum value of force on Z-axis on suction nozzle, to be used with equation sets 
1-5
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Mxs max = maximum value of moment about X-axis on suction nozzle, to be used with 
equation sets 1-5 

Mys max = maximum value of moment about Y-axis on suction nozzle, to be used with 
equation sets 1-5 

Mzs max = maximum value of moment about Z-axis on suction nozzle, to be used with 
equation sets 1-5 

Fxd max = maximum value of force on X-axis on discharge nozzle, to be used with equation 
sets 1-5 

Fyd max = maximum value of force on Y-axis on discharge nozzle, to be used with equation 
sets 1-5 

Fzd max = maximum value of force on Z-axis on discharge nozzle, to be used with equation 
sets 1-5 

Mxd max = maximum value of moment about X-axis on discharge nozzle, to be used with 
equation sets 1-5 

Myd max = maximum value of moment about Y-axis on discharge nozzle, to be used with 
equation sets 1-5 

Mzd max = maximum value of moment about Z-axis on discharge nozzle, to be used with 
equation sets 1-5 

Group 1 is defined as ASME B73.1, B73.3 and B73.5M sizes AA and AB. Two/four-pole, 60 
cycle speed and up to 20/10 hp, respectively. 

Group 2 is defined as ASME B73.1, B73.3 and B73.5M sizes A05, A10, A20, A30, A40, A50, 
A60, A70 and A80. Two/four-pole, 60-cycle speed and up to 130/65 hp, respectively. 

Group 3 is defined as ASME B73.1, B73.3 and B73.5M sizes A90, A100, A110 and A120. 
Four/six-pole, 60-cycle speed and up to 220/146 hp, respectively. 

A1.1 ASME B73.1 pump assessment of applied nozzle loads 

Loads given in Tables B through E are applicable for ASME B73.1 pumps constructed of 
ASTM A351/A351M – Grade CF8M (Type 316SS) operated between 20 and 1000 F and 
mounted on a grouted metal baseplate with anchor bolts. 

For an individual force or moment, pumps must be capable of satisfactory operation when 
subjected to loads shown in Table B while meeting the criteria of equation set 1 provided in 
Table A below. 

For a combination of more than one force and/or moment, pumps must be capable of 
satisfactory operation when subjected to the loads in Tables C through E while meeting the 
criteria of equation sets 2 – 5 of Table A given below. When combining loads, the absolute 
value of any individual load must not exceed the value given in Table B. 
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Adjustment of the tabulated maximum forces and moments are performed if any of the 
following occur. 

a. Temperature is above 1000 F. 

b. The pump material construction is not ASTM A351/A351M – Grade CF8M. 

c. The base is not a fully grouted metal baseplate with anchor bolts. 

Table A – Equation sets 1 through 5 (using the maximum forces and moments of 
the referenced tables, applied loads shall satisfy the criteria defined by these 
equations) 

Set Equation Reference Remarks 

1 |
𝐹𝑋𝑆

𝐹𝑋𝑆𝑚𝑎𝑥
| ≤ 1.0, |

𝐹𝑌𝑆
𝐹𝑌𝑆𝑚𝑎𝑥

| ≤ 1.0, |
𝐹𝑍𝑆

𝐹𝑍𝑆𝑚𝑎𝑥
| ≤ 1.0, |

𝑀𝑋𝑆

𝑀𝑋𝑆𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑌𝑆

𝑀𝑌𝑆𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑍𝑆

𝑀𝑍𝑆𝑚𝑎𝑥

| ≤ 1.0 

 

|
𝐹𝑋𝑑

𝐹𝑋𝑑𝑚𝑎𝑥
| ≤ 1.0, |

𝐹𝑌𝑑
𝐹𝑌𝑑𝑚𝑎𝑥

| ≤ 1.0, |
𝐹𝑍𝑑

𝐹𝑍𝑑𝑚𝑎𝑥
| ≤ 1.0, |

𝑀𝑋𝑑

𝑀𝑋𝑑𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑌𝑑

𝑀𝑌𝑑𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑍𝑑

𝑀𝑍𝑑𝑚𝑎𝑥

| ≤ 1.0 

Table B Individual 
loading 

2 
1

2
𝑥

[
 
 
 |

𝐹𝑋𝑆
𝐹𝑋𝑆𝑚𝑎𝑥

| + |
𝐹𝑌𝑆

𝐹𝑌𝑆𝑚𝑎𝑥
| + |

𝐹𝑍𝑆
𝐹𝑍𝑆𝑚𝑎𝑥

| + |
𝑀𝑋𝑆

𝑀𝑋𝑆𝑚𝑎𝑥

| + |
𝑀𝑌𝑆

𝑀𝑌𝑆𝑚𝑎𝑥

| + |
𝑀𝑍𝑆

𝑀𝑍𝑆𝑚𝑎𝑥

| +

|
𝐹𝑋𝑑

𝐹𝑋𝑆𝑚𝑎𝑥
| + |

𝐹𝑌𝑑
𝐹𝑌𝑆𝑚𝑎𝑥

| + |
𝐹𝑍𝑑

𝐹𝑍𝑆𝑚𝑎𝑥
| + |

𝑀𝑋𝑑

𝑀𝑋𝑑𝑚𝑎𝑥

| + |
𝑀𝑌𝑑

𝑀𝑌𝑑𝑚𝑎𝑥

| + |
𝑀𝑍𝑑

𝑀𝑍𝑑𝑚𝑎𝑥

|
]
 
 
 

≤ 1.0 
Table C Nozzle 

stress, 
hold-
down bolt 
stress, 
pumps 
slippage 

3 −1.0 ≤ 𝑎 =
𝐹𝑌𝑆

𝐹𝑌𝑆 𝑚𝑎𝑥
+

𝑀𝑋𝑆

𝑀𝑋𝑆 𝑚𝑎𝑥

+
𝑀𝑌𝑆

𝑀𝑌𝑆 𝑚𝑎𝑥

+
𝑀𝑍𝑆

𝑀𝑍𝑆 𝑚𝑎𝑥

+
𝐹𝑌𝑑

𝐹𝑌𝑑 𝑚𝑎𝑥
 

+
𝑀𝑋𝑑

𝑀𝑋𝑑 𝑚𝑎𝑥

+
𝑀𝑌𝑑

𝑀𝑌𝑑 𝑚𝑎𝑥

+
𝑀𝑍𝑑

𝑀𝑍𝑑 𝑚𝑎𝑥

≤ 1.0 

Table D y-axis 
movement 

4 −1.0 ≤ 𝑏 =
𝐹𝑋𝑆

𝐹𝑋𝑆 𝑚𝑎𝑥
+

𝐹𝑍𝑆
𝐹𝑍𝑆 𝑚𝑎𝑥

+
𝑀𝑋𝑆

𝑀𝑋𝑆 𝑚𝑎𝑥

+
𝑀𝑌𝑆

𝑀𝑌𝑆 𝑚𝑎𝑥

+
𝑀𝑍𝑆

𝑀𝑍𝑆 𝑚𝑎𝑥

+ 

 
𝐹𝑋𝑑

𝐹𝑋𝑑 𝑚𝑎𝑥
+

𝐹𝑌𝑑
𝐹𝑌𝑑 𝑚𝑎𝑥

+
𝐹𝑍𝑑

𝐹𝑍𝑑 𝑚𝑎𝑥
+

𝑀𝑋𝑑

𝑀𝑋𝑑 𝑚𝑎𝑥

+
𝑀𝑌𝑑

𝑀𝑌𝑑 𝑚𝑎𝑥

+
𝑀𝑍𝑑

𝑀𝑍𝑑 𝑚𝑎𝑥

≤ 1.0 

 

Table E z-axis 
movement 

5 √𝑎2 + 𝑏2 ≤ 1.0 Equation 
sets 3 and 4 

Combined 
axis 
movement 
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Table B – Maximum forces and moments for use with equation set 1 to assess 
applied loads 
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Table C- Maximum forces and moments for use with equation set 2 to assess 
applied loads 

 

Table D – Maximum forces and moments for use with equation set 3 to assess 
applied loads 
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Table E – Maximum forces and moments for use with equation set 4 to assess 
applied loads 

 
A1.2 Nozzle loads and adjustment factors 
The loads in the tables are multiplied by adjustment factors when applicable. The lowest 
correction factor is applied when more than one adjustment factor is involved. For instance, 
if the pump is an ASME B73.5 pump (90% reduction factor) mounted on a fully grouted 
nonmetallic baseplate (80% reduction factor), then the reduction factor for Tables B through 
E is 80% 

A1.2.1 Alternate pump mounting 

For alternate mounting conditions, the pump must be mounted on a base that can, as a 
minimum, withstand the applied nozzle loads combined with normal operating loads. 

A1.2.1.1 Still-mounted metal baseplate 

100% of the values in Table C and 90% of values in Table D and Table E are used. If after 
adjusting the value for a particular load in Tables D and E, the absolute value of any adjusted 
value is lower than the corresponding load in Table B, then the lower value is substituted 
into Table B. 

A1.2.1.2 Ungrouted metal baseplate that is anchored down 

100% of the values in Table C and 80% of the values in Tables D and E are used. If after 
adjusting the value for a particular load in Tables D and E, the absolute value of any adjusted 
value is lower than the corresponding load in Table B, then the lower value is substituted 
into Table B. 

A1.2.1.3 Grouted nonmetal baseplate with anchor bolts 

80% of the values in Tables B through E are used.  

A1.2.1.4 Ungrouted nonmetal baseplate that is anchored down 

70% of the values in Tables B through E are used.  

A1.2.2 Temperature and material adjustment factors for ASME B73.1 and ASME 
B73.3 pumps 
 
A1.2.2.1 Adjustment factors 

For temperatures above 1000 F and/or the use of a material other than ASTM A351/351M – 
Grade CF8M, the loads in Table C are reduced by multiplying the proper adjustment factor 
from Table A1.2.2b. 

If after adjusting the value for a particular load in Table C, any adjusted value is lower than 
the corresponding load in Table B, then the lower value is substituted in Table B. 
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Material group numbers used in Table A1.2.2b are defined in Table A1.2.2.a 

Table A1.2.2a – List of material specifications as used in Table B 

 

Table A1.2.2b – ASME B73.1 metallic pump temperature and material adjustment 
values used on Table C values 
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Coordinate System for ASME B73.2 vertical in-line pumps 

 
Figure 2 – Coordinate system for ASME B73.2 vertical in-line pumps 

A2.0 Definitions (refer to Figure above) 

Fxs = applied force on X-axis on suction nozzle, to be assessed using equation set 6 
Fys = applied force on Y-axis on suction nozzle, to be assessed using equation set 6 
Fzs = applied force on Z-axis on suction nozzle, to be assessed using equation set 6 
Mxs = applied moment about X-axis on suction nozzle, to be assessed using equation set 6 
Mys = applied moment about Y-axis on suction nozzle, to be assessed using equation set 6 
Mzs = applied moment about Z-axis on suction nozzle, to be assessed using equation set 6 
Fxd = applied force on X-axis on discharge nozzle, to be assessed using equation set 6 
Fyd = applied force on Y-axis on discharge nozzle, to be assessed using equation set 6 
Fzd = applied force on Z-axis on discharge nozzle, to be assessed using equation set 6 
Mxd = applied moment about X-axis on discharge nozzle, to be assessed using equation set 6 
Myd = applied moment about Y-axis on discharge nozzle, to be assessed using equation set 6 
Mzd = applied moment about Z-axis on discharge nozzle, to be assessed using equation set 6 
Fx max = maximum value of force on X-axis on suction or discharge nozzles, to be used with 
equation set 6 
Fy max = maximum value of force on Y-axis on suction or discharge nozzles, to be used with 
equation set 6 
Fz max = maximum value of force on Z-axis on suction or discharge nozzles, to be used with 
equation set 6 
Mx max = maximum value of moment about X-axis on either nozzle, to be used with equation 
set 6 
My max = maximum value of moment about Y-axis on either nozzle, to be used with equation 
set 6 
Mz max = maximum value of moment about Z-axis on either nozzle, to be used with equation 
set 6 

A2.1 ANSI/ASME B73.2 pump assessment of applied nozzle loads 

Loads given in Table B above are applicable for ASME B73.2 pumps constructed of ASTM 
A351/A351M – Grade CF8M (Type 316SS) operated between -20 and 1000 F. 

For an individual force or moment or for a combination of more than one force and/or 
moment, pumps should be capable of satisfactory operation when subjected to loads shown 
in Table A2.1b (adjusted if applicable) while meeting the criteria of equation set 6 in Table 
A2.1a. 
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Table A2.1a – Equation set 6 

Set Equation Reference Remarks 

6 |
𝐹𝑋𝑆
𝐹𝑋𝑚𝑎𝑥

| ≤ 1.0, |
𝐹𝑌𝑆
𝐹𝑌𝑚𝑎𝑥

| ≤ 1.0, |
𝐹𝑍𝑆
𝐹𝑍𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑋𝑆

𝑀𝑋𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑌𝑆

𝑀𝑌𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑍𝑆

𝑀𝑍𝑚𝑎𝑥

| ≤ 1.0 

|
𝐹𝑋𝑑
𝐹𝑋𝑚𝑎𝑥

| ≤ 1.0, |
𝐹𝑌𝑑
𝐹𝑌𝑚𝑎𝑥

| ≤ 1.0, |
𝐹𝑍𝑑
𝐹𝑍𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑋𝑑

𝑀𝑋 𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑌𝑑

𝑀𝑌𝑚𝑎𝑥

| ≤ 1.0, |
𝑀𝑍𝑑

𝑀𝑍𝑚𝑎𝑥

| ≤ 1.0 

- Individual 
loading 

Table A2.1b – Maximum forces and moments for use with equation set 6 to assess 
applied loads 

 

A2.1.1 Temperature and material adjustment factors 

Adjustments of allowable load values are performed when any of the following occurs: 
a. Temperature is above 1000 F 
b. The pump material construction is not ASTM A351/A351M – Grade CF8M 

A2.1.2 Adjustment factors 

For temperatures above 1000 F and/or the use of a material other than ASTM A351/A351M 
– Grade CF8M, the loads in Table A2.1b are reduced by multiplying them by the proper 
adjustment factor from Table A2.1d. Material group numbers used in Table A2.1d are 
defined in Table A2.1c.  
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Table A2.1c – List of materials specifications as used in Table A2.1d 

 

Table A2.1d – ASME B73.2 metallic pump temperature and material adjustment 
values used 
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Coordinate System for Axial split case pumps (single-stage double suction and 
two-stage single suction) 

 
Figure 3 – Coordinate system for axial split case pumps 

A3.0 Definitions (refer to Figure above) 

Fxs = applied force on X-axis on suction nozzle, to be assessed using equation 1 
Fys = applied force on Y-axis on suction nozzle, to be assessed using equation 1 
Fzs = applied force on Z-axis on suction nozzle, to be assessed using equation 1 
Mxs = applied moment about X-axis on suction nozzle, to be assessed using equation 1 
Mys = applied moment about Y-axis on suction nozzle, to be assessed using equation 1 
Mzs = applied moment about Z-axis on suction nozzle, to be assessed using equation 1 
Fxd = applied force on X-axis on discharge nozzle, to be assessed using equation 1 
Fyd = applied force on Y-axis on discharge nozzle, to be assessed using equation 1 
Fzd = applied force on Z-axis on discharge nozzle, to be assessed using equation 1 
Mxd = applied moment about X-axis on discharge nozzle, to be assessed using equation 1 
Myd = applied moment about Y-axis on discharge nozzle, to be assessed using equation 1 
Mzd = applied moment about Z-axis on discharge nozzle, to be assessed using equation 1 
Fx max = maximum value of force on X-axis on either nozzle, to be used with equation1 
Fy max = maximum value of force on Y-axis on either nozzle, to be used with equation 1 
Fz max = maximum value of force on Z-axis on either nozzle, to be used with equation 1 
Mx max = maximum value of moment about X-axis on either nozzle, to be used with equation 
1 
My max = maximum value of moment about Y-axis on either nozzle, to be used with equation 
1 
Mz max = maximum value of moment about Z-axis on on either nozzle, to be used with 
equation 1 
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A3.1 Axial split case pumps assessment of applied loads 

The lowest values of maximum forces and moments from Tables A3.1a and A3.1b are used. 
The combined applied loads should satisfy the criteria defined by equation 1 below. 

 

Table A3.1a – Maximum forces and moments for use with equation 1 to assess 
applied loads based on the hold-down bolts 

 
Table A3.1b – Maximum forces and moments for use with equation 1 to assess 
applied loads based on the nozzle stress 
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Coordinate System for Vertical turbine short set pumps 
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A4.0 Definitions 

fx, fy and fz are the actual applied nozzle forces in their respective coordinate direction 

mx, my and mz are actual applied nozzle moments in their respective coordinate direction 

Fx, Fy and Fz are tabulated maximum permissible nozzle forces in their respective 
coordinate direction 

Mx, My and Mz are tabulated maximum permissible nozzle moments in their respective 
coordinate direction 

A4.1 Vertical turbine short set pumps assessment of applied loads 

The tables above show maximum permissible forces and moments for each coordinate 
direction of each flange. Each value in the tables represents the maximum allowable load in a 
particular direction acting alone. For cases in which more than one load is applied 
simultaneously, the following formula should be satisfied. 

 
 

 

 

 

 

 

 



NEMA SM-23 (1991) for Turbines 
 

679 
 

NEMA SM-23 (1991) for Turbines 

There are two types of allowables. 

1. Allowables for each nozzle and  

2. Combined allowables for each turbine.  

1. Allowables for each Nozzle 

The resultant force and the resultant moment at any connection must not exceed 

3𝐹𝑅 +𝑀𝑅 ≤ 500𝐷𝑒 

where 

𝐹𝑅 = resultant force at the nozzle (lb) 

𝑀𝑅 = resultant moment at the nozzle (ft.-lb) 

𝐷𝑒 = nominal pipe size (inches) of the connection up to 8” in diameter 

 = (16 + 𝐷𝑛𝑜𝑚)/3  If the size is greater than 8” 

2. Combined Allowables for the Turbine  

The combined resultants of the forces and moments at the inlet, exhaust and extraction 
nozzles resolved at the centerline of the exhaust nozzle must not exceed the following two 
conditions: 

(a) These resultant should not exceed: 

2𝐹𝐶 +𝑀𝐶 ≤ 250𝐷𝐶 

where 

𝐹𝐶 = combined resultant of inlet, exhaust and extraction forces (lb) 

𝑀𝐶 = combined resultant of inlet, exhaust and extraction moments (ft.-lb.) 

𝐷𝐶  = diameter (in inches) of a circular opening equal to the total areas of the inlet, exhaust 
  and extraction nozzles up to a value of 9” in diameter 
 = (18 + Equivalent diameter) / 3 (in.) For values > 9” 

(b) The components of these resultants shall not exceed:  

𝐹𝑋 = 50𝐷𝐶𝑀𝑋 = 250𝐷𝐶 
𝐹𝑌 = 125𝐷𝐶𝑀𝑌 = 125𝐷𝐶 
𝐹𝑍 = 100𝐷𝐶𝑀𝑍 = 125𝐷𝐶 

where 

𝐹𝑋 = horizontal component of 𝐹𝑅 parallel to the turbine shaft 

𝐹𝑌 = vertical component of 𝐹𝑅 

𝐹𝑍 = horizontal component of 𝐹𝑅 at right angles to the turbine shaft 

𝑀𝑋 = horizontal component of 𝑀𝑅 parallel to the turbine shaft 

𝑀𝑌 = vertical component of 𝑀𝑅 

𝑀𝑍 = horizontal component of 𝑀𝑅 at right angles to the turbine shaft 
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API 617 (Seventh edition, June 2003) for Compressors 

1. Allowables for each Nozzle 

The total resultant force and resultant moment imposed on the compressor at any 
connection should not exceed 

3𝐹𝑟 +𝑀𝑟 ≤ 927𝐷𝑒 

Where  

𝐹𝑟 =  resultant force at the Nozzle (lb)  

𝑀𝑟 =  resultant moment at the Nozzle (ft.-lb)  

𝐷𝑒 =  nominal pipe size (inches) of the connection up to 8” in diameter  

 =  (16 + Dnom)/3 If the size is greater than 8” 

2. Combined Allowables for Compressors 

The combined resultants of the forces and moments of the inlet, sidestream, and discharge 
connections resolved at the centerlines of the largest connection should not exceed the 
following two conditions:  
(a) The resultant should not exceed: 

2𝐹𝑐 +𝑀𝑐 ≤ 462𝐷𝑐 

Where  

𝐹𝑐 =  combined resultant of inlet, sidestream, and discharge forces (lb)  

𝑀𝑐 =  combined resultant of inlet, sidestream, and discharge moments, and moments  
  resulting from forces (ft.-lb) 

𝐷𝑐 = diameter of one circular opening equal to the total areas of the inlet, sidestream, and 
 discharge openings. If the equivalent nozzle diameter is greater than 9”, use a value

 of Dc equal to (18 + Equivalent Diameter) / 3 

(b) The components of these resultants shall not exceed: 

𝐹𝑥 = 92𝐷𝑐 𝑀𝑥 = 462𝐷𝑐 

𝐹𝑦 = 231𝐷𝑐 𝑀𝑦 = 231𝐷𝑐 

𝐹𝑧 = 185𝐷𝑐 𝑀𝑧 = 231𝐷𝑐 

Where  

𝐹𝑥 = horizontal component of F
c
 parallel to the compressor shaft (lb)  

𝐹𝑦 = vertical component of F
c
 (lb)  

𝐹𝑧 = horizontal component of F
c
 at right angles to be compressor shaft (lb)  

𝑀𝑥 = component of M
c
 around the horizontal axis (ft-lb)  

𝑀𝑦 = component of M
c
 around the vertical axis (ft-lb)  

𝑀𝑧 = component of M
c
 around the horizontal axis at right angles to the compressor (ft-lb)
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Z: Perpendicular to compressor shaft    X: Parallel to compressor shaft 
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Notation based on ASME Section VIII, Division 1, Appendix 2 (2013) 

The symbols described below are used in the formulas for the design of flanges 

𝐴 = outside diameter of flange 

𝐴𝑏 = cross-sectional area of the bolts using the root diameter of the thread 
𝐴𝑚 =  total required cross-sectional area of bolts taken as greater of 𝐴𝑚1 and 𝐴𝑚2 

𝐴𝑚1 =  total cross-sectional area of bolts at root of thread or section of least diameter under  
 stress, required for the operating conditions 

=
𝑊𝑚1

𝑆𝑏
 

𝐴𝑚2 = total cross-sectional area of bolts at root of thread or section of least diameter under 
 stress 

=
𝑊𝑚2

𝑆𝑎
 

𝐵 = inside diameter of flange 

𝐵′ = inside diameter of reverse flange 
𝑏 =  effective gasket or joint-contact-surface seating width 
𝑏0 =  basic gasket seating width (from Table 2-5.2) 
𝐶 =  bolt-circle diameter 
𝑐 =  basic dimension used for the minimum sizing of welds 

𝑒 =  factor = 
𝐹

ℎ𝑜
 

𝑑 =  factor = 
𝑈

𝑉
ℎ𝑜𝑔0

2 for integral type flanges 

𝑑 =  factor =
𝑈

𝑉𝐿
ℎ𝑜𝑔0

2 for loose type flanges 

𝑒 =  factor =
𝐹

ℎ𝑜
 for integral type flanges 

𝑐 =  factor =
𝐹𝐿

ℎ𝑜
 for loose type flanges 

𝐹 = factor for integral type flanges (from Fig. 2-7.2) 
𝐹𝐿 = factor for loose type flanges (from Fig. 2-7.4) 

𝑓 = hub stress correction for integral flanges from Fig. 2-7.6 (when greater than one, this 
 is the ratio of the stress in the small end of hub to the stress in the large end), (for 
 values below limit of figure, use f = 1.) 

𝐺 = diameter at location of gasket load reaction 

𝑔0 = thickness of hub at small end 

𝑔1 = thickness of hub at back of flange 

𝐻 = total hydrostatic end force = 0.785𝐺2𝑃 

𝐻𝐷 = hydrostatic end force on area inside of flange =0.785𝐵2𝑃 

𝐻𝐺  = gasket load (difference between flange design bolt load and total hydrostatic end 
 force) = W – H 

𝐻𝑃 = total joint-contact surface compression load = 2b x 3.14 𝐺𝑚𝑃 

𝐻𝑇 = difference between total hydrostatic end force and the hydrostatic end force on area 

 inside of flange = 𝐻 − 𝐻𝐷 

ℎ = hub length 



Flange Qualification  
 

685 
 

ℎ𝐷 =  radial distance from the bolt circle, to the circle on which HD acts, as prescribed in 
 Table 2-6 

ℎ𝐺  =  radial distance from gasket load reaction to the bolt circle = 
𝐶−𝐺

2
 

ℎ𝑂 =  factor = √𝐵𝑔0 

ℎ𝑇 =  distance from the bolt circle, to the circle on which 𝐻𝑇 acts, as prescribed in Table  
 2-6 

𝐾 =  ratio of outside diameter of flange to inside diameter of flange = A / B 

𝐿 = factor = 
(𝑡𝑒+1)

𝑇
+
𝑡3

𝑑
 

𝑀𝐷 =  component of moment due to 𝐻𝐷 = 𝐻𝐷ℎ𝐷 

𝑀𝐺  =  component of moment due to 𝐻𝐺  = 𝐻𝐺ℎ𝐺  

𝑀𝑇 =  component of moment due to 𝐻𝑇 = 𝐻𝑇ℎ𝑇 

𝑀𝑂 =  total moment acting upon the flange for the operating conditions or gasket seating as 
 may apply 

𝑀𝑂 =  𝑊
(𝐶−𝐺)

2
for gasket seating condition 

𝑀𝑂 = 𝐻𝐷ℎ𝐷 + 𝐻𝐺ℎ𝐺 +𝐻𝑇ℎ𝑇for operating condition 

𝑁 =  width used to determine the basic gasket seating with 𝑏0, based upon the possible  
 contact width of the gasket (see Table 2-5.2) 

𝑃 =  internal design pressure 

𝑅 =  radial distance from bolt circle to point of intersection of hub and back of flange. For 
 integral and hub flanges, R = (C-B / 2) – g1 

𝑆𝑎 =  allowable bolt stress at reference temperature 

𝑆𝑏 =  allowable bolt stress at design temperature 

𝑆𝑓 =  allowable stress for material of flange at design temperature (operating condition) 

𝑆𝐻 =  calculated longitudinal stress in hub 

𝑆𝑅 =  calculated radial stress in flange 

𝑆𝑇 =  calculated tangential stress in flange 

𝑇 =  factor involving K (from Fig. 2-7.1) 

𝑡 =  flange thickness 

𝑈 =  factor involving K (from Fig. 2-7.1) 

𝑉 =  factor for integral type flanges (from Fig. 2-7.3) 

𝑉𝐿 =  factor for loose type flanges (from Fig. 2-7.5) 

𝑊 =  flange design bolt load, for the operating condition or gasket seating 

 =  𝑊𝑚1 for operating condition 

 = 
(𝐴𝑚+𝐴𝑏)𝑆𝑎

2
for gasket seating condition 

𝑊𝑚1= minimum required bolt load for the operating conditions 

𝑊𝑚1= minimum required bolt load for gasket seating 

𝑤 = nubbin width used to determine the basic gasket seating width 𝑏0, based on contact 
 width between the flange and the gasket (see Table 2-5.2)11 

𝑌 =  factor involving K (from Fig. 2-7.1) 

𝑦 =  gasket or joint-contact-surface unit seating load 

𝑍 =  factor involving K (from Fig. 2-7.1) 
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Calculation of Flange Stresses 

The stresses in the flange shall be determined for both the operating conditions and gasket 
seating condition, in accordance with the following formulas: 

(1) Integral type flanges 

Longitudinal hub stress 𝑆𝐻 = 
𝑓𝑀𝑂

𝐿𝑔1
2𝐵
< 1.5𝑆𝑓  

Radial flange stress 𝑆𝑅 = 
(1.33𝑡𝑒+1)𝑀𝑂

𝐿𝑡2𝐵
< 𝑆𝑓  

Tangential flange stress 𝑆𝑇 = 
𝑌𝑀𝑂

𝑡2𝐵
− 𝑍𝑆𝑅 < 𝑆𝑓  

Combined stress  
𝑆𝐻+𝑆𝑅

2
< 𝑆𝑓and 

𝑆𝐻 + 𝑆𝑇
2

< 𝑆𝑓 

(2) Loose type flanges with hubs 

Longitudinal hub stress 𝑆𝐻 = 
𝑓𝑀𝑂

𝐿𝑔1
2𝐵
< 1.5𝑆𝑓  

Radial flange stress 𝑆𝑅 = 
(1.33𝑡𝑒+1)𝑀𝑂

𝐿𝑡2𝐵
< 𝑆𝑓  

Tangential flange stress 𝑆𝑇 =
𝑌𝑀𝑂

𝑡2𝐵
− 𝑍𝑆𝑅 < 𝑆𝑓  

Combined stress  

𝑆𝐻+𝑆𝑅

2
< 𝑆𝑓and 

𝑆𝐻 + 𝑆𝑇
2

< 𝑆𝑓 

where, 

𝐿 =  factor = 
(𝑡𝑒+1)

𝑇
+
𝑡3

𝑑
 

𝑑 =  factor = 
𝑈

𝑉𝐿
ℎ𝑜𝑔0

2 for integral type flanges 

𝑒 =  factor =
𝐹𝐿

ℎ𝑜
 

𝑉𝐿 = factor for loose type flanges (from Fig. 2-7.5) 

𝐹𝐿 =  factor for loose type flanges (from Fig. 2-7.4) 

(3) Loose type flanges without hubs 

Longitudinal hub stress 𝑆𝐻 = 0 

Radial flange stress 𝑆𝑅 = 0 

Tangential flange stress 𝑆𝑇 =
𝑌𝑀𝑂

𝑡2𝐵
< 𝑆𝑓 
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Combined stress  

𝑆𝐻+𝑆𝑅

2
< 𝑆𝑓and 

𝑆𝐻 + 𝑆𝑇
2

< 𝑆𝑓 

where, 

𝐿 = factor =  

𝑑 = factor = 
2

00 gh
V

U

L

 

𝑒 = factor = 
o

L

h

F
 

𝑉𝐿 =  factor for loose type flanges (from Fig. 2-7.5) 

𝐹𝐿 =  factor for loose type flanges (from Fig. 2-7.4) 

(4) Optional type flanges (calculated as loose flanges without hubs) 

Longitudinal hub stress 𝑆𝐻 = 0 

Radial flange stress 𝑆𝑅 = 0 

Tangential flange stress 𝑆𝑇 =
𝑌𝑀𝑂

𝑡2𝐵
< 𝑆𝑓 

Combined stress  

𝑆𝐻+𝑆𝑅

2
< 𝑆𝑓and 

𝑆𝐻 + 𝑆𝑇
2

< 𝑆𝑓 

where, 

𝐿 = factor = d

t

T

te 3)1(




 

𝑑 = factor = 
2

00 gh
V

U

L

 

𝑒 = factor = 
o

L

h

F
 

𝑉𝐿 = factor for loose type flanges (from Fig. 2-7.5) 

𝐹𝐿 = factor for loose type flanges (from Fig. 2-7.4) 

 

d

t

T

te 3)1(
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(5) Reverse type flanges 

Longitudinal hub stress 𝑆𝐻 = 
𝑓𝑀𝑂

𝐿𝑟𝑔1
2𝐵′

< 1.5𝑆𝑓  

Radial flange stress 𝑆𝑅 = 
(1.33𝑡𝑒𝑟+1)𝑀𝑂

𝐿𝑟𝑡2𝐵′
< 𝑆𝑓  

Tangential flange stress 𝑆𝑟 =
𝑌𝑀𝑂

𝑡2𝐵
− 𝑍𝑆𝑅

0.67𝑡𝑒𝑟+1

1.33𝑡𝑒𝑟+1
< 𝑆𝑓  

Combined stress  

𝑆𝐻+𝑆𝑅

2
< 𝑆𝑓and 

𝑆𝐻 + 𝑆𝑇
2

< 𝑆𝑓 

where, 

𝐿𝑟 = factor = 
(𝑡𝑒𝑟+1)

𝑇
+

𝑡3

𝑑𝑟
 

𝑑𝑟 = factor = 
𝑈𝑟

𝑉
ℎ𝑜𝑔0

2 

𝑒𝑟 = factor = 
𝐹

ℎ𝑜
 

ℎ𝑜 = factor =√𝐴𝑔0 

𝛼𝑟 = 
1+0.668

(𝐾+1)

𝑌

𝐾2
 

𝑇𝑟 = 
𝑍+0.3

𝑍−0.3
𝛼𝑟𝑇 

𝑈𝑟 = 𝛼𝑌𝑈 

𝑌𝑟 = 𝛼𝑌𝑌 
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Problem 1: 

(Example from “Taylor Forge & Pipe Works, 1961”) 

Flange Details: 

Flange Type : Loose Flanges with Hubs 
Flange Outside Diameter [A] = 40.375 (inch) 
Flange Inside Diameter [B]  = 33.25 (inch) 
Inside Diameter of Reverse Flange [B']  = 20 (inch) 
Flange Thickness [t] = 2.125 (inch) 
Small End Hub Thickness [g0] = 0.875 (inch) 
Large End Hub Thickness [g1] = 1.125 (inch) 
Hub Length [h] = 2.5 (inch) 
All. Stress @ Design Temp [sf] = 17500 (psi) 
All. Stress @ Ref. Temp [sfa] = 17500 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 38.25 (inch) 
Number of Bolts = 44 
Bolt Diameter = 1 (inch) 
All. Stress @ Ref. Temp [sa] = 20000 (psi) 
All. Stress @ Design Temp [sb] = 20000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 35.75 (inch) 
Gasket Inner Diameter = 34.25 (inch) 
Leak Pressure Ratio [m] = 2.75 
Gasket Seating Stress [y] = 3700 (psi) 
Facing Sketch = 1 
Facing Column = 1 

Load Data: 

Design Pressure = 400 (psi) 
Design Temperature = 500 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 
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Comparison of Results: 

Flange Stresses Text Book Results 
(psi) 

CAEPIPE 
(psi) 

CAESAR II 
(psi) 

Operating condition    

Longitudinal Hub (SH) 20800 21153 21214 

Radial Flange (SR)              11100 11110 11155 

Tangential Flange (ST) 13800 13826 13797 

0.5(SH + SR) 15950 16132 16185 

0.5(SH + ST) 17300 17489 17506 

Gasket Seating Condition    

Longitudinal Hub (SH) 14400 14623 15095 

Radial Flange (SR)              7660 7681 7938 

Tangential Flange (ST) 9500 9558 9818 

0.5(SH + SR) 11030 11152 11517 

0.5(SH + ST) 11950 12091 12457 

Problem 2: 

(Example 10.5 on page 209 Chapter 10 on “CASTI Guidebook to ASME Section VIII Div.1 
– Pressure Vessels – Third Edition”) 

Flange Details: 

Flange Type : Reverse Flanges 
Flange Outside Diameter [A] = 49 (inch) 
Flange Inside Diameter [B]  = 48.25 (inch) 
Inside Diameter of Reverse Flange [B']  = 20.25 (inch) 
Flange Thickness [t] = 5.25 (inch) 
Small End Hub Thickness [g0] = 0.375 (inch) 
Large End Hub Thickness [g1] = 1.375 (inch) 
Hub Length [h] = 6 (inch) 
All. Stress @ Design Temp [sf] = 12000 (psi) 
All. Stress @ Ref. Temp [sfa] = 20000 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 44 (inch) 
Number of Bolts = 32 
Bolt Diameter = 1.25 (inch) 
All. Stress @ Ref. Temp [sa] = 25000 (psi) 
All. Stress @ Design Temp [sb] = 21000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 24 (inch) 
Gasket Inner Diameter = 22 (inch) 
Leak Pressure Ratio [m] = 2.50 
Gasket Seating Stress [y] = 10000 (psi) 
Facing Sketch = 1 
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Facing Column = 1 

Load Data: 

Design Pressure = 150 (psi) 
Design Temperature = 800 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 

Comparison of Results: 

Flange Stresses Text Book Results 
(psi) 

CAEPIPE 
(psi) 

CAESAR II 
(psi) 

Operating condition    

Longitudinal Hub (SH) 2060 2257 2055 

Radial Flange (SR)              280 307 280 

Tangential Flange (ST) 1340 1314 1336 

0.5(SH + SR) 1170 1282 1168 

0.5(SH + ST) 1700 1785 1695 

Gasket Seating Condition    

Longitudinal Hub (SH) 9220 10082 9220 

Radial Flange (SR)              1260 1372 1257 

Tangential Flange (ST) 6000 7004 5997 

0.5(SH + SR) 5240 5727 5239 

0.5(SH + ST) 7610 8543 8703 

 

Problem 3: 

(Example from KEDKEP CONSULTING, INC. dated May 27, 2008) 

Flange Details: 

Flange Type : Loose Flanges without Hubs / Optional Flanges 
Flange Outside Diameter [A] = 38.4 (inch) 
Flange Inside Diameter [B] = 32 (inch) 
Inside Diameter of Reverse Flange [B'] = 32 (inch) 
Flange Thickness [t] = 4 (inch) 
Small End Hub Thickness [g0] = 0.001 (inch) 
Large End Hub Thickness [g1] = 0.001 (inch) 
Hub Length [h] = 0.001 (inch) 
All. Stress @ Design Temp [sf] = 20000 (psi) 
All. Stress @ Ref. Temp [sfa] = 20000 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 36 (inch) 
Number of Bolts = 28 
Bolt Diameter = 1 (inch) 
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All. Stress @ Ref. Temp [sa] = 25000 (psi) 
All. Stress @ Design Temp [sb] = 25000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 32.75 (inch) 
Gasket Inner Diameter = 32 (inch) 
Leak Pressure Ratio [m] = 0.50 
Gasket Seating Stress [y] = 0 (psi) 
Facing Sketch = 2 
Facing Column = 2 

Load Data: 

Design Pressure = 300 (psi) 
Design Temperature = 295 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 

Comparison of Results: 

Flange Stresses Text Book Results 
(psi) 

CAEPIPE 
(psi) 

CAESAR 
II 
(psi) 

Operating Condition 

Longitudinal Hub (SH) 0 0 3 

Radial Flange (SR) 0 0 0 

Tangential Flange (ST) 10577 10569 10618 

0.5(SH + SR) 0 0 1.5 

0.5(SH + ST) 0 0 5310.5 

Bolt Stress 16378 16371 16445 

Gasket Seating Condition 

Longitudinal Hub (SH) 0 0 3 

Radial Flange (SR) 0 0 0 

Tangential Flange (ST) 12147 11987 12166 

0.5(SH + SR) 0 0 1.5 

0.5(SH + ST) 0 0 6085 

Bolt Stress 0 0 124 

 



 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This page is blank



 

 
 

 

 

 

 

 
 

 

Pressure Design of Pipe & Pipe Fittings 

as per EN 13480-3 (2017) 



Pressure Design of Pipe & Pipe fittings according to SS EN 13480-3 (2017) 

 

702 
 

Internal pressure according to SS EN 13480-3 (2017) 

Straight Pipes 

The minimum required wall thickness for a straight pipe without allowances and tolerances, 
ep, is calculated from equation 6.1-1 and 6.1-3 depending on the ratio between inner and 
outer diameter as follows: 

For Do/Di<= 1.7 

ep =  
PcD0

2fz + Pc
  

For Do/Di> 1.7 

ep =  
Do
2
[1 − √

fz − pc
fz + pc

]   

where, 

Do = outside diameter of pipe 

Di = inside diameter of pipe = Do – 2 x en 

en = nominal wall thickness of pipe 

f = Allowable stress for material at maximum temperature 

z = weld efficiency factor = 1.0 

pc = maximum internal pressure = maximum of CAEPIPE input pressures P1 through P10 

ep = minimum required wall thickness 

 

Elbows 

The minimum required wall thickness of the intrados and the extrados of the elbow without 
allowances and tolerances, ep1 / ep2, is calculated from equation B.4.1-3 

ep1 = ep2 = e.B 

B =  
D0
2e
−
R

e
+ √[

D0
2e
−
R

e
]
2

+ 2
R

e
−
D0
2e

 

where 

Do = outside diameter of elbow 

e = minimum required wall thickness of corresponding straight pipe computed as per Eq. 
6.1-1 or 6.1-3 

R = radius of the elbow 
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ep1 = ep2 = minimum required wall thickness of the elbow 

Bends (formed by cold bending of straight pipes) 

Wall thickness of the intrados of the bend 

The minimum required wall thickness of the intrados of the bend without allowances and 
tolerances, ep1, is calculated from equation B.4.1-1 

ep1 = e .Bint 

Bint =  
D0
2e
+
r

e
− [
Do
2e
+
r

e
− 1]√

(
r

e
)
2

− (
Do

2e
)
2

(
r

e
)
2

−
Do

2e
(
Do

2e
− 1)

 

r/e is calculated from 

r

e
=  √

1

2
{(
Do
2e
)
2

+ (
R

e
)
2

} + √
1

4
((
Do
2e
)
2

+ (
R

e
)
2

)

2

−
Do
2e
(
Do
2e
− 1) (

R

e
)
2

 

where 

Do = outside diameter of bend 

Di = inside diameter of bend = Do – 2 x en 

e = minimum required wall thickness of corresponding straight pipe computed as per Eq. 
6.1-1 or 6.1-3 

R = radius of the bend 

ep1 = minimum required wall thickness of the intrados 

 

Wall thickness of the extrados of the bend 

The minimum required wall thickness of the extrados of the bend without allowances and 
tolerances, ep2, is calculated from equation B.4.1-8 

ep2 = e .Bext 

Bext =  
D0
2e
−
r

e
− [
Do
2e
−
r

e
− 1]√

(
r

e
)
2

− (
Do

2e
)
2

(
r

e
)
2

−
Do

2e
(
Do

2e
− 1)

 

r/e is calculated from 

r

e
=  √

1

2
{(
Do
2e
)
2

+ (
R

e
)
2

} + √
1

4
((
Do
2e
)
2

+ (
R

e
)
2

)

2

−
Do
2e
(
Do
2e
− 1) (

R

e
)
2
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where 

Do = outside diameter of bend 

Di = inside diameter of bend = Do – 2 x en 

e = minimum required wall thickness of corresponding straight pipe computed as per Eq. 
6.1-1 or 6.1-3 

R = radius of the bend 

ep2 = minimum required wall thickness of the extrados 

Reducers 

 

Junction between the large end of a cone and a cylinder without a knuckle 

The minimum required wall thickness (e1) of the larger cylinder adjacent to the junction is 
calculated from Subsection 6.4.6.2 as the greater of ecyl and ej where ej is determined from 

β =
1

3
√
Dc
ej

tan ∝

1 +
1

√cos∝

− 0.15                                       (Eq. 6.4.6 − 2) 

ej =  
pcβDc
2f

                                                                          (Eq. 6.4.6 − 1) 

The value of ej is acceptable, if the value given by Eq. 6.4.6-1 is not less than that assumed in 
Eq. 6.4.6-2 

econ =
pcDe

2fZ + pc

1

COS(α)
                                                (Eq. 6.4.4 − 2) 

   

  ecyl =
pcD01

2fZ+pc
 

e1 = thickness of larger cylinder = max (ej, ecyl) 

e3 = thickness of cone shell = max (ej, econ) 

where 

De = outside diameter of the cone 

D01 = outside diameter of the larger cylinder 
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D02 = outside diameter of the small cylinder 

Dc = mean diameter of the larger cylinder at the junction with the cone = D01 - en 

en = nominal wall thickness of the larger cylinder at the junction with the cone 

∝ = cone angle 

e1 = minimum required wall thickness for larger cylinder adjacent to the junction. 

e3 = minimum required wall thickness at cone. 

f = Allowable stress for material at maximum temperature 

pc = maximum internal pressure = maximum of CAEPIPE input pressures P1 through P10 

Z = weld efficiency factor = 1.0 

Junction between the small end of a cone and a cylinder without a knuckle 

The minimum required wall thickness (e2) of the small cylinder adjacent to the junction is 
calculated according to Subsection 6.4.8.2 as follows. 

s =  
e3
ej2

 

With e3 already determined in the earlier section, assume value of ej2 and calculate the values 

of s, τ and βH 

When s < 1.0, then 

τ = s√
s

cos ∝
+ √

1 + s2

2
 

When s >= 1.0, then 

τ = 1 + √s
1 + s2

2cos ∝
 

 

βH = 0.4√
Dc
ej2

tan ∝

τ
+ 0.5                             (Eq.  6.4.8 − 4) 

ej2 =  
pcDcβH
2fZ

                                                  (Eq. 6.4.8 − 5) 
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The value of ej2 is acceptable, if the value given by Eq. 6.4.8-5 is not less than that assumed 
for Eq. 6.4.8-4 

ecyl =
pcD02
2fZ + pc

 

e2 = max (ej2, ecyl) 

where 

D02 = outside diameter of the small cylinder at the junction with the cone 

Dc = mean diameter of the small cylinder at the junction with the cone = D02 - en 

en = nominal wall thickness of the small cylinder at the junction with the cone 

∝ = cone angle 

e2 = minimum required wall thickness of the small cylinder at the junction with the cone 

f = Allowable stress for material at maximum temperature 

pc = maximum internal pressure = maximum of CAEPIPE input pressures P1 through P10 

Z = weld efficiency factor = 1.0 
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External Pressure Design according to SS EN 13480-3 (2017) 

Pipes, Elbows, Mitre Bends and Reducers 

Interstiffener collapse 

The thickness of the pipe within the unstiffened length L shall not be less than that 
determined by the following. 

Pr ≥ k. Pc 

Py =
Sea
Rm

 

Pm =
Eteaε

Rm
 

ε =
1

𝑛𝑐𝑦𝑙
2 − 1 +

Z2

2 {
 

 
1

(
𝑛𝑐𝑦𝑙
2

Z2
+ 1)

2 +
ea2

12Rm2(1−v2)

(𝑛𝑐𝑦𝑙
2 − 1 + Z2)

2

}
 

 

 

Z =
πRm
L

 

using the calculated value of Pm/Py, Pr/Py is determined from Table 9.3.2.1 of Subsection 
9.3.2 

where 

ncyl = integer >= 2 to minimize the value of Pm.  

CAEPIPE goes through an iterative routine by increasing the value of ncyl from 2 and above 
until the minimum collapse pressure (pm) is reached. 

Rm = mean radius of the pipe 

L = length between the stiffener, is calculated from CAEPIPE input as follows 

for Pipe, L = length of pipe (= distance between the “From” and “To” node of CAEPIPE) 

for Elbow and Miter bend, L = arc length measured on extrados of elbow and miter bend 

for Reducer, L = Length of the reducer 

Et = Young’s modulus of material at design temperature (max of CAEPIPE Temperature T1 
through T10) 

ea = analysis thickness of reducer at smaller end = en – corr.all – mill tolerance 

en = nominal thickness of reducer at smaller end 

k = factor = 1.5 

Pc = external pressure = maximum negative CAEPIPE input pressures P1 through P10 
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S = elastic stress limits for pipe and stiffener for External Pressure Design 

= “Rp0.2t” for non-austenitic steels  

= “Rp0.2t/1.25” for austenitic steels  

Note: 

Generally, allowable stress is (2/3) x Yield. So, for Piping code = EN 13480-3, the value of 
Rp0.2t is computed as “Rp0.2t = f  x 1.5” 

For all other Piping Codes, the value of Rp0.2t is computed as “Rp0.2t = allowable stress x 
1.5”. 

Additional check for Reducers 

In addition to the above, as stated in Subsection 9.4.2 of EN 13480-3, the moment of inertia, 
Ix taken parallel to the axis of the cylinder, of the part of the cone and cylinder with a 

distance of √Deq. e on either side of the junction is not less than: 

Ix = 0.18DeqLDs
2
pc
Et
≤ Ixa 

where 

Deq = equivalent diameter = 

D1+D2
2

cos (α)
 

D1 = outside diameter of larger end of reducer 

D2 = outside diameter of smaller end of reducer 

α =cone angle of reducer input in CAEPIPE 

Ixa = moment of inertia of reducer at smaller end 

Ds = diameter of the centroid of the moment of inertia of the stiffening cross section 
calculated as shown below 

Icone = (√Deqe1. e1) (
Dmcon
2

)
2

= (Acone) (
Dmcon
2

)
2

 

ICyl = (√Deqe2. e2) (
Dmcyl

2
)
2

= (Acyl) (
Dmcyl

2
)
2

 

Istiff = (Acone + Acyl) (
Ds
2
)
2

 

From the above,  

Icone + ICyl = Istiff 

and 
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Ds = 2√
Istiff

(Acone + Acyl)
 

e1 = analysis thickness of reducer at larger end = en1 – corr.all – mill tolerance  

e2 = analysis thickness of reducer at smaller end = en2 – corr.all – mill tolerance 

en1& en2 = nominal thickness of reducer at larger end and smaller end respectively
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Rectangular Cross-section Welded Attachments 

 

The notations described below are used in the formulas for the design. 

𝐿1=half length of attachment in circumferential direction of the run pipe  

𝐿2= half length of attachment in longitudinal direction of the run pipe  

𝑅= mean pipe radius 

𝐷𝑜=outside diameter of run pipe 

𝑇= nominal run pipe wall thickness  

𝐿𝑎= lesser of L2 and T  

𝐿𝑏= lesser of L1 and T  

𝐿𝑐= lesser of L1 and L2 

𝐿𝑑= greater of L1 and L2 

𝐴𝑇 = 4. 𝐿1. 𝐿2= cross-sectional area of the rectangular attachment 

𝑍𝑡𝐿 = (
4

3
) . 𝐿1. 𝐿2

2 

𝑍𝑡𝑁 = (
4

3
) . 𝐿1

2. 𝐿2 

𝛽1 =
𝐿1
𝑅

 

𝛽2 =
𝐿2
𝑅

 

𝛾 =
𝑅

𝑇
 

Limits of Applicability 

𝜷𝟏 ≤ 𝟎. 𝟓 

𝜷𝟐 ≤ 𝟎. 𝟓 

𝜷𝟏. 𝜷𝟐 ≤ 𝟎. 𝟕𝟓 

𝑀𝐿 = bending moment applied to the attachment as shown in figure above 
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𝑀𝑁 = bending moment applied to the attachment as shown in figure above 

𝑀𝑇 = torsional moment applied to the attachment as shown in figure above 

𝑄1 = shear load applied to the attachment as shown in figure above. 

𝑄2 = shear load applied to the attachment as shown in figure above 
W  = thrust load applied to the attachment as shown in figure above 
 
ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of 
attachment loads used in the stress calculation are based on the loads used in the different 
code equations. 
 
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring 
simultaneously under all service loading conditions.  

Calculate 𝜼, 𝑿𝟏 𝒂𝒏𝒅 𝒀𝟏 using the factors listed in Table below. 

Load Index Ao 𝜃 𝑋𝑜 𝑌𝑜 
Thrust (W)  CW 2.2 400 0 0.05 

Longitudinal Moment (ML) CL 2.0 500 -0.45 -0.55 
Circumferential Moment (MN) CN 1.8 400 -0.75 -0.60 

𝑋1 = 𝑋𝑜 + 𝑙𝑜𝑔10𝛽1 

𝑌1 = 𝑌𝑜 + 𝑙𝑜𝑔10𝛽2 

𝜂 = −(𝑋1𝐶𝑜𝑠𝜃 + 𝑌1𝑆𝑖𝑛𝜃) −
1

𝐴𝑜
(𝑋1𝑆𝑖𝑛𝜃 − 𝑌1𝐶𝑜𝑠𝜃)

2 

𝐶𝑊 = 3.82(𝛾)1.64𝛽1𝛽2𝜂
1.54but not less than 1.0 

𝐶𝐿 = 0.26(𝛾)1.74𝛽1𝛽2
2𝜂4.74but not less than 1.0 

𝐶𝑁 = 0.38(𝛾)
1.90𝛽1

2𝛽2𝜂
3.40but not less than 1.0 

𝐵𝐿 = (2/3) CL but not less than 1.0 

𝐵𝑁 = (2/3) CN but not less than 1.0 

𝐵𝑊 = (2/3) CW but not less than 1.0 

𝐾𝑇 = 2.0 for full penetration weldsandfillet or partial penetration welds welded on 4 sides 
 = 3.6 for fillet or partial penetration welds welded on 2 or 3 sides 
SA= f(1.25Sc+0.25Sh) as defined in NC/ND-3611.2 (lesser of pipe or attachment material allowable) 
Sc= allowable stress at ambient temperature (lesser of pipe or attachment material allowable) 
Sh= allowable stress at Max. Temperature (lesser of pipe or attachment material allowable) 
Sy= yield stress (lesser of pipe or attachment material yield stress) 
 

(A) Calculate Pipe Stress SMTS due to Sustained Loads on Attachment 

𝑀𝑇𝑇𝑆 = 𝑚𝑎𝑥(
𝑀𝑇𝑆

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝑆

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑀𝑇𝑆 =
𝐵𝑊𝑊𝑆

𝐴𝑇
+
𝐵𝑁𝑀𝑁𝑆

𝑍𝑡𝑁
+
𝐵𝐿𝑀𝐿𝑆

𝑍𝑡𝐿
+

𝑄1𝑆
2𝐿1𝐿𝑎

+
𝑄2𝑆
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝑆 
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where 

WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight 
and Other Sustained Loads 

MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment 
due to Weight and Other Sustained Loads 

Note: Absolute values of Forces and Moments are used while calculating SMTS 
Stresses. 

(B) Calculate PipeStress SMTO due to Occasional Loads on Attachment 

𝑀𝑇𝑇𝑂 = 𝑚𝑎𝑥 (
𝑀𝑇𝑂

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝑂

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑀𝑇𝑂 =
𝐵𝑊𝑊𝑜
𝐴𝑇

+
𝐵𝑁𝑀𝑁𝑂

𝑍𝑡𝑁
+
𝐵𝐿𝑀𝐿𝑂

𝑍𝑡𝐿
+

𝑄1𝑂
2𝐿1𝐿𝑎

+
𝑄2𝑂
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝑂 

where 

WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to 
Occasional Loads such as Wind or Seismic 

MTO, MLO and MNO are the torsional moment and bending moments applied at the 
attachment due to Occasional Loads such as Wind or Seismic 

Note: Absolute values of Forces and Moments are used while calculating SMTO 
Stresses. 

(C) Calculate PipeStresses SNTE and SPTE due to Thermal Loads on Attachment 

𝑀𝑇𝑇𝐸 = 𝑚𝑎𝑥 (
𝑀𝑇𝐸

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝐸

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑁𝑇𝐸 =
𝐶𝑊𝑊𝐸

𝐴𝑇
+
𝐶𝑁𝑀𝑁𝐸

𝑍𝑡𝑁
+
𝐶𝐿𝑀𝐿𝐸

𝑍𝑡𝐿
+

𝑄1𝐸
2𝐿1𝐿𝑎

+
𝑄2𝐸
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝐸 

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸 

where 

WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to 
Thermal Loads 

MTE, MLE and MNE are the torsional moment and bending moments applied at the 
attachment due to Thermal Loads 

Note: Absolute values of Forces and Moments are used while calculating SNTE 
Stresses. 
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(D) Calculate PipeStresses SNTD and SPTD due to Settlement Loads on Attachment 

𝑀𝑇𝑇𝐷 = 𝑚𝑎𝑥(
𝑀𝑇𝐷

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝐷

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑁𝑇𝐷 =
𝐶𝑊𝑊𝐷

𝐴𝑇
+
𝐶𝑁𝑀𝑁𝐷

𝑍𝑡𝑁
+
𝐶𝐿𝑀𝐿𝐷

𝑍𝑡𝐿
+

𝑄1𝐷
2𝐿1𝐿𝑎

+
𝑄2𝐷
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝐷 

𝑆𝑃𝑇𝐷 = 𝐾𝑇 . 𝑆𝑁𝑇𝐷 

where 

WD, Q1D and Q2D are the thrust load and shear forces applied at the attachment due to 
Settlement Loads 

MTD, MLD and MND are the torsional moment and bending moments applied at the 
attachment due to Settlement Loads 

Note: Absolute values of Forces and Moments are used while calculating SNTD 
Stresses. 

(E) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads 

SMTR = Stress SMTS calculated in Subsection A above 

SPTR = Stress SPTE calculated in Subsection C above  

(F) Calculate Attachment Stresses: SNT** due to Abs. Max. Loads 

𝑀𝑇𝑇
∗∗ = 𝑚𝑎𝑥(

𝑀𝑇
∗∗

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇
∗∗

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑁𝑇
∗∗ =

𝐶𝑊𝑊
∗∗

𝐴𝑇
+
𝐶𝑁𝑀𝑁

∗∗

𝑍𝑡𝑁
+
𝐶𝐿𝑀𝐿

∗∗

𝑍𝑡𝐿
+
𝑄1

∗∗

2𝐿1𝐿𝑎
+
𝑄2

∗∗

2𝐿2𝐿𝑏
+𝑀𝑇𝑇

∗∗ 

Analysis of Attachment Welded to Pipe with a Full Penetration Weld 

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh 

Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy 

Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA 

Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh 

Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA) 

Additional Check 

SNT** ≤ 2.Sy 

|
𝑄1

∗∗

2𝐿1𝐿𝑎
+
𝑄2

∗∗

2𝐿2𝐿𝑏
+𝑀𝑇𝑇

∗∗| ≤ 𝑆𝑌 

  



ASME Section III, Division 1 – Appendix Y – NC/ND (2010) – Article Y-3000 

 

715 
 

Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld 

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh 

Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy 

Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA 

Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh 

Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA) 

Additional Check 

|SNT**|≤ 2.Sy 

|
𝑄1

∗∗

2𝐿1𝐿𝑎
+
𝑄2

∗∗

2𝐿2𝐿𝑏
+𝑀𝑇𝑇

∗∗| ≤ 𝑆𝑌 

Note: Additional compliance check as per Eq. 7 and Eq. 8 of Y-3420 (b) are not 
performed in CAEPIPE at this time 

 

where,  

k = 1.5 for Level A& B loadings, 1.8 for Level C loadings and 2.0 for Level D loadings 

SL = Sustained Stress on Run Pipe as per NC-3652 Eq. (8) 

SLO = Sustained + Occasional Stress on Run Pipe as per NC-3653.1 Eq. (9) 

SE = Thermal Stress on Run Pipe as per NC-3653.2 Eq. (10) 

SD = Settlement Stress on Run Pipe as per NC-3653.2 Eq. (10a) 

STE = Sustained + Thermal Stress on Run Pipe as per NC-3653.2 Eq. (11) 

SMTS = Pipe Stress SMTS computed in Subsection A above 

SMTO = Pipe Stress SMTO computed in Subsection B above 

SPTE = Pipe Stress SPTE computed in Subsection C above 

SPTD = Pipe Stress SPTD computed in Subsection D above 

SMTR = Pipe Stress SMTR computed in Subsection E above 

SPTR = Pipe Stress SPTR computed in Subsection E above 

SNT**= Pipe Stress SNT** computed in Subsection F above 
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HollowCircular Cross-section Welded Attachments 

 

The notations described below are used in the formulas for the design. 

𝑅= mean run pipe radius  

𝑅𝑜= run pipe outside radius 

𝑟𝑜= attachment outside radius 

𝑟𝑖= attachment inside radius 

𝐷𝑜 =  outside diameter of run pipe 

𝑑𝑜 =  outside diameter of attachment 

𝑇= nominal run pipe wall thickness  

𝑡= nominal attachment wall thickness  

𝐴𝑇 = 𝜋(𝑟𝑜
2 − 𝑟𝑖

2)= cross-sectional area of the circular attachment 

𝐼𝑇 = 
𝜋

4
(𝑟𝑜

4 − 𝑟𝑖
4) 

𝑍𝑇 = 
𝐼𝑇
𝑟𝑜

 

𝐽 =  min(𝜋𝑟𝑜
2𝑇,   𝑍𝑇) 

𝛾 =  
𝑅𝑜
𝑇

 

𝛽 = 
𝑑𝑜
𝐷𝑜

 

𝜏 =  
𝑡

𝑇
 

Limits of Applicability 

𝟒. 𝟎 ≤  𝜸 ≤ 𝟓𝟎 

0.2 ≤ 𝜏 ≤ 1.0 

0.3 ≤ 𝛽 ≤ 1.0 
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𝑀𝐿 = bending moment applied to the attachment as shown in figure above 

𝑀𝑁 = bending moment applied to the attachment as shown in figure above 

𝑀𝑇 = torsional moment applied to the attachment as shown in figure above 

𝑄1 = shear load applied to the attachment as shown in figure above. 

𝑄2 = shear load applied to the attachment as shown in figure above 
W  = thrust load applied to the attachment as shown in figure above 
 
ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of 
attachment loads used in the stress calculation are based on the loads used in the different 
code equations. 
 
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring 
simultaneously under all service loading conditions.  

 
𝐶 = 𝐴𝑜(2𝛾)

𝑛1𝛽𝑛2𝜏𝑛3but not less than 1.0 

Equation for C is used to determine CW, CL and CN based on the following Table. Maximum 
values of CW, CL and CNamong the values calculated for the pipe and the attachment are used 
subsequently. 

Load Index Part 𝛽 range Ao n1 n2 n3 

Thrust (W) CW Pipe 0.3 to1.0 1.40 0.81 (a) 1.33 
Attachment 0.3 to1.0 4.00 0.55 (b) 1.00 

Longitudinal 
Moment (ML) 

CL Pipe 0.3 to1.0 0.46 0.60 -0.04 0.86 
Attachment 0.3 to1.0 1.10 0.23 -0.38 0.38 

Circumferential 
Moment (MN) 

CN Pipe 0.3 to 0.55 0.51 1.01 0.79 0.89 
Attachment 0.3 to 0.55 0.84 0.85 0.80 0.54 

Circumferential 
Moment (MN) 

CN Pipe >0.55 to 1.0 0.23 1.01 -0.62 0.89 
Attachment >0.55 to 1.0 0.44 0.85 -0.28 0.54 

(a) - Replace 𝛽𝑛2 with 𝑒−1.2𝛽
3
 

(b) - Replace 𝛽𝑛2 with 𝑒−1.35𝛽
3
 

 

𝐶𝑇 = 1.0 for 𝛽<= 0.55 

 = CN for 𝛽 = 1.0, but not less than 1.0;  

CT should be linearly interpolated for 0.55 <= 𝛽< 1.0, but not less than 1.0 
 

𝐵𝑊 = 0.5 CW but not less than 1.0 

𝐵𝐿 = 0.5 CL but not less than 1.0 

𝐵𝑁 = 0.5 CN but not less than 1.0 

𝐵𝑇 = 0.5 CT but not less than 1.0 

𝐾𝑇 = 1.8 for full penetration welds 
 = 2.0 for fillet or partial penetration welds 
SA = f(1.25Sc + 0.25Sh) as defined in NC/ND-3611.2 (lesser of pipe or attachment material allowable) 
Sc = allowable stress at ambient temperature (lesser of pipe or attachment material allowable) 
Sh = allowable stress at maximum temperature (lesser of pipe or attachment material allowable) 
Sy = yield stress (lesser of pipe or attachment material yield stress) 
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ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of 
attachment loads used in the stress calculation are based on the loads used in the different 
code equations. 
 
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring 
simultaneously under all service loading conditions.  

 (A) Calculate PipeStress SMTS due to Sustained Loads on Attachment 

𝑆𝑀𝑇𝑆 =
𝐵𝑊𝑊𝑆

𝐴𝑇
+
𝐵𝑁𝑀𝑁𝑆

𝑍𝑇
+
𝐵𝐿𝑀𝐿𝑆

𝑍𝑇
+
2𝑄1𝑆
𝐴𝑇

+
2𝑄2𝑆
𝐴𝑇

+
𝐵𝑇𝑀𝑇𝑆

𝐽
 

where 

WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight 
and Other Sustained Loads 

MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment 
due to Weight and Other Sustained Loads 

Note: Absolute values of Forces and Moments are used while calculating SMTS 
Stresses. 

(B) Calculate PipeStress SMTO due to Occasional Loads on Attachment 

𝑆𝑀𝑇𝑂 =
𝐵𝑊𝑊𝑂

𝐴𝑇
+
𝐵𝑁𝑀𝑁𝑂

𝑍𝑇
+
𝐵𝐿𝑀𝐿𝑂

𝑍𝑇
+
2𝑄1𝑂
𝐴𝑇

+
2𝑄2𝑂
𝐴𝑇

+
𝐵𝑇𝑀𝑇𝑂

𝐽
 

where 

WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to 
Occasional Loads such as Wind or Seismic 

MTO, MLO and MNO are the torsional moment and bending moments applied at the 
attachment due to Occasional Loads such as Wind or Seismic 

Note: Absolute values of Forces and Moments are used while calculating SMTO 
Stresses. 

(C) Calculate PipeStresses SNTE and SPTE due to Thermal Loads on Attachment 

𝑆𝑁𝑇𝐸 =
𝐶𝑊𝑊𝐸

𝐴𝑇
+
𝐶𝑁𝑀𝑁𝐸

𝑍𝑇
+
𝐶𝐿𝑀𝐿𝐸

𝑍𝑇
+
2𝑄1𝐸
𝐴𝑇

+
2𝑄2𝐸
𝐴𝑇

+
𝐶𝑇𝑀𝑇𝐸

𝐽
 

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸 

where 

WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to 
Thermal Loads 

MTE, MLE and MNE are the torsional moment and bending moments applied at the 
attachment due to Thermal Loads 

Note: Absolute values of Forces and Moments are used while calculating SNTE 
Stresses. 
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(D) Calculate PipeStresses SNTD and SPTD due to Settlement Loads on Attachment 

𝑆𝑁𝑇𝐷 =
𝐶𝑊𝑊𝐷

𝐴𝑇
+
𝐶𝑁𝑀𝑁𝐷

𝑍𝑇
+
𝐶𝐿𝑀𝐿𝐷

𝑍𝑇
+
2𝑄1𝐷
𝐴𝑇

+
2𝑄2𝐷
𝐴𝑇

+
𝐶𝑇𝑀𝑇𝐷

𝐽
 

𝑆𝑃𝑇𝐷 = 𝐾𝑇 . 𝑆𝑁𝑇𝐷 

where 

WD, Q1D and Q2D are the thrust load and shear forces applied at the attachment due to 
Settlement Loads 

MTD, MLD and MND are the torsional moment and bending moments applied at the 
attachment due to SettlementLoads 

Note: Absolute values of Forces and Moments are used while calculating SNTD 
Stresses. 

(E) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads on 
Attachment 

SMTR = Stress SMTS calculated in Subsection A above 

SPTR = Stress SPTE calculated in Subsection C above  

(F) Calculate Attachment Stresses: SNT** due to Abs. Max. Loads 

𝑆𝑁𝑇
∗∗ =

𝐶𝑊𝑊
∗∗

𝐴𝑇
+
𝐶𝑁𝑀𝑁

∗∗

𝑍𝑇
+
𝐶𝐿𝑀𝐿

∗∗

𝑍𝑇
+
2𝑄1

∗∗

𝐴𝑇
+
2𝑄2

∗∗

𝐴𝑇
+
𝐶𝑇𝑀𝑇

∗∗

𝐽
 

Analysis of Attachment Welded to Pipe with a Full Penetration Weld 

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh 

Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy 

Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA 

Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh 

Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA) 

Additional Check 

|SNT**|≤ 2.Sy 

|
2𝑄1

∗∗

𝐴𝑇
+
2𝑄2

∗∗

𝐴𝑇
+
𝑀𝑇

∗∗

𝐽
| ≤ 𝑆𝑌 

Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld 

Sustained Stress (SSL) = SL + SMTS≤ 1.5Sh 

Occasional Stress (SSO) = SLO + SMTS + SMTO≤k.Sy 

Thermal Stress (SSE) = SE + (SPTE / 2.0) ≤ SA 

Settlement Stress (SSD) = SD + (SPTD / 2.0) ≤ 3.0Sh 

Sustained + Thermal Stress (SSR) = STE + SMTR + (SPTR / 2.0) ≤ (Sh + SA) 
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Additional Check 

|SNT**|≤ 2.Sy 

|
2𝑄1

∗∗

𝐴𝑇
+
2𝑄2

∗∗

𝐴𝑇
+
𝑀𝑇

∗∗

𝐽
| ≤ 𝑆𝑌 

Note: Additional compliance checks as per Eq. 7 and Eq. 8 of Y-5420 (b) are not 
performed in CAEPIPE at this time 

 

where,  

k = 1.5 for Level A& B Loadings, 1.8 for Level C loadings and 2.0 for Level D loadings 

SL = Sustained Stress on Run Pipe as per NC-3652 Eq. (8) 

SLO = Sustained + Occasional Stress on Run Pipe as per NC-3653.1 Eq. (9) 

SE = Thermal Stress on Run Pipe as per NC-3653.2 Eq. (10) 

SD = Settlement Stress on Run Pipe as per NC-3653.2 Eq. (10a) 

STE = Sustained + Thermal Stress on Run Pipe as per NC-3653.2 Eq. (11) 

SMTS = Pipe Stress SMTS computed in Subsection A above 

SMTO = Pipe Stress SMTO computed in Subsection B above 

SPTE = Pipe Stress SPTE computed in Subsection C above 

SPTD = Pipe Stress SPTD computed in Subsection D above 

SMTR = Pipe Stress SMTR computed in Subsection E above 

SPTR = Pipe Stress SPTR computed in Subsection E above 

SNT**= Pipe Stress SNT** computed in Subsection F above 
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Rectangular Cross-section Welded Attachments 

 

The notations described below are used in the formulas for the design. 

𝐿1= half length of attachment in circumferential direction of the run pipe  

𝐿2= half length of attachment in longitudinal direction of the run pipe  

𝑅= mean pipe radius 

𝐷𝑜= outside diameter of run pipe 

𝑇= nominal run pipe wall thickness  

𝐿𝑎= lesser of L2 and T  

𝐿𝑏= lesser of L1 and T  

𝐿𝑐= lesser of L1 and L2 

𝐿𝑑= greater of L1 and L2 

𝐴𝑇 = 4. 𝐿1. 𝐿2= cross-sectional area of the rectangular attachment 

𝑍𝑡𝐿 = (
4

3
) . 𝐿1. 𝐿2

2 

𝑍𝑡𝑁 = (
4

3
) . 𝐿1

2. 𝐿2 

𝛽1 =
𝐿1
𝑅

 

𝛽2 =
𝐿2
𝑅

 

𝛾 =
𝑅

𝑇
 

Limits of Applicability 

𝜷𝟏 ≤ 𝟎. 𝟓 

𝜷𝟐 ≤ 𝟎. 𝟓 
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𝜷𝟏. 𝜷𝟐 ≤ 𝟎. 𝟕𝟓 

 

𝑀𝐿 = bending moment applied to the attachment as shown in figure above 

𝑀𝑁 = bending moment applied to the attachment as shown in figure above 

𝑀𝑇 = torsional moment applied to the attachment as shown in figure above 

𝑄1 = shear load applied to the attachment as shown in figure above. 

𝑄2 = shear load applied to the attachment as shown in figure above 
W  = thrust load applied to the attachment as shown in figure above 

ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of 
attachment loads used in the stress calculation are based on the loads used in the different 
code equations. 

ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring 
simultaneously under all service loading conditions.  

Calculate 𝜼, 𝑿𝟏 𝒂𝒏𝒅 𝒀𝟏 using the factors listed in Table below. 

Load Index Ao 𝜃 𝑋𝑜 𝑌𝑜 
Thrust (W)  CW 2.2 400 0 0.05 

Longitudinal Moment (ML) CL 2.0 500 -0.45 -0.55 
Circumferential Moment (MN) CN 1.8 400 -0.75 -0.60 

𝑋1 = 𝑋𝑜 + 𝑙𝑜𝑔10𝛽1 

𝑌1 = 𝑌𝑜 + 𝑙𝑜𝑔10𝛽2 

𝜂 = −(𝑋1𝐶𝑜𝑠𝜃 + 𝑌1𝑆𝑖𝑛𝜃) −
1

𝐴𝑜
(𝑋1𝑆𝑖𝑛𝜃 − 𝑌1𝐶𝑜𝑠𝜃)

2 

𝐶𝑊 = 3.82(𝛾)1.64𝛽1𝛽2𝜂
1.54but not less than 1.0 

𝐶𝐿 = 0.26(𝛾)1.74𝛽1𝛽2
2𝜂4.74but not less than 1.0 

𝐶𝑁 = 0.38(𝛾)
1.90𝛽1

2𝛽2𝜂
3.40but not less than 1.0 

𝐵𝐿 = (2/3) CL but not less than 1.0 

𝐵𝑁 = (2/3) CN but not less than 1.0 

𝐵𝑊 = (2/3) CW but not less than 1.0 

𝐾𝑇 = 2.0 for full penetration welds and fillet or partial penetration welds welded on 4 sides 
 = 3.6 for fillet or partial penetration welds welded on 2 or 3 sides 
fa = allowable stress range as defined in Clause 12.1.3 of EN 13480-3 (2017) 
Sc = allowable stress at ambient temperature 
fh = allowable stress at max temperature as provided in Clause 12.1.3 of EN 13480-3 (2017) 
fcr = design stress in the creep range as defined in Clause 5.3 of EN 13480-3 (2017) 
ReHt = yield stress 

Pipe Stresses are calculated using the equations 11.5.3-1, 11.5.3-2, 11.5.3-3 and 11.5.3-4 
provided in Clause 11.5.3.  
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(A) Calculate PipeStress SMTS due to Sustained Loads on Attachment 

𝑀𝑇𝑇𝑆 = 𝑚𝑎𝑥(
𝑀𝑇𝑆

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝑆

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑀𝑇𝑆 =
𝐵𝑊𝑊𝑆

𝐴𝑇
+
𝐵𝑁𝑀𝑁𝑆

𝑍𝑡𝑁
+
𝐵𝐿𝑀𝐿𝑆

𝑍𝑡𝐿
+

𝑄1𝑆
2𝐿1𝐿𝑎

+
𝑄2𝑆
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝑆 

where 

WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight 
and Other Sustained Loads 

MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment 
due to Weight and Other Sustained Loads 

Note: Absolute values of Forces and Moments are used while calculating SMTS 
Stresses. 

 (B) Calculate PipeStress SMTO due to Occasional Loads on Attachment 

𝑀𝑇𝑇𝑂 = 𝑚𝑎𝑥 (
𝑀𝑇𝑂

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝑂

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑀𝑇𝑂 =
𝐵𝑊𝑊𝑜
𝐴𝑇

+
𝐵𝑁𝑀𝑁𝑂

𝑍𝑡𝑁
+
𝐵𝐿𝑀𝐿𝑂

𝑍𝑡𝐿
+

𝑄1𝑂
2𝐿1𝐿𝑎

+
𝑄2𝑂
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝑂 

where 

WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to 
Occasional Loads such as Wind or Seismic 

MTO, MLO and MNO are the torsional moment and bending moments applied at the 
attachment due to Occasional Loads such as Wind or Seismic 

Note: Absolute values of Forces and Moments are used while calculating SMTO 
Stresses. 

 (C) Calculate Attachment Stresses: SNTE and SPTE due to Thermal Loads 

𝑀𝑇𝑇𝐸 = 𝑚𝑎𝑥 (
𝑀𝑇𝐸

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇𝐸

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑁𝑇𝐸 =
𝐶𝑊𝑊𝐸

𝐴𝑇
+
𝐶𝑁𝑀𝑁𝐸

𝑍𝑡𝑁
+
𝐶𝐿𝑀𝐿𝐸

𝑍𝑡𝐿
+

𝑄1𝐸
2𝐿1𝐿𝑎

+
𝑄2𝐸
2𝐿2𝐿𝑏

+𝑀𝑇𝑇𝐸 

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸 

where 

WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to 
Thermal Loads 
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MTE, MLE and MNE are the torsional moment and bending moments applied at the 
attachment due to Thermal Loads 

Note: Absolute values of Forces and Moments are used while calculating SNTE 
Stresses. 

(D) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads on 
Attachment 

SMTR = additional stress resulting from sustained loads = SMTS calculated in Subsection A 
above 

SPTR = additional stress resulting from restrained thermal loads = SPTE calculated in 
Subsection C above  

(E) Calculate PipeStresses SMTC and SPTC due to Creep on Attachment 

SMTC = additional stress resulting from sustained loads = SMTS calculated in Subsection A 
above 

SPTC = additional stress resulting from restrained thermal loads = SPTE calculated in 
Subsection C above  

(F) Calculate PipeStress SNT** due to Abs. Max. Loads 

𝑀𝑇𝑇
∗∗ = 𝑚𝑎𝑥(

𝑀𝑇
∗∗

𝐿𝑐𝐿𝑑𝑇 [1 + (
𝐿𝑐

𝐿𝑑
)]
;

𝑀𝑇
∗∗

[0.8 + 0.05 (
𝐿𝑑

𝐿𝑐
)] 𝐿𝑐

2𝐿𝑑
) 

𝑆𝑁𝑇
∗∗ =

𝐶𝑊𝑊
∗∗

𝐴𝑇
+
𝐶𝑁𝑀𝑁

∗∗

𝑍𝑇
+
𝐶𝐿𝑀𝐿

∗∗

𝑍𝑇
+
𝑄1

∗∗

2𝐿1𝐿𝑎
+
𝑄2

∗∗

2𝐿2𝐿𝑏
+𝑀𝑇𝑇

∗∗ 

Analysis of Attachment Welded to Pipe with a Full Penetration Weld 

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh 

Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh 

Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa 

Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa) 

Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr 

Additional Check 

SNT** ≤2ReHt 

|
𝑄1

∗∗

2𝐿1𝐿𝑎
+
𝑄2

∗∗

2𝐿2𝐿𝑏
+𝑀𝑇𝑇

∗∗| ≤ R𝑒𝐻𝑡 

 

Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld 

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh 

Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh 

Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa 

Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa) 
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Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr 

Additional Check 

SNT** ≤2ReHt 

|
𝑄1

∗∗

2𝐿1𝐿𝑎
+
𝑄2

∗∗

2𝐿2𝐿𝑏
+𝑀𝑇𝑇

∗∗| ≤ R𝑒𝐻𝑡 

Note: Additional compliance checks as per Eq. 11.5.4-1 and Eq. 11.5.4-2 of Clause 
11.5.4 are not performed in CAEPIPE at this time. 

where,  

S1 = Sustained Stress on Run Pipe as per 12.3.2-1 of EN 13480-3 (2017) 

S2 = Sustained + Occasional Stress on Run Pipe as per 12.3.3-1 of EN 13480-3 (2017) 

S3 = Thermal Stress on Run Pipe as per 12.3.4-1 of EN 13480-3 (2017) 

S4 = Sustained + Thermal Stress on Run Pipe as per 12.3.4-2 of EN 13480-3 (2017) 

S5 = Settlement Stress on Run Pipe as per 12.3.5-1 of EN 13480-3 (2017) 

SMTS = Pipe Stress SMTS computed in Subsection A above 

SMTO = Pipe Stress SMTO computed in Subsection B above 

SPTE = Pipe Stress SPTE computed in Subsection C above 

SMTR = Pipe Stress SMTR computed in Subsection D above 

SPTR = Pipe Stress SPTR computed in Subsection D above 

SMTC = Pipe Stress SMTR computed in Subsection E above 

SPTC = Pipe Stress SPTR computed in Subsection E above 

SNT**= Pipe Stress SNT** computed in Subsection F above 
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HollowCircular Cross-section Welded Attachments 

 

The symbols described below are used in the formulas for the design. 

𝑅= mean run pipe radius  

𝑅𝑜= run pipe outside diameter 

𝑟𝑜= attachment outside radius 

𝑟𝑖= attachment inside radius 

𝐷𝑜 =  outside diameter of run pipe 

𝑑𝑜 =  outside diameter of attachment 

𝑇= nominal run pipe wall thickness  

𝑡= nominal attachment wall thickness  

𝐴𝑇 = 𝜋(𝑟𝑜
2 − 𝑟𝑖

2)= cross-sectional area of the circular attachment 

𝐼𝑇 = 
𝜋

4
(𝑟𝑜

4 − 𝑟𝑖
4) 

𝑍𝑇 = 
𝐼𝑇
𝑟𝑜

 

𝐽 =  min(𝜋𝑟𝑜
2𝑇,   𝑍𝑇) 

𝛾 =  
𝑅𝑜
𝑇

 

𝛽 = 
𝑑𝑜
𝐷𝑜

 

𝜏 =  
𝑡

𝑇
 

Limits of Applicability 

𝟒. 𝟎 ≤  𝜸 ≤ 𝟓𝟎 

0.2 ≤ 𝜏 ≤ 1.0 
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0.3 ≤ 𝛽 ≤ 1.0 

𝑀𝐿 = bending moment applied to the attachment as shown in figure above 

𝑀𝑁 = bending moment applied to the attachment as shown in figure above 

𝑀𝑇 = torsional moment applied to the attachment as shown in figure above 

𝑄1 = shear load applied to the attachment as shown in figure above. 

𝑄2 = shear load applied to the attachment as shown in figure above 
W  = thrust load applied to the attachment as shown in figure above 
 
ML, MN, MT, Q1, Q2 and W are determined at the surface of the pipe. The values of 
attachment loads used in the stress calculation are based on the loads used in the different 
code equations. 
 
ML**, MN**, MT**, Q1**, Q2** and W** are absolute values of maximum loads occurring 
simultaneously under all service loading conditions.  

 
𝐶 = 𝐴𝑜(2𝛾)

𝑛1𝛽𝑛2𝜏𝑛3but not less than 1.0 

Equation for C is used to determine CW, CL and CN based on the following Table. Maximum 
values of CW, CL and CN among the values calculated for the pipe and the attachment are 
used subsequently. 

Load Index Part 𝛽 range Ao n1 n2 n3 

Thrust (W) CW Pipe 0.3 to1.0 1.40 0.81 (a) 1.33 
Attachment 0.3 to1.0 4.00 0.55 (b) 1.00 

Longitudinal 
Moment (ML) 

CL Pipe 0.3 to1.0 0.46 0.60 -0.04 0.86 
Attachment 0.3 to1.0 1.10 0.23 -0.38 0.38 

Circumferential 
Moment (MN) 

CN Pipe 0.3 to 0.55 0.51 1.01 0.79 0.89 
Attachment 0.3 to 0.55 0.84 0.85 0.80 0.54 

Circumferential 
Moment (MN) 

CN Pipe >0.55 to 1.0 0.23 1.01 -0.62 0.89 
Attachment >0.55 to 1.0 0.44 0.85 -0.28 0.54 

(a) - Replace 𝛽𝑛2 with 𝑒−1.2𝛽
3
 

(b) - Replace 𝛽𝑛2 with 𝑒−1.35𝛽
3
 

 

𝐶𝑇 = 1.0 for 𝛽<= 0.55 

 = CN for 𝛽 = 1.0, but not less than 1.0;  

CT should be linearly interpolated for 0.55 <= 𝛽< 1.0, but not less than 1.0 
 

𝐵𝑊 = 0.5 CW but not less than 1.0 

𝐵𝐿 = 0.5 CL but not less than 1.0 

𝐵𝑁 = 0.5 CN but not less than 1.0 

𝐵𝑇 = 0.5 CT but not less than 1.0 

𝐾𝑇 = 1.8 for full penetration welds 
 = 2.0 for fillet or partial penetration welds 
fa = allowable stress range as defined in Clause 12.1.3 of EN 13480-3 (2017) 
Sc = allowable stress at ambient temperature 
fh = allowable stress at max temperature as provided in Clause 12.1.3 of EN 13480-3 (2017) 
fcr = design stress in the creep range as defined in Clause 5.3 of EN 13480-3 (2017) 
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ReHt = yield stress 

(A) Calculate PipeStress SMTS due to Sustained Loads on Attachment 

𝑆𝑀𝑇𝑆 =
𝐵𝑊𝑊𝑆

𝐴𝑇
+
𝐵𝑁𝑀𝑁𝑆

𝑍𝑇
+
𝐵𝐿𝑀𝐿𝑆

𝑍𝑇
+
2𝑄1𝑆
𝐴𝑇

+
2𝑄2𝑆
𝐴𝑇

+
𝐵𝑇𝑀𝑇𝑆

𝐽
 

where 

WS, Q1S and Q2S are the thrust load and shear forces applied at the attachment due to Weight 
and Other Sustained Loads 

MTS, MLS and MNS are the torsional moment and bending moments applied at the attachment 
due to Weight and Other Sustained Loads 

Note: Absolute values of Forces and Moments are used while calculating SMTS 
Stresses. 

 (B) Calculate Pipe Stress SMTO due to Occasional Loads on Attachment 

𝑆𝑀𝑇𝑂 =
𝐵𝑊𝑊𝑂

𝐴𝑇
+
𝐵𝑁𝑀𝑁𝑂

𝑍𝑇
+
𝐵𝐿𝑀𝐿𝑂

𝑍𝑇
+
2𝑄1𝑂
𝐴𝑇

+
2𝑄2𝑂
𝐴𝑇

+
𝐵𝑇𝑀𝑇𝑂

𝐽
 

where 

WO, Q1O and Q2O are the thrust load and shear forces applied at the attachment due to 
Occasional Loads such as Wind or Seismic 

MTO, MLO and MNO are the torsional moment and bending moments applied at the 
attachment due to Occasional Loads such as Wind or Seismic 

Note: Absolute values of Forces and Moments are used while calculating SMTO 
Stresses. 

 (C) Calculate PipeStresses SNTE and SPTE due to Thermal Loads on Attachment 

𝑆𝑁𝑇𝐸 =
𝐶𝑊𝑊𝐸

𝐴𝑇
+
𝐶𝑁𝑀𝑁𝐸

𝑍𝑇
+
𝐶𝐿𝑀𝐿𝐸

𝑍𝑇
+
2𝑄1𝐸
𝐴𝑇

+
2𝑄2𝐸
𝐴𝑇

+
𝐶𝑇𝑀𝑇𝐸

𝐽
 

𝑆𝑃𝑇𝐸 = 𝐾𝑇 . 𝑆𝑁𝑇𝐸 

where 

WE, Q1E and Q2E are the thrust load and shear forces applied at the attachment due to 
Thermal Loads 

MTE, MLE and MNE are the torsional moment and bending moments applied at the 
attachment due to Thermal Loads 

Note: Absolute values of Forces and Moments are used while calculating SNTE 
Stresses. 

(D) Calculate PipeStresses SMTR and SPTR due to Sustained + Thermal Loads on 
Attachment 

SMTR = Stress SMTS calculated in Subsection A above 

SPTR = Stress SPTE calculated in Subsection C above  
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(E) Calculate PipeStresses SMTC and SPTCdue to Creep on Attachment 

SMTC = Stress SMTS calculated in Subsection A above 

SPTC = Stress SPTE calculated in Subsection C above  

(F) Calculate PipeStress SNT** due to Abs. Max. Loads on Attachment 

𝑆𝑁𝑇
∗∗ =

𝐶𝑊𝑊
∗∗

𝐴𝑇
+
𝐶𝑁𝑀𝑁

∗∗

𝑍𝑇
+
𝐶𝐿𝑀𝐿

∗∗

𝑍𝑇
+
2𝑄1

∗∗

𝐴𝑇
+
2𝑄2

∗∗

𝐴𝑇
+
𝐶𝑇𝑀𝑇

∗∗

𝐽
 

Analysis of Attachment Welded to Pipe with a Full Penetration Weld 

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh 

Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh 

Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa 

Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa) 

Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr 

Additional Check 

|SNT**|≤ 2.ReHt 

|
2𝑄1

∗∗

𝐴𝑇
+
2𝑄2

∗∗

𝐴𝑇
+
𝑀𝑇

∗∗

𝐽
| ≤ 𝑅𝑒𝐻𝑡 

 

Analysis of Attachment Welded to Pipe with a Fillet or Partial Penetration Weld 

Sustained Stress (SSL) = S1 + SMTS≤ 1.5fh 

Occasional Stress (SSO) = S2 + SMTS + SMTO≤1.8fh 

Thermal Stress (SSE) = S3 + (SPTE / 2.0) ≤fa 

Sustained + Thermal Stress (SSR) = S4 + SMTR + (SPTR / 2.0) ≤ (fh + fa) 

Creep Stress (SSC) = S4 + SMTC + (SPTC / 2.0) ≤ 1.25fcr 

Additional Check 

|SNT**|≤ 2.ReHt 

|
2𝑄1

∗∗

𝐴𝑇
+
2𝑄2

∗∗

𝐴𝑇
+
𝑀𝑇

∗∗

𝐽
| ≤ 𝑅𝑒𝐻𝑡 

Note: Additional compliance checks as perEq. 11.4.4-1 and Eq. 11.4.4-2 of Clause 
11.4.4 are not performed in CAEPIPE at this time 

where,  

S1 = Sustained Stress on Run Pipe as per 12.3.2-1 of EN 13480-3 (2017) 

S2 = Sustained + Occasional Stress on Run Pipe as per 12.3.3-1 of EN 13480-3 (2017) 

S3 = Thermal Stress on Run Pipe as per 12.3.4-1 of EN 13480-3 (2017) 

S4 = Sustained + Thermal Stress on Run Pipe as per 12.3.4-2 of EN 13480-3 (2017) 
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S5 = Settlement Stress on Run Pipe as per 12.3.5-1 of EN 13480-3 (2017) 

SMTS = Pipe Stress SMTS computed in Subsection A above 

SMTO = Pipe Stress SMTO computed in Subsection B above 

SPTE = Pipe Stress SPTE computed in Subsection C above 

SMTR = Pipe Stress SMTR computed in Subsection D above 

SPTR = Pipe Stress SPTR computed in Subsection D above 

SMTC = Pipe Stress SMTR computed in Subsection E above 

SPTC = Pipe Stress SPTR computed in Subsection E above 

SNT**= Pipe Stress SNT** computed in Subsection F above 
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Six stiffnesses are shown below at the nozzle-vessel interface - three are calculated and the 
other three are assumed rigid. 

 

 

 

 

The coordinate system is as shown in the figure. The six components of the forces and 
moments at the nozzle-vessel interface are: 

P = Radial load MC = Circumferential moment 

VC = Circumferential load MT = Torsional moment 

VL = Longitudinal load ML = Longitudinal moment 

Of the six components of stiffnesses, only three stiffnesses, axial (Kx), circumferential (Kyy), 

and longitudinal (Kzz), are calculated. The remaining three are assumed to be rigid. 

Several graphs are given at the end of this annexure. The stiffness coefficients are obtained 
by interpolating logarithmically from these graphs. 

The first two, Figures D-1 and D-2, are used to calculate nozzle stiffness coefficients for 
Nozzles on cylindrical vessels. Figure D-1 is used to calculate the axial stiffness coefficient 
and Figure D-2 is used to calculate circumferential and longitudinal stiffness coefficients. 
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Nomenclature 

𝐷 = mean diameter of vessel 

𝑑 = outside diameter of nozzle 

𝑇 = thickness of vessel 

𝑡 = thickness of nozzle 

λ = (𝑑/D)√𝐷/T 

Λ = 𝐿/√𝐷𝑇 

𝐿 = unsupported length of cylinder 

 = 8𝐿1𝐿2/(√𝐿1 +√𝐿2)
2
 

𝐿1 = distance from nozzle center line to vessel end 

𝐿2 = distance from nozzle center line to vessel end 

𝐸 = modulus of elasticity of vessel material 

Axial Stiffness(𝑲𝒙) 

𝐾𝑥 = 𝛼 ×
4.95𝐸𝑇2

𝐷√𝛬
 

where 

𝛼 = stiffness coefficient read from Figure D-1 

Circumferential Stiffness(𝑲𝒚𝒚) 

𝐾𝑦𝑦 = 𝛽 × 𝐸𝑇3 

where 

𝛽 =1stiffness coefficient read from Figure D-2. 

The bottom three curves in Figure D-2, marked Circumferential moment MCare used to 

find𝛽. 

Longitudinal Stiffness(𝑲𝒛𝒛) 

𝐾𝑧𝑧 = 𝛾 × 𝐸𝑇3 

where 

γ = stiffness coefficient read from Figure D-2. 

The top two curves in Figure D-2, marked Longitudinal moment MLare used to findγ. 

(1) 

(2) 

 (3) 
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Calculation of Nozzle stiffnesses for Nozzles on Flat-bottom tanks 

This procedure is similar to the previous one. 

 

As before, only three stiffnesses are calculated as the other three are assumed to be rigid. The 

ones that are calculated are axial(𝐾𝑥), circumferential(𝐾𝑦𝑦), and longitudinal (𝐾𝑧𝑧). 

For Nozzles on flat-bottom tanks, twelve graphs are given at the end of this annexure, 
Figures D-3 through D-14. Six are for “with reinforcing pad (on vessel)” with the other six 
for no reinforcing pad on the vessel. The stiffness coefficients are obtained using the 
appropriate graph. 
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Nomenclature 

𝑅 = Mean radius of vessel  

𝑡 = thickness of vessel 

2𝑎 = outside diameter of nozzle 

Axial Stiffness(𝑲𝒙) 

𝐾𝑥 = 𝐾𝑅 × 𝐸 × (2𝑎) 

where 

𝐾𝑅 = axial stiffness coefficient. 

Circumferential Stiffness(𝑲𝒚𝒚) 

𝐾𝑦𝑦 = 𝐾𝐶 × 𝐸 × (2𝑎)
3 

where 

𝐾𝐶 = circumferential stiffness coefficient. 

Longitudinal Stiffness(𝑲𝒛𝒛) 

𝐾𝑧𝑧 = 𝐾𝐿 × 𝐸 × (2𝑎)
3 

where 

𝐾𝐿 =longitudinal stiffness coefficient. 

The graphs for stiffness coefficients follow: 

(4) 

(5) 

(6) 
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Figure D-1:Stiffness coefficient for axial load on nozzle 
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Figure D-2:Stiffness coefficients for moment loads on nozzle 
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Figure D-3:Stiffness coefficient for axial load (with reinforcing pad)(L/2a = 1.0) 

 

Figure D-4:Stiffness coefficient for circumferential moment (with reinforcing 
pad)(L/2a=1.0) 
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Figure D-5: Stiffness coefficient for longitudinal moment (with reinforcing pad)(L/2a = 1.0) 

 

Figure D-6:Stiffness coefficient for axial load (with reinforcing pad)(L/2a = 1.5) 
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Figure D-7:Stiffness coefficient for circumferential moment (with reinforcing pad) 
(L/2a = 1.5) 

 

Figure D-8:Stiffness coefficient for longitudinal moment (with reinforcing pad)(L/2a=1.5) 
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Figure D-9:Stiffness coefficient for axial load (no reinforcing pad)(L/2a = 1.0) 

 

Figure D-10:Stiffness coefficient for circumferential moment (no reinforcing pad)(L/2a= 
1.0) 



Nozzle Stiffness Calculations 
 

742 

 

Figure D-11:Stiffness coefficient for longitudinal moment (no reinforcing pad)(L/2a = 1.0) 

 

Figure D-12:Stiffness coefficient for axial load (no reinforcing pad)(L/2a = 1.5) 
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Figure D-13:Stiffness coefficient for circumferential moment (no reinforcing pad) 
(L/2a = 1.5) 

 

Figure D-14:Stiffness coefficient for longitudinal moment (no reinforcing pad)(L/2a=1.5 
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Calculation of Nozzle stiffnesses on Spherical Vessels 

As before, only three stiffnesses are calculated as the other three are assumed to be rigid. The 

ones that are calculated are axial(𝐾𝑥), circumferential(𝐾𝑦𝑦), and longitudinal (𝐾𝑧𝑧). 

For Nozzles on Spherical Vessels, Figures G.2.4.3 and G.2.4.9 from PD 5500 (2009) have 
been referred as given below.   
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Nozzle Evaluation
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Local Loads on nozzles in spherical shells 

Conditions of applicability 

𝑎) 0.001 ≤ 𝑒𝑎/𝑅 ≤ 0.1 

b) distances to any other local load in any direction shall be not less than √𝑅. 𝑒𝑐 

c) nozzle thickness shall be maintained over a distance of 𝐿 ≥ √𝑑. 𝑒𝑏 

where, 

e = nominal shell thickness 

ea = analysis shell thickness = e – corrosion allowance 

eb = nozzle thickness 

ec = analysis thickness of the combined shell and reinforcing plate  

   = ea + e2 . min(f2/f;1) when a reinforcing plate is fitted 

   = ea when no reinforcing plate is fitted 

R = mean shell radius at the nozzle 

e2 = reinforcing pad thickness 

f2 = allowable design stress of reinforcing pad plate 

f = allowable design stress of shell material 

Maximum allowable individual loads 

Allowable axial nozzle load 

Allowable axial nozzle load Fz.max is computed using Eq. (16.4-7) 

𝐹𝑧.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐
2(1.82 + 2.4√1 + 𝑘. 𝜆𝑠 + 0.91. 𝑘. 𝜆𝑠

2) 

where 

k = min (
2𝑓𝑏𝑒𝑏

𝑓𝑒𝑐
√
𝑒𝑏

𝑑
; 1.0) 

𝜆𝑠 =
𝑑

√𝑅𝑒𝑐
 

d = mean nozzle diameter 

fb = allowable design stress of nozzle material 

Allowable bending moment 

Allowable bending moment MB.max is computed using Eq. (16.4-8) 

𝑀𝐵.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐
2
𝑑

4
(4.90 + 2.0√1 + 𝑘. 𝜆𝑠 + 0.91. 𝑘. 𝜆𝑠

2) 
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Local Loads on nozzles in cylindrical shells 

Conditions of applicability 

𝑎) 0.001 ≤ 𝑒𝑎/𝐷 ≤ 0.1 

b) 𝜆𝐶 =
𝑑

√𝐷𝑒𝑐
 

b) distances to any other local load in any direction shall be not less than √𝐷. 𝑒𝑐 

c) nozzle thickness shall be maintained over a distance of 𝐿 ≥ √𝑑. 𝑒𝑏 

where, 

e = nominal shell thickness 

ea = analysis shell thickness = e – corrosion allowance 

eb = nozzle thickness 

ec = analysis thickness of the combined shell and reinforcing plate  

   = ea + e2 . min(f2/f;1) when a reinforcing plate is fitted 

   = ea when no reinforcing plate is fitted 

D = mean shell diameter at the opening 

e2 = reinforcing pad thickness 

f2 = allowable design stress of reinforcing pad plate 

f = allowable design stress of shell material 

Maximum allowable individual loads 

Allowable axial nozzle load 

Allowable axial nozzle load Fz.max is computed using Eq. (16.5-3) 

𝐹𝑧.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐
2. 𝐶1 

where 

𝐶1 = 𝑚𝑎𝑥[(𝑎𝑜 + 𝑎1. 𝜆𝐶 + 𝑎2. 𝜆𝐶
2 + 𝑎3. 𝜆𝐶

3 + 𝑎4. 𝜆𝐶
4); 1.81] as per Eq. (16.5-4) 

 

𝜆𝐶 =
𝑑

√𝐷𝑒𝑐
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Allowable circumferential moment 

Allowable bending moment MX.max is computed using Eq. (16.5-5) 

𝑀𝑋.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐
2
𝑑

4
𝐶2 

where, 

𝐶2 = 𝑚𝑎𝑥[(𝑎𝑜 + 𝑎1. 𝜆𝐶 + 𝑎2. 𝜆𝐶
2 + 𝑎3. 𝜆𝐶

3 + 𝑎4. 𝜆𝐶
4); 4.90] as per Eq. (16.5-6) 

 

Allowable longitudinal moment 

Allowable longitudinal moment MY.max is computed using Eq. (16.5-7) 

𝑀𝑌.𝑚𝑎𝑥 = 𝑓. 𝑒𝑐
2
𝑑

4
𝐶3 

where, 

𝐶3 = 𝑚𝑎𝑥[(𝑎𝑜 + 𝑎1. 𝜆𝐶 + 𝑎2. 𝜆𝐶
2 + 𝑎3. 𝜆𝐶

3 + 𝑎4. 𝜆𝐶
4); 4.90] as per Eq. (16.5-8) 
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General 

CAEPIPE computes Local Shell Stresses at Nozzles as per WRC Bulletin 537 (2013) and 
performs Stress Compliance as per ASME Section VIII Division 2 (2017). 

As stated in ASME Section VIII Division 2 (2017) code, shell stresses computed for primary 
loads of Sustained and Sustained + Occasional should exclude the Radial and Tangential 
Bending Stresses. On the other hand, for Operating load which includes secondary loads due 
to temperature change and thermal anchor movements, Radial and Tangential Bending 
Stresses should be included for compliance as per ASME Section VIII Division 2 (2017). 
Refer to the extract from ASME Section VIII Division 2 (2017) provided at the end of this 
section for details on the implementation of Stress Compliance in CAEPIPE.  

Local Stresses in Spherical Shells at Hollow Circular Attachments 

As per Section 3.5.1 of WRC Bulletin 537, the below procedure provides one with a tool to 
compute stresses in the shell, but not in the nozzle. In some instances, stresses will be higher 
in the nozzle wall than they are in the vessel wall. This possibility is most likely if the nozzle 
opening is not reinforced, or if the reinforcement is placed on the vessel wall and not on the 
nozzle. 
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Local Stresses in Cylindrical Shells at Solid Circular Attachments 

As per Section 4.5.3 of WRC Bulletin 537, the below procedure provides one with a tool to 
compute stresses in the shell, but not in the attachment. Under certain conditions, stresses 
may be higher in the attachment than they are in the vessel. For example, in the case of a 
nozzle, it is likely that the stresses will be higher in the nozzle wall than they are in the vessel 
wall if the nozzle opening is unreinforced or if the reinforcement is placed on the vessel wall 
and not on the nozzle. 
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Note: 

1. Original Curves are referred for all figures. For example, 3C-Original is referred to 
read the parameters required for calculating Circumferential Membrane Stress due to 
P. 

2. Figure 2C-1 – Original is referred to calculate Circumferential Bending Stress due to 
P at Points AU, AL, BU and BL. Similarly, Figure 1C is referred to calculate 
Circumferential Bending Stress due to P at Points CU, CL, DU and DL. 

3. Figure 1C-1 – Original is referred to calculate Longitudinal Bending Stress due to P 
at Points AU, AL, BU and BL. Similarly, Figure 2C is referred to calculate Longitudinal 
Bending Stress due to P at Points CU, CL, DU and DL. 

See Note 2 below 

See Note 3 below 
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Stress Compliance of Local Shell Stresses at Nozzles 

[Extract from ASME Section VIII Division 2 (2017)] 
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The Design Earthquake Load – ASCE/SEI 7-16 

Chapter 13 titled “Seismic Design Requirements for Nonstructural Components” from 
ASCE/SEI 7-16 provides Seismic Design requirements for architectural, mechanical and 
electrical components including specific references to ASME boiler, pressure vessels and 
piping as detailed below. 

Site Coefficients and Risk-Targeted Maximum Considered Earthquake (MCE) 
Spectral Response Acceleration Parameters 

The MCE spectral response acceleration parameter for Site Class effects shall be determined 
by Eq. 11.4-1. 

𝑆𝑀𝑆 = 𝐹𝑎𝑆𝑆 

where, 

Fa = Site Coefficient defined in Table 11.4-1. 

SS = the mapped MCE spectral response acceleration parameter at short periods as 
determined in accordance with Section 11.4.1. The value of Ss can be retrieved from the 
USGS website http://earthquake.usgs.gov/designmaps. 

 

Note: Site specific analysis is required for Site Class E with Ss>= 1.0 and Site Class F,  

Design Spectral Acceleration Parameters 

Design earthquake spectral response acceleration parameter at short period, SDS shall be 
determined from Eq. 11.4-3. 

𝑆𝐷𝑆 = (
2

3
) 𝑆𝑀𝑆 

Seismic Design Force 

The horizontal seismic design force (Fp) shall be applied at the component’s center of 
gravity and distributed relative to the component’s mass distribution and shall be determined 
in accordance with Eq. 13.3-1 of para. 13.3.1. 

𝐹𝑝 =
0.4𝑎𝑝𝑆𝐷𝑆𝑊𝑝

(
𝑅𝑝

𝐼𝑝
)

(1 + 2
𝑧

ℎ
) 

http://earthquake.usgs.gov/designmaps
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Fp is not required to be taken as greater than 

𝐹𝑝 = 1.6𝑆𝐷𝑆𝐼𝑝𝑊𝑝 

Fp shall not be taken as less than 

𝐹𝑝 = 0.3𝑆𝐷𝑆𝐼𝑝𝑊𝑝 

where, 

Fp = seismic design force 

SDS = spectral acceleration, short period, as determined above 

SMS = maximum MCE spectral acceleration at short periods  

ap = component amplification factor that varies from 1.00 to 2.50(see Table 13.6-1 below) 

Ip = component importance factor that varies from 1.00 to 1.50 (see Section 13.1.3) 

Wp = component operating weight 

Rp = component response modification factor that varies from 1.00 to 12 (see Table 13.6-1 below) 

z = height in structure of point of attachment of component with respect to the base. For items at or 
below the base, z shall be taken as 0. The value of z/h need not exceed 1.0. 

h = average roof height of structure with respect to the base 

Note: 

As per 13.1.8, the earthquake loads determined in accordance with Section 13.3.1 shall be 
multiplied by a factor 0.7. This can be performed in CAEPIPE by entering the value as 0.70 
for “All. Stress Factor ADS(a)” through “ASCE/SEI 7-16” Seismic parameter input dialog. 

Vertical Seismic Force 

As per para. 13.3.1, Vertical Seismic Force shall be computed as 

𝑉𝑝 = 0.2𝑆𝐷𝑆𝑊𝑝 

where, 

SDS and Wp are as defined above. 
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The Design Wind Load – ASCE/SEI 7-16 

Chapter 26 titled “Wind Load: Generic Requirements” is used to determine basic parameters 
for determining wind loads and Chapter 29 titled “Wind Load on Other Structures and 
Building Appurtenances – MWFRS” of ASCE/SEI 7-16 provides a directional wind force 
determination procedure for building appurtenances and other structures. Details referred 
from these two (2) chapters for implementation in CAEPIPE are detailed below. 

Type of Element Classification 

Type of Element Classification = Other Structures 

Figure 26.1-1 directs the ASCE 7 user to the appropriate method to determine wind forces 
for the particular building or structure the user is concerned with. The method most 
appropriate for industrial plant piping of any type is detailed in Chapter 29, “Wind Loads on 
Other Structures and Building Appurtenances – MWFRS”. 

Wind Load Parameters 

The following wind load parameters shall be determined in accordance with Chapter 26. 

Basic Wind Speed (V): 

The basic wind speed, V, used in the determination of design wind loads on buildings and 
other structures shall be determined from Fig. 26.5-1 as follows.  

Fig. 26-5-1A can be referred for Risk Category I buildings and other structures. 

Fig. 26-5-1B can be referred for Risk Category II buildings and other structures  

Fig. 26.5-1C can be referred for Risk Category III buildings and other structures. 

Fig. 26.5-1D can be referred for Risk Category IV Buildings and Other Structures. 

Wind Directionality Factor Kd: 

The wind directionality factor, Kd, shall be determined from Table 26.6-1 as given below. 

Exposure Categories: 

As detailed in Section 26.7.3 of ASCE/SEI 7-16, Exposure Categories can be B, C or D. 

Topographical Factor Kzt: 

As detailed in Section 26.8.2, Wind speed-up effects shall be included in the calculation of 
design wind loads by using the factor Kzt. 

Figure 26.8-1 (given below) can be referred to compute the Topographical Factor Kzt. 

𝐾𝑧𝑡 = (1 + 𝐾1𝐾2𝐾3)
2 

where K1, K2 and K3 are given in Fig. 26.8-1. 

If site conditions and locations of structures do not meet all the conditions specified in 
Section 26.8.1 then Kzt = 1.0 

Velocity Pressure Exposure Coefficient Kz 

Velocity pressure exposure coefficient Kz can be determined from Table 26.10.1 provided 
below.  
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Velocity Pressure 

Velocity pressure, qz, evaluated at height z shall be calculated by the following equation: 

𝑞𝑧 = 0.00256𝐾𝑧𝐾𝑧𝑡𝐾𝑑𝐾𝑒𝑉
2 (𝑙𝑏/𝑓𝑡2) 

where 

Kd = wind directionality factor as defined above 

Kzt = velocity pressure exposure coefficient as defined above 

Kz = topographic factor as defined above 

Ke = ground elevation factor to adjust air density permitted Ke = 1 

V = basic wind speed as defined above 

Design Wind Loads – Other Structures 

The design wind force for other structures (chimneys, tanks, rooftop equipment for h > 60, 
and similar structures, open signs, lattice frameworks, and trussed towers) shall be 
determined by section 29.4, ASCE 7-16, with the following equation: 

𝐹 = 𝑞𝑧𝐶𝑓𝐺𝐴𝑓 (𝑙𝑏) 

where 

qz = velocity pressure evaluated at height z as defined above of the centroid of area Af 

G = gust-effect factor for a rigid building or other structure is permitted to be taken as 0.85 

Cf = force coefficients from Fig. 29.4-1 given below 

Af = projected area normal to the wind except where Cf is specified for the actual surface 
area in ft2 
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The Design Snow Loads – ASCE/SEI 7-22 

Chapter 7 titled “Snow Loads” in ASCE/SEI 7-22 provides Snow Loads Design 
requirements as detailed below. 

Ground Snow Loads (Pg) 

Ground snow loads, Pg, to be used in the determination of “Design Snow Loads” shall be 
calculated using the ASCE Design Ground Snow Load Geodatabase. A graphical 
representation of the data in the ASCE Design Ground Snow Load Geodatabase is shown in 
Figures 7.2-1A through 7.2-1D for the conterminous United States and Table 7.2-1 for 
Alaska. Where the results from the geodatabase indicate that a case study needs to be 
conducted for a specific location, the ground snow load determination for the location shall 
be based on an analysis of data available in the vicinity of the site, shall meet the reliability 
targets set forth in Table 1.3-1, and shall be approved by the Authority Having Jurisdiction. 

Ground Snow Load Geodatabase of geocoded design ground snow load values are available 
at https://asce7hazardtool.online/.  

Flat Roof Snow Loads (Pf) 

The flat roof snow load (Pf) shall be calculated in lb∕ft2 (kN∕m2) using Eq. 7.3-1 of 

ASCE/SEI 7-22 as given below.  

𝑃𝑓 = 0.7𝐶𝑒𝐶𝑡𝑃𝑔 

where 

Pg = Ground Snow Load based as per Risk Category and Site Class. 

Ce = Exposure Factor as per Table 7.3-1. 

Ct = Thermal Factor as per Table 7.3-2. 

Snow Loads on Pipes 

 

https://asce7hazardtool.online/
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Pipes with a diameter less than or equal to 0.73 Pf∕γ shall be designed for a triangular snow 

load in accordance with Figure 7.13-2(a). Individual pipes with a diameter greater than 0.73 

pf ∕γ shall be designed for a trapezoidal snow load, in accordance with Figure 7.13-2(b). 

Snow loads on pipes are not required to be considered if the wintertime external surface 
temperature of the pipe is greater than 45 °F (7.2 °C). 

If D <= 0.73 Pf∕γ 

𝑆𝑛𝑜𝑤 𝐿𝑜𝑎𝑑 =
1

2
𝐷. ℎ. 𝛾. 1  

where 

h = 1.37.D 

If D > 0.73 Pf∕γ 

𝑆𝑛𝑜𝑤 𝐿𝑜𝑎𝑑 =
1

2
(𝑎 + 𝑏). ℎ. 𝛾. 1 

 

where 

Pf = Flat Roof Snow Load (lb/ft2 or kN/m2) 

h = Pf/ γ(ft or m) 

D = Pipe Outer Diameter + 2 * Insulation Thickness (ft or m) 

b = bottom width = 0.934 D (ft or m) 

x = Tan(20) * h (ft or m) 

a = top width = b – 2x (ft or m) 

γ= Snow density, as determined from Equation (7.7-1), lb∕ft3 (kN∕m3) 

γ= (0.13Pg + 14) but not more than 30 lb∕ft3 

γ= (0.426Pg + 2.2) but not more than 4.7 kN∕m3 
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Ice Loads – Atmospheric Icing – ASCE/SEI 7-22 

Chapter 10 titled “Ice Loads – Atmospheric Icing” in ASCE/SEI 7-22 provides the Ice 
Loads Design requirements as detailed below. 

Ice Load  

The ice load shall be determined using the volume or cross-sectional area of glaze ice formed 
on all exposed surfaces of structural members, guys, components, appurtenances, and cable 
systems. On structural shapes, prismatic members, and other similar shapes, the cross 
sectional area of ice shall be determined by 

𝐴𝑖 = 𝜋
𝑡𝑑

12
(𝐷𝑐 +

𝑡𝑑

12
) [English Units] 

𝐴𝑖 = 𝜋
𝑡𝑑

1000
(𝐷𝑐 +

𝑡𝑑

1000
) [SI Units] 

where 

Ai = Cross Section Area of Ice (ft2 or m2). 

td = Radial Ice Thickness (inch or mm) 

Dc = Diameter of the cylinder circumscribing an object, ft (m). Dc is shown for a variety of 
cross-sectional shapes in Figure 10.4-1 of ASCE/SEI 7-22. 
 

 

Ice Loads on Pipes 

𝐼𝑐𝑒 𝐿𝑜𝑎𝑑 = 𝐴𝑖.𝛾. 1 
where 

γ= ice density = 56 lb∕ft3 (900 kg/m3) 

Ai = Cross Section Area of Ice (ft2 or m2). 
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The Design Wind Load 

Section 4 titled “Wind velocity and velocity pressure” is used to compute Peak Velocity 
Pressure at a given elevation. 

Basic Values 

The fundamental value of the basic wind velocity, Vb,Q, is the characteristic 10 minutes 
mean wind velocity, irrespective of wind direction and time of year, at 10m above ground 
level in open country terrain with low vegetation such as grass and isolated obstacles with 
separations of at least 20 obstacle heights. 

The basic wind velocity shall be calculated from Expression (4.1) of EN 1991-1-4 (2010) as 
given below. 

𝑽𝒃,𝑸 = 𝑪𝒅𝒊𝒓. 𝑽𝒃. 𝑪𝑺𝒆𝒂𝒔𝒐𝒏 

where 

Vb is the basic wind velocity, defined as a function of wind direction and time of year at 10m 
above ground of terrain category II. 

Vb,Q is the fundamental value of the basic wind velocity 

Cdir is the directional factor, the recommended value is 1.0. 

Cseason is the season factor, the recommended value is 1.0. 

Mean Wind 

The mean wind velocity Vm(z) at a height z above the terrain depends on the terrain 
roughness and orography and on the basic wind velocity, Vb, and is determined using 
Expression (4.3) of EN 1991-1-4 (2010) as given below. 

𝑽𝒎(𝒛) = 𝑪𝒓(𝒛). 𝑽𝒃. 𝑪𝒐(𝒛) 

Where 

Cr(z) is the terrain roughness factor. This can be computed as given below. 

C0(z) is the orography factor, the recommended value is 1.0. See Section 4.3.3 of EN 1991-1-
4 (2010) for further details. 

Terrain Roughness Factor[Cr(z)] 

The roughness factor, Cr(z), accounts for the variability of the mean wind velocity at the site 
of the structure due to: 

a. height above ground level 

b. ground roughness of the terrain upwind of the structure in the wind direction 
considered. 

𝑪𝒓(𝒛) = 𝑲𝒓. 𝑳𝒏 (
𝒛

𝒛𝒐
)𝒇𝒐𝒓 𝒛𝒎𝒊𝒏 < 𝑧 <  𝑧𝒎𝒂𝒙 

𝑪𝒓(𝒛) = 𝑪𝒓(𝒛𝒎𝒊𝒏)𝒇𝒐𝒓 𝒛 <  𝑧𝒎𝒊𝒏 
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where 

𝑲𝒓 = 𝟎. 𝟏𝟗. (
𝒛

𝒛𝒐,𝑰𝑰
)

𝟎.𝟎𝟕

 

where 

zO,II= 0,05 m [terrain category II, as per Table 4.1 of EN 1991-1-4 (2010)] 

zmin is the minimum height defined in Table 4.1 of EN 1991-1-4 (2010) 

zmax is to be taken as 200 m 

 

Wind Turbulence 

The turbulence intensity Iv(z) at height z is defined as the standard deviation of the 
turbulence divided by the mean wind velocity. 

𝑰𝑽(𝒛) =
𝑲𝒕

𝑪𝒐(𝒛). 𝐥𝐧 (
𝒛

𝒛𝒐
)
  for   𝒛𝒎𝒊𝒏 < 𝑧 <  𝑧𝒎𝒂𝒙 

𝑰𝒗(𝒛) = 𝑰𝒗(𝒛𝒎𝒊𝒏)    for     𝒛 <  𝑧𝒎𝒊𝒏 

where 

Kt is the turbulence factor. The value may be given in the National Annex. The 
recommended value for Kt is 1.0. 

C0(z) is the orography factor as explained above.  

z0is the roughness length as given in Table 4.1 of EN 1991-1-4 (2010). 

Peak Velocity Pressure [Qp(z)] 

The peak velocity pressure Qp(z) at height z, which includes mean and short-term velocity 
fluctuations, is determined using Expression (4.8) of EN 1991-1-4 (2010) as given below. 

𝑸𝒑(𝒛) = [𝟏 + 𝟕. 𝑰𝒗(𝒛)].
𝟏

𝟐
. 𝝆. 𝑽𝒎

𝟐 (𝒛) = 𝑪𝒆(𝒛).𝑸𝒃 

where 
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𝜌 is the air density, which depends on the altitude, temperature and barometric pressure to 
be expected in the region during wind storms 

𝐶𝑒(𝑧)is the exposure factor = 
𝑸𝒑(𝒛)

𝑸𝒃
 

𝑄𝑏is the basic velocity pressure = 
1

2
. 𝜌. 𝑉𝑏

2 

Design Wind Loads 

The design wind force is then determined as given below.  

𝐹 = 𝑸𝒑(𝒛). 𝐴𝑓  

where 

𝑸𝒑(𝒛) = peak velocity pressure evaluated at height z  

Af = projected area normal to the wind  

 

Note: 

In Expression 5.3, Wind Force is computed by multiplying the above Qp(z) with 
CsCd and Cf. From Section 6.2(d), for chimneys with circular cross-sections (similar 
to the flow around circular pipes), CsCd is specified as 1.0. So, the only factor that is 
NOT yet applied in computing the design wind loads above is Cf.  

From Section 7.9 for Circular Cylinders, for most piping systems, Cf should be of 
between 0.7 and 1.0. Surface roughness factors (k) provided in Section 7.9.2 and end-
effect factors provided in Section 7.13 (used for computing Cf) are mostly related to 
structural elements.  Since piping elements are connected to either adjoining pipe 
elements or fittings or components or equipment, the end-effect factor for any 
element in a pipe stress model should be 1.0; it is equivalent to saying that, from fluid 
flow point of view, each element in a pipe stress model is behaving as an infinitely 
long element. Hence, it does not cause the kind of end flow effect created by finite 
length elements.   

In view of the above, applying only Eq. 4.8 to compute design wind force is 
conservative. Hence, in the current version of CAEPIPE, Expression 5.3 is not 
implemented to calculate Design Wind Loads. 
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